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Welcome
If you are enrolled in this class, you should already have taken
and received a passing grade in Avaya™ Predictive Dialing
System Foundations 12.0 class. If you have not taken this class,
please consult with your instructor.
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Using the Web Site
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Using the Avaya PDS 12.0
March 2002

Welcome
If you are enrolled in this class, you should already have taken and received a passing grade in Avaya™
Predictive Dialing System Foundations 12.0 class. If you have not taken this class, please consult with
your instructor.

Module contents

Agenda

Course Materials

Using the Web Site
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Agenda
March 2002

This section describes the agenda for this four day class.

Day 1 Introduction to the course
 Review of foundations course
 Campaign Life Cycle
 Lunch
 PDS basics
Day 2 Review activity
 Phone strategy
 Record selections
 Lunch
 More record selections
 Jobs
 Tools - Completion Code Manager
Day 3 Review Activity
 Campaign Editor project
 Manage Jobs
 Manage agents
 Lunch
 Tools - Hierarchy Manager & Agent Blending
 Campaign Analyst
 PC Analyst
Day 4 Review
 More PC Analysis
 System Reports
 Lunch
 Sustaining Activities
 CUI Campaigns
 Review
 Qualification test & follow up
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Course materials
March 2002

Every student should have the following materials:

Student Workbook Contains an outline of the class lessons, study aids, diagrams, and
exercises.

Classroom Web Site Contains supporting materials for the Student Workbook, together with
links to relevant topics in the documentation as well as other resources.

CD-ROM Contains the online course content, instructor presentations, online
Avaya PDS User's Guide, and Online Help.

Both the student workbook and classroom web site present the course modules and lessons. These are
two different tools that are meant to be used together. Use the workbook to make your own notes about
each lesson. Use the classroom web site (CD-ROM) to read about the lesson and to test your knowledge
with self-correcting quizzes. Most students will find exercises and group activities easier to follow in the
workbook during class. After class you can quickly look up exercise tasks to refresh your skills.

Take some time now and look at the workbook and the online course so that you can quickly and easily
find the same lessons in each.

Qualification tests are located on the training web server. Instructions for accessing the qualification test
for this class are located in the Qualifications section.
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Using the web site in class
March 2002

When you first open the classroom website, the first feature you see is the navigation panel.

 

This menu allows you to navigate to any class
content.

Click  to display subtopics. Click  to
collapse the topic tree.

Select the topic link to display that topic in the
right frame of the web browser.

Some topics, such as the User's Guide,
Glossary or Search open new browser
windows. These windows are smaller so that
you can, for example, look up a glossary term
while using the Campaign Monitor application.

The Canpaign Life Cycle icon is linked to the
diagram of the Campaign Life Cycle. The
instructor refers to this often throughout the
class.

If you are using this web site from the
CD-ROM, the first time you open the User's
Guide or Online Help, you are prompted to
confirm that a java control is installed on your
computer. Just say "Yes."

 

On reference pages, the icon is used to
indicate a resource. In some cases, a resource is
unavailable and no link icon is displayed.
Overviews are displayed in larger browser
windows than Procedures. Most overview
topcis come from the User's Guide, while most
procedures come from the online help.

Clicking these reference links opens up windows that are sized according to content. Most procedures,
from the online help resource, appear in a smaller window so that you can both read the procedure and

Using Web Site
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use the Campaign Director application to which the procedure refers.

Overviews and other material from the Avaya PDS User Guide are displayed in a larger window so that
the additional features, such as navigation buttons, can be displayed without reducing the readability of
the text.

Your instructor will tell you when you need to use an online resource from the classroom web site. Some
students prefer to follow along with the instructor on the web, while others prefer to follow in the student
workbook.

Because of the limitations of the screen projectors used in the classroom, it is often possible to see
additional detail in your own monitor, as compared with the projected image. Also, since most of the
images were optimized for on-screen use, and may reproduce poorly in the student workbook.
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Foundations
March 2002

Module contents

Architecture

Software

Terminology review

Objectives
At the end of this module you will:

Recall the Avaya PDS architecture and software as described in the Foundation Concepts for the
Avaya™ Predictive Dialing System

●   

Describe the Campaign Life Cycle and understand the purpose of each component●   

Identify which Campaign Director software application is used in each of the Campaign Life
Cycle phases

●   
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Architecture
March 2002

Module contents

Topic

Network architecture

Tier architecture

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Architecture Overview Procedure

Avaya PDS Overview   

Avaya PDS System Components   

Multiple-dialer operations   
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Software
March 2002

There are three main applications in the Avaya™ Predictive Dialing System (PDS) Campaign Director
application suite:

Application Task Campaign Life Cycle

Campaign Editor Defines calling campaigns; who, how
and when will you call clients

Implementation

Campaign Monitor Monitors and manages active jobs,
agents, and Avaya PDS dialers

Operation

Campaign Analyst Reports recent and historical data about
the effectiveness of your calling
campaigns

Evaluation

In addition, there are several helper applications, called tools, that can be accessed from any of the main
Campaign Director applications:

Application Task Campaign Life Cycle

Hierarchy Manager Manages Hierarchies Preparation and
Sustaining

Completion Code Manager Edits Completion Code Parameters Implementation and
Sustaining

Agent Blending Configure Blend options Implementation and
Sustaining

System Telnet Access the dialer system menus Preparation, Evaluation
and Sustaining

PC Analysis Telnet Access the PC Analysis application Evaluation

 Additional resources

You can find additional information about the software, and related discussions, at the following links.

Software Overview Procedure

Campaign Editor  

Software
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Campaign Monitor  

Campaign Analyst  

Hierarchy Manager  

Completion Code Manager  

Blend Manager  

System Telnet  

PC Analysis  
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Terminology review
March 2002

In the Foundation Concepts class, you were introduced to the basic building blocks you need to learn the
skills you will use as a system supervisor. Review the following important terminology and ask your
instructor to clarify and terms that are unclear to you.

Glossary of new terms for the Avaya PDS version 12
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Architecture quiz
March 2002

Which tier do jobs run on?  Which tier is responsible for communicating to other
dialers in a pod?

 server tier

 Phone Strategies

  Jobs

  Record Selections

  server tier

 mid tier

 client tier

 all of the above

  
Which tier handles interactions with Agents?  Inbound calls are handled by

 all tiers

 server tier

mid tier

 client tier

  server tier

 client tier

 mid tier

PBX / ACD
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Avaya PDS overview

Overview

The Avaya PDS works with your call center's equipment and operations to perform call
center tasks. The following list describes the main functions of the Avaya PDS:  

Receives customer records from the call center's host computer●   

Selects and sorts customer records based on your call center's business goals●   

Allows agents to update customer information on an agent screen or on the host,
depending on your configuration

●   

Passes only specific call types to agents●   

Adjusts the calling pace to meet the call center's requirements●   

Monitors ACD inbound traffic and predicts when to acquire and release ACD agents
for outbound calling (Avaya PDS with Agent Blending)

●   

Supports outbound, inbound, and blend jobs●   

Generates a variety of reports, including job, agent, and system reports for three time
variables

●   

Uploads record information to the host (optional)●   
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System components

Overview

Depending on the configuration and Avaya PDS purchased, the hardware features may be different. The purpose of this section is to provide a
general understanding of the names and functions of the various Avaya PDS components.  

Hardware components

The basic Avaya PDS includes the following hardware components:  

System cabinet●   

Digital switch●   

Digital switch subrack●   

Digital switch buses●   

ENBC I/O Transition Module●   

Avaya PDS CPU●   

Maintenance modem●   

Administrator console●   

Agent workstation (customer provided)●   

Supervisor workstation (customer provided)●   

Printers●   

System cabinet

The system cabinet contains the Avaya PDS software and hardware that allows the system to call customers and connect agents to those customers.
The system cabinet components also store system, job, and agent statistics.  

Components inside the system cabinet include:  

Digital switch to provide telephone switching services●   

Avaya PDS CPU to run the system software●   

DDS drive for backing up and restoring the Avaya PDS database and files●   

Modem and access server for remote technical support of the system (systems installed in the United States and Canada include a maintenance
modem and modem cable. All other installations outside the United States and Canada include only a modem cable. You, your VAR, or your

●   

System components 
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partner provides the modem.)

Uninterruptible Power Supply (UPS) to control power to the cabinet components●   

Components that connect to the system cabinet include:  

Administrator console for access to the Avaya PDS CPU●   

Public Switched Telephone Network (PSTN) for placing and receiving calls●   

Local Area Network (LAN) for connecting to agent and supervisor workstations●   

Agent and supervisor headsets or telephones●   

Cabinet specifications for Avaya PDSs may be different.  

The following illustration shows a typical system cabinet layout in the Avaya PDS environment.

System components 
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Digital switch

The digital switch places calls, performs call progress analysis, answers calls, connects calls to agents or hold queues, plays messages, and
communicates with the system controller (Avaya PDS CPU). The digital switch is comprised of two subsystems: the digital switch subrack and the
ENBC/IO Transition Module. The digital switch uses an Ethernet connection to communicate with the system controller.  

Digital switch subrack

The digital switch subrack, also called the digital switch card file, contains cards that provide the following functions:  

Provides a central processor for the digital switch●   

System components 
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Monitors alarm conditions and provides controls for resetting the digital switch●   

Provides interfaces for voice cables and various types of telephone trunks●   

Places, receives, and processes telephone calls●   

Plays digitized voice messages●   

Switches calls to workstation headsets●   

All systems have one ENBC and one EDTG card. The number of LPVC2s depends on your system. The other cards vary from site to site, depending
on the number and type of trunks connected to the system.  

The following table provides an overview of the functions of the most common cards.

Card type General function Description

ENBC  

(Enhanced Network Bus Controller)  
Control circuit card  

This card controls the operation of the digital switch under the direction of the
Avaya PDS CPU.  

EDTG  

(Enhanced Digital Tone Generator)  
Service circuit card  

Generates DTMF (Dual Tone Multi-frequency) or MF (Multi-frequency) tones for
placing calls and testing audio paths.  

LPVC2  

Large Port Voice Card  
Service circuit card  Plays and records digitized voice messages and ziptones.  

DDC  

Digital Dialer Card  
Service circuit card  Generates additional DTMF tone channels and provides additional ports/capacity.  

ECPA  

Enhanced Call Progress Analyzer  
Service circuit card  

Detects and analyzes call progress tones, voices, and automated voice and message
systems.  

EDRC  

Enhanced DTMF Receiver Card  
Service circuit card  Detects and reports DTMF digits on inbound calls which provide ANI/DNIS.  

ECC  

Enhanced Conference Card  
Service circuit card  Provides transfer and conference capabilities.  

UTC-2  

Universal Trunk Card  
Port interface card  Provides an interface to analog ground start or analog loop start telephone trunks.  

QT1  

Quad T1 card  
Port interface card  Provides interfaces to four digital T1 telephone trunks (non-ISDN).  

System components 
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QE1  

Quad E1 card  
Port interface card  Provides interfaces to four digital E1 telephone trunks (non-ISDN).  

T1-PRI/N  

T1 Primary Rate Interface card  
Port interface card  

Provides interfaces to one T1-based Primary Rate Interface (ISDN) telephone
trunk.  

E1-PRI  

E1 Primary Rate Interface card  
Port interface card  

Provides interfaces to one E1-based Primary Rate Interface (ISDN) telephone
trunk.  

QT1-PRI  

Quad T1 Primary Rate Interface card  
Port interface card  

Provides interfaces to four T1-based Primary Rate Interface (ISDN) telephone
trunks.  

QE1-PRI  

Quad E1 Primary Rate Interface card  
Port interface card  

Provides interfaces to four E1-based Primary Rate Interface (ISDN) telephone
trunks.  

OLIC2  

Operator Line Interface Card  
Port interface card  Provides an interface to analog voice cables for 24 direct-connect headsets.  

 

Digital switch buses

The digital switch buses are integrated in the digital switch subrack and controller. The buses control signals and other information within the digital
switch.

Digital switch bus name Description

Ethernet  Carries communication network traffic between the Avaya PDS CPU and the digital switch.  

SCSI  
Connects the ENB I/O Transition Module to the digital switch subrack. When the call center starts a calling job, the
ENBC uses the SCSI bus to download digitized voice messages to the LPVC.  

Communication  

Carries control signals and data between the ENBC and the cards in the digital switch subrack.  

When the digital switch is reset, the ENBC uses the communication bus to download application software to cards in
the digital switch subrack.  

PCM  
Carries telephone audio information within the digital switch. The digital switch uses the PCM bus to link the ports on
the port interface cards and service circuit cards in the digital switch subrack.  

 

System components 
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ENBC I/O Transition Module

The ENBC (Enhance Network Bus Controller) I/O Transition Module provides the following connections to the digital switch:  

Ethernet●   

serial RS-232 communication●   

SCSI●   

external clock for testing●   

The ENBC I/O Transition Module has the following components:  

hard disk drive●   

diskette drive●   

serial RS-232 ports●   

Ethernet connections●   

SCSI connection●   

ENBC connection●   

The hard drive contains the operating system, application software, and configuration information used by the digital switch.  

Avaya PDS CPU

The Avaya PDS CPU is a Hewlett-Packard computer running the HP-UX operating system. It controls all Avaya PDS operations and provides the
interface that supervisors and agents use on their workstations. It contains the Avaya PDS software that calls customers, connects agents and
customers, and stores system, job, and agent statistics.  

The Avaya PDS CPU contains a DDS tape drive that provides data storage and is used for backing up system software.  

AC power

A UPS controls power to the assemblies in the system cabinet.  

Fan

The system cabinet has one fan assembly -- the digital switch subrack fan.  

Maintenance modem

The Avaya PDS uses a high-speed modem to enable remote access to the system for diagnostic and maintenance purposes. The modem connects an
analog telephone line to the access server to provide access to the major subsystems.  

Systems installed in the United States and Canada include a maintenance modem and modem cable.  

All other installations outside the United States and Canada include only a modem cable. You, your VAR, or your partner provides the modem.  

System components 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/01_AvayaPDSOV_BA4.html (6 of 8) [4/5/2002 3:24:26 PM]



Administrator console

The administrator console provides access to the Avaya PDS CPU and digital switch. It connects directly to the access server inside the system
cabinet. This console consists of a monitor and keyboard. The system administrator uses it to perform basic system operations, such as backing up
system files, shutting down the system, and setting the system's time and date. Do not use the administrator console to run jobs, select records, or
similar tasks.  

Systems installed in the United States and United Kingdom include the administrator console. For installations outside the United States and United
Kingdom, you, your VAR, or your partner provides the console or purchases one through Avaya.  

Agent workstation (customer provided)

Each agent workstation consists of a computer and voice connection. During calling jobs, agents use the workstation to talk to customers and update
customer records.  

An agent workstation can be a personal computer (PC) or a dumb terminal. See the Avaya PDS Installation Planner for specific requirements.  

Personal computers

PCs can be network-connected or serial-connected (direct-connected). The Avaya PDS provides the best service using network connected PCs.
Network connected PCs use a Windows or Windows NT operating system. The Avaya PDS supports connections to either an Ethernet or Token
Ring type of network. The Avaya PDS uses TCP/IP to move data between itself and the agent workstations. These systems can use graphical user
interfaces designed by an application developer using the Avaya PDS Agent API.  

Serial-connected computers require a terminal emulation package and terminal servers for connection to the Avaya PDS CPU.  

Dumb terminals

Dumb terminals are usually serial-connected to the Avaya PDS through terminal servers. Dumb terminals use the character-based menu system.  

Supervisor workstation (customer provided)

Supervisor workstations are usually network-attached PCs. They may also be serial-attached dumb terminals or serial-attached PCs. Supervisor
workstations require a headset or telephone. System supervisors use these workstations to set up and manage system settings, set up jobs, and
monitor calling activity. See the Avaya PDS Installation Planner for specific requirements.  

Comparison

The supervisor workstation is identical to the agent workstation except it is usually a PC running Campaign Director. If it is a dumb terminal, the
workstation uses a character-based menu system.  

Printers

The printer is used to print status messages, error messages, diagnostic information, and reports on call center operations. You are responsible for the
purchase, installation, and maintenance of the printer.  

System components 
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The printer is connected to your call center's LAN, which makes it available to other application software. The printer connects to the Avaya PDS
CPU by an Ethernet LAN connection.  
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) has the capability to be configured into a
pod. A pod is a group of up to four dialers connected by a middle-tier structure.  

Contents

This section contains the following topics:  

Shared features●   

Primary and secondary dialers●   

Pod impacts●   
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Software quiz
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Which application is not part of Campaign
Director?

 Completion Code Manager

 PC Analysis

 Campaign Monitor

 Campaign Analyst

 Campaign Editor

  is used to copy completion codes

 is used to set completion code parameters

 is used to add or delete completion codes

 all of the above

   
PC Analysis can  Which of these runs only on the PC

 do anything Campaign Analyst can

 base reports on all dialers

 produce system reports

 only report about one dialer at a time

  Job Monitor

 PC Analysis

 SNMP Client

 System Telnet

   Copyright© 2002 Avaya Inc.
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Campaign Editor

Overview

Campaign Editor is used for a variety of tasks. Following is a sample list of tasks performed
using Campaign Editor:  

Create and modify a phone strategy, record selection, or job●   

Open a phone strategy, record selection, or job on local dialer or another dialer (if
multi-dialer option is enabled)

●   

Save a phone strategy, record selection, or job to another dialer●   

Display a record selection report●   

Campaign Editor application

Campaign Editor allows you to see large amounts of information in a single window.  

When the Jobs button is selected, (left-hand side of your screen), you see a list of
existing jobs. If you select one of the jobs in the list, you see a tree structure on the
right-hand side of the window. The tree structure displays all of your settings for that
particular job. To modify the job settings, double-click the fields in the tree structure.

●   

When the Strategies button is selected, you see a list of existing phone strategies. If
you select a phone strategy in the list, you see a wizard on the right-hand side of the
window. The wizard screens contain all of your settings for the selected phone
strategy. To modify phone strategy settings, use the Next and Back buttons located at
the bottom of each wizard screen to navigate. On the wizard screens, append rows and
double-click fields to modify phone strategy settings.

●   

When the Selections button is selected, you see a list of existing record selections. If
you select a record selection, you see a wizard on the right-hand side of the widow.
The wizard screens contain all of your settings for the selected record selection. To
modify record selection settings, use the Next and Back buttons located at the bottom
of each wizard screen to navigate. On the wizard screens, append rows and
double-click fields to modify record selection settings.

●   
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Campaign Monitor

Overview

Campaign Monitor is used for a variety of tasks. In this version, the previous Campaign
Manager functions are incorporated into Campaign Monitor.  

Following is a sample list of tasks performed using Campaign Monitor:  

Monitor agents on one or multiple dialers (if multi-dialer option is enabled)●   

Customize your view settings●   

View detailed agent, supervisor, job, or dialer information and save customized views
to use at a later time

●   

Sort data based on information that is relevant to your call center●   

User Interface

See the "Campaign Monitor personalization and navigation" section for information on
Campaign Monitor.  
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Campaign Analyst

Overview

Campaign Analyst is a reporting tool for the Avaya PDS. Campaign Analyst can filter data
according to agent, supervisor, job, or dialer, depending on your call center goals.  

See "Campaign Analyst" for more information.  
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) uses Completion Code Manager to
categorize completion codes as Right Party Contacts (RPCs), Abandons, and Closures.  

Contents

This section contains the following topics:  

Completion code categories●   

Start Completion Code Manager●   

Set a completion code as RPC●   

Set a completion code as a Closure●   

Set a completion code as an Abandon●   

Remove a completion code●   

Change a completion code description●   

View Completion Code Manager for another dialer●   
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Overview

Purpose

The Agent Blending tool allows you to manage domains (ACD call queues) and domain
groups (every domain is a member of a domain group). Start the Agent Blending tool from
the Campaign Monitor or Campaign Editor Tools menu.  

Contents

This section contains the following topics:  

Agent Blending●   

Supported ACDs●   

Switch terminology●   

Domains●   

Domain Groups●   

Start the Agent Blending tool●   

Create a domain group●   

Create a domain●   

Edit domain group settings●   

Edit domain settings●   

Delete a domain group●   

Delete a domain●   

Move a domain to a different group●   

Stop the blend engine●   

Start the blend engine●   

Reset the blend engine●   

Resynch the blend engine●   

View ACD statistics●   

View alerts●   

View transactions●   

Overview 
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Overview

Purpose

The System Telnet tool provides access to the AvayaTM Predictive Dialing System (PDS)
character-based user interface.  

Contents

This section contains the following topics:  

System Telnet●   

Toolbar icons●   

Start System Telnet●   
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PC Analysis

Overview

PC Analysis allows you to use data from the Avaya PDS to prepare reports, charts, mail
merge letters, and spreadsheets using PC software.  

Using PC Analysis, you can extract five statistics files:  

job history●   

agent history●   

calling information●   

calling transactions●   

calling lists●   

The extract is in a comma delimited file without headings. In order to use the information,
you need to import it into a PC program such as Excel, Lotus, a word processing merge file,
or database. You can then create the reports, charts, letters and spreadsheets from the PC
program.  

When you run PC Analysis, you may see a significant reduction in system performance. For
this reason, we suggest that you run the extract when there are no active jobs. Understanding
the information in the Avaya PDS files helps you create extracts that contain the data you
need.  
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Which portion of the Campaign Life Cycle is
Campaign Editor used for most?

 Which of these is not installed with Campaign
Director?

 Implementation

 Operations

  Preparation

  Evaluation

  Campaign Analyst

 PC Analysis

 Hierarchy Manager

 PC Analysis Telnet

  
Whcih application is used to send messages to
agents?

 How much disk space does PC Analysis require to
install on the Campaign Director workstation?

 Campaign Editor

 Agent Blending

 PC Analysis

 Campaign Monitor

  250 MB

 100 MB

 153.5 MB

 0 MB

  Copyright© 2002 Avaya Inc.
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Module contents

Topic

GUI vs. CUI

System menus

Related tasks

Avaya PDS Agent

Objectives
At the end of this module you will be able to:

Access the System Telnet tool through Campaign Director software●   

Create, edit, and delete users via the Supervisor menu system●   

Understand the various options available in the Calling List and Users menu●   

   Copyright© 2002 Avaya Inc.
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) consists of software, hardware, and
networked components. The system is comprised of the system cabinet, supervisor
workstation, agent workstations, printer, and modem. As a system supervisor, you use the
supervisor workstation and the Campaign Director applications to set up, monitor, modify,
and report on your calling activities.  

This guide focuses on how you can use the Campaign Director applications (Campaign
Monitor, Campaign Editor, and Campaign Analyst) to make your call center more effective.
 

Contents

This section contains the following topics:  

Avaya PDS overview●   

System components●   

Campaign Director●   

Campaign Editor●   

Campaign Monitor●   

Campaign Analyst●   
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This material is protected by the copyright laws of the United States and other countries. It may not be
reproduced, distributed, or altered in any fashion by any entity (either internal or external to Avaya Inc.),

Notice

Every effort was made to ensure that the information in this book was complete and accurate at the time of
printing. However, information is subject to change.

Mandatory Customer Information

Preventing Toll Fraud

Toll Fraud is the unauthorized use of your telecommunications system by an unauthorized party (for
example, a person who is not a corporate employee, agent, subcontractor, or working on your company’s
behalf). Be aware that there is a risk of toll fraud associated with your system and that, if toll fraud occurs,
it can result in substantial additional charges for your telecommunications services.

Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call
the Technical Service Center’s Toll Fraud Intervention Hotline at 1-800-643-2353.

Providing Telecommunications Security

Telecommunications security of voice, data, and/or video communications is the prevention of any type of
intrusion to, that is, either unauthorized or malicious access to or use of, your company’s
telecommunications equipment by some party.

Your company’s “telecommunications equipment” includes both this Avaya product and any other voice/
data/video equipment that could be accessed via this Avaya product (that is, “networked equipment”).

An “outside party” is anyone who is not a corporate employee, agent, subcontractor, or working on your
company’s behalf. Whereas, a “malicious party” is Anyone, including someone who may be otherwise
authorized, who accesses your telecommunications equipment with either malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time multiplexed and/or circuit-based) or
asynchronous (character-, message-, or packet-based) equipment or interfaces for reasons of:

• Utilization (of capabilities special to the accessed equipment)
• Theft (such as, of intellectual property, financial assets, or toll-facility access)
• Eavesdropping (privacy invasions to humans)
• Mischief (troubling, but apparently innocuous, tampering)
• Harm (such as harmful tampering, data loss or alteration, regardless of motive or intent)
Be aware that there may be a risk of unauthorized or malicious intrusions associated with your system and/
or its networked equipment. Also realize that, if such an intrusion should occur, it could result in a variety
of losses to your company, including but not limited to, human/data privacy, intellectual property, material
assets, financial resources, labor costs, and/or legal costs.

Your Responsibility for Your Company’s Telecommunications Security
The final responsibility for securing both this system and its networked equipment rests with you - an Avaya
customer’s system administrator, your telecommunications peers, and your managers. Base the fulfillment
of your responsibility on acquired knowledge and resources from a variety of sources including but not
limited to:

• Installation documents
• System administration documents
• Security documents
• Hardware-/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your peers should carefully program
and configure your:

• Avaya provided telecommunications system and their interfaces
• Avaya provided software applications, as well as their underlying hardware/software platforms and
interfaces
• Any other equipment networked to your Avaya products
Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in
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accordance with the instructions, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be required
to correct the interference at his own expense.

Part 68: Network Registration Number. This equipment is registered with the FCC in accordance with
Part 68 of the FCC Rules. It is identified by FCC registration number AV1USA-28011-MA-T. Refer to
“Federal Communications Commission Statement” in “About This Book” for more information regarding
Part 68.

Canadian Department of Communications (DOC) Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the radio
interference regulations of the Canadian Department of Communications.

Le Présent Appareil Nomérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux
appareils numériques de la class A préscrites dans le reglement sur le brouillage radioélectrique édicté par
le ministére des Communications du Canada.

Trademarks

DEFINITY and Mosaix are registered trademarks of Avaya Inc.

Other products and brand names are trademarks or registered trademarks of their respective holders.

Ordering Information

Call: Avaya Publications Center

Voice 1-800-457-1235 International Voice 410-568-3680

Fax 1-800-457-1764 International Fax 410-891-0207

Write: GlobalWare Solutions

200 Ward Hill Avenue

Haverhill, MA 01835

Order: Document No. 90486-01A VOL1

You can be placed on a standing order list for this and other documents you may need. Standing order will
enable you to automatically receive updated versions of individual documents or document sets, billed to
account information that you provide. For more information on standing orders, or to be put on a list to
receive future issues of this document, contact the Avaya Publications Center.

For information about Avaya products and services, go to www.avaya.com. For product documentation for
all Avaya products and related documentation, go to www.avayadocs.com .

European Union Declaration of Conformity

The “CE” mark affixed to the DEFINITY ONE equipment described in this book indicates that the
equipment conforms to the following European Union (EU) Directives:

• Electromagnetic Compatibility (89/336/EEC)

• Telecommunications Terminal Equipment (TTE) i-CTR3 BRI and i-CTR4 PRI

For more information on standards compliance, contact your local distributor.
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About this information product

Purpose The purpose of this manual is to provide detailed information about the
operation of the AvayaTM Predictive Dialing System (PDS).

Reason for reissue The following list describes changes to the Avaya PDS User’s Guide
since the last release.

• This guide has been formatted for easier use.

• This guide has been branded to match our product name changes.

• This guide contains two volumes - one for the graphical,
Campaign Director interface, and the other for the Character-
Based User Interface, which uses menus to navigate through the
system (these two interfaces cannot be used simultaneously).

• This guide is arranged by task rather than by application. This
allows the information to flow according to user task rather than
individual tasks performed within certain applications.

Intended-Audience The audience for this manual includes any user of the Avaya PDS. This
includes, but is not limited to, system supervisors, integration
consultants, application consultants, and customer support engineers.
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1 Avaya Predictive Dialing
System

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) consists of software,
hardware, and networked components. The system is comprised of the
system cabinet, supervisor workstation, agent workstations, printer, and
modem. As a system supervisor, you use the supervisor workstation
and the Campaign Director applications to set up, monitor, modify, and
report on your calling activities.

This guide focuses on how you can use the Campaign Director
applications (Campaign Monitor, Campaign Editor, and Campaign
Analyst) to make your call center more effective.

Contents This section contains the following topics:

• Avaya PDS overview

• System components

• Campaign Director

• Campaign Editor

• Campaign Monitor

• Campaign Analyst
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.............................................................................................................................................................................................................................................................
Avaya PDS overview

Overview The Avaya PDS works with your call center’s equipment and
operations to perform call center tasks. The following list describes the
main functions of the Avaya PDS:

• Receives customer records from the call center’s host computer

• Selects and sorts customer records based on your call center’s
business goals

• Allows agents to update customer information on an agent screen
or on the host, depending on your configuration

• Passes only specific call types to agents

• Adjusts the calling pace to meet the call center’s requirements

• Monitors ACD inbound traffic and predicts when to acquire and
release ACD agents for outbound calling (Avaya PDS with Agent
Blending)

• Supports outbound, inbound, and blend jobs

• Generates a variety of reports, including job, agent, and system
reports for three time variables

• Uploads record information to the host (optional)
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.............................................................................................................................................................................................................................................................
System components

Overview Depending on the configuration and Avaya PDS purchased, the
hardware features may be different. The purpose of this section is to
provide a general understanding of the names and functions of the
various Avaya PDS components.

Hardware components The basic Avaya PDS includes the following hardware components:

• System cabinet

• Digital switch

• Digital switch subrack

• Digital switch buses

• ENBC I/O Transition Module

• Avaya PDS CPU

• Maintenance modem

• Administrator console

• Agent workstation (customer provided)

• Supervisor workstation (customer provided)

• Printers

System cabinet The system cabinet contains the Avaya PDS software and hardware that
allows the system to call customers and connect agents to those
customers. The system cabinet components also store system, job, and
agent statistics.

Components inside the system cabinet include:

• Digital switch to provide telephone switching services

• Avaya PDS CPU to run the system software

• DDS drive for backing up and restoring the Avaya PDS database
and files

• Modem and access server for remote technical support of the
system (systems installed in the United States and Canada include
a maintenance modem and modem cable. All other installations
outside the United States and Canada include only a modem cable.
You, your VAR, or your partner provides the modem.)

• Uninterruptible Power Supply (UPS) to control power to the
cabinet components
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Components that connect to the system cabinet include:

• Administrator console for access to the Avaya PDS CPU

• Public Switched Telephone Network (PSTN) for placing and
receiving calls

• Local Area Network (LAN) for connecting to agent and
supervisor workstations

• Agent and supervisor headsets or telephones

Cabinet specifications for Avaya PDSs may be different.

The following illustration shows a typical system cabinet layout in the
Avaya PDS environment.

Digital switch The digital switch places calls, performs call progress analysis, answers
calls, connects calls to agents or hold queues, plays messages, and
communicates with the system controller (Avaya PDS CPU). The
digital switch is comprised of two subsystems: the digital switch
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subrack and the ENBC/IO Transition Module. The digital switch uses
an Ethernet connection to communicate with the system controller.

Digital switch subrack The digital switch subrack, also called the digital switch card file,
contains cards that provide the following functions:

• Provides a central processor for the digital switch

• Monitors alarm conditions and provides controls for resetting the
digital switch

• Provides interfaces for voice cables and various types of telephone
trunks

• Places, receives, and processes telephone calls

• Plays digitized voice messages

• Switches calls to workstation headsets

All systems have one ENBC and one EDTG card. The number of
LPVC2s depends on your system. The other cards vary from site to
site, depending on the number and type of trunks connected to the
system.

The following table provides an overview of the functions of the most
common cards.

Card type General function Description

ENBC

(Enhanced Network
Bus Controller)

Control circuit card This card controls the
operation of the digital
switch under the
direction of the Avaya
PDS CPU.

EDTG

(Enhanced Digital
Tone Generator)

Service circuit card Generates DTMF
(Dual Tone Multi-
frequency) or MF
(Multi-frequency)
tones for placing calls
and testing audio
paths.

LPVC2

Large Port Voice Card

Service circuit card Plays and records
digitized voice
messages and ziptones.
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DDC

Digital Dialer Card

Service circuit card Generates additional
DTMF tone channels
and provides additional
ports/capacity.

ECPA

Enhanced Call
Progress Analyzer

Service circuit card Detects and analyzes
call progress tones,
voices, and automated
voice and message
systems.

EDRC

Enhanced DTMF
Receiver Card

Service circuit card Detects and reports
DTMF digits on
inbound calls which
provide ANI/DNIS.

ECC

Enhanced Conference
Card

Service circuit card Provides transfer and
conference
capabilities.

UTC-2

Universal Trunk Card

Port interface card Provides an interface
to analog ground start
or analog loop start
telephone trunks.

QT1

Quad T1 card

Port interface card Provides interfaces to
four digital T1
telephone trunks (non-
ISDN).

QE1

Quad E1 card

Port interface card Provides interfaces to
four digital E1
telephone trunks (non-
ISDN).

T1-PRI/N

T1 Primary Rate
Interface card

Port interface card Provides interfaces to
one T1-based Primary
Rate Interface (ISDN)
telephone trunk.

E1-PRI

E1 Primary Rate
Interface card

Port interface card Provides interfaces to
one E1-based Primary
Rate Interface (ISDN)
telephone trunk.

Card type General function Description
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Digital switch buses The digital switch buses are integrated in the digital switch subrack and
controller. The buses control signals and other information within the
digital switch.

QT1-PRI

Quad T1 Primary Rate
Interface card

Port interface card Provides interfaces to
four T1-based Primary
Rate Interface (ISDN)
telephone trunks.

QE1-PRI

Quad E1 Primary Rate
Interface card

Port interface card Provides interfaces to
four E1-based Primary
Rate Interface (ISDN)
telephone trunks.

OLIC2

Operator Line
Interface Card

Port interface card Provides an interface
to analog voice cables
for 24 direct-connect
headsets.

Card type General function Description

Digital switch
bus name

Description

Ethernet Carries communication network traffic between
the Avaya PDS CPU and the digital switch.

SCSI Connects the ENB I/O Transition Module to the
digital switch subrack. When the call center starts
a calling job, the ENBC uses the SCSI bus to
download digitized voice messages to the LPVC.

Communication Carries control signals and data between the
ENBC and the cards in the digital switch subrack.

When the digital switch is reset, the ENBC uses
the communication bus to download application
software to cards in the digital switch subrack.

PCM Carries telephone audio information within the
digital switch. The digital switch uses the PCM
bus to link the ports on the port interface cards
and service circuit cards in the digital switch
subrack.
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ENBC I/O Transition
Module

The ENBC (Enhance Network Bus Controller) I/O Transition Module
provides the following connections to the digital switch:

• Ethernet

• serial RS-232 communication

• SCSI

• external clock for testing

The ENBC I/O Transition Module has the following components:

• hard disk drive

• diskette drive

• serial RS-232 ports

• Ethernet connections

• SCSI connection

• ENBC connection

The hard drive contains the operating system, application software, and
configuration information used by the digital switch.

Avaya PDS CPU The Avaya PDS CPU is a Hewlett-Packard computer running the HP-
UX operating system. It controls all Avaya PDS operations and
provides the interface that supervisors and agents use on their
workstations. It contains the Avaya PDS software that calls customers,
connects agents and customers, and stores system, job, and agent
statistics.

The Avaya PDS CPU contains a DDS tape drive that provides data
storage and is used for backing up system software.

AC power

A UPS controls power to the assemblies in the system cabinet.

Fan

The system cabinet has one fan assembly -- the digital switch subrack
fan.

Maintenance modem The Avaya PDS uses a high-speed modem to enable remote access to
the system for diagnostic and maintenance purposes. The modem
connects an analog telephone line to the access server to provide access
to the major subsystems.

Systems installed in the United States and Canada include a
maintenance modem and modem cable.
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All other installations outside the United States and Canada include
only a modem cable. You, your VAR, or your partner provides the
modem.

Administrator console The administrator console provides access to the Avaya PDS CPU and
digital switch. It connects directly to the access server inside the system
cabinet. This console consists of a monitor and keyboard. The system
administrator uses it to perform basic system operations, such as
backing up system files, shutting down the system, and setting the
system’s time and date. Do not use the administrator console to run
jobs, select records, or similar tasks.

Systems installed in the United States and United Kingdom include the
administrator console. For installations outside the United States and
United Kingdom, you, your VAR, or your partner provides the console
or purchases one through Avaya.

Agent workstation
(customer provided)

Each agent workstation consists of a computer and voice connection.
During calling jobs, agents use the workstation to talk to customers and
update customer records.

An agent workstation can be a personal computer (PC) or a dumb
terminal. See the Avaya PDS Installation Planner for specific
requirements.

Personal computers

PCs can be network-connected or serial-connected (direct-connected).
The Avaya PDS provides the best service using network connected
PCs. Network connected PCs use a Windows or Windows NT
operating system. The Avaya PDS supports connections to either an
Ethernet or Token Ring type of network. The Avaya PDS uses TCP/IP
to move data between itself and the agent workstations. These systems
can use graphical user interfaces designed by an application developer
using the Avaya PDS Agent API.

Serial-connected computers require a terminal emulation package and
terminal servers for connection to the Avaya PDS CPU.

Dumb terminals

Dumb terminals are usually serial-connected to the Avaya PDS through
terminal servers. Dumb terminals use the character-based menu
system.
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Supervisor workstation
(customer provided)

Supervisor workstations are usually network-attached PCs. They may
also be serial-attached dumb terminals or serial-attached PCs.
Supervisor workstations require a headset or telephone. System
supervisors use these workstations to set up and manage system
settings, set up jobs, and monitor calling activity. See the Avaya PDS
Installation Planner for specific requirements.

Comparison

The supervisor workstation is identical to the agent workstation except
it is usually a PC running Campaign Director. If it is a dumb terminal,
the workstation uses a character-based menu system.

Printers The printer is used to print status messages, error messages, diagnostic
information, and reports on call center operations. You are responsible
for the purchase, installation, and maintenance of the printer.

The printer is connected to your call center’s LAN, which makes it
available to other application software. The printer connects to the
Avaya PDS CPU by an Ethernet LAN connection.
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Campaign Director

Overview Campaign Director is a suite of call management applications that
serve as the interface between a call center supervisor and the Avaya
PDS. Campaign Director applications allow you to easily and
dynamically design, control, monitor, and analyze call center activity.
The Avaya PDS increases your call center’s productivity and helps you
achieve your campaign goals.

The Avaya PDS consists of software and networked components,
including the Avaya PDS cabinet, supervisor workstations, agent
workstations, printers, and modems.

The Campaign Director software provides a graphical user interface to
the Avaya PDS which runs on your supervisor workstation.

New features of Campaign
Director

The newest release of Campaign Director encompasses all existing
functionality of earlier versions. The following list describes the new
features of Campaign Director.

Integration of monitoring and control functions The functionality
of Campaign Monitor and Campaign Manager are combined into
Campaign Monitor to provide a single interface to all job and agent
monitor and control functions.

Enterprise-wide monitoring Campaign Monitor allows you to view
multiple dialers across the enterprise. Campaign Monitor provides the
ability to focus on a single agent on a single dialer as well as provide an
enterprise-view of a call center.

Customizable views In order to satisfy the needs of a wider, more
diverse audience, Campaign Monitor provides tools for customizing
views of enterprise data and saving view configurations.

Improved speed and performance Files are retrieved from and
stored directly to the PDS by means of the Command and Control
interface, therefore, eliminating the need to synchronize with each
Avaya PDS.

Improved User Interface (UI) The current tabular layout of
Campaign Editor is replaced with a single form to maintain the same
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look and feel as Campaign Monitor. This new design is similar to
MicrosoftTM Outlook.

Improved usability The job and record selection editor screens
display additional information which lets you view the current status of
the jobs or record selections on a specified system.

Ease of use Campaign Editor automaticallys execute the record
selection (if needed) and then verifies the job. If the job verification
passes, you will be offered a choice of starting the job or cancelling the
operation. You still have the capability to run record selections as a
separate action.

Global Campaign Director
features

With Campaign Director’s new user interface, there are several features
that have been added in order to increase the ability to customize
settings. The table below identifies some of the new features that are
used throughout the Campaign Director applications and tools.

New feature Description

Button bar Allows you to use shortcuts and navigate
more easily.

Sort columns Allows you to sort data in ascending and
descending order by clicking a column’s
heading.

Resize columns Allows you to make a column wider or
narrower by clicking the area between
column headings and then dragging to the
left or right.

Refresh Allows you to refresh the data in the
active window.

Launch tools Allows you to launch various tools:
Hierarchy Manager, Completion Code
Manager, Agent Blending, PC Analysis
telnet, and System telnet.
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Campaign Editor

Overview Campaign Editor is used for a variety of tasks. Following is a sample
list of tasks performed using Campaign Editor:

• Create and modify a phone strategy, record selection, or job

• Open a phone strategy, record selection, or job on local dialer or
another dialer (if multi-dialer option is enabled)

• Save a phone strategy, record selection, or job to another dialer

• Display a record selection report

Campaign Editor
application

Campaign Editor allows you to see large amounts of information in a
single window.

• When the Jobs button is selected, (left-hand side of your screen),
you see a list of existing jobs. If you select one of the jobs in the
list, you see a tree structure on the right-hand side of the window.
The tree structure displays all of your settings for that particular
job. To modify the job settings, double-click the fields in the tree
structure.

• When the Strategies button is selected, you see a list of existing
phone strategies. If you select a phone strategy in the list, you see
a wizard on the right-hand side of the window. The wizard screens
contain all of your settings for the selected phone strategy. To
modify phone strategy settings, use the Next and Back buttons
located at the bottom of each wizard screen to navigate. On the
wizard screens, append rows and double-click fields to modify
phone strategy settings.

Multiple dialer controls Allows you to save and retrieve record
selections, phone strategies, and jobs from
multiple dialers if this feature is enabled.
Also allows you to run reports across
dialers.

Define main dialer Allows you to define the main dialer
within a pod (up to four dialers).

New feature Description
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• When the Selections button is selected, you see a list of existing
record selections. If you select a record selection, you see a wizard
on the right-hand side of the widow. The wizard screens contain
all of your settings for the selected record selection. To modify
record selection settings, use the Next and Back buttons located at
the bottom of each wizard screen to navigate. On the wizard
screens, append rows and double-click fields to modify record
selection settings.
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Campaign Monitor

Overview Campaign Monitor is used for a variety of tasks. In this version, the
previous Campaign Manager functions are incorporated into Campaign
Monitor.

Following is a sample list of tasks performed using Campaign Monitor:

• Monitor agents on one or multiple dialers (if multi-dialer option is
enabled)

• Customize your view settings

• View detailed agent, supervisor, job, or dialer information and
save customized views to use at a later time

• Sort data based on information that is relevant to your call center

User Interface

See the “Campaign Monitor personalization and navigation” section
for information on Campaign Monitor.
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.............................................................................................................................................................................................................................................................
Campaign Analyst

Overview Campaign Analyst is a reporting tool for the Avaya PDS. Campaign
Analyst can filter data according to agent, supervisor, job, or dialer,
depending on your call center goals.

See “Campaign Analyst” for more information.
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2 Campaign Life Cycle

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses campaigns to
target specific customers. The Campaign Life Cycle describes the day
to day tasks that you perform in a typical call center.

Following the Campaign Life Cycle description are introductions to
each application within Campaign Director. This helps you understand
how the Campaign Life Cycle activities are relative to Campaign
Editor, Campaign Monitor, and Campaign Analyst.

Contents This section contains the following topic:

• Campaign Life Cycle
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Campaign Life Cycle

Overview The term campaign is used to group together calling lists, phone
strategies, record selections, and jobs that share an objective. A
campaign can contain several jobs, each with its own phone strategy
and record selection, which target a specific group of customers.

Whether your campaigns last a day or a month, there are events that
occur during every Campaign Life Cycle.
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Campaign Life Cycle
activities

The Campaign Life Cycle diagram creates a circular view of the
activities involved during a campaign. The following table outlines
those activities.

Activity Consists of:

Preparation • verify download

• set user accounts

• system configuration and set-up

Planning Set campaign objectives

• job objectives

• record selections

• phone strategies

• other optional features

Implementation Implementation plan

• create phone strategies

• create and verify record selections

• create jobs

Operation Manage operation

• start jobs

• log in to jobs

• monitor and modify jobs

• shutdown jobs

Evaluation Evaluation and completion

• define and run reports

• analyze output

• upload results

• backup results

Sustaining • maintain user accounts

• system administration
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3 Multi-dialer

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) has the capability to be
configured into a pod. A pod is a group of up to four dialers connected
by a middle-tier structure.

Contents This section contains the following topics:

• Shared features

• Primary and secondary dialers

• Pod impacts
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Shared features

Overview A pod of Avaya PDS dialers contains up to four dialers connected
through a middle-tier server. Following is a list of features that are
shared among dialers in a pod:

• calling lists

• jobs

• phone strategies

• record selections

A single Avaya PDS can dial up to 130,000 outbound calls per hour.
With the multi-dialer feature enabled, you can manage up to four
dialers with list sharing across a distributed dialer network, enabling
increased outbound call volume of up to 500,000 calls per hour.

A multi-dialer office environment greatly increases your company's
outreach capacity. The functionality allows you to manage up to four
dialers in a distributed architecture using a single, unified
administration and supervisor interface for faster implementation of
large-scale outreach programs.

Campaign Director makes it easy for you to manage operations and
monitor traffic and workload across the multi-dialer network.

Shared calling list The Avaya PDS allows you to run a job using a calling list from a
different dialer. Any Avaya PDS in a pod can be used to dial another
dialer’s (in that same pod) calling list. This allows multiple dialers to
call on the same calling list at the same time, which provides scalability
on a single campaign above the physical agent limitation of one Avaya
PDS.

The primary advantage of a shared calling list is speed. Imagine a job
with 11,277 records finishing in 1/4 the normal time!

The shared list feature allows the agent capacity of multiple Avaya
PDSs to be used for a single job. For example, one supervisor on dialer
1 (in a pod of 4) can use a calling list that resides on dialer 3, start a job
that resides on dialer 2, and have agents from all 4 Avaya PDSs log in
to the job to complete outbound calls.

Pod monitoring The pod feature combines monitoring, control, and administration of
all four dialers in a pod from a single Campaign Director workstation.
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Multi-dialer agent login management

You can create and manage logins and passwords for multiple dialers
from a single system. For example, a login and password created on
one dialer may be populated to all dialers in a pod.

Multi-dialer monitoring

Campaign Monitor supports multiple dialers across the pod. For
example, real-time job data from multiple dialers can be aggregated
into a single view of the overall pod.

Multi-dialer control

Campaign Monitor provides control functions across all dialers in a
pod. This allows one supervisor to stop jobs, adjust Expert Calling
Ratio, assign line pools, and perform other job control functions from a
single Campaign Director workstation.

Multi-dialer administration

Campaign Director applications and tools provide administration
across all dialers in a pod. For example, you can copy, delete, and
modify phone strategies, record selections, or jobs, regardless of the
dialer they reside on. If you delete a record selection, you will first be
prompted for the dialer the record selection resides on, and then you
will be prompted for which record selection you want to delete.
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Primary and secondary dialers

Overview In a pod, there are dialers that are configured as the “primary” dialer
and the “secondary” dialer.

Primary dialer A pod’s primary dialer is an Avaya PDS dialer that runs the mid-tier
software and controls that coordinations data management are. Every
Avaya PDS pod must have a primary dialer. Secondary dialers feed
data to the primary dialer that processes the data and makes it available
for monitoring and reporting. In this way, the system supervisor can
view status or create reports that include the operation of all the dialers
in the pod.

Secondary dialer The secondary dialer is any dialer of an Avaya PDS pod that reports
data to and is coordinated with other secondary dialers by a primary
dialer. One secondary dialer can also be configured to take over
primary dialer functions in the event of a primary dialer failure.



Multi-dialer

3 - 4 3

............................................................................................................................................................................................................................................................

.............................................................................................................................................................................................................................................................
Pod impacts

Overview If you work with a pod (one to four dialers), there are special
considerations to think about as you create ways to manage, control,
and administer settings across multiple dialers.

Multi-dialer Campaign Monitor always shows data for all dialers in a pod.
However, the controls for multi-dialer are turned off by default. You
can turn on the multi-dialer control from Settings > Options. Choose
which dialers in a pod to view. See “View control functions” for more
information.

Once the multi-dialer control is turned on, each job control dialog box
(for example, Job Linking or Change Time Zones) shows a check
mark. If you want to control a single dialer, clear the check box.

Completion codes Dialer completion codes and their corresponding code number and
code description are contained in a system file called compcode.cfg.
Each dialer has one compcode.cfg file.

Completion codes are used in a variety of ways. Initially, they are used
by the agent to end a call with a customer. This tells the Avaya PDS
what the outcome of that call was. Completion codes are also used as
part of reporting. They are essential to accurate reporting and can be
used to determine the success of a campaign.

If there are four dialers in a pod, that also means there are four
compcode.cfg files. It is important to keep these four completion code
files synchronized for a variety of reasons:

• Agents use the same codes for the same call outcome

• Reporting from completion codes is accurate

• Eliminates the need for troubleshooting for reasons of inaccurate
completion codes. Keeps all dialer completion codes synchronized

• To aggregate data across dialer effectively, completion code
descriptions and completion code assignments (RPC, Abandon,
Closure) must remain consistent across all dialers in a pod

Jobs Jobs should be named carefully. Use the following guidelines when
creating or modifying jobs:

• Do not create multiple jobs on multiple dialers with the same
name if they have very different job parameters.
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• If you want control like jobs in a single step (jobs with similar or
like parameters), then name the jobs the same on different dialers.
For example, if you want to change the quota on job1 on all
dialers, you can do so in one step.

Agents In a pod environment, agent logons must be unique across dialers.
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4 Agent types

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) places calls and uses
agents to talk to customers. The agent type is a logon parameter that
determines the type of calls an agent can handle during a job.

Agents take calls placed or received by the Avaya Predictive Dialing
System. The Avaya PDS supports several agent types. The agent type is
a logon parameter that tells the Avaya PDS what types of calls a
specific agent is allowed to take.

Contents This section contains the following topics:

• Agent types

• Agent logons
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Agent types

Agent types Agents can log on to the Avaya PDS using several agent types, which
are determined by your Avaya PDS configuration. The agent type
determines the type of job agents can join and the type of calls they
handle during a job.

Outbound agents Outbound agents handle outbound calls only.
Outbound agents can join the following jobs types:

• Unit work list

• Managed Dialing

• Sales Verification

• Infinite

Managed agent Managed agents only handle outbound calls during
an outbound job set up as a Managed Dialing job.

Inbound agent Inbound agents handle only inbound calls. They can
join inbound or blend jobs. The Avaya PDS receives calls directly from
customers or through an ACD.

Blend agent Blend agents handle both outbound and inbound calls.
They join blend jobs and can handle customer records on outbound and
inbound calling screens.

Person to Person agent Person to Person agents handle outbound
calls when outbound agents are not available.

ACD agent ACD agents handle outbound calls on the Avaya PDS.
They may also handle inbound calls on the ACD or may only take
outbound calls depending on which domain group they logged into on
the ACD.
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Agent logons

Basic logon The following table describes the agent logons used, regardless of the
blending configuration on your system.

Agent Blending logon If your system is configured with Agent Blending, the following table
describes the agent logons used.

Intelligent Call Blending
logon

If your system is configured with Intelligent Call Blending, the
following table describes the agent logons used.

Agent type Logon Joins job Handles calls

Managed M outbound outbound calls on
Avaya PDS

Outbound O outbound or
blend

outbound calls on
Avaya PDS

Person to
Person

PTP outbound outbound calls on
Avaya PDS

Agent type Logon Joins job Handles calls

ACD ACD outbound outbound calls on Avaya
PDS and inbound calls on
ACD

Agent type Logon Joins job Handles calls

Inbound I inbound or
blend

inbound calls on Avaya
PDS

Blend B blend inbound and outbound
calls on Avaya PDS
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5 Calling list

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses calling lists, a
group of customer records, to place calls to customers.

Contents This section contains the following topics:

• Calling list features

• Download calling lists
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Calling list features

Overview A calling list is a file on the Avaya PDS containing customer records.
The host system creates files of customer records for the Avaya PDS.
After the customer records are downloaded from the host, the Avaya
PDS adds several fields to each record to help track calling results.
After the system adds the fields, it may check for and reject duplicate
records and uncallable phone numbers. This process depends upon
your system configuration. The Avaya PDS refers to the set of modified
records as the calling list.

During calling list preprocessing, the Avaya PDS performs the
following actions:

• Checks for and flags duplicate records and invalid telephone
numbers

• Identifies and marks records that have been on the system more
than a specified number of days

• Recalls the name of the last agent to speak to the customer

• Stores the result of the last call attempt as recorded by the agent

• Verifies the following statistics:

– The name of the last agent to speak with the customer

– The date and time of the last call attempt

– The result of the last call attempt as recorded by the agent on
the system

– The number of days the record has been on the system

– The record status
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Download calling lists

Download calling lists Before you begin calling activities, you need to provide the Avaya PDS
with a calling list. The system uses two types of calling lists, one for
outbound calling and one for inbound calling (Intelligent Call Blending
systems only).

In most call centers, the system automatically downloads data files
from the host computer for the outbound calling list. The host data files
contain the records and fields you defined as necessary to your
outbound call activity.

Schedules At scheduled times, the Avaya PDS converts the customer records in a
specific calling list to your host computer’s format and creates an
upload file. When the host receives this file, it runs a script (written by
your host application contact) that updates your customer database.

Environment The calling list environment is responsible for these activities:

• Creating the files required to convert host computer data to the
Avaya PDS calling list format

• Preparing the calling list for calling

• Preparing the calling list for extracting data to send back to the
host after calls have been made
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6 Completion codes

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses completion codes
to identify the result of a call.

Contents This section contains the following topics:

• Completion codes

• Completion code table
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Completion codes

Completion codes A completion code identifies a call result. When a customer answers a
phone call, the Avaya PDS transfers the call to an agent. At the end of
the call, the agent records the outcome by pressing an agent key or by
clicking a graphical user interface (GUI) button that is associated with
a completion code.

The Avaya PDS stores the completion codes and uses them to select
records for calling and reports. The system identifies completion codes
by a code number, call result, and description. The call result is a short
name that makes the code easier for agents to identify. The description
provides call center supervisors with a more detailed description. Each
system has one set of completion codes.

The completion code can be an agent-generated code you specified or a
standard system completion code. If the system does not pass the call to
an agent, the Avaya PDS generates the completion code. The following
list are examples of when the Avaya PDS would not pass a call to an
agent:

• A busy signal

• A SIT (Standard Information Tone), which could represent a
disconnected number or circuits that are too busy to handle the
call

• A line that is idle before dialing

• No answer

A system completion code typically identifies an unsuccessful call
attempt. For example, 03 (TIMEOUT) and 15 (NOANSWER). The
only successful call attempts the Avaya PDS identifies are Virtual
Agent 91 and 92. You can change the number of times the system
attempts to call the customer.

The following list are examples of completion codes that agents would
use after a call attempt:

• Recall (try back later when the desired party is available)

• Promise to pay

• Answering machine/left message

• Talked to customer

When the Avaya PDS processes a host download file, it leaves a null
entry in the completion code field for each record. When the system
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unsuccessfully calls a phone number, it releases the record and
completes the field with the appropriate system completion code.
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Completion code table

Completion code table The following table is a sample representation of completion codes. If
you have Avaya’s Producer software application, you can customize
the completion codes.

Code
Number

Code Name Code
Type

Code Description

00 NOTCALLED System The account has not
been called.

01 CODE1 Reserved for system.

02 ERROR System The system detected
an invalid phone
number.

03 TIMEOUT System The system did not
receive a dial tone.

04 HANG_PORT System The line was idle
after the system
called the client
record phone number.

05 NOTINZONE System The local time for the
client phone is
outside calling hours.

06 MOFLASH_B Agent Native voice and data
transfer: Agent
transfers call to
inbound agent
without remaining on
the line (blind
transfer).

07 HANG_TRANS System No agent available
for a supervisor
transfer.
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08 TDSS_HF_B Agent ADAPTS API: Agent
transfers call without
remaining on the line
(blind hookflash
transfer).

09 Reserved for system.

10 Reserved for system.

11 BUSY System The system detected
a busy signal.

12 CONTTONE System The system detected
a continuous tone,
such as a facsimile or
modem.

13 AUTOVOICE System The system detected
an answering
machine.

14 VOICE System Interim code when a
person is on the line.

15 NOANSWER System The call placed was
not answered.

16 RINGING Agent Can be user-defined
but is typically
defined as a phone
call that was still
ringing but was
passed to an agent.

17 CUSTHU Agent Can be user-defined
but is typically
defined as the client
hung up while the
call was in the wait
queue, but the call
was passed to an
agent.

Code
Number

Code Name Code
Type

Code Description
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18 TRANSFER Agent Can be user-defined
but is typically
defined as a transfer
release.

19 RECALL Agent Can be user-defined
but is typically
defined as a recall
release.

20 - 34 Agent Customer-assigned
codes used by agents.

35 CANCEL System Can be user-defined
but is typically
defined as the agent
cancelled the
managed call.

36 INTERCEPT System Special Information
Tone (SIT) indicating
an operator intercept.

37 NOCIRCUIT System Special Information
Tone (SIT) indicating
that circuits were
unavailable.

38 DISCONN System Special Information
Tone (SIT) indicating
that the call was a
disconnected number.

39 VACANT System Special Information
Tone (SIT) indicating
that the call could not
be completed as
dialed.

40 REORDER System The call resulted in a
fast busy tone.

41 R_RINGING System Reserved for system.

Code
Number

Code Name Code
Type

Code Description
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42 LINEFAIL System A failure on the
phone line occurred.

43 OP_RECALL System Operator set recall.

44 DTMF_V System DTMF tone detected.

45 HU_INB System The client hung up
while in the inbound
wait queue.

46 HU_OUT System The client hung up
while in the outbound
wait queue.

47 HANG_INB System An agent was not
available for the
inbound call.

48 HANG_OUT System An agent was not
available for the
outbound call.

49 OPDIED System The agent session
ended abnormally.

50 R_HSONHOOK System Agent headset
disconnected from
the Avaya PDS.

51 - 85 Agent Customer-assigned
codes used by agents.

86 - 88 Agent Reserved.

89 MANAGEDA Agent Managed Dial:
Managed non-
connection.

90 MANAGEDB Agent Managed Dial:
Managed non-
connection.

91 VIRTVOICE System Virtual Agent:
Virtual message to
VOICE.

Code
Number

Code Name Code
Type

Code Description
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92 VIRTAUTOV System Virtual Agent:
Virtual message to
AUTOVOICE.

93 SOLD Agent Sales Verification:
Sold campaign.

94 VERIFIED Agent Sales Verification:
Sale verified.

95 UNVERIFIED Agent Sales Verification:
Sale not verified.

96 - 97 Reserved for system.

98 AORECALL Agent Owned Recall.

99 Reserved for system.

Code
Number

Code Name Code
Type

Code Description
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7 Log in to Campaign Director

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses Campaign
Director to interface with the hardware and software that is included
with the system. Campaign Director contains three modules: Campaign
Editor, Campaign Monitor, and Campaign Analyst.

Contents This section contains the following topic:

• Log in to Campaign Director
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Log in to Campaign Director

Overview The Avaya PDS allows you to access any Campaign Director
application (Campaign Monitor, Campaign Editor, or Campaign
Analyst) by using one password. After you are logged on to one
application, you can access the others without entering another user
name and password.

Log in to Campaign
Director

Use the following procedure to log in to any Campaign Director
application.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Monitor, Campaign
Editor, or Campaign Analyst.

............................................................................................................................................................................

2 Type your log in name (must be at least 3 characters) and password, and
then click OK.

Note

If you exit all applications, you will need to log in again.
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8 Campaign Editor settings

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) gives you the ability to
enable or disable multi-dialer commands and set your save and refresh
options in Campaign Editor.

Contents This section contains the following topics:

• Enable or disable multi-dialer commands

• Save options

• Set refresh options
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Enable or disable multi-dialer commands

Enable or disable multi-
dialer commands

Use the following procedure to enable or disable multi-dialer
commands.

............................................................................................................................................................................

1 In Campaign Editor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, click the Multi-dialer tab.

............................................................................................................................................................................

3 Select Enable to enable multi-dialer commands. (Select Disable to
disable multi-dialer commands.)

............................................................................................................................................................................

4 Select the dialer you want to use.

............................................................................................................................................................................

5 Click Apply to save your changes, or click OK to save your changes and
close the dialog box.
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Save options

Save options Use the following procedure to set Save options.

............................................................................................................................................................................

1 In Campaign Editor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, click the Save tab.

............................................................................................................................................................................

3 Select Prompt before overwrite to receive a prompt before saving.
(Select Overwrite without asking to save without receiving a prompt.)

............................................................................................................................................................................

4 Click Apply to save your changes, or click OK to save your changes and
close the dialog box.
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Set refresh options

Set refresh options Use the following procedure to set refresh options.

............................................................................................................................................................................

1 In Campaign Editor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, click the Refresh tab.

............................................................................................................................................................................

3 Select the interval at which you want Campaign Editor to refresh.

............................................................................................................................................................................

4 Click Apply to save your changes, or click OK to save your changes and
close the dialog box.
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9 Phone strategy

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses phone strategies to
call customers more effectively.

Contents This section contains the following topics:

• Phone strategy overview

• Phone strategy preparation

• Phone strategy settings

• Create a phone strategy

• Copy a phone strategy

• View phone strategy settings

• Edit a phone strategy

• Delete a phone strategy

• List all phone strategies on a selected dialer

• Append a phone strategy row

• Insert a row in a phone strategy

• Delete a row in a phone strategy

• Move a row up in a phone strategy

• Move a row down in a phone strategy

• Select all rows in a phone strategy
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• Unselect all rows in a phone strategy
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Phone strategy overview

Overview A phone strategy is a set of instructions that tells the Avaya PDS to call
customers during a calling campaign. A phone strategy tells the Avaya
PDS when and how to call clients, which customer phone number to
call, and the frequency of calls.

The Avaya PDS applies the criteria and settings specified in the phone
strategy to the calling list records.

The following parameters define a phone strategy:

• Which phone number to call first

• The number of rings to allow before disconnecting

• The time to wait before retrying a phone number that was busy,
unanswered, or disconnected

• The phone number to call if the first phone number is unanswered

• The number of times to retry a busy phone number

• The number of times to call a phone number before switching to
an alternate phone number

• The types of calls to be passed to an agent when the Avaya PDS
detects an answer

Phone strategy parameters Phone strategy parameters are grouped into four areas: Initial Phone,
Alternate Initial Phone, Call Detection Mode, and Retries. The
following table describes each group of parameters.

Initial Phone The first phone number the system will
call.

Alternate Initial Phone The phone number that becomes the
initial phone at a specified time of day.

Call Detection Mode The system detects how the phone
number is answered (such as live voice,
answering machine, and operator). This
determines which calls are passed to
agents.

Retries This parameter tells the system to retry a
phone number depending on the previous
outcome.
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Phone strategy preparation

Overview The Avaya PDS receives and prepares the host data file and creates a
calling list. A phone strategy is used to specify the phone numbers to
call during a job and how to place the calls.

Before you create a new phone strategy, you must decide which phone
strategy parameters to use to define how the system places calls.

Wildcard characters Phone strategies use one or more wildcard characters to clarify which
phones are called, how often, and in what order.

Using wildcard characters

Wildcard characters are symbols used to increase productivity by
selecting ranges in the phone strategy.

Wildcard characters include:

Wildcard character Description

= is equal to

<> or ~ is not equal to

> is greater than

< is less than

>= is greater than or equal to

<= is less than or equal to
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Phone strategy settings

Initial phone The initial phone is the first phone number the Avaya PDS calls for
each record. In the calling list, phone numbers are stored in phone
fields. These fields are labeled PHONE1, PHONE2, and so on. If a
record does not match the criteria you set, the system will not call the
record.

The Avaya PDS classifies phone numbers by phone type and assigns a
number to each type. For example, the home phone might be phone
number 1 and the business phone number 2. The Avaya PDS phone
type numbers are set during your system configuration.

Alternate initial phone The alternate initial phone setting is used to set up one or more phones
that the Avaya PDS will use as alternate initial phones based on the
time of day. At a particular time of day, the alternate initial phone
replaces the initial phone as the first phone number to call. The system
can switch to calling the alternate initial phone number at the time you
specify in the alternate initial phone settings.

Alternate initial time settings are also defined in this parameter, which
changes the time the system starts calling the alternate initial phone.
The system starts calling based on the local time in the selected time
zone.

Example

You can tell the Avaya PDS to switch from calling business phones
during the day (initial phone) to calling home phones (alternate initial
phone) during the evening starting at 6 PM.

Call detection mode The call detection mode is used to determine the types of calls the
Avaya PDS passes to agents. Call detection modes correspond to
responses that the system detects when it dials a number. Typical call
detection modes include voice, autovoice, and operator intercept. The
system passes calls to agents based on the selected modes.

The type of connect criteria determines what type of connects the
Avaya PDS will pass to an agent.

Define the following parameters for call detection mode settings:

• The ring count is the number of rings to allow before the system
records a NOANSWER completion code.
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• The call detection mode tells the system which calls to pass to
agents.

When the Avaya PDS places a call, the system detects what type of
answer occurs for each call. The following table lists the codes that are
used in the Call Detection Mode tab:

Tip

Increase your hit rate by deciding which detection modes to use. With
each additional criteria you select, more calls can be handled by your
agents instead of by the system.

Retries The retries setting is used to determine how long the Avaya PDS waits
before retrying a number, how many times it retries the same phone
number, and which phone it calls next.

The Avaya PDS determines the settings by the result of the initial call.
For example, you can tell the system to retry the call in 15 minutes
when the initial call result is busy and to stop calling that record if there
is no answer after three retries.

Note

It is important to understand the difference between a system retry and
a customer recall.

• Retries are computer generated retries. If the Avaya PDS detects a
busy signal on the first call attempt, it will retry based on the retry
parameters set in the phone strategy.

Code Answer type

V Voice

AV Autovoice

INT Operator intercept

NOCIRC No circuit available

DISCON Disconnected number

VAC Vacant number

REORD Reorder
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• Recalls are set by agents. An agent can set either an Agent Owned
Recall (the system routes the recall to the agent who set it) or a
general recall (any available agent talks to the customer when the
system recalls the account).
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Create a phone strategy

Create a phone strategy Use the following procedure to create a phone strategy:

............................................................................................................................................................................

1 Start Campaign Editor.

............................................................................................................................................................................

2 In your button bar, click the name of the dialer where you want your
phone strategy to reside. (You can save it to other dialers or delete it
from this dialer later.)

............................................................................................................................................................................

3 On the button bar, click Strategies.

............................................................................................................................................................................

4 Select File > New.

............................................................................................................................................................................

5 On the right side of the window, click the List field, select a calling list,
and then click Next.

............................................................................................................................................................................

6 In the Initial Phone pane, click the Phone field and select a phone.
Double-click the other fields to define your initial phone settings, and
then click Next.

............................................................................................................................................................................

7 (Optional) In the Alternate Initial pane, specify alternate initial phone
settings. Right-click and select Append Row. Double-click the fields to
enter values. Select options as needed. Right-click and select Select All
to select all options. Right-click and select Unselect All to clear all
options. Click Next.

............................................................................................................................................................................

8 In the Detection Mode pane, select the detection modes to pass to the
agents, and then click Next.
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9 In the Retries pane, select the call results to retry. For each result you
select, type a value in the Retry Interval (mins), Attempts, and Next
Phone columns.

............................................................................................................................................................................

10 Select File > Save. The strategy is automatically saved to the dialer that
you had selected in the button bar. If multi-dialer is enabled, select
additional dialers where the strategy should be saved. Type a file name
for your strategy, and then click OK. (If the check boxes are unavailable,
enable them in the Settings > Options dialog box.)
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Copy a phone strategy

Copy a phone strategy Use the following procedure to copy a phone strategy.

............................................................................................................................................................................

1 Double-click the phone strategy you want to copy.

............................................................................................................................................................................

2 Select File > Save As.

............................................................................................................................................................................

3 Avaya PDS automatically copies the file to the selected dialer. If multi-
dialer is enabled (a grayed-out check box indicates that multi-dialer is
unavailable; enable and disable multi-dialer using the Settings >
Options dialog box), you can copy the strategy to additional dialers.
Select dialers as needed, type a file name for the phone strategy, and then
click OK.
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View phone strategy settings

View phone strategy
settings

Use the following procedure to view phone strategy settings.

............................................................................................................................................................................

1 Double-click the phone strategy you want to open.
The phone strategy settings appear in the right-hand pane.

............................................................................................................................................................................

2 To navigate through the phone strategy settings, click Next or Back.
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Edit a phone strategy

Overview Change phone strategy settings when doing so will help your system
call more efficiently. Changes take affect the next time a job that uses
the strategy is started.

If you select a different calling list for a phone strategy, you might need
to redefine certain phone strategy settings:

• If the newly selected calling list contains the same number of
phone fields with the same field names as the original list, the
system retains all the phone strategy settings.

• If the newly selected calling list has a different number of phones
or the phone field names are different, the system retains the initial
phone and alternate initial phone settings, but does not retain the
original detection modes and retries settings.

Edit a phone strategy Use the following procedure to edit a phone strategy.

............................................................................................................................................................................

1 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

2 Make the necessary edits in the right-hand pane.

............................................................................................................................................................................

3 Select File > Save, and then click OK.
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Delete a phone strategy

Delete a phone strategy Use the following procedure to delete a phone strategy.

............................................................................................................................................................................

1 Double-click the phone strategy you want to delete.

............................................................................................................................................................................

2 Select File > Delete.

............................................................................................................................................................................

3 When asked if you really want to do this, click Yes if you do.

............................................................................................................................................................................

4 If the multi-dialer option is enabled, the Multiple dialer command
dialog box appears. Click to clear the check boxes of the dialers from
which you do not want to delete the strategy. Click OK. (If the check
boxes are grayed out, select Settings > Options to enable the multi-
dialer settings.)
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List all phone strategies on a selected dialer

List all phone strategies on
a selected dialer

Use the following procedure to view a list of all phone strategies on a
selected dialer.

............................................................................................................................................................................

1 On the button bar, select the dialer for which you want to list the phone
strategies.

............................................................................................................................................................................

2 Click Strategies.
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Append a phone strategy row

Append a phone strategy
row

Appending a row adds a row beneath the bottom row. Use the
following procedure to append a row to your phone strategy.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Strategies.

............................................................................................................................................................................

2 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

3 In the right hand pane, click Back or Next to select the pane you want
to edit.

............................................................................................................................................................................

4 Select Edit > Append Row.
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Insert a row in a phone strategy

Insert a row in a phone
strategy

Inserting a row adds a row directly above the row you select. Use the
following procedure to insert a row in your phone strategy.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Strategies.

............................................................................................................................................................................

2 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

3 In the right-hand pane, click Back or Next to select the pane you want
to edit.

............................................................................................................................................................................

4 Select the row that the new row will appear above.

............................................................................................................................................................................

5 Select Edit > Insert Row.
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Delete a row in a phone strategy

Delete a row in a phone
strategy

Use the following procedure to delete a row from your phone strategy.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Strategies.

............................................................................................................................................................................

2 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

3 In the right hand pane, click Back or Next to select the pane you want
to edit.

............................................................................................................................................................................

4 Select the row you want to delete.

............................................................................................................................................................................

5 Select Edit > Delete Row.
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Move a row up in a phone strategy

Move a row up in a phone
strategy

Use the following procedure to move a row up in your phone strategy.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Strategies.

............................................................................................................................................................................

2 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

3 In the right hand pane, click Back or Next to select the pane you want
to edit.

............................................................................................................................................................................

4 Select the row to move.

............................................................................................................................................................................

5 Select Edit > Move Up.
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Move a row down in a phone strategy

Move a row down in a
phone strategy

Use the following procedure to move a row down in your phone
strategy.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Strategies.

............................................................................................................................................................................

2 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

3 In the right hand pane, click Back or Next to select the pane you want
to edit.

............................................................................................................................................................................

4 Select the row you want to move down.

............................................................................................................................................................................

5 Select Edit > Move Down.
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Select all rows in a phone strategy

Select all rows in a phone
strategy

Use the following procedure to select all rows in your phone strategy.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Strategies.

............................................................................................................................................................................

2 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

3 In the right hand pane, click Back or Next to select the pane you want
to edit.

............................................................................................................................................................................

4 Select Edit > Select All.
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Unselect all rows in a phone strategy

Unselect all rows in a
phone strategy

Use the following procedure to unselect all rows in a phone strategy.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Strategies.

............................................................................................................................................................................

2 Double-click the phone strategy you want to edit.

............................................................................................................................................................................

3 In the right hand pane, click Back or Next to select the pane you want
to edit.

............................................................................................................................................................................

4 Select Edit > Unselect All.
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10 Record selection

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses record selections
to determine which records to call during a job. You can create your
own customized record selections that contain your own rules. For
example, call only customers with an outstanding balance of < $5,000
and who live in California. After you have defined your customized
record selection, you can save that record selection for use on any
future calling campaign.

Contents This section contains the following topics:

• Record selection

• Record selection organization

• Record selection wildcard characters

• Understand the Selection Reports pane

• Open and view a record selection

• Complete the Miscellaneous pane

• Complete the Records pane

• Complete the Calling Results pane

• Complete the Time Zone pane

• Complete the Recalls pane (optional)

• Complete the Sort pane (optional)
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• Create a record selection

• Save a record selection

• Edit a record selection

• Delete a record selection

• Verify a record selection

• Run a record selection

• Copy a record selection

• List all record selections on a selected dialer

• View selection reports

• View record selection settings

• Append record selection rows

• Insert a row in a record selection

• Delete a row in a record selection

• Move a row up in a record selection

• Move a row down in a record selection

• Select all rows in a record selection

• Unselect all rows in a record selection
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Record selection

Overview A record selection contains the set of instructions that tells the Avaya
PDS which customer records to select from a calling list. Record
selections allow supervisors to define the criteria for selecting records
and target specific customers to be called during a job. A record
selection consists of selection criteria and a phone strategy. Each job
uses the results of a record selection and a phone strategy to call
customers.

When starting a record selection, the Avaya PDS chooses records based
on the following criteria:

• calling list fields

• time zones

• previous calling results

• agent set recalls

• phone strategy settings

You can verify a record selection before you start a job to determine
how many records are chosen.

Target Time Zones

You can use your record selection to target time zones such as Eastern,
Central, or Pacific. This allows only records from specific time zones
to be targeted. If not specified, the Avaya PDS defaults to a “follow the
sun” method, meaning it calls records from east to west.

Target completion codes

You can use your record selection to target completion codes such as
BUSY or NOANSWER. Use this to also select SIT tone completion
codes to run a job to look for disconnected or redirected numbers, or
numbers that are no longer in service.

Target goals

You can use your record selection to target goals, such as accounts
more than 30 days overdue, accounts with a balance over $2,000, or
records in a particular state.
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Record selection use Create a record selection when an existing record selection does not
meet your current needs. Edit a record selection when you want to
modify an existing record selection.

To view a record selection, open Campaign Editor and click Selections
in the button bar. Then, double-click a record selection title. Record
selection settings populate the right-hand pane, which serves as a
wizard. Back and Next buttons located at the bottom of the screen
allow you to switch among the various wizard screens.

The wizard screens guide you through the record selection editing
process. If you are ever unsure what to enter in a field, you should
double-click or single-click the field to see if there is a list of values to
choose from or a blinking cursor that indicates you can type your own
value in the field.

The difference between Selections and Selection Reports in the button
bar is that Selections causes all of the record selections that you have
created to appear and Selection Reports causes reports for all of the
record selections that have already run to appear. Selection Reports
provides detailed information about the results of the record selection,
while Selections serves as an editor (and not a reporting mechanism).
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Record selection organization

Overview A record selection contains options defined by the supervisor. The
system chooses a record if it meets specific criteria. Use the record
selection in conjunction with the phone strategy to determine who you
want to call (record selection) and how you want to call (phone
strategy) those selected records.

As soon as you click Selections in the button bar, your screen becomes
divided into two areas: a left-hand pane and a right-hand pane. The left-
hand pane lists your record selections that you have created, while the
right-hand side allows you to edit a record selection’s settings by using
the various panes.

Record selection panes The following table describes the various panes that appear on the
right-hand area of the window; click the Next and Back buttons to
switch among these panes.

Pane name Pane description

Miscellaneous pane Use the Miscellaneous pane to select a
calling list, phone strategy file, unit
work list field, time zone ignore option,
or selection type (infinite or verify).

Records pane Use the Records pane to define which
records the system uses during a job
based on logic statements that you
create.

Time Zones pane Use the Time Zones pane to select time
zones that the system uses to determine
which phone numbers to call.

Calling Results pane Use the Calling Results pane to tell the
system which phone numbers to call
based on previous calling results.
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Recalls pane Use the Recalls pane to determine which
agent-set recalls to include in the record
selection.

Sort pane Use the Sort pane to determine the
record order that the system uses to call
clients.

Pane name Pane description
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Record selection wildcard characters

Wildcard characters Like phone strategies, record selections use wildcard characters to
specify criteria for a field. Use wildcard character expressions to define
the subset of records you want to call. A wildcard character expression
is a combination of wildcard characters (such as < or >) and values.

Use wildcard characters Use wildcard characters in the Records and Recalls panes. Each
wildcard character expression specifies a field name (from the records
in your calling list), a wildcard character, and a value.

Values can be numbers, letters, dates, and times. For example, account
balances consist of numbers, while client names consist of letters.
Wildcard characters include the following:

Wildcard characters Description

> greater than

< less than

= equal to

~ not equal to

>= greater than or equal to

<= less than or equal to

- use between a range of values

, use between multiple values

* wildcard character

! list wildcard character

? single character wildcard character
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Example record selection statements include the following:

Consider the following tips when you create your record selection
statement:

• You can connect two or more statements using the operators AND
and OR.

Use AND to narrow the selection to the client records that meet
the criteria in both statements.

Use OR to broaden the selection to select the client records that
meet the conditions in either statement.

• Click Append to add a line to the bottom of the selection area.

• Click Insert to insert a line below the cursor.

• Click Delete to delete the selected line.

Field Value What is selected?

ACCT_BALANCE >=500 Customer records with account
balances greater than or equal
to $500.

CITY =Chicago Customer records with Chicago
addresses.
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Understand the Selection Reports pane

Overview When you click Selection Reports in the button bar, the Selection
Reports pane appears and shows a list of record selections that have
previously been run. The Selection Reports pane is an area that
contains summary information, so you do not modify its contents.
Modify record selections in the pane that appears when you click
Selections in the button bar.

To view a selection report, double-click a selection. You can then right-
click and select Select All so that you can copy and paste the report into
a different application.

Understand the Selection
Reports pane

The Selection Reports pane contains the following headings: Selection,
List, Status, Records, Records Remaining, Recalls, and Select Ran at.

The following table describes these headings:

Heading Description

Selection Record selection file name

List Calling list associated with this record
selection

Status Record selection status is In Use if being
used for a currently running job or Available
if not.

Records Number of customer records associated with
this record selection file

Records Remaining Number of records that still need to be
called (this number changes if the job is
running)

Recalls Number of recalls (callbacks) that this
record selection file has flagged

Selection Ran at Time and date stamp
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Open and view a record selection

Open and view a record
selection

Use the following procedure to open and view a record selection.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Editor.

............................................................................................................................................................................

2 On the button bar, click Selections. The list of selections for the selected
dialer appear. To see record selections that have been defined for a
different dialer, click the name of the dialer on the button bar, and then
click Selections for that dialer.

............................................................................................................................................................................

3 Double-click a record selection title to display the selection settings in
the right-most pane.

............................................................................................................................................................................

4 Use the Next and Back buttons to move through the wizard screens.
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Complete the Miscellaneous pane

Complete the
Miscellaneous pane

Use the following procedure to modify the fields on the Miscellaneous
pane.

............................................................................................................................................................................

1 Click the List field to use the drop-down list. Select a calling list.

............................................................................................................................................................................

2 Click the Strategy File field to use the drop-down list. Select a phone
strategy file that you have already created (it is beneficial to create a
phone strategy, record selection and then job, in that order).

............................................................................................................................................................................

3 Click the Unit Field field and select a unit work list.

............................................................................................................................................................................

4 Click the Ignore Time Zone field and select Yes or No.

............................................................................................................................................................................

5 Click the Selection Type field and select Infinite, Verify, or blank
(blank is usually the first list item and is an empty, blank option; in this
case it indicates that you want neither Infinite nor Verify). Select
Infinite if your job is an infinite job; select Verify if your job is a verify
job.
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Complete the Records pane

Complete the Records
pane

Use the Records pane to define your record selection statement.

............................................................................................................................................................................

1 Select Next or Back to navigate to the Records pane.

............................................................................................................................................................................

2 Click the Field field to use the drop-down list. Select a field (for
example, BAL).

............................................................................................................................................................................

3 Double-click the Value field to type a value (for example, >3000).

............................................................................................................................................................................

4 (Optional) If you use the Logic field, you begin to create a multi-line
logic statement. Click the Logic field to use the drop-down list to select
AND or OR.

............................................................................................................................................................................

5 Double-click the Group field to type a letter or number. For example, if
you type a “1” in the Group column for the first row and a “1” in the
Group column for the second row, then you have just grouped the first
two rows into a group called “1.”
When you group rows, the Logic column becomes a critical linking
component because its logic operator determines how the linked
elements resolve as one statement.

............................................................................................................................................................................

6 To add a row, select Edit > Append Row.

............................................................................................................................................................................

7 Repeat steps 2 through 6 for each selection criteria.
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Complete the Time Zone pane

Complete the Time Zone
pane

Use the following procedure to select which time zones the Avaya PDS
will call.

............................................................................................................................................................................

1 Select the time zones you want to call. To select all time zones, right-
click and select Select All.

............................................................................................................................................................................

2 Clear the each time zone you do not want to include. To clear all time
zones, right-click and select Unselect All.
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Complete the Calling Results pane

Complete the Calling
Results pane

Use the following procedure to complete the calling results pane.

............................................................................................................................................................................

1 Select each completion code you want the system to call. You can right-
click and select Select All.

............................................................................................................................................................................

2 Clear each completion code you do not want to call. Right-click and
select Unselect All to clear all of the completion codes.

Note

New records that have not been called yet are assigned a “Record not
yet called” code. You will almost always select the “Record not yet
called” box because you have never attempted to call that customer
before.
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Complete the Recalls pane (optional)

Complete the Recalls pane The Recalls wizard pane is blank by default because it is optional. It is
common not to define recall settings to tell the Avaya PDS to dial all
scheduled agent-set recalls. To make only the recalls scheduled during
the current job, enter criteria to match the Records pane. To prevent any
agent-set recalls, enter values that cannot be met so that no records can
qualify for recall. For example, select the STATE field and enter ZZ (no
records will have a STATE value of ZZ, so no records can be selected
for recall).

............................................................................................................................................................................

1 If the Recalls pane has no visible rows, right-click and select Append
Row.

............................................................................................................................................................................

2 Click the Field field to select a field (for example, BAL).

............................................................................................................................................................................

3 Double-click the Value field to type a value (for example, >3000).

............................................................................................................................................................................

4 (Optional) If you use the Logic field, you begin to create a multi-line
logic statement. Click the Logic field to use the drop-down list to select
AND or OR.

............................................................................................................................................................................

5 Double-click the Group field to type a letter or number. For example, if
you type a “1” in the Group column for the first row and a “1” in the
Group column for the second row, then you have just grouped the first
two rows into a group called “1.”
When you group rows, the Logic column becomes a critical linking
component because its logic operator determines how the linked
elements resolve as one statement.
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Complete the Sort pane (optional)

Complete the Sort pane This screen is blank by default because it is optional. Use the following
procedure to tell the Avaya PDS how to sort the selected records.

............................................................................................................................................................................

1 If the Sort pane has no visible rows, right-click and select Append Row.

............................................................................................................................................................................

2 Click the Order field to use the drop-down list and select Ascending or
Descending.

............................................................................................................................................................................

3 Click the Sorts Records By field to enter a value.

............................................................................................................................................................................

4 To change the priority, select the row and then select Move Up or Move
Down.

Note

If you set more than nine sorts, the Avaya PDS performance will be
reduced.
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Create a record selection

Create a record selection Use the following procedure to create a record selection.

............................................................................................................................................................................

1 Select the name of the dialer where you want your record selection to
reside. (You can save it to additional dialers or delete it from this dialer
later.)

............................................................................................................................................................................

2 On the button bar, click Selections.

............................................................................................................................................................................

3 Select File > New. The right-hand pane populates.

............................................................................................................................................................................

4 In the right-hand pane, click the List field and select a calling list.

............................................................................................................................................................................

5 Click Next and Back to complete the other panes.

............................................................................................................................................................................

6 When finished, select File > Save.
The record selection is automatically saved to the dialer you selected.

............................................................................................................................................................................

7 Type a file name, and then click OK.
(If the additional dialers were unavailable, select Settings > Options to
change your multi-dialer settings.)
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Save a record selection

Save a record selection Use the following procedure to save a record selection.

............................................................................................................................................................................

1 When you finish defining settings for a record selection, select File >
Save.

............................................................................................................................................................................

2 Your record selection will automatically be saved to the selected dialer.
Select additional dialers on which to save your record selection. (If the
check boxes are unavailable, select Settings > Options to change your
multi-dialer settings.)

............................................................................................................................................................................

3 Type a file name for your record selection, and then click OK.
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Edit a record selection

Edit a record selection Use the following procedure to edit a record selection.

............................................................................................................................................................................

1 Double-click on the record selection you want to edit.

............................................................................................................................................................................

2 Make the necessary edits in the right-hand pane.

............................................................................................................................................................................

3 Select File > Save to save the changes.
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Delete a record selection

Delete a record selection Use the following procedure to delete a record selection.

............................................................................................................................................................................

1 Select the record selection you want to delete.

............................................................................................................................................................................

2 Select File > Delete.

............................................................................................................................................................................

3 When asked if you are sure, click Yes if you are sure.
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Verify a record selection

Verify a record selection Use the following procedure to verify that the settings for a particular
record selection are complete and that the record selection will run
when started. The Avaya PDS displays a message if an error occurs.
You should review your wizard screens before verifying a record
selection. You cannot verify a record selection until you have saved
your work.

............................................................................................................................................................................

1 Select the record selection you want to verify.

............................................................................................................................................................................

2 Select File > Verify, and then click OK.
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Run a record selection

Run a record selection Use the following procedure to run a record selection.

............................................................................................................................................................................

1 Click the record selection you want to run.

............................................................................................................................................................................

2 Select File > Run, and then click OK.

Note

You do not need to run a record selection before you start a job. You
can, however, run a record selection to check to determine how many
records are selected. When you start a job, the system first verifies the
record selection, and then starts the job.
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Copy a record selection

Copy a record selection Use the following procedure to copy a record selection.

............................................................................................................................................................................

1 Select the record selection you want to copy.

............................................................................................................................................................................

2 Select File > Save As.

............................................................................................................................................................................

3 Type a name for the copied record selection, and then click OK.
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List all record selections on a selected dialer

List all record selections
on a selected dialer

Use the following procedure to view a list of all record selections on a
selected dialer.

............................................................................................................................................................................

1 Select the name of the dialer whose record selections you want to list.

............................................................................................................................................................................

2 Click Selections.
The record selections for the selected dialer appear.
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View selection reports

View selection reports In the button bar, you see both Selections and Selection Reports. The
difference between these two is that Selections displays all of the
record selections that you have created and Selection Reports displays
all of the record selections that you have run. Selection Reports
provides detailed information about the results of the record selection,
while Selections serves as an editor and not a reporting mechanism.
Use the following procedure to view selection reports.

............................................................................................................................................................................

1 In the button bar, select the dialer whose record selection reports you
want to view.

............................................................................................................................................................................

2 Click Selection Reports.

............................................................................................................................................................................

3 Double-click the name of a selection report. The right-hand pane
populates with your selection report.

............................................................................................................................................................................

4 If you want to copy and paste the report to a different application, right-
click and select Select All. Then, right-click and select Copy.
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View record selection settings

View record selection
settings

Use the following procedure to view record selection settings.

............................................................................................................................................................................

1 Double-click the record selection you want to open.
The record selection settings will appear in the right hand pane.

............................................................................................................................................................................

2 Click Next or Back to navigate through all of the record selection
settings.
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Append record selection rows

Append record selection
rows

Appending a row adds a row beneath the bottom row. Use the
following procedure to append a row in your record selection.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Selections.

............................................................................................................................................................................

2 Double-click the record selection you want to edit.

............................................................................................................................................................................

3 Click Next or Back to navigate to the pane you want to edit.

............................................................................................................................................................................

4 Select Edit > Append Row.
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Insert a row in a record selection

Insert a row in a record
selection

Inserting a row adds a row directly above the highlighted row. Use the
following procedure to insert a row to your record selection.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Selections.

............................................................................................................................................................................

2 Double-click the record selection you want to edit.

............................................................................................................................................................................

3 Click Next or Back to navigate to the pane you want to edit.

............................................................................................................................................................................

4 Select the row that the new row will appear directly above.

............................................................................................................................................................................

5 Select Edit > Insert Row.
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Delete a row in a record selection

Delete a row in a record
selection

Use the following procedure to delete a row from your record selection.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Selections.

............................................................................................................................................................................

2 Double-click the record selection you want to edit.

............................................................................................................................................................................

3 Click Next or Back to navigate to the pane you want to edit.

............................................................................................................................................................................

4 Select the row you want to delete.

............................................................................................................................................................................

5 Select Edit > Delete Row.
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Move a row up in a record selection

Move a row up in a record
selection

Use the following procedure to move a row up in your record selection.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Selections.

............................................................................................................................................................................

2 Double-click the record selection you want to edit.

............................................................................................................................................................................

3 Click Next or Back to navigate to the pane you want to edit.

............................................................................................................................................................................

4 Select the row you want to move.

............................................................................................................................................................................

5 Select Edit > Move Up.
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Move a row down in a record selection

Move a row down in a
record selection

Use the following procedure to move a row down in your record
selection.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Selections.

............................................................................................................................................................................

2 Double-click the record selection you want to edit.

............................................................................................................................................................................

3 Click Next or Back to navigate to the pane you want to edit.

............................................................................................................................................................................

4 Select the row you want to move.

............................................................................................................................................................................

5 Select Edit > Move Down.
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Select all rows in a record selection

Select all rows in a record
selection

Use the following procedure to select every row in your record
selection.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Selections.

............................................................................................................................................................................

2 Double-click the record selection you want to edit.

............................................................................................................................................................................

3 Click Next or Back to navigate to the pane you want to edit.

............................................................................................................................................................................

4 Select Edit > Select All.
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Unselect all rows in a record selection

Cancel a row selection in a
record selection

Use the following procedure cancel a row selection in your record
selection.

............................................................................................................................................................................

1 On the Campaign Editor button bar, click Selections.

............................................................................................................................................................................

2 Double-click the record selection you want to edit.

............................................................................................................................................................................

3 Click Next or Back to navigate to the pane you want to edit.

............................................................................................................................................................................

4 Select Edit > Unselect All.
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Overview

Purpose A job contains all the information the AvayaTM Predictive Dialing
System (PDS) needs to call clients. A job integrates a calling list, phone
strategy, record selection, and other settings to place outbound calls and
receive inbound calls.

Contents This section contains the following topics:

• Job types

• Outbound job

• Job settings

• Create a job

• View job settings

•  Save a job

• Save a job as another name or on a different dialer

• Start a job on one or more dialers

• Start multiple jobs on currently selected dialer

• Copy a job

• Edit a job

• Verify a job on one or more dialers

• Verify multiple jobs on the currently selected dialer
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• Delete a job on one or more dialers

• Delete multiple jobs on the currently selected dialer

• List all jobs on a selected dialer
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Job types

Overview Jobs are part of a campaign. A job, depending on what type of system
configuration you have, can make outbound calls, receive inbound
calls, verify a sale, or a handle variety of other tasks.

If you have an Intelligent Call Blending system, you can use Campaign
Editor to set up three types of jobs:

• Outbound jobs

• Inbound jobs

• Blend jobs

If you have an Agent Blending system, you can use Campaign Editor to
set up outbound jobs.

Outbound jobs During outbound jobs, the Avaya PDS uses a calling list, phone
strategy, record selection, and other settings to place outbound calls to
customers. There are many settings to configure for an outbound job.
These are discussed more in depth in the following section.

Inbound jobs During inbound jobs, the Avaya PDS automatically routes inbound
calls to agents. There are no inbound jobs on an Agent Blending
system. All inbound calls are handled by inbound ACD agents.
Because the Avaya PDS does not control the inbound call activity on
the Agent Blending system, the system does not consider it a job.

Blend jobs The term blend job refers to job run on an Intelligent Call Blending
system. During an Intelligent Call Blending job, the Avaya PDS moves
agents between outbound and inbound calls. Blend agents receive
inbound calls during peak inbound activity and outbound calls when
inbound activity decreases.

An Avaya PDS blend agent handles both inbound and outbound calls
with Intelligent Call Blending.
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Outbound job

Overview During outbound jobs, the Avaya PDS automatically dials phone
numbers and routes calls to agents. The system screens for answering
machines, phone operator intercepts, busy signals, Interactive Voice
Response systems (IVRs), and no answers.

Special outbound jobs

An outbound job uses settings to target customers for calling. Agent
Blending and Intelligent Call Blending systems both use outbound
jobs. Depending on your system configuration, there are up to five
special jobs. These settings are configured when you create or modify a
job.

• A Unit Work List job divides customer records into subsets.
Agents work with records only in their assigned work lists.

• A Managed Dialing job allows agents to preview or cancel a
customer record before the Avaya PDS calls the customer. As the
supervisor, you can adjust the preview time and allow agent to
cancel calls depending on how the job settings are configured.

• A Sales Verification job creates a second campaign to verify a sale
or commitment that the customer made. Use the Sales Verification
Record Selection when starting a Sales Verification job.

• An Infinite job uses a special record selection to receive new
records for calling while the job is active. Use the Infinite record
selection when starting an Infinite job.The Avaya PDS uses this
record selection to add new records (downloaded from your host)
to an existing calling list on an active infinite job. An infinite job
runs until you stop it manually.

• A Virtual Agent job allows the Avaya PDS to run a job without
agents. When the Avaya PDS detects a customer or an answering
machine, the system plays a recorded message.

Define Sales Verification, Unit Work List, Virtual, and Managed on the
second screen of the Campaign Editor Job Wizard when you create a
new job. These features are optional and some features are mutually
exclusive. For example, if you select Virtual, you cannot select any
other choices. If you select Managed, you can only select Sales
Verification with it. If you select Unit Work List, you can only select
Sales Verification with it.
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Job settings

Overview There are several settings that you define for each outbound job. The
settings on your system may vary depending on your configuration.
The settings are grouped in the following way:

• Basic

• Outbound

• Managed

• Interactive Voice Response

• Unit Work List

Basic job settings Basic settings are for every type of job, regardless of whether it is
outbound, inbound, or blend. The following settings are listed in the
BASIC tree structure.

Main data processing label

Use the drop-down list to select the correct main data processing label.
The main data process label instructs the Avaya PDS to begin job
processing and tells the system what to display on the agent screens.

Note

If you run a virtual or sales verification job, select the appropriate data
process label. For example, select virtual for a virtual job, verify for a
sales verification job, and generic for an outbound job.

Job description

Double-click in the text box and type a job description. This is a
description of the job. For example, type a description that reflects the
goal of the job such as 30-day Accounts.

Link to job

You can tell the Avaya PDS to automatically start a job when this job
ends. Use the Link to job setting to select the next job to start.

When you link a job, the system transfers each agent to the next job
after the agent completes the last call and releases the record. The
system displays a message telling the agents that they are changing
jobs.
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The following table describes the types of jobs that can link together:

Note

If you stop a job that has a job linked to it, the Avaya PDS will
automatically start the next job.

Agent keys definition file name

Use the drop-down list to select the agent keys file name to use during a
job. An agent keys file is configured with different sets of functions for
keys used during differently types of jobs.

Line type(s) for use on job

Double-click and the line types to use during a job. Use this setting to
select or clear the groups of lines the Avaya PDS uses for a job.

Earliest start time

Double-click to set the time (numbers only) you want the Avaya PDS to
begin calling customer records.

The Avaya PDS is preset with recommended start and stop times for
different time zones. If you enter a time that is earlier than the
recommended start time, the system does not begin dialing until the
system clock reaches the recommended time.

Latest stop time

Double-click to set the time (numbers only) you want the Avaya PDS to
stop calling customer records.

Job type Can link to

outbound job outbound or blend job (includes Unit
Work List jobs)

Managed Dialing job ONLY to managed jobs (includes Unit
Work List jobs)

inbound job ONLY to inbound job

blend job blend job (blend job cannot link to
outbound job)

virtual job ONLY virtual job
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Run job without agents

Select this option if you want to run your job without agents. This field
does not appear unless you select Virtual in the Campaign Editor Job
Wizard (when you create a new job).

Transfer on hold message number

Double-click and type the number of the message that users should
hear during the call-transfer process.

Outbound job settings Outbound settings are for outbound jobs. The following settings are
listed in the OUTBOUND tree structure.

Do Not Call group name

Use the drop-down list to select the Do Not Call Group file name.

Initial hit rate

Double-click and enter the initial hit rate (number only).

Initial hit rate determines the average number of calls per agent the
Avaya PDS makes during the first five minutes of the job. The initial
hit rate is the number of call completions compared with call attempts.

For example, an initial hit rate of 50% means the system must make
approximately two dialing attempts for each agent to get one successful
connection. When the Avaya PDS gathers statistics from actual call
attempts, it readjusts the hit rate automatically to meet the minimum hit
rate setting. Set the rate too low (20 to 30) and the Avaya PDS could
make more connects than your agents can handle during the initial
dialing period. Set the rate too high (over 70) and the system could fail
to make enough connections to keep your agents busy.

Use the following table to adjust the initial hit rate according to the
particular needs of the job:

If you want to make Set rate to Description

Daytime home calls 30 3 calls per agent for 1
connection

Evening home calls 50 2 calls per agent for 1
connection
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Expert Calling ratio

Double-click for text boxes to enter in Expert Calling ratio settings.

Following are the three choices for setting Expert Calling ratio:

Remember, when you use Calls in Wait Queue, customer wait times are
affected. When you use Agent Work Time or Agent Update Time, the
average agent idle time can be short, but there may be a large
percentage of customers in the wait queue at any given time.

End jobs when no more calls remain

Select this option if you want the Avaya PDS to end jobs when each
customer has been called at least once.

Clear this option if you want the Avaya PDS to end jobs after all calls
are completed, including recalls.

Weekend home calls 50 2 calls per agent for 1
connection

Daytime office calls 70 1 call per agent for 1
connection

Setting Description & recommended setting

Calls in the
wait queue

The Avaya PDS achieves a balance between agents
waiting for a call and customers placed in the wait
queue.

Enter a percent value between 1 and 100. The
recommended setting is between 4 and 31.

Agent Work
Time

The Avaya PDS monitors the time agents take to
complete calls and update records and adjusts the
calling pace accordingly.

Enter a percent value between 1 and 100. The
recommended setting is between 29 and 71.

Agent Update
Time

The Avaya PDS monitors the time agents take to
update records and adjusts the calling pace
accordingly.

Enter a percent value between 1 and 100. The
recommended setting is between 32 and 78.

If you want to make Set rate to Description
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Outbound calling list

Select a list name from the drop-down list. The outbound calling list is
the list you will use for the job.

The calling list name contains the host dialer name (where the list is
stored) and the calling list name. The calling list description (if any) is
listed in the right-hand column drop-down list.

Minimum hit rate

Double-click to set the minimum hit rate (number only). The minimum
hit rate determines the maximum number of calls the Avaya PDS will
make in order to make an agent connection.

Use minimum hit rate to limit the number of lines a job can use, even if
the hit rate falls below this rate. For example, a minimum hit rate of
30% means the system will make no more than three dialing attempts
for each agent. This prevents the Avaya PDS from allocating more
pooled lines to a poorly performing job at the expense of a more
successful job.

Enter a value between 1 and 100 in increments of 10. A typical setting
is 30.

Order calls by time zone

Select this option if you want the Avaya PDS to order calls by times
zones. This means the Avaya PDS calls “following the sun,” or east to
west.

With either choice, time zone laws are still applied.

Quota setting (completion code, quota)

Double-click to use a drop-down list and a box. Use the drop-down list
to select a completion code. Use the text box to enter a quota (for
example, a quota number of 500 would mean that a job automatically
stops if the number of completion codes reaches 500).

Save quota setting when the job ends

Select this option to save the quota setting when the jobs ends.

Quota settings file name

Double-click to type a file name in the field.
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Recall reschedule interval (mins)

If Agent Owned Recall is configured on your system, this field will be
visible. Double-click to enter the minimum amount of time that must
pass before the system tries to pass the agent a recall.

Recall notification time (min)

If Agent Owned Recall is configured on your system, this field will be
visible. Double-click to enter the amount of time that the system will
look for the agent (to pass the recall to the agent who set it up).

Number of recall attempts

If Agent Owned Recall is configured on your system, this field will be
visible. Double-click to enter the number of times to look for the agent
that set up the recall.

Script label for call

Select the script label from the drop-down list. The script label is the
name of the script being used for the job. This determines the messages
the customer hears when placed in the wait queue.

If a customer is placed in a wait queue, the customer hears a message.
The wait queue messages are created for different jobs. The message or
string of messages a customer hears is the message script.

Outbound screen(s)

Select the outbound screen name from the drop-down list. This
determines the outbound screen that agents see on their workstations
during an outbound job.

Record selection file name

Select the record selection name from the drop-down list. The Selection
parameter identifies which record selection is used for the outbound
job. The record selection contains the phone strategy used for the job.

Transfer to inbound job name

Select the transfer to inbound job name from the drop-down list of
inbound or blend job names that agents can transfer calls to.

Total wait delay (sec.)

Double-click the total wait delay field and enter in the number of
seconds (from 0 to 999) that the customer can wait in the Avaya PDS
wait queue before the system ends the call.
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Managed job settings Managed settings are settings for Managed Dialing jobs. The following
settings are listed in the MANAGED tree structure.

The following settings become active only if the MANAGED check
box is selected.

Allow dialing from deleted record

Select this option to allow an agent to dial a deleted record.

Clear the check box to prevent agents from dialing a deleted record.

This setting can only be used if the MANAGED check box is selected.

Allow agents to cancel call

Select this option to allow an agent to cancel a Managed Dialing call.

Clear this option to prevent agents from cancelling a Managed Dialing
call.

This setting can only be used if the MANAGED check box is selected.

Display empty record at preview

Select this option to allow an agent to display an empty record at
preview.

Clear this option to prevent agents from displaying empty record at
preview.

This setting can only be used if the MANAGED check box is selected.

Time limit (sec.) for preview

Double-click the time limit field and enter in a value (in seconds)
between 1 and 999. This parameter sets the time that an agent can
preview a record before the Avaya PDS dials the number. Use 0 (zero)
to set an unlimited amount of preview time.

This setting can only be used if the MANAGED check box is selected.

Allow record search type at preview

Select one of the following three options from the drop-down list:

• NONE - No search is allowed. The only way for the agent to make
a call is by manually entering a phone number.

• HASH - The search is done through the PDS QuickSearch
method. The calling list is searched until the matching record is
found.
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• LIS - The search is accomplished through the List Indexed
Sequential method. The LIS method processes the calling list into
a table that is indexed on a key field from the calling list. That key
field is specified during configuration.

This setting can only be used if the MANAGED check box is selected.

Interactive Voice Response
job settings

The INTERACTIVE VOICE RESPONSE tree structure becomes
active when its check box is selected.

IVR identifier

Double-click the field to enter the IVR identifier.

Script to run on the IVR

Double-click the field to enter the script to be used for the IVR.

Unit Work List job settings The UNIT WORK LIST tree structure becomes active when its check
box is selected.

Record selection with units

Select a unit work list record selection from the drop-down list to use
with this job.
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Create a job

Overview You are not required to run a record selection before starting a job.
Campaign Editor will automatically execute the record selection if
needed, and then verify the job. If the job verification passes, you are
offered a choice of starting the job or cancelling the action.

Create a job Use the following procedure to create a job.

............................................................................................................................................................................

1 In the Campaign Editor button bar, select a dialer, and then click Jobs.

............................................................................................................................................................................

2 Select File > New.

............................................................................................................................................................................

3 Click Next when the Campaign Editor Job Wizard appears.

............................................................................................................................................................................

4 Select the type of job to create, the appropriate outbound or inbound
calling list, and the check box next to the options you want to use: Sales
Verification, Unit Work List, Virtual, or Managed, and then click Next.

............................................................................................................................................................................

5 Type a job description, and then click Finish.
The default tree structure for your job type (inbound, outbound, blend,
etc.) appears in the right-hand pane. Use the Setting column to edit
values.
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.............................................................................................................................................................................................................................................................
View job settings

View job settings Use the following procedure to view job settings.

............................................................................................................................................................................

1 Double-click the job you want to view.
The job settings appear in the right-hand pane.
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.............................................................................................................................................................................................................................................................
Save a job

Save a job Use the following procedure to save a job.

............................................................................................................................................................................

1 Select File > Save to save the job. (If needed, provide a file name.)

............................................................................................................................................................................

2 Click OK.
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Save a job as another name or on a different dialer

Save a job as another name
or on a different dialer

Use the following procedure to save a job as another name or on a
different dialer.

............................................................................................................................................................................

1 Double-click the job you want to save.

............................................................................................................................................................................

2 Select File > Save As.
If the multi-dialer option is enabled, select additional dialers to which
you want to save the job. (If the dialer check boxes are unavailable and
you want to enable them, select Settings > Options.)

............................................................................................................................................................................

3 Type a file name for your job, and then click OK.
The job is saved to the dialer you selected in the button bar and it to any
additional dialers you selected.



Jobs

1 1 - 1 4 1

............................................................................................................................................................................................................................................................
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Start a job on one or more dialers

Start a job on one or more
dialers

Use the following procedure to start a job on one or more dialers.

............................................................................................................................................................................

1 Double-click the job you want to start.

............................................................................................................................................................................

2 Select File > Run.
If the multi-dialer option is enabled, you are asked if you want to run the
job on additional dialers. Select additional dialers on which you want to
start the job.

............................................................................................................................................................................

3 Click OK.
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Start multiple jobs on currently selected dialer

Start multiple jobs on
currently selected dialer

Use the following procedure to start multiple jobs on the currently
selected dialer.

............................................................................................................................................................................

1 Control-click the jobs you want to start.

............................................................................................................................................................................

2 Select File > Run, and then click OK.
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Copy a job

Copy a job Use the following procedure to copy a job.

............................................................................................................................................................................

1 Double-click the job you want to copy.

............................................................................................................................................................................

2 Select File > Save As.
If the multi-dialer option is enabled, select the dialer where you want to
copy a job.

............................................................................................................................................................................

3 Type a file name for the job, and then click OK.
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Edit a job

Edit a job Use the following procedure to edit a job.

............................................................................................................................................................................

1 Select File > Open.

............................................................................................................................................................................

2 Double-click the job you want to edit, and then make the necessary edits
in the right-hand pane.

............................................................................................................................................................................

3 Select File > Save to save the job.
If the multi-dialer option in enabled, select the additional dialers to save
the job to.

............................................................................................................................................................................

4 Type a file name for the job, and then click OK.
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Verify a job on one or more dialers

Verify a job on one or more
dialers

Use the following procedure to verify a job on one or more dialers.

............................................................................................................................................................................

1 Select the job you want to verify.

............................................................................................................................................................................

2 Select File > Verify.
If the multi-dialer option is enabled, you are prompted to select whether
or not to verify the job on additional dialers. Specify your preferences,
and then click OK.

............................................................................................................................................................................

3 In the This File is OK dialog box, click OK.
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Verify multiple jobs on the currently selected dialer

Verify multiple jobs on the
currently selected dialer

Use the following procedure to verify multiple jobs on the currently
selected dialer.

............................................................................................................................................................................

1 Control-click to select all the jobs you want to verify.

............................................................................................................................................................................

2 Select File > Verify.

............................................................................................................................................................................

3 Click OK in The File is OK dialog box.
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Delete a job on one or more dialers

Delete a job on one or more
dialers

Use the following procedure to delete a job on one or more dialers.

............................................................................................................................................................................

1 Select the job you want to delete.

............................................................................................................................................................................

2 Select File > Delete.
If the multi-dialer option is enabled, you are prompted to specify
whether or not to delete the job from additional dialers. Make your
selections, and then click OK.

............................................................................................................................................................................

3 When prompted, click Yes to delete the job.
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Delete multiple jobs on the currently selected dialer

Delete multiple jobs on the
currently selected dialer

Use the following procedure to delete multiple jobs on the currently
selected dialer.

............................................................................................................................................................................

1 Control-click to select the jobs you want to delete.

............................................................................................................................................................................

2 Select File > Delete.
If the multi-dialer option is enabled, you are prompted to specify
whether or not to delete the job from additional dialers. Make your
selections, and then click OK.

............................................................................................................................................................................

3 When prompted, click Yes to delete the jobs.
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List all jobs on a selected dialer

List all jobs on a selected
dialer

Use the following procedure to list all jobs on a selected dialer.

............................................................................................................................................................................

1 Select the dialer name on the button bar.

............................................................................................................................................................................

2 Click Jobs. A list of jobs on the selected dialer appears.
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12 Campaign Monitor settings

.............................................................................................................................................................................................................................................................
Overview

Purpose Campaign Monitor gives you the ability to define how data is arranged,
specify the time range, change a job on the fly, customize a view
according to completion code, customize a view according to an
agent’s state, and determine the refresh rate and the preferred saving
method.

The topics in this chapter discuss settings that are the Campaign
Monitor’s default settings. You can modify these settings during a job
from the Campaign Monitor toolbar, but unless you save these changes
to a custom view and then select that custom view from the button bar
the next time you open Campaign Monitor, your modified settings are
lost. When you start Campaign Monitor, it applies the default settings.

Contents This section contains the following topics:

• Set the default hierarchy

• Set time range

• Set job changes

• Set agent states to display

• Set view set

• Set refresh rate

• Set save on exit settings
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Set the default hierarchy

Set the default hierarchy The default hierarchy is set in the Options dialog box. The preferences
that you specify in the Options dialog box Scope tab dynamically
affect the Hierarchy Manager option on all of the view toolbars. For
some of the choices on this tab, you will need to have previously
created hierarchies using the Hierarchy Manager tool.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, select the Scope tab.

............................................................................................................................................................................

3 Under How should data be arranged, select one of the following:
Use current dialers and jobs
Use the default agent/supervisor hierarchy
Use a custom hierarchy.

............................................................................................................................................................................

4 Click OK.
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Set time range

Set the time range The time range is set in the Options dialog box. The preferences that
you specify in the Options dialog box’s Scope tab dynamically affect
the Time Scope icon on all of your views’ toolbars.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Options.

............................................................................................................................................................................

2 Under What time range should views support?, select or clear Show
data for all jobs run since the last dialer reboot, if applicable, and
then click OK.
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Set job changes

Set job changes Use the Multi-Dialer Control tab to choose which of the available
dialers you want included in your views. Use the following procedure
to set job changes.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, select the Multi-Dialer Control tab.

............................................................................................................................................................................

3 To apply job changes to all dialers, select Apply job changes to all
selected dialers, or to apply job changes to specific dialers, select the
name of the dialer to which you want to apply job changes, and then
click OK.
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Set agent states to display

Set agent states to display Use the Agent States tab to choose which agent states to display.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, select the Agent States tab.

............................................................................................................................................................................

3 Select which states to display, and then click OK.
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Set view set

Set view set Use the Appearance tab to set the view set.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, select the Appearance tab.

............................................................................................................................................................................

3 Type the view set to use, or select Browse to locate your view set, and
then click OK.
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Set refresh rate

Set refresh rate Use the Appearance tab to set a refresh rate.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, select the Appearance tab.

............................................................................................................................................................................

3 Click the up or down arrow to set the refresh interval (in seconds) for
your views, and then click OK.
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Set save on exit settings

Set save on exit settings Use the Feedback tab to choose how changes to views and view sets
are saved when the application closes.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Options.

............................................................................................................................................................................

2 In the Options dialog box, select the Feedback tab.

............................................................................................................................................................................

3 Below each choice, select when to save changes, and then click OK.
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13 Campaign Monitor navigation
and personalization

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) allows you to
customize the display of Campaign Monitor windows and navigate
among the various tool applications within Campaign Monitor.

Contents This section contains the following topics:

• User interface

• Navigate among the Tool menu applications

• Use large icons or small icons in the button bar

• Open a standard view

• Open a view or view set from another location

• Create a custom view

• Save current view

• Save as view set

• Save view set with a new name

• Delete a view set

• Add a view to the Custom button group

• Refresh a view



1 3 - 1 6 0

...........................................................................................................................................................................................................................................................

Campaign Monitor navigation and personalization

.............................................................................................................................................................................................................................................................
User interface

Overview Campaign Monitor has a button bar on the left-hand side of the screen
and an open space where your various windows (or views) appear. A
view is a window that displays when you click a button in the button
bar. In each view, you can filter information and customize your
monitoring.

Campaign Monitor screen
layout and usage

Campaign Monitor is highly customizable. The following is a sample
list of Campaign Monitor’s customizable features. In addition to these
features, you should experiment with the toolbar options in each view
to customize individual views. After you have a view set up the way
you want it, you can save it as a custom view so that it is available for
you to select from the Custom button group on the button bar. For more
information on customizing individual views using the toolbar, see
“View Control Functions.”

Button bar

The button bar works like an accordion: it expands and contracts. In
other words, when you click a button group, the group expands to
display its buttons.

To learn more about the various Campaign Monitor views and how to
customize each view, see the “Views” section.

Sort

You can sort the contents of a view by clicking a column heading.
When you click a heading, you see a small arrow appear alongside the
heading; if the small arrow is pointing up, you are sorting the data in
ascending order. If the small arrow is pointing down, then you are
sorting in descending order.

Resize columns

You can resize any column in a view by hovering your cursor between
the heading titles until a double-arrow appears. Hold down the left
mouse button while you drag your cursor to resize the columns.
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Navigate among the Tool menu applications

Navigate among the Tool
menu applications

Campaign Monitor comes with tool applications that you access from
the Tools menu. Use the following procedure to start Tool menu
applications.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Monitor.

............................................................................................................................................................................

2 To start a tool, select it from the Tools menu.
While you use the tool, Campaign Monitor remains open in the
background so that you can navigate back to it when you are finished
using the tool.
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Use large icons or small icons in the button bar

Use large icons or small
icons in the button bar

You can view large or small buttons on the button bar. Use the
following procedure to switch between large and small icons in the
button bar.

............................................................................................................................................................................

1 On the button bar, click to expand the button group whose icon size you
want to change.

............................................................................................................................................................................

2 Right-click, and then select either Large Icons or Small Icons.
A check mark next to the menu command indicates which view you are
currently using.
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.............................................................................................................................................................................................................................................................
Open a standard view

Open a standard view Use the following procedure to open a standard view in Campaign
Monitor.

............................................................................................................................................................................

1 On the Campaign Monitor button bar, click View Set, Dialer, Job,
Supervisor, Agent, or Custom.

............................................................................................................................................................................

2 Select the view you want to open.
The view opens as a new window in the right-hand pane.
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Open a view or view set from another location

Open a view or view set
from another location

Use the following procedure to open a view or view set from another
location.

............................................................................................................................................................................

1 In Campaign Monitor, select File > Open.

............................................................................................................................................................................

2 Locate and select the view or view set you want to open, or type the file
name in the File name field, and then click OK.
The view or view set opens as a new window in the right-hand pane.



Campaign Monitor navigation and personalization

1 3 - 1 6 5

............................................................................................................................................................................................................................................................
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Create a custom view

Create a custom view Use the following procedure to create a custom view.

............................................................................................................................................................................

1 In Campaign Monitor, select File > New.
The Campaign Monitor View Wizard opens.

............................................................................................................................................................................

2 Follow the steps in the View Wizard to create your custom view.
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Save current view

Save current view Use the following procedure to save a current view.

............................................................................................................................................................................

1 On the Campaign Monitor button bar, click View Set, Dialer, Job,
Supervisor, Agent, or Custom.

............................................................................................................................................................................

2 Select the button for the view you want to open.

............................................................................................................................................................................

3 Alter the view using the view’s toolbar.

............................................................................................................................................................................

4 When you have the view set up the way you want, select File > Save.
The next time you select the view, your saved preferences appear.
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Save as view set

Save as view set Use the following procedure to save a view set.

............................................................................................................................................................................

1 On the Campaign Monitor button bar, click View Set, Dialer, Job,
Supervisor, Agent, or Custom.

............................................................................................................................................................................

2 Select the button for the view you want to open.
The view opens as a new window in the right-hand pane

............................................................................................................................................................................

3 Repeat steps 1 and 2 until you have all necessary views open.

............................................................................................................................................................................

4 Select File > Save All As.

............................................................................................................................................................................

5 Type a name for your view set, and then click OK.
A button for the view set appears in the View Set group.
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Save view set with a new name

Save view set with a new
name

Use the following procedure to save a view set with a new name.

............................................................................................................................................................................

1 On the Campaign Monitor button bar, click View Set, Dialer, Job,
Supervisor, Agent, or Custom.

............................................................................................................................................................................

2 Select the button for the view set you want to open. The view set opens.

............................................................................................................................................................................

3 Select File > Save All As.

............................................................................................................................................................................

4 Type the name you want to give your view set, and then click OK.
The view set’s new name appears in the View Set button group.
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Delete a view set

Delete a view set Use the following procedure to delete a view set.

............................................................................................................................................................................

1 On the Campaign Monitor button bar, click View Set.

............................................................................................................................................................................

2 Right-click the view set you want to delete, and then select Remove
Viewset.
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Add a view to the Custom button group

Add a view to the Custom
button group

To create a button, you must have a view open in the main pane. Use
the following procedure to add a view to the Custom button group.

............................................................................................................................................................................

1 Open a view that you would like to have as a button.

............................................................................................................................................................................

2 Right-click in the button bar area and select Add View to Custom.

............................................................................................................................................................................

3 Type a name for the button, and then click OK. The view appears in the
Custom button group.
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Refresh a view

Refresh a view Use the following procedure to refresh a view.

............................................................................................................................................................................

1 With a view open, press the F5 key.
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Overview

Purpose Campaign Monitor uses the button bar (left-hand side of the window)
as the primary navigation point for opening views. You can open and
save favorite views, display views according to completion codes,
display views according to agent and supervisor relationships, and
configure alerts so that you can receive notifications from the Avaya™
Predictive Dialing System (PDS). Campaign Monitor displays views in
the main window (right-hand side of your screen).

Contents This section contains the following topics:

• Views

• Dialer Status view

• Dialer Agents view

• Dialer Lines view

• Dialer History view

• Job Status view

• Job Agents view

• Job Detail view

• Job Call Handling view

• Job Completion Codes view

• Job Wait Queues view
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• Job History view

• Job Performance view

• Supervisor Agents view

• Find Agent view

• Agent Detail view

• Agent Completion Codes view

• Agent History view
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Views

Overview A view displays information about dialers, jobs, agents, and completion
codes. In Campaign Monitor, you are able to create your views, save
them on exit, and then restore them. This allows you to display views in
the same way without having to recreate specific views.

The button bar provides a means of organizing the available views, as
well as access to those views. The button bar contains six view
categories: View Set, Dialer, Job, Supervisor, Agent, and Custom.

View toolbar description There are several view control options.

Table view

Displays the data without icons (only available if the view has two
presentation modes).

Graphic view

Displays the data with icons (only available if the view has two
presentation modes).

Filter data

Allows you to filter the data in the view according to one selected
criteria.

Performance code

(For the Job Performance View only.) Allows you to select which
completion code to use when monitoring job performance.

Hide/show columns

Allows you to select which of the available data fields appear.

Find item

Allows you to search for a text string within a view. For example,
search for a specific agent or job.

Hierarchy Manager icon

Allows you to choose the types of data that appear in the scope
selectors.
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You can choose to use no hierarchy, the default supervisor/agent
hierarchy (if one has been defined using Settings > Options), or
another custom hierarchy (if one has been defined using Settings >
Options). You can define the default supervisor/agent hierarchy and
the custom hierarchy.

Time Selector

Allows you to choose the time range for the data in the view.

Refresh

Refreshes the data in the open views.

View categories The following view categories are available in Campaign Monitor:

View set

You can create a view set that you can save and restore as a group. The
first time you click View Set, and no view set is active, the Save As
dialog box appears so you can name the set and choose its storage
location. When the dialog box closes, a button for the new view set
appears in the View Sets group on the button bar. If you change a view,
you will be asked whether the view should be saved.

Dialer views

Use the Dialer views to see Dialer Status, Dialer Agents, Dialer Lines,
and Dialer History.

Job views

Use the Job views to see Job Status, Job Agents, Job Detail, Job Call
Handling, Job Completion Codes, Job Wait Queues, Job History, and
Job Performance.

Hierarchy Scope selector 1 Scope selector 2 Scope selector 3

No hierarchy Dialer (default) Job (default) empty

Default agent/
supervisor
hierarchy

Dialer (default) Job (default) supervisor (bottom
level of the
selected hierarchy)

Custom Top level of the
selected hierarchy

Middle level of the
selected hierarchy

Bottom level of the
selected hierarchy
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Supervisor view

Use the Supervisor view to see the Supervisor Agents data.

Agent view

Use the Agent views to display Agent data.

Custom view

The custom views section will vary, depending on what you choose to
include. Campaign Monitor lets you save a customized view to the
Custom group.
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Dialer Status view

Dialer Status view The Dialer Status view displays the job, agent, and line resources used
on a dialer. The view shows the agents and lines assigned to all dialers
in the selected scope, as well as the jobs and the state of completion of
each job.

The following table describes the Dialer Status views.

Dialer Status Description

DialerID A unique identification number, automatically
assigned to a dialer, and is used to identify dialer
data in the database.

Dialer The name of a dialer in the current scope.

JobID A unique identification number, automatically
assigned to a job (by name), used to identify job
data in the database.

Job The name of each job running in the current scope.

Job Instance A unique identification number, automatically
assigned to a single instance of a job, used to
identify data associated with that job instance in the
database. Each time a job runs, the system assigns it
a new job instance ID.

Status The current status of the job (status types include
stopped, running, error, or shutting down).

Start Time The date and time the job instance started.

Stop Time The time the job instance stopped or blank if the job
is still running.

Estimated Job
End

The time that Campaign Monitor estimates the job
will end. For an inbound job, this field is empty.

Inbound
Agents

The total number of inbound agents logged in to
each job.

Outbound
Agents

The total number of outbound agents logged in to
each job.

Blend Agents The total number of blend agents logged in to each
job.
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Managed
Agents

The total number of managed agents logged in to
each job.

PTP Agents The total number of person-to-person agents logged
in to each job.

ACD Agents The total number of ACD Agents logged into each
job.

Total Agents The total number of agents logged in to each job.

Total Lines The total number of lines in use by the job.

% Complete The percentage of records called based upon the
total number of records selected for calling.

Dialer Status Description
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Dialer Agents view

Dialer Agents view The Dialer Agents view displays the agents active on one or more
dialers.

You can choose which agent states to include in the Dialer Agent view
by selecting, on the Agent States tab in the Options dialog box, the
agent states you want to view. You can further limit the agent states in a
single view by using the Filter option.

The following table describes the Dialer Agents view.

Dialer
Agents

Description

Total The total number of agents within the selected
scope.

Talk The total number of agents with status “Talk” in the
selected scope.

Update The total number of agents with status “Update” in
the selected scope.

Idle The total number of agents with status “Idle” in the
selected scope.

ACD The total number of ACD agents in the selected
scope.

Acquired The total number of acquired ACD agents in the
selected scope.

Offline The total number of offline agents in the selected
scope.

Logging Off The total number of agents that have requested log
off but are still handling calls.

Dialer The name of the dialer on which the job instance is
running.

Job The name of a currently running job. Available data
includes the names of all jobs running in the current
scope.
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Job Instance A unique identification number automatically
assigned to a single instance of a job, used to
identify data associated with that job instance in the
database. Each time a job runs, the system assigns a
new job instance ID.

Agent ID The identification number of the agent logged in to
the selected dialer.

Status The current status of the agent. Status types include
Talk, Update, Idle, ACD, Acquired, and Offline.

On Status The duration of the current status of the agent in
hh:mm:ss format.

Agent Type The type of calling activity that the agent logged in
to handle. Acceptable values include Outbound,
Inbound, and Blend.

On Job The elapsed time that the agent has been working
on a job.

Headset The headset ID or ACD extension assigned to the
agent. The system uses this data to perform audio
monitoring of an agent.

Dialer
Agents

Description
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Dialer Lines view

Dialer Lines view The Dialer Lines view displays line assignments and activity levels for
each job.

The following table describes the Dialer Lines view.

Dialer Lines Description

Dialer The name of the dialer on which the job instance is
running.

Job The name of each job running on the dialer.

JobID A unique identification number, automatically
assigned to a job (by name), used to identify job
data in the database.

Job Number The unique number, assigned by the dialer to this
instance of the job.

Job Instance A unique identification number, automatically
assigned to a single instance of a job, to help
identify data associated with that job instance in the
database. Each time a job runs the system assigns a
new job instance ID.

Lines In Use The number of lines currently in use by the job.

System Lines
in Use

The number of lines in use by the job as a
percentage of the total number of lines on the
system.
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Dialer History view

Dialer History view The Dialer History view shows dialer activity over time. The view lists
all instances of a job that have run on a dialer, regardless of the current
status of the job. For example, if Job1 runs from 8:00 until 10:30, then
restarts at 11:15, both job instances appear in the view separately. The
default value for the time selector is active data + recent data.

The following table describes the Dialer History view.

Dialer History Description

Dialer ID A unique identification number, automatically
assigned to a dialer, used to identify data related
to that dialer in the database.

Dialer The name of the dialer in the current scope.

Job The name of a job that has run during the
current time scope.

JobID A unique identification number, automatically
assigned to a job (by name), used to identify job
data in the database.

Job Instance A unique identification number, automatically
assigned to a single instance of a job, used to
identify data associated with that job instance in
the database. Each time a job runs, the system
assigns a new job instance ID.

Job Number The unique number, assigned by the dialer to
this instance of the job.

Status The current status of the job (status types
include: stopped, running, error, or shutting
down).

Start Time The time the job started.

Stop Time The time the job stopped.

Estimated Job
End

The time that Campaign Monitor estimates the
job will end. For an inbound job, this field is
empty.
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Connects The total number of connects (both inbound and
outbound) for each job instance. A subtotal
appears for each job and each dialer.

RPCs The total number of calls released as right-party
contacts (RPCs) for each job instance. A
subtotal appears for each job and each dialer.

Closures The total number of calls released as closures
for each job instance. A subtotal appears for
each job and each dialer.

Abandons The total number of calls released as abandoned
for each job instance. A subtotal appears for
each job and each dialer.

Agent Hours The total number of hours agents have logged
on to a job instance over the course of the job. A
subtotal appears for each job and each dialer.

Total Records The total number of records selected for calling.
For inbound jobs, this field is always zero.

Records Called The total number of records called during the
course of the job. A subtotal appears for each
job and each dialer.

Dialer History Description
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Job Status view

Job Status view The Job Status view displays the same data as the Dialer Resource
view, but is grouped and totaled by job.

The following table displays the Job Status view.

Job Status Description

DialerID A unique identification number, automatically
assigned to a dialer, used to identify data related to
that dialer in the database.

Dialer The name of a dialer in the current scope.

JobID A unique identification number, automatically
assigned to a job (by name), used to identify job
data in the database.

Job The job name appears in the window title bar.

Job Instance A unique identification number, automatically
assigned to a single instance of a job, used to
identify data associated with that job instance in the
database. Each time a job runs, the system assigns a
new job instance ID.

Status The current status of the job (status types include:
stopped, running, error, or shutting down).

Start Time The time the job started running.

Stop Time The time the job stopped running.

Estimated Job
End

The time that Campaign Monitor estimates the job
will end. For an inbound job, this field is empty.

Inbound
Agents

The total number of inbound agents logged in to
each job.

Outbound
Agents

The total number of outbound agents logged in to
each job.

Blend Agents The total number of blend agents logged in to each
job.

Managed
Agents

The total number of managed agents logged in to
each job.
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PTP Agents The total number of PTP agents logged in to each
job.

ACD Agents The total number of ACD agents logged in to each
job.

Total Agents The total number of agents within the selected
scope.

Total Lines The number of lines currently in use by each job.

% Complete The percentage of records called based upon the
total number of records selected for calling.

Job Status Description
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Job Agents view

Job Agents view The Job Agents view displays the same data as the Dialer Agents view,
but groups the data by job. If you select All from the first scope selector
and Job2 from the second scope selector, the view displays a summary
of data for all jobs called Job2 on all dialers.

You can choose the agent states that you want to include in the Job
Agent view by selecting, on the Agent States tab in the Options dialog
box, the states you want to view. You can limit the agent states in a
single view by using the Filter.

The following table describes the Job Agents view.

Job
Agents

Description

Total The total number of agents within the selected scope.

Talk The total number of agents with status “Talk” in the
selected scope.

Update The total number of agents with status “Update” in the
selected scope.

Idle The total number of agents with status “Idle” in the
selected scope.

ACD The total number of ACD agents in the selected
scope.

Acquired The total number of acquired ACD agents in the
selected scope.

Offline The total number of offline agents in the selected
scope.

Logging
Off

The total number of agents that have requested a log
off, but are still handling calls.

Dialer The name of the dialer.

Job The name of a currently running job. Available data
includes the names of all jobs in the current scope.
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Job
Instance

A unique identification number, automatically
assigned to a single instance of a job, used to identify
data associated with that job instance in the database.
Each time a job run, the system assigns a new job
instance ID.

Agent ID The identification number of the agent logged in to
the selected dialer.

Agent The name of an agent logged into the selected dialer.

Status The current status of the agent. Status types include
Talk, Update, Idle, ACD, Offline, off job, and logging
off.

On Status The duration of the current status of the agent in
hh:mm:ss format.

Agent Type The type of calling activity that the agent logged in to
handle. Acceptable values include Outbound,
Inbound, Blend.

On Job The elapsed time that the agent has actually been
working on a job.

Headset The headset ID or ACD extension assigned to the
agent. The system uses this data to perform audio
monitoring of an agent.

Job
Agents

Description
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Job Detail view

Job Detail view The Job Detail view displays detailed information about the
performance of a job, including connect, RPC, and closure rates. It also
displays static operational information about the job, as well as the
current setting of various runtime parameters.

Because the Job Detail view is the lowest-level view of a job, data is
not summed over time or dialers. Instead, it is information about a
single instance of a job. For historical or summary information about a
job, see the Job History view.

The following table describes the Job Detail view.

Job Detail Description

Job Name The job name appears in the window title bar.

Job Number The unique number assigned to this instance of the
job by the dialer.

Dialer The name of the dialer on which the job instance is
running.

Status The current status of the job (status types include:
stopped, running, error, or shutting down).

Selection The name of the file that defines which records will
be available for calling. If the job is inbound, this
field is blank.

Strategy The name of the file that defines which records will
be available for calling. If the job is inbound, this
field is blank.

Expert
Calling
Ratio

The Expert Calling Ratio defined for the job. If the
job is inbound, this field is blank.

Running Hit
Rate

The overall hit rate (percentage of call completions
measured against call attempts) for the job calculated
from job start to the present.

Current Hit
Rate

The hit rate for the job over the last five to ten
minutes. The Avaya PDS uses this figure to make
adjustments in the Expert Calling Ratio.
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Inbound
Connects

The total number of inbound calls connected.

Inbound
Connects
per Hr

The average number of inbound connects per hour.
The value is calculated by dividing the total number
of inbound connects by the total Online Time (Online
Time is the elapsed time since the job instance
began).

Outbound
Connects

The total number of outbound calls connected.

Outbound
Connects
per Hr

The average number of outbound connects per hour.
The value is calculated by dividing the total number
of outbound connects by the total Online Time.

Total
Connects

The total number of inbound and outbound connects
for the job.

Start Time The time the job started running.

Time Left The estimated time remaining to complete calling for
the job. For an inbound job, this field is empty.

Total
Records

The total number of records selected for calling. For
inbound jobs, this field is always zero.

Total Calls The total number of calls made or handled for the job,
including both inbound and outbound calls.

Records
Left

The number of eligible records not yet called for the
job. For inbound jobs, this field is always zero.

Total RPCs The total number of RPCs currently recorded.

RPCs per
Connect

The number of RPCs as a percentage of the total
number of connects. This value is calculated by
dividing the total RPC connects by total agent
connects.

% Complete The percentage complete for the job. This value is
calculated by dividing the total records called by total
records selected for calling. An outbound job will
never appear as 100% complete unless all records are
called. Inbound jobs always appear as 100%
complete.

Job Detail Description
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Records
Called

The total number of records that have been called (or
completed).

Connects/
Call

The percentage of calls that resulted in a connect.

RPCs Per
Connect

The percentage of connects that resulted in an RPC.

Closures
Per Connect

The percentage of connects that resulted in a closure.

Closures
Per RPC

The percentage of RPCs that resulted in a closure.

Job Detail Description
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Job Call Handling view

Job Call Handling view The Job Call Handling view displays how much time each agent spends
talking to customers, updating records, and waiting for the next call.
For example, select All on the first scope selector and Job1 on the
second scope selector to display all agents logged onto Job1, on any
dialer.

The following table describes the Job Call Handling view.

Job Call Handling Description

Agent Name The name of the agent logged on to a specific
job.

Agent ID A unique identification number assigned to
each agent by the database.

Agent Type The type of calling activity the agent logged
in to handle. Acceptable values include
Outbound, Inbound, Blend.

Connects Per Hour The total number of connects per hour in the
selected scope.

Average Talk The average time agents of a specific agent
type spend talking on each call.

Average Idle The average time agents of a specific agent
type spend waiting between calls.

Average Update The average time agents of a specific agent
type spend updating records.

Average Preview The average time a managed agent spends
previewing records. (For managed agents
only.)

Duty Cycle The ratio of the average time spent talking
and updating to the total time from the
beginning of one call to the beginning of the
next call.
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Job Completion Codes view

Job Completion Codes
view

The Job Completion Codes view displays completion codes used
during the job. Additional information includes the total number of
calls, connects, and RPCs; the per hour number of calls, connects, and
RPCs; and the number of RPCs per connect.

The following table describes the Job Completion Codes view.

Job
Completion
Codes

Description

Closure A check mark indicates that you have defined the
code as a closure in the Completion Code
Manager.

Code The unique identification number associated with
each completion code.

RPC The number of records released with this code as
a percentage of the total number of RPCs. (For
codes marked as RPC only.)

Abandon A check mark indicates that you have defined the
code as an abandon in the Completion Code
Manager.

Name The user-defined name or description assigned to
each code. This description is defined by the user
in the Completion Code Manager.

Total The total calls made by the dialer in the selected
scope.

Avg/Hr The average number of calls released with a
completion code during an hour.

RPC % For each code designated as an RPC, the
percentage of connects recorded for each
completion code based on the total number of
RPCs for the job.
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Note

You define which codes are abandons using Completion Code
Manager. By default, codes 45 and 47 are inbound abandons and 46
and 48 are outbound abandons.

Campaign Monitor always uses the definitions that were in effect when
the job began. If you change any of the completion code descriptions,
you will not see the changes until the next time the job runs.

Closure % The percentage of closures recorded for each
completion code based on the total number of
RPCs for the job.

% of Calls The number of calls recorded for each code as a
percentage of the total number of calls for the
job.

Job
Completion
Codes

Description
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Job Wait Queues view

Job Wait Queues view The Job Wait Queues view displays information about calls directed to
the wait queue during a job, including the number of calls currently in
queue, the number abandoned, and the average wait time for each call.
A historical graph displays the total calls added to the queue at 15-
minute intervals for the job instance selected in the upper part of the
view.

Note

You define which codes are abandons using Completion Code
Manager. By default, codes 45 and 47 are inbound abandons and 46
and 48 are outbound abandons.

The following table describes the Job Wait Queues view.

Job Wait
Queues

Description

Job The name of each job running in the current scope.

JobID A unique identification number, automatically
assigned to a job (by name), used to identify job
data in the database.

Dialer The name of the dialer on which the job instance is
running.

Dialer ID A unique identification number, automatically
assigned to a dialer, and is used to identify dialer
data in the database.

Inbound In
Queue

The total number of inbound calls currently in the
wait queue.

Outbound In
Queue

The total number of outbound calls currently held
in the wait queue.

Total In Queue The total number of calls currently in the wait
queue. The total is also broken down by call type,
either inbound or outbound.

Inbound
Queue Total

The total number of inbound calls that have spent
time in the wait queue since the job began.
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Outbound
Queue Total

The total number of outbound calls that have spent
time in the wait queue since the job began.

Queue Total The total number of calls, both inbound and
outbound, that have spent time in the wait queue.

Avg Inbound
Wait Time

The average number of minutes and seconds that
an inbound call spends in the wait queue in the
mm:ss format.

Avg Outbound
Wait Time

The average number of minutes and seconds that
an outbound call spends in the wait queue in the
mm:ss format.

Avg Wait Time The average time calls (inbound, outbound) spent
in the wait queue. The total figure is a weighted
average of inbound and outbound wait times.

Inbound
Connects

The total number of inbound calls connected to an
agent.

Outbound
Connects

The total number of outbound calls connected to
an agent.

Total Connects The total number of calls, both inbound and
outbound, connected to an agent.

Inbound Calls
Answered

The total number of inbound calls answered by the
dialer. (This number includes all inbound calls
connected to an agent plus all inbound calls
abandoned in the wait queue.)

Outbound
Calls
Answered

The total number of outbound calls answered by a
client. (This number includes all outbound calls
connected to an agent plus all outbound calls
abandoned in the wait queue.)

Outbound
Calls Placed

The total number of outbound calls dialed,
regardless of the final outcome of the call (i.e.,
abandoned or connected).

Inbound
Abandoned

The total number of inbound calls abandoned by
the client or by the system.

Outbound
Abandoned

The total number of outbound calls abandoned by
the client or by the system.

Job Wait
Queues

Description
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Total
Abandoned

The total number of calls marked with a
completion code that has been defined as an
“abandon.”

% Abandoned
Per Inbound
Connect

The total number of abandoned calls divided by
the total number of inbound connects and
multiplied by 100.

% Abandoned
Per Outbound
Connect

The total number of abandoned calls divided by
the total number of outbound calls and multiplied
by 100.

% Abandoned
Per Total
Connects

The total number of abandoned calls divided by
the total number of connects and multiplied by
100.

% Abandoned
Per Inbound
Calls
Answered

The total number of abandoned calls divided by
the sum of the total inbound connects and the total
number of inbound calls abandoned.

% Abandoned
Per Outbound
Calls
Answered

The total number of abandoned calls divided by
the sum of the total number of outbound connects
and the total number of outbound calls abandoned.

% Abandoned
Per Total Calls
Answered

The total number of abandoned calls divided by
the sum of the total number of connects and the
total number of system abandons (codes 45-48).

% Abandoned
Per Outbound
Calls Placed

The total number of abandoned calls divided by
the total number of outbound calls placed.

Job Wait
Queues

Description
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Job History view

Job History view The Job History view displays the same information as the Dialer
History view grouped by job, rather than dialer.

The following table displays the Job History view.

Job History Description

Dialer ID A unique identification number, automatically
assigned to a dialer, used to identify data related to
that dialer in the database.

Dialer The name of the dialer in the current scope.

Job The name of a job that has run during the current
time scope.

Job ID A unique identification number, automatically
assigned to a job (by name), used to identify job
data in the database.

Job Number The unique number assigned to this instance of the
job by the dialer.

Job Instance A unique identification number, automatically
assigned to a single instance of a job, used to help
identify data associated with that job instance in
the database. Each time a job runs, the system
assigns a new job instance ID.

Status The current status of the job (status types include:
stopped, running, error, or shutting down).

Start Time The time the job started.

Stop Time The time the job stopped.

Estimated End
Time

The time that Campaign Monitor estimates the job
will end. For an inbound job, this field is empty.

Connects The total number of connects (both inbound and
outbound) for each job instance. A subtotal
appears for each job and each dialer.

RPCs The total number of calls released as right-party
contacts (RPCs) for each job instance. A subtotal
appears for each job and each dialer.
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Closures The total number of calls released as closures for
each job instance. A subtotal appears for each job
and each dialer.

Abandons The total number of calls released as abandoned
for each job instance. A subtotal appears for each
job and each dialer.

Agent Hours The total number of hours agents have logged on
to a job instance over the course of the job. A
subtotal appears for each job and each dialer.

Total Records The total number of records selected for calling.
For inbound jobs, this field is always zero.

Records Called The total number of records called during the
course of the job. A subtotal appears for each job
and each dialer.

Job History Description
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Job Performance view

Job Performance view The Job Performance view compares agent performance on a selected
completion code. The code the system uses for comparison appears at
the top of the view. The view also includes Total Releases, Average Per
Hour, and the names of the highest and lowest performers. You can
change the comparison code by clicking Performance Code. A red
line drawn through the bar charts indicates the current average value
for the code.

The following table describes the Job Performance view.

Job Performance Description

Completion Code The completion code used to compare agent
performance.

Average Per Hour The average number of calls released with
this code by a single agent.

Average Total The average number of calls released with
this code by a single agent.

Highest Performer The name of the agent with the best
performance.

Lowest Performer The name of the agent with the lowest
performance.

Agent The name of the agent. This list of agents
includes all of the agents assigned to the
job.

Agent ID A unique identification number assigned to
each agent by the database.

Total The total number of calls released with this
code by an agent.

Per Hour The average number of calls released with
this code in an hour by this agent.
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Supervisor Agents view

Supervisor Agents view The Supervisor Agents view displays the same data as the Dialer
Agents view, but groups the data by job. This view is only available if
you have defined a supervisor-agent hierarchy and selected that
hierarchy as the default supervisor-agent hierarchy using Settings >
Options.

You can choose which agent states should be included in the Supervisor
Agent view by selecting, on the Agent States tab in the Options dialog
box, the states you want to view. You can further limit the agent states
in a single view by using the Filter icon.

The following table describes the Supervisor Agents view.

Supervisor
Agents

Description

Total The total number of agents within the selected
scope.

Talk The total number of agents with status “Talk” in the
selected scope.

Update The total number of agents with status “Update” in
the selected scope.

Idle The total number of agents with status “Idle” in the
selected scope.

ACD The total number of ACD agents in the selected
scope.

Acquired The total number of acquired ACD agents in the
selected scope.

Offline The total number of offline agents in the selected
scope.

Logging Off The total number of agents that have requested log
off, but are still handling calls.

Dialer The name of the dialer.

Job The name of a currently running job. Available data
includes the names of all jobs running in the current
scope.
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Job Instance A unique identification number, automatically
assigned to a single instance of a job, used to
identify data associated with that job instance in the
database. Each time a job runs, the system assigns a
new job instance ID.

Agent The name of an agent logged into the selected
dialer.

Agent ID The identification number of the agent logged in to
the selected dialer.

Status The current status of the Agent. Status types include
Talk, Update, Idle, ACD, Offline, off job, and
logging off.

On Status The duration of the current status of the agent in
hh:mm:ss format.

Agent Type The type of calling activity the agent is logged in to
handle. Acceptable values include Outbound,
Inbound, and Blend.

On Job The amount of time the agent has been on the job in
hh:mm:ss format.

Headset The headset ID or ACD extension assigned to the
agent. The system uses this data to perform audio
monitoring of an agent.

Supervisor
Agents

Description
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Find Agent view

Find Agent view The Find Agent view helps you locate one or more agents by name,
dialer, supervisor, or job. The results appear in a grid at the bottom of
the dialog box. You can select one or more agents from the result list
and perform any of the actions on the Find Agent toolbar.

The following table displays the Find Agent view.

Find Agent Description

Agent The name of the agent to search for, or a wildcard
character (*).

Status The current status of the agent or activity and the
duration of the status. Status types include Talk,
Update, Idle, ACD, Offline, logging off, and off job.

Dialer The name of one or more dialers on which to search.
Also available as a column.

Job The name of one or more jobs to limit the search.
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Agent Detail view

Agent Detail view The Agent Detail view displays detailed information about the current
activity and performance of an agent.

The following table describes the Agent Detail view.

Agent Detail Description

Name The name of the agent appears in the title bar.

Dialer The name of the dialer on which the agent is
working.

Supervisor The name of one or more supervisors to limit the
search. This is only valid if you define an agent/
supervisor hierarchy. See note under Supervisor
Agents view.

Job The name of the job on which the agent is
working.

Status The current status of the agent or activity and the
duration of the status. Status types include Talk,
Update, Idle, ACD, Offline, off job, and logging
off.

Agent Type The type of calling activity the agent is logged in
to handle. Acceptable values include Outbound,
Inbound, and Blend.

Current Type The type of calling activity in which the agent is
currently engaged. This data is significant for
agents that log in as blend, but are normally
engaged in either Inbound or Outbound activity.
Their agent type is Blend, but their current type
varies between Outbound and Inbound.
Similarly, for agents that have logged in as
ACD, both agent type and current type change to
Outbound once the agent has been acquired.

Last Released The last time an ACD agent was released to
inbound.

Last Acquired The last time an ACD agent was acquired for
outbound calling.
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Total Talk The total time spent talking on the job.

Total Update The total time spent updating records.

Total Preview The total time spent waiting for a call.

Total Idle The total time spent waiting for a call.

Average Talk -
This Agent

The average time spent talking on each call. The
data appears as a number and as a section of the
pie.

Average Talk -
Average Agent
of This Type

The average time spent talking on each call by
agents of the same type. The data appears as a
number and as a section of the pie chart.

Average Idle -
This Agent

The average time the agent spent waiting
between calls. The data appears as a number and
as a section of the pie chart.

Average Idle -
Average Agent
of This Type

The average time spent waiting between calls by
agents of the same type. The data appears as a
number and as a section of the pie chart.

Average preview
- this agent

The average time spent previewing records. The
data appears as a number and as a section of the
pie chart. (Managed agents only.)

Average Update
- this Average
Agent of This
Type

The average time spent updating records by
agents of the same type.

AverageUpdate -
this agent

The average time spent updating records by this
agent.

Average preview
- average agent
of this type

The average time spent previewing records by
agents of the same type. The data appears as a
number and as a section of the pie chart.
(Managed agents only.)

Agent Detail Description
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Duty Cycle -
This Agent

The average ratio between time spent talking
and updating a record and the time from the
beginning of one call to the beginning of the
next call.

Duty Cycle -
Average Agent
of This Type

The average duty cycle for agents of the same
type.

Agent Detail Description
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Agent Completion Codes view

Agent Completion Codes
view

The Agent Completion Codes view displays the calling results in terms
of completion codes. Additional information includes the total number
of calls, connects, and RPCs; the per hour number of calls, connects,
and RPCs; and the number of RPCs per connect.

The following table displays the Agent Completion Codes view.

Agent
Completion
Codes

Description

Connects The total number of connects for this agent.

RPCs The total number of RPCs for this agent.

Closures The total number of closures for this agent.

Code The unique identification number associated with
each completion code.

RPC A check mark indicates the code is an RPC.

Closure A check mark indicates the code is a closure.

Name The user-defined name or description assigned to
each code.

Total The total number of calls released with each
completion code.

Avg/Hr The average number of calls released with a
completion code during an hour.

Type Avg/Hr The average number of calls released by a specific
type of agent with a completion code during an hour.

% of RPCs For each code designated as an RPC, the percentage
of connects recorded for each completion code based
on the total number of RPCs for the job. See Job
Completion Codes view.
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% of
Closures

For each code designated as a closure, the
percentage of connects recorded for each completion
code based on the total number of closures for the
job. See Job Completion Codes view.

% of Calls The number of calls recorded for each code as a
percentage of the total number of calls for the job.
See Job Completion Codes view.

Agent
Completion
Codes

Description



Campaign Monitor views

1 4 - 2 0 9

............................................................................................................................................................................................................................................................

.............................................................................................................................................................................................................................................................
Agent History view

Agent History view The Agent History view displays detailed information about the past
activity and performance of an agent.

The following table displays the Agent History views.

Agent History Description

Agent The name of the agent logged in to the selected
dialer.

Agent ID The identification number of the agent logged in to
the selected dialer.

Dialer The name of the dialer in the current scope.

Dialer ID A unique identification number, automatically
assigned to a dialer, used to identify data related to
that dialer in the database.

Job The name of a job runs during the current time
scope.

JobID A unique identification number, automatically
assigned to a job (by name), used to identify job
data in the database.

First Login The date and time the agent first logged on to a job
in yyyy/mm/dd hh:mm:ss format.

Last Logout The date and time the agent last logged off of a job
in yyyy/mm/dd hh:mm:ss format.

Agent Hours The total number of hours agents have logged on to
a job instance over the course of the job. A subtotal
appears for each job and each dialer.
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.............................................................................................................................................................................................................................................................
Overview

Purpose A view is the name given to the customizable window that appears in
the main area of Campaign Monitor after you click a button on the
button bar. This section describes how to use views in Campaign
Monitor.

Contents This section contains the following topics:

• View control toolbar

• Filter data in a view

• Select a performance code

• Set scope selectors

• Scope selectors examples

• Select a time range

• Select a hierarchy

• Hide or show columns

• Select Table View or Graphical View

•  Save a view as HTML
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View control toolbar

Toolbar buttons within a
View

Every view opens with a set of tools that help you manipulate the data
in a View. The available options vary depending the view. For example,
the time selector option does not appear if time scoping is not allowed
for data in a view.

View tool Button Description

Table View If the view has two presentation
modes (graphical and table) this
button displays the data without
icons (not available for all
views).

Graphical
View

If the view has two presentation
modes (graphical and table) this
button displays the data by
showing icons (not available for
all views).

Filter Data Displays a dialog box that allows
you to filter the data in the view
according to one selected
criteria.

Performance
Code

Displays a dialog box that allows
you to select a completion code
to use to measure agent
performance.

Hide/Show
Columns

Displays a dialog box that allows
you to select which of the
available data fields will be
displayed.

Find Allows you to search for an item
in a view.

Level 1 Scope
Selector

A drop-down list that allows you
to limit the amount of data in the
display.
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Level 2 Scope
Selector

The choices in this list depend on
the choice made in the Level1
Scope Selector.

Level 3 Scope
Selector

The choices offered in this list
depend on the choices made in
the Level1 and Level2 Scope
Selectors.

Hierarchy
Manager

A pull-down list that allows you
to select the types of data that
will appear in the Scope
Selectors.

Time Scope A pull-down list that lets you
select the time range for the data
displayed in the view.

Refresh view Allows you to refresh a view.

View tool Button Description
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Filter data in a view

Filter data in a view Use the following procedure to filter data in a view.

............................................................................................................................................................................

1 With a view open, click Filter Data. The Filter Data dialog box appears.

............................................................................................................................................................................

2 Select a column from the list. The options in this list are the column
headings for the selected view.

............................................................................................................................................................................

3 From the Operator list, select an operator.

............................................................................................................................................................................

4 In the Value box, type a value, and then click OK.
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Select a performance code

Select a performance code The performance code option is available only from the Job
Performance view. Use the following procedure to select a performance
code.

............................................................................................................................................................................

1 From the Job Performance view, click Performance Code. (You may
then be prompted to use the scope selector drop-down lists on the view
toolbar to select a single dialer and a single job.) The Performance
Completion Code dialog box appears.

............................................................................................................................................................................

2 Select a code, and then click OK. Campaign Monitor uses the selected
code to measure agent performance.

Note

The Performance Completion Code dialog box lists a set of completion
codes. For each code, the system displays the RPC, Closure, and
Abandon attributes and a description. The RPC, Closure, and Abandon
attributes are based on Completion Code Manager settings when the
job started. The description, however, reflects the current completion
code description from Completion Code Manager.
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Scope selectors examples

Overview The three drop-down lists in the view toolbar are called scope selectors.
They are used along with the Hierarchy Manager toolbar button. The
option you select using the Hierarchy Manager toolbar button
dynamically changes the available options in the three scope selectors.
From left-to-right, the default scope selectors are dialer and job. The
scope selector feature allows you to alternately narrow and broaden the
range of data displayed in a view. You can select one or all items from
each selector.

Note

A list of supervisors appears in the third scope selector only if you have
defined an agent-supervisor hierarchy using the Hierarchy Manager
tool (Tools > Hierarchy Manager) and designated that hierarchy as
the default hierarchy in Campaign Monitor (Settings > Options).

Example One

Set the first selector to All Level 1, the second selector to All Level 2,
and the third selector to All Level 3. The view displays data for all
dialers, all jobs, and all supervisors. If you change the dialer selector to
DialerA, Campaign Monitor removes the data for all other dialers from
the view.

Example Two

If the first selector is set to All Level 1 and the second selector is set to
30Day, the view displays data for all jobs named 30Day regardless of
the dialer on which the jobs reside.
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Set scope selectors

Set scope selectors Set the scope using the three drop-down lists available from any view
toolbar. The options in the lists are determined by the default hierarchy
selections and by using the Hierarchy Manager toolbar button. From
left-to-right, the default scope selectors are dialer and job. The scope
selector feature allows you to alternately narrow and broaden the range
of data displayed in a view.

............................................................................................................................................................................

1 With a view open, click the arrow to the right of the Hierarchy
Manager button and select one of the following: No hierarchy, Use
default hierarchy, or Use custom hierarchy.

............................................................................................................................................................................

2 From the first scope selector, select an item. By default, a list of dialer
names appear. If you selected Use custom hierarchy, the top-level items
of the selected hierarchy appear in this list.
The item you select in the first scope selector typically reduces the
options available in the second scope selector. You can select All Level
1, which does not narrow your view’s scope.

............................................................................................................................................................................

3 From the second scope selector, select an item. By default, a list of job
names appear. If you selected Use custom hierarchy, the middle-level
items of the selected hierarchy appear in this list.
The item you select typically narrows the options available in the third
scope selector. You can select All Level 2, which does not narrow your
view’s scope.

............................................................................................................................................................................

4 From the third scope selector, select an item. By default, the third scope
selector contains no options except All Level 3. If you selected either
Use default hierarchy or Use custom hierarchy, the bottom-level items
of the selected hierarchy appear in this list.
The All Level 3 value does not narrow your view’s scope.
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Select a time range

Select a time scope You can expand the default time view of current data only (for
example, running jobs and active agents) to include recently run jobs
(for example, since last dialer restart).

For example, change the time scope setting to display a view showing
right party contacts for all instances of Job1 that have run during a
single day.

Time selection is limited to views and data fields where summing
makes sense. For example, non-numerical data is not summed.
Similarly, data whose value is transient (for example, minimum hit
rate) is not summed.

Select a time range Set the time range for your view by clicking the arrow to the right of
Time Scope on any view toolbar.

............................................................................................................................................................................

1 With a view open, click the arrow to the right of Time Scope.

............................................................................................................................................................................

2 From the list, select Active Data or Active+Recent Data.
Active Data means that your view will only display data for currently
running jobs. Active+Recent Data will display data for currently
running jobs and jobs that have run during a single day.
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Select a hierarchy

Select a hierarchy Click the arrow to the right of Hierarchy Manager (located on any
view toolbar) and select the hierarchy items that populate the lists in the
scope selectors. In turn, the options you select in the scope selectors
can narrow or broaden the scope of the data displayed in your views.

............................................................................................................................................................................

1 With a view open, click the arrow to the right of Hierarchy Manager.

............................................................................................................................................................................

2 From the list, select No Hierarchy, Use default hierarchy, or Use
custom hierarchy.
The No Hierarchy option sets the scope selectors back to their default
settings. The first scope selector lists dialers, the second scope selector
lists jobs, and the third scope selector contains no items except All Level
3.
The Use default hierarchy option allows you to use your default
hierarchy that you specify through Settings > Options. The bottom-
level items of the selected hierarchy appear in the third scope selector
list.
The Use custom hierarchy allows you to use the custom hierarchy that
you specify through Settings > Options. The top-, middle-, and bottom-
level items of the selected hierarchy populate the first, second, and third
scope selectors, respectively.
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Hide or show columns

Hide or show columns Use the following procedure to hide or show columns. This allows you
to customize your view to display only the columns you want.

............................................................................................................................................................................

1 With a view open, click the Hide/Show columns button.

............................................................................................................................................................................

2 Clear a column’s check box to hide a column in your current view. Select
a check box to show a column in your current view.
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Select Table View or Graphical View

Select Table View or
Graphical View

Use the following procedure to display views in table or graphical
form. Table view is the default.

............................................................................................................................................................................

1 With a view open, click the Graphic View button to switch to a view
that uses icons.

............................................................................................................................................................................

2 With a view open, click the Table View button to switch to a view that
does not display icons of the data in your view.
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Save a view as HTML

Save a view as HTML Use the following procedure to save your view as HTML.

............................................................................................................................................................................

1 In Campaign Monitor, select the view to save as HTML.

............................................................................................................................................................................

2 Select File > Save as HTML. Campaign Monitor opens a new window
with the HTML output.
By default, the HTML file will be saved to
C:\Program Files\Avaya\Campaign Director\Monitor\View Name.html.
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16 Job control functions

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) allows you to adjust job
settings while a job is running. You make these adjustments through the
Campaign Monitor Tools menu. The new settings expire when the job
ends.

The job controls are available from any view that displays a list of jobs,
such as the Job Status view or the Job Wait Queue view.

Contents This section contains the following topics:

• Stop a job

•  Link to job

• Minimum hit rate

• Expert calling ratio

• Inbound settings

• Reassign lines

• Managed Dialing

• Time zones

• Unit Work Lists

• Detection modes

• Alternate initial
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• Recalls
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Stop a job

Stop a job Use the following procedure to stop a job.

............................................................................................................................................................................

1 In Campaign Monitor, open a view that lists jobs, and then select the job
you want to stop.

............................................................................................................................................................................

2 Select Tools > Stop Job. The Stop Job dialog box appears.

............................................................................................................................................................................

3 Select one of the following two options:

............................................................................................................................................................................

4 Click OK. A dialog box appears asking you Are you sure?

............................................................................................................................................................................

5 Click Yes to stop the job.

Shutdown gracefully as
agents complete calls

Allows you to stop a job after the agents
complete their current calls. This option
allows the agents to end their current
calls and release the records. This is the
typical method.

Stop job immediately Allows you to stop a job immediately.
The Avaya PDS disconnects all phone
conversations and closes the records
immediately. As a result, agents cannot
finish speaking with a customer or
update customer records.
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Link to job

Link to job Use the Link to job option to identify a job to start automatically when
the current job completes. When you link a job, the system transfers
agents to the next job as the agents complete their last calls and release
the records. The system displays a message telling the agents that they
are changing jobs. For rules regarding linking jobs, see “Job Settings”
located in the Jobs section.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Link to Job.

............................................................................................................................................................................

3 Select a job, and then click OK.
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Minimum hit rate

Minimum hit rate The minimum hit rate determines the maximum number of calls the
Avaya PDS will make as it attempts to make an agent connection. For
example, a minimum hit rate of 30% means the system will make no
more than three dialing attempts for each agent. This prevents the
Avaya PDS from allocating more pooled lines to a poorly performing
job at the expense of a more successful job.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Minimum Hit Rate.

............................................................................................................................................................................

3 Use the slider or type a value from 1 to 100 in increments of 10, and then
click OK.
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Expert calling ratio

Expert calling ratio Expert calling ratio changes the way the Avaya PDS system predicts
when to make the next call. You can select any of the following three
ratios: Callers in the wait queue, Agent Work Time, or Agent
Update time. If you are currently experiencing a high abandonment
rate, you may want to lower the percentage; if your agents are
experiencing large amounts of idle time you may want to increase the
percentage. This rule is true using any of the three ratios.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Expert Calling Ratio.

............................................................................................................................................................................

3 Click the Expert Calling Mode field and select either Callers in the
wait queue, Agent update time, or Agent work time.

............................................................................................................................................................................

4 Double-click the Value field and enter a value from 0 to 100 in
increments of 10, and then click OK.
Wait at least 15 minutes before changing your expert calling ratio again
because your change will not be noticeable to you for at least that long.
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Inbound settings

Inbound settings Use this menu command to adjust your inbound settings.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select an inbound or blend job, and then select Tools > Inbound
Settings.

............................................................................................................................................................................

3 Double-click the Value field to enter settings, and then click OK.
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Reassign lines

Reassign lines When you reassign lines, you alleviate congestion on certain Avaya
PDS lines so that your jobs run more quickly.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Reassign Lines.

............................................................................................................................................................................

3 A check indicates that the line group is activate (in use). Click to select
or clear line groups as needed, and then click OK.
Use the Activate All button to select all of the line groups. Use the
Deactivate All button to clear all of the line groups.
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Managed Dialing

Managed Dialing Managed jobs allow agents to preview a customer’s record prior to
beginning their conversation with the customer. For more information
on Managed Dialing settings, see “Job Settings” in the Job section.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a Managed Dialing job, and then select Tools > Managed
Dialing.

............................................................................................................................................................................

3 Modify agents’ preview time setting by typing a different value in the
Time Limit box.

............................................................................................................................................................................

4 Select Allow agent to cancel calls to immediately allow agents to
cancel calls, and then click OK.
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Time zones

Time zones Select the check box if you want the Avaya PDS to sort calls by times
zones.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Time Zones.

............................................................................................................................................................................

3 Clear time zones you do not want to call, and then click OK.
Click Activate All to select all time zones. Click Deactivate All to clear
all time zones.
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Unit Work Lists

Unit Work Lists A unit work list creates a sub-list in a job so that certain agents can be
assigned to a unit work list and, therefore, receive only certain calls.
For example, you can set up a unit work list in a job so that Spanish-
speaking customers are routed only to Spanish-speaking agents.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Unit Work Lists.

............................................................................................................................................................................

3 Clear or select a unit work list for the currently running job, and then
Click OK.
Click Activate All to select all unit IDs. Click Deactivate All to clear
all unit IDs.
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Detection modes

Detection modes Use the Detection Mode option to determine the types of calls the
Avaya PDS passes to agents. For more information on detection modes,
see “Call detection mode settings” in the Phone Strategies section.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Detection Modes.

............................................................................................................................................................................

3 Click the Phone field to select a phone.

............................................................................................................................................................................

4 Double-click the Rings field to type a different number of rings.

............................................................................................................................................................................

5 To add a phone, click Add Phone, and then repeat steps 3 and 4 to edit
the fields.

............................................................................................................................................................................

6 To remove a phone, select the phone you want to delete, click Remove
Phone, and then click OK.
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Alternate initial

Alternate initial The alternate initial phone replaces the initial phone as the first phone
number to call at a particular time of day. The system begins to call the
alternate initial phone number at the time you specify in the alternate
initial phone settings. For more information, see “Alternate Initial
Phone Settings” in the Phone Strategies section.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Alternate Initial.

............................................................................................................................................................................

3 Click the Phone field to select a phone.

............................................................................................................................................................................

4 Double-click the Local Time to edit the time. To toggle between AM
and PM, select it, and then use your up and down arrows.

............................................................................................................................................................................

5 Click the Time Zones field, and then click the button to display the list
of time zones. Select the time zones you want to call.

............................................................................................................................................................................

6 Click Add Phone to append a row, and then configure the new alternate
initial phone’s settings.
To remove a phone, select the phone you want to remove, and then click
Remove Phone.

............................................................................................................................................................................

7 Click OK.
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Recalls

Recalls Use the recalls setting to determine how long the Avaya PDS waits
before recalling a number, how many times it recalls the same phone
number, and which phone it calls next.

............................................................................................................................................................................

1 Open a Campaign Monitor view that lists jobs.

............................................................................................................................................................................

2 Select a job, and then select Tools > Recalls.

............................................................................................................................................................................

3 Double-click the various fields on the Recalls dialog box to edit the
recalls currently configured. The Result column indicates the calling
result of the call. The Retry Interval values are displayed in minutes.

............................................................................................................................................................................

4 Click Add Recall to insert a row where you can edit a new recall.
To delete a recall, select the row, and then click Remove Recall.

............................................................................................................................................................................

5 Click OK
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17 Quotas

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses quotas as a means
to complete a certain number of calls based on a selected outcome. A
quota is a maximum number of releases for a particular completion
code. When the quota for a unit is reached, no more calls are placed.

In Campaign Editor, you set and modify a quota that is applied when
the job starts. In Campaign Monitor, you set and modify a quota that
affects a currently running job. This section discusses quotas as they
apply to Campaign Monitor only. See “Jobs” for more information on
setting quota information in Campaign Editor.

Contents This section contains the following topics:

• Job end and quotas

• Create or modify a quota
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Job end and quotas

Job end and quotas A quick review of ending a job will help you understand why you
might want to specify a quota. Here are the ways in which a job can
end:

• The job reaches the Latest Time to Stop setting.

• The job is manually stopped.

• The job stops only after the Avaya PDS calls all initial phones at
least once.

• The job stops only after the Avaya PDS calls all recalls at least
once.

• The job stops when the Avaya PDS calls all scheduled recalls, but
it stops calling when it has called all initial phones at least once.

• The job stops when the agents meet the quota set for the job.

The topics that follow are concerned with the last item in the previous
list. Some supervisors use the Quota feature as a way to quickly stop a
job. For example, specify a quota that your agents will quickly meet for
a job.

Note

Quotas are not used for inbound-only jobs.



Quotas

1 7 - 2 3 9

............................................................................................................................................................................................................................................................
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Create or modify a quota

Create or modify a quota Use the following procedure in Campaign Monitor to change the quota
value during calling activities.

............................................................................................................................................................................

1 Start Campaign Monitor.

............................................................................................................................................................................

2 Select a job, and then select Tools > Quotas.
The Quota dialog box appears.

............................................................................................................................................................................

3 Double-click the Unit ID field and type a Unit ID.

............................................................................................................................................................................

4 Click the Completion Code field to select a completion code.

............................................................................................................................................................................

5 Double-click the Quota field and type a number (the number must be
greater than 0).
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18 Alerts

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses alerts to signal to
supervisors of the end of a job, a goal being met, and other campaign
events.

Contents This section contains the following topics:

• Alerts

• Alert Settings

• Create an alert

• Edit an alert

• Remove an alert

• View a log

• Enable and disable alerts

• Check the status of each alert
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Alerts

Overview You can define up to 10 alerts that provide audio cues, visual cues, log
files, e-mails, or pager signals when job/agent performance, system or
job status, or line usage varies beyond predetermined levels. This
capability allows you to identify and correct potential problems before
they escalate.

For example, you might want to know when an agent takes more than
five minutes on a call or when the hit rate on a job is less than 30%.
Alerts can also be set to tell you when the system needs attention, for
example, a job is approaching completion.

To access alerts, start Campaign Monitor and select Settings > Alerts.

Note

If you set an alert, you can close Campaign Monitor. When you restart
Campaign Monitor, your alert will be saved. However, if Campaign
Monitor is closed when you should receive your notification, you will
not receive notification. In other words, Campaign Monitor must be
active in order for you to receive a notification. After you receive an
alert notification, the alert is not automatically enabled again. Open the
Alert Viewer and select Enabled to reactivate an alert.

Alert examples The Avaya PDS can alert you for many reasons. The following is a
sample list.

• Average Idle Time - the average time that all agents or a specific
agent are idle (not talking or updating).

• Average Talk Time - the average time that all agents or a specific
agent spend talking.

• Average Update Time - the average update time that all agents or
a specific agent spend updating a customer record.

• Current Talk Time - the talk time for all agents or a specific
agent, as shown talking in real-time (rather than an average over
multiple calls).

• Current Update Time - the update time for all agents or a
specific agent, as shown updating in real-time (rather than an
average over multiple calls).

• Total Idle Time - the total idle time for all agents or a specific
agent, as idle time added over the course of a single job.
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• Total Talk Time - the total talk time for all agents or a specific
agent, as talk time added over the course of a single job.

• Total Update Time - the total update time for all agents or a
specific agent, as update time added over the course of a single
job.

• Line Utilization - the percentage of lines in use; for example, you
might want to know when 95% of your lines are utilized so that
you can free up some lines (otherwise, when 100% of the lines are
utilized, customers will automatically be placed in a wait queue
when they call in).

• Current Hit Rate - a hit rate is the ratio or percentage of call
connects to call attempts (a 25% hit rate means that out of 100
attempts, 25 connects were made or it takes 4 calls to connect to
one customer); a minimum hit rate keeps a job with a low hit rate
from using all the lines when it shares a line pool with other jobs.

• Time on Dialer - this feature is like an alarm clock: when the
dialer hits a certain time of the day/night, you are alerted.

• Agent Completion Code Total - the accumulated total of
completion codes that agents have entered.

• Agent Completion Code Average - the average number of
completion codes that agents have entered.

• Job Completion Code Average - the completion code average
per hour; this is useful if, for example, you would like an overall
sense of job performance.

• Job Completion Code Total - the total of all job completion
codes, as accumulated over the entire life of a job; this is helpful if
you want to shut down a job or reassign agents to another job
when the goal for a job has been met.

• Agents Assigned - the number of agents currently on a job.

• Job End - the job has ended.

• Records Left - the number of records still left in the job that need
to be called.

• Records Left as Percent of Total - the percent of records in the
entire job still left to be called.

• Time Remaining - the estimated time left on a job.

Note

There is also one alert that you may receive that you do not configure
yourself. The Avaya PDS automatically alerts you if new data has not
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appeared in the database for more than 12 minutes (12 is the current
setting). This alert lets you know if the data you are viewing in
Campaign Monitor is not being updated.
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Alert Settings

Alert settings The following table shows possible combinations of alert settings:

Condition Dialer Job Agent Relation Value Modifier

Agent Comp Code
Totals

Yes Yes Yes >,< Total

Agent Comp code
Avg

Yes Yes Yes >,< Average
Per Hour

Agents Assigned Yes Yes No >,<

Average Idle Time Yes Yes Yes >,< 0-1440 minutes

Average Talk Time Yes Yes Yes >,< 0-1440 minutes

Average Update
Time

Yes Yes Yes >,< 0-1440 minutes

Current Hit Rate Yes Yes No >,< 1-100 %

Current Talk Time Yes Yes Yes >,< 0-1440

Current Update
Time

Yes Yes Yes >,< 0-1440

Job Comp Code Avg Yes Yes No >,<

Job Comp Code
Total

Yes Yes No >,<

Job End Yes Yes No

Line Utilization Yes Yes No >,< 1-100 %

Records Left Yes Yes No >,<

Records Left
Percent

Yes Yes No >,< 1-100 %

Time on Dialer Yes No No >,< 1:00-
12:59

AMPM
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The dialer, job, and agent columns indicate whether a data item is
relevant to a particular alert condition. For example, you can set a Job
End alert for any job on any dialer, and you can set a Total Talk Time
alert on any agent on any job on any dialer.

Time Remaining Yes Yes No >,< 0-1440 minutes

Total Idle Time Yes Yes Yes >,< 0-1440 minutes

Total Talk Time Yes Yes Yes >,< 0-1440 minutes

Total Update Time Yes Yes Yes >,< 0-1440 minutes

Condition Dialer Job Agent Relation Value Modifier
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Create an alert

Overview You create alerts in Alerts Viewer, which is a available in Campaign
Monitor.

Create an alert Use the following procedure to create an alert.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Monitor.

............................................................................................................................................................................

2 Select Settings > Alerts.
(If an e-mail configuration wizard appears, either complete it or cancel
out of it.)

............................................................................................................................................................................

3 In the Alerts Viewer dialog box, click Add.
The Alert Editor dialog box appears.

............................................................................................................................................................................

4 On the Alert Definition tab, select the condition you want to monitor
and complete the conditional statement.

............................................................................................................................................................................

5 On the Scope tab, narrow your alert condition.
You can skip this tab if you do not want to narrow your alert criteria.

............................................................................................................................................................................

6 On the Notifications tab, specify how Avaya PDS notifies you: a pop-up
alert on your screen, an audible sound, a log file, or an e-mail.
If you select Send to log, then you can view a log file that will contain
all alert conditions that have been met. This log file is accessible using
the View Log button on the Alert Viewer.
If Send e-mail is unavailable, configure your default e-mail client on
your PC. If Send e-mail is available and you want to receive an e-mail
alert notification, type your e-mail address in the To... box.
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............................................................................................................................................................................

7 Click OK.
The alert name and summary information appear in the Alerts Viewer
dialog box.
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Edit an alert

Edit an alert Use the following procedure to edit an alert.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Alerts.
The Alert Viewer dialog box appears.

............................................................................................................................................................................

2 Select the alert you want to edit, and then click Edit.
The Alert Editor dialog box appears.

............................................................................................................................................................................

3 Use the Alert Definition, Scope, and Notifications tabs to modify the
alert.

............................................................................................................................................................................

4 Click OK.
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Remove an alert

Remove an alert Use the following procedure to remove an alert.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Alerts.
The Alert Viewer dialog box appears.

............................................................................................................................................................................

2 Select the alert you want to delete, and then click Remove.

............................................................................................................................................................................

3 Click OK.
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View a log

View a log If you have selected the Send to Log option for an alert (which you set
on the Notifications tab on the Alert Editor), you can use the View Log
button in the Alert Viewer dialog box to display a log of all alert
conditions that have been met.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Alerts.

............................................................................................................................................................................

2 On the Alert Viewer dialog box, click View Log.
A log file (text file) appears in a separate window.
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Enable and disable alerts

Overview In Alert Viewer, you have the option to disable alerts, which tells the
Avaya PDS not to notify you about an alert. For example, if you usually
monitor agent Doe everyday because he is a new hire, but agent Doe
calls in sick for a day, clear the check box next to the agent Doe alert to
disable the alert. When agent Doe returns to work, select the agent Doe
alert to reactivate it.

The Enabled check box tells you whether or not the Avaya PDS is
actively checking the alert’s condition. A check mark indicates that the
Avaya PDS is monitoring the condition. Job Ended, Current Talk Time,
and Current Update Time automatically reactivate after their condition
is met, but all other alerts require that you re-enable them in Alerts
Viewer.

Enable and disable alerts Use the following procedure to enable and disable alerts.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Alerts.

............................................................................................................................................................................

2 Select the Enabled field to activate monitoring of the alert condition.
Clear Enabled to deactivate the alert.
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Check the status of each alert

Overview In Alert Viewer, you can check the status of your alerts. If an alert
condition has not been met, its status is On. If an alert condition has
been met, its status is Off.

Check the status of each
alert

Use the following procedure to check the status of each alert.

............................................................................................................................................................................

1 In Campaign Monitor, select Settings > Alerts.

............................................................................................................................................................................

2 Notice whether the Status column has an On or Off status.
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19 Agent control functions

.............................................................................................................................................................................................................................................................
Overview

Purpose During calling activities, Campaign Monitor provides a means to find a
particular agent, and then take an action for that agent.

Contents This section contains the following topics:

• Agent control functions

• Find an agent

• Transfer an agent to another job

• Send message to an agent

• Monitor agent line

• Remove an agent from a job
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Agent control functions

Overview Campaign Monitor allows you to search for one or more agents in order
to complete various tasks. After an agent is found, you can initiate the
following actions:

• Transfer one or more agents to another job

• Send a message to one or more agents

• Monitor an agent line

• Remove an agent from a job

Before performing any of these tasks, you must first find an agent.

Hierarchies You can find agents in several ways. If you know the exact agent login,
you can search for a single agent. Use the following hierarchy groups to
search for a single agent or a group of agents.

Job Search all agents in a job.

Supervisor Search all agents reporting to a supervisor.

Dialer Search all agents on a dialer.

Note

An agent must be set up within the supervisor hierarchy in order for the
agent to be found using this function. Set up hierarchies using
Hierarchy Manager.

Using wildcard characters In addition to finding a single agent, you can use wildcard characters to
search for multiple agents.

Wildcard
character

Description

* Search for all agents. Use also for multiple agents
with identical characters. For example, *smith will
find all agents with anything containing the letters
smith.

? Search for a single character within an agent login.

, Search for multiple agents by their exact login names,
separated by commas.
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Find an agent

Find an agent Use the following procedure to find an agent.

............................................................................................................................................................................

1 On the Campaign Monitor button bar, click Agent, and then click Find
Agent.
The Find Agent dialog box appears.

............................................................................................................................................................................

2 Type the name of an agent or use wildcard characters to select multiple
agents.

............................................................................................................................................................................

3 Use scope selectors to filter information.

............................................................................................................................................................................

4 Click Find.
Agent names appear in the lower section of the Find Agent dialog box.
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Transfer an agent to another job

Transfer an agent to
another job

Use the following procedure to transfer an agent to another job.

............................................................................................................................................................................

1 Find the agent or agents that you want to transfer to another job.

............................................................................................................................................................................

2 Select one or more agents in the Find Agent dialog box.

............................................................................................................................................................................

3 Click Transfer Agent.
A list of currently running jobs appears.

............................................................................................................................................................................

4 Select the job to transfer the agent to, and then click OK.

Note

You may not see the agent transfer immediately. Factors such as agent
talk time and update time may affect how quickly the agent transfers.
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Send message to an agent

Send message to an agent Use the following procedure to send a message to an agent.

............................................................................................................................................................................

1 Find the agent or agents to whom you want send a message.

............................................................................................................................................................................

2 Select one or more agents in the Find Agent dialog box.

............................................................................................................................................................................

3 Click Send Message.
The Send Message dialog box appears.

............................................................................................................................................................................

4 Type the message to send to an agent, and then click OK.
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Monitor agent line

Monitor agent line Use the following procedure to monitor an agent line.

............................................................................................................................................................................

1 Find the agent that you want to monitor.

............................................................................................................................................................................

2 Select the agent in the Find Agent dialog box.

............................................................................................................................................................................

3 Click Monitor Agent.
A dialog box appears.

............................................................................................................................................................................

4 Enter headset ID number, and then click OK.
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Remove an agent from a job

Remove an agent from a
job

Use the following procedure to immediately disconnect an agent from a
call. Use this option only for emergencies when the agent cannot use a
normal disconnect method. Remove Agent immediately removes the
agent from the job and logs the agent out of the Avaya PDS.

............................................................................................................................................................................

1 Find the agent or agents that you want to remove from a job.

............................................................................................................................................................................

2 Select one or more agents in the Find Agent dialog box.

............................................................................................................................................................................

3 Click Remove Agent.
The system prompts you, “Are you sure you want to remove this agent
from the current job?”

............................................................................................................................................................................

4 Click Yes to remove the agent, or click No to close the message box
without removing the agent.
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Show an agent view

Show an agent view From the Find Agent dialog box, display an agent view for a selected
agent. Choose from the Agent Detail, Agent Completion Codes, and
Agent History views.

............................................................................................................................................................................

1 Find the agent for whom you want see a view.

............................................................................................................................................................................

2 Select the agent in the Find Agent dialog box.

............................................................................................................................................................................

3 Click the Show an agent view arrow.
A list of available views appears.

............................................................................................................................................................................

4 Select Agent Detail, Agent Completion Codes, or Agent History, and
then click OK.
The selected view for the selected agent appears.
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20 Campaign Analyst

.............................................................................................................................................................................................................................................................
Overview

Purpose Campaign Analyst generates call management reports with job, agent,
and system details based on Avaya Predictive Dialing System (PDS)
activity.

Contents This section contains the following topics:

• Reports

• Report categories

• Preview a report

• Export a report

• Create a new report configuration

• Schedule a report

• Change a report

• Print a report

• Delete a report configuration
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Reports

Overview Reports provide statistical information that you can use to evaluate
your calling campaigns. For example, reports can show you how agents
spend their time, which completion codes are most frequently used, the
amount of time a particular job ran, and the hierarchy of managers and
agents.

In Campaign Analyst, reports are grouped into four categories: Agent,
Job, Time of Day, and Administrative. For each category, Campaign
Analyst provides several reports. For example, the Agent category
include reports about agent activity, performance summary, and
completion code summary. For each report, Campaign Analyst
provides several variations or configurations. The different
configurations sort, group, and filter data differently.

In Campaign Analyst, report categories appear on the button bar. For
each category, the reports are listed. When you select a report, the
report configurations appear in the main pane.

The main pane displays five columns (from left to right): record
configuration title, Group 1, Group 2, Group 3, and Criteria. The last
four columns display the options that were selected for the report
configuration.

There are many configurations for each report, so you should compare
the configurations and experiment with the New and Change reports
features. These features allow you to customize a report’s
configuration. After you create and save a configuration, it appears
with the other configurations for that report so you can access it any
time you use Campaign Analyst.

In addition, you can use the Schedule feature to generate reports
automatically (daily, weekly, or monthly). When you set up a report
schedule, you specify the exact time that Avaya PDS sends the report to
your printer.
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Report categories

Report categories Campaign Analyst reports fall under the following categories: Agent,
Job, Time of Day, and Administrative.

Agent reports Agent reports present statistics on both an agent’s work
time (such as total work, update, and idle time) and performance (such
as total connects and connects per hour).

Job reports Job reports present job statistics by job type: inbound,
outbound, or blend. These reports include statistics about how the
system ran a job, system information on calling activity, and statistics
about combined agent activity during a job.

Several job report configurations also group statistics by system to
accommodate a multi-dialer environment.

Time of Day reports Time of day reports present job information
grouped by time segments. Time of Day reports let you evaluate job
performance at intervals of 60, 30, 20, 15, 10, or 5 minutes. The
interval is set when your system is installed.

The data in any reported interval includes only calls that ended during
that interval. For example, if an agent started talking to a customer at
12:29 and ended the call with a Promise to Pay at 12:32, the total talk
time, update time, idle time, the PTP completion code count and all
other data associated with that transaction would be added to the 12:30-
1:00 interval.

Several Time of Day report configurations also group statistics by
system to accommodate a multi-dialer environment.

Administrative reports Administrative reports present information
about the hierarchies created using Hierarchy Manager.

Managed Dialing reports Agent, Job, and Time of Day report groups include reports designed for
Managed Dialing jobs. Campaign Analyst handles connect and online
time statistics for Managed Dialing jobs differently than it does for
regular (outbound, inbound, and blend) jobs.
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The following table summarizes the differences between regular and
Managed Dialing reports with regard to the connect and online time
statistics.

By default, reports for regular jobs do not contain statistics for
Managed Dialing jobs. Regular job reports contain criteria to include
statistics where job type is outbound (OUT), inbound (INB), or blend
(BLND). If you want a report to include both Managed Dialing and
regular job statistics, use the Campaign Analyst report wizard to
remove the criteria. On page 4 of the wizard, remove the Job Type
condition and its associated values.

Note

If you generate a report that combines statistics from both regular and
Managed Dialing jobs, the numbers for online time and connects
statistics might be skewed because of the differences in how those
statistics are calculated.

Agent Completion Code
Summary reports

The Completion Code Summary report in the Agent report group
contains statistics about completion codes the agents used during jobs.
The report displays up to 14 completion codes. You can control which
codes appear on the report.

Campaign Analyst selects the first 14 completion codes for which the
first character of the description is an asterisk (*). (Campaign Analyst
selects codes in numerical order.) Use Completion Code Manager to
add an asterisk to the descriptions of the completion codes that you
want the Agent Completion Code Summary report to include. If you
add an asterisk to more than 14 completion code descriptions,
Campaign Analyst selects the first 14 codes and disregards the rest.

In the report, the description appears in a narrow, three-line column (the
asterisk does not appear in the report). Consider modifying long
descriptions so that they are more readable when you view the report.

Statistic Regular job Managed Dialing job

Connect An agent is connected to
a call placed by the
Avaya PDS.

An agent previewed a
record and did not cancel
the call.

Online time Amount of time an agent
waited for connects,
talked to clients, and
updated records.

Regular job online time
plus the time an agent
previewed records.
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For example, possible abbreviations for a Promise to Pay description
include Prom to Pay or PTP.

Note

If you are operating in a multi-dialer environment, Campaign Analyst
uses the Completion Code Manager settings from the primary dialer.
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Preview a report

Preview a report When you preview a report, Campaign Analyst launches a report
viewer that lets you view, print, and export a report.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Analyst.

............................................................................................................................................................................

2 Select a report category on the button bar.

............................................................................................................................................................................

3 Select a report in the button bar.

............................................................................................................................................................................

4 Select a report configuration.

............................................................................................................................................................................

5 Select Reports > Preview.
Campaign Analyst displays the report in a new window.
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Export a report

Export a report Export a report to use or view the data in a different application.

............................................................................................................................................................................

1 Select a report category on the button bar.

............................................................................................................................................................................

2 Select a report in the button bar.

............................................................................................................................................................................

3 Select a report configuration in the main pane.

............................................................................................................................................................................

4 Select Reports > Preview.
Campaign Analyst displays the report.

............................................................................................................................................................................

5 Click Export.

............................................................................................................................................................................

6 From the Format list, select a format.
For example, select Crystal Reports (RPT).

............................................................................................................................................................................

7 Click OK.
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Create a new report configuration

Overview Create a new report configuration to define your preferred grouping
(affects the indentation of your information and the hierarchical
layout), timeframe (tells Campaign Analyst the time frame you want
the report to cover), filtering (set the conditions that tell Campaign
Analyst to include only specific information in your report), and title
(specifies a title for your report configuration).

The New menu item is unavailable until you select a report in the
button bar. When you finish creating the configuration, it appears with
the title you specify as the last item in the list of report configurations.

Create a new report When you select New, the Campaign Analyst Report Wizard appears
and guides you through the configuration process.

............................................................................................................................................................................

1 Select a report category on the button bar.

............................................................................................................................................................................

2 Select Reports > New.
The Campaign Analyst Report Wizard appears.

............................................................................................................................................................................

3 Read the Welcome screen, and then click Next.

............................................................................................................................................................................

4 In the Data Grouping wizard page, use the drop-down lists to group your
information, and then click Next.
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For example, if you choose the following options:

The report would look like the following sample report (notice how
month, week, and date are indented based on your data grouping
selections):

If you select a hierarchy branch as a group criteria, you must select the
hierarchy name as a selection criteria (page 4 of the Campaign Analyst
Report Wizard).
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5 In the Date Criteria wizard page, set the date conditions for the report
selection formula, and then click Next.
For example, if you select the following options:

The report will look like the following sample report (notice that the
date at the top of the page contains a single date: yesterday’s date):

............................................................................................................................................................................

6 In the Additional Report Criteria wizard page, filter your data. If you
leave these settings blank (which is common), then you would not
narrow the data selected by the report. Select your conditions, and then
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click Next.
Consider the following example, filters data based on Job Name:

The report would include only data for the job named mytest.

If you selected a hierarchy branch as a group criteria (on page 2 of the
wizard), you must select the hierarchy as a selection condition.
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7 In the Report Title wizard page, type a name your report configuration.
For example, if you typed the following title in the title field:

The report will look like the following sample report (notice the title
just below the Campaign Analyst heading):

............................................................................................................................................................................

8 Click Preview to generate and view the report or click Finish to end the
wizard (you can make changes to it later by using the Change
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command). After you click Finish, your report configuration appears as
the last item in the list of report configurations.

Note

Although it is possible to have more than one instance of the report
wizard open at a time, for the most reliable performance, you should
always try to have only one wizard open at a time.
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Schedule a report

Schedule a report Use the following procedure to schedule a time to print reports
automatically. After you have scheduled a report, you can look in the
Control Panel to view your scheduled reports: Start > Settings >
Control Panel...“Scheduled Tasks” option.

............................................................................................................................................................................

1 In Campaign Analyst, select a report configuration to schedule.

............................................................................................................................................................................

2 Select Tools > Scheduler.

............................................................................................................................................................................

3 In the Schedule dialog box, select the frequency option that corresponds
with how often you want to print the report (Once, Daily, Weekly,
Monthly).
If you select Weekly or Monthly, the report will print on Monday only.
If you want to choose a different week day, use MS Scheduler to change
the day. The settings that you specify in MS Scheduler override the
Campaign Analyst schedule.

............................................................................................................................................................................

4 Select a start time and date.

............................................................................................................................................................................

5 Type the number of copies you want the Avaya PDS to print, and then
click OK.
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Change a report

Change a report If there is an existing report configuration that you need to modify, use
the Change command to alter it.

............................................................................................................................................................................

1 Select a report configuration.

............................................................................................................................................................................

2 Select Reports > Change.
The Campaign Analyst Report Wizard appears.

............................................................................................................................................................................

3 Read the Welcome page, and then click Next.

............................................................................................................................................................................

4 Follow the on-screen instructions to change the report criteria.
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Print a report

Print a report Use the following procedure to print a Campaign Analyst report.

............................................................................................................................................................................

1 Select a report configuration.

............................................................................................................................................................................

2 Select Reports > Print.

............................................................................................................................................................................

3 Type the number of copies you want to print, and then click OK.
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.............................................................................................................................................................................................................................................................
Delete a report configuration

Delete a report
configuration

Use the following procedure to delete a Campaign Analyst report
configuration.

............................................................................................................................................................................

1 Select a report configuration.

............................................................................................................................................................................

2 Select Reports > Delete.

............................................................................................................................................................................

3 Click Yes to delete the report configuration, or click No to close the
message box without deleting the report configuration.
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21 Hierarchy Manager

.............................................................................................................................................................................................................................................................
Overview

Purpose Hierarchy Manager is a Campaign Director tool to help you group and
organize data. Hierarchy Manager lets you create agent, job, or dialer
hierarchies that reflect the way your company or business is organized.
For example, you can create relationships between the Avaya™
Predictive Dialing System (PDS) agents and the management structure
of a company. You can use hierarchies in Campaign Monitor to adjust
the scope of data to view and in Campaign Analyst to group data in
reports.

Contents This section contains the following topics:

• Hierarchies

• Start Hierarchy Manager

• Create a hierarchy

• Open a hierarchy

• Add a level to a hierarchy

• Add a data item to a hierarchy

• Move a level or item within a hierarchy

• Rename a hierarchy level

• Remove a level from a hierarchy
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• Remove a data item from a hierarchy

• Rename a hierarchy

• Delete a hierarchy
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Hierarchies

Hierarchy branches, levels,
and data items

A hierarchy contains one or more branches. Each branch contains three
hierarchy levels (top, middle, and bottom), with one or more data items
assigned to the bottom level. Each branch can contain more than one
middle level, and each middle level can contain one or more bottom
levels.

For example, a job hierarchy contains two branches. Each branch
follows this structure:

• Top level = Portfolio (Loans, Savings)

• Middle level = Account Type (Car, Mortgage, Certificate
Deposits)

• Bottom level = Term (60 months, 30 years)

Data items (job names) were assigned to the bottom level of each
branch.

When you add a job or an agent to the Avaya PDS, it becomes available
for use in Hierarchy Manager immediately. Also, agents, jobs, and
dialers are available in Hierarchy Manager until data in the database
expires. This allows for historical reporting. For example, if you
remove an agent login from the Avaya PDS but the database still
contains data for that agent, the name of the agent still appears in the
Hierarchy Manager list of available agents.
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Hierarchy Manager supports three hierarchy types: agent, job, and
dialer.

Agent hierarchies An agent hierarchy creates statistical relationships for individual agent
activity and performance data that the Avaya PDS collects during
calling activities. Activity and performance data examples include Talk
Time, Idle Time, and Connects per Hour.

For example, an agent hierarchy can represent the management
structure of a company. Top, middle, and bottom levels represent
directors, managers, and supervisors, respectively. Agents are assigned
to each supervisor. Campaign Monitor can use this hierarchy to group
agent activity and performance data by supervisor.

Agent hierarchies are most effectively applied when monitoring agent
views in Campaign Monitor and when grouping data in Campaign
Analyst agent reports.

Job hierarchies A job hierarchy creates statistical relationships for individual job
activity data that the Avaya PDS collects during calling activities.
Examples of job activity data include Calls Placed, Connects per Hour,
and Time in Wait Queue.

In a multi-dialer environment, job hierarchies apply to all jobs across
all dialers unless you make all jobs unique across all dialers or create a
dialer-job relationship outside of Hierarchy Manager. For example,
when you create a job, include a reference to the dialer in the job name
such as job1_dialer1.

Job hierarchies are most effectively applied when monitoring job views
in Campaign Monitor and when grouping data in Campaign Analyst
job reports.

Dialer hierarchies A dialer hierarchy creates relationships for individual dialer activity
data that the Avaya PDS collects during calling activities. Dialer
activity includes all available job and agent activity and performance
data.

For example, in a four-dialer pod environment, the collections
department uses dialer1 and dialer2 and the marketing department uses
dialer3 and dialer4. A hierarchy branch could contain a level for
department with individual dialers assigned to the level. Dialer
hierarchies let you meaningfully group data by department and dialer.
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Start Hierarchy Manager

Start Hierarchy Manager Hierarchy Manager can be accessed from the Tools menu in either
Campaign Monitor or Campaign Analyst. Use the following procedure
to access the Hierarchy Manager.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Monitor or Campaign Analyst.

............................................................................................................................................................................

2 Select Tools > Hierarchy Manager. The Hierarchy Manager window
appears.
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Create a hierarchy

Overview Create an agent, job, or dialer hierarchy based on the hierarchy type
you select. When you create a new hierarchy, you add top, middle, and
bottom hierarchy levels and assign data items. If you name two like
levels the same under one parent level, Hierarchy Manager combines
them. For example, if a hierarchy middle level contains two bottom
levels named Supervisor, Hierarchy Manager combines all data items
assigned to both Supervisor levels and removes the duplicate level.

Create a hierarchy Use the following procedure to create a hierarchy.

............................................................................................................................................................................

1 On the button bar, click Agent Hierarchies, Job Hierarchies, or Dialer
Hierarchies depending on the type of hierarchy you want to create.

............................................................................................................................................................................

2 Select Hierarchy > New. Hierarchy Manager displays a new hierarchy
including a default structure.
The Available list contains agent, job, or dialer names depending on
which hierarchy type you selected.

............................................................................................................................................................................

3 Add hierarchy levels.
To add a hierarchy level, right-click the level above where you want to
add a level, and then select Add Level. Hierarchy Manager inserts a
level named New Level.

............................................................................................................................................................................

4 Rename the new level.
Right-click New Level, select Rename, type a new name (up to 20
characters), and then press Enter.

............................................................................................................................................................................

5 Repeat steps 3 and 4 for each level you want to add to the hierarchy.

............................................................................................................................................................................

6 Add data items.
Drag and drop an item from the Available list onto the bottom level of
the branch to which you want to add it.
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After an item is added to the hierarchy, Hierarchy Manager moves the
data item from the Available list to the Allocated list.

............................................................................................................................................................................

7 Select Hierarchy > Save to save the hierarchy settings.
Hierarchy Manager does not save branches that do not contain data
items. Empty branches will no longer appear in the hierarchy after you
close and restart Hierarchy Manager.

............................................................................................................................................................................

8 In the Hierarchy Properties dialog box, type a name (up to 64 characters)
for the hierarchy, and then click OK.
Hierarchy Manager saves the hierarchy settings.



2 1 - 2 9 0

...........................................................................................................................................................................................................................................................

Hierarchy Manager

.............................................................................................................................................................................................................................................................
Open a hierarchy

Open a hierarchy Use the following procedure to open a hierarchy that you want to view
or change.

............................................................................................................................................................................

1 On the button bar, click Agent Hierarchies, Job Hierarchies, or Dialer
Hierarchies depending on the type of hierarchy you want to open.
A list of hierarchies appears in the button bar for the selected hierarchy
type.

............................................................................................................................................................................

2 Select a hierarchy.
The selected hierarchy appears.
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Add a level to a hierarchy

Hierarchy levels To build your organizational structure in Hierarchy Manager, you add
levels to a hierarchy. Each branch in a hierarchy contains three levels:
top, middle, and bottom. When you add a level, Hierarchy Manager
adds a level that is subordinate to the selected level. For example, if
you add a level to a top level item, Hierarchy Manager adds a middle
level item. To add a top level item, add a level to the hierarchy name.

A hierarchy can contain one or more top levels. Each hierarchy branch
(top level) can contain one or more middle levels. Each middle level
can contain one or more bottom levels. Bottom levels can contain only
data items. No other level can contain data items.

If you name two like levels the same under one parent level, Hierarchy
Manager combines them. For example, if a middle level contains two
bottom levels named Supervisor, Hierarchy Manager combines all data
items assigned to both Supervisor levels into one level and removes the
duplicate level.

Hierarchy Manager does not save branches that do not contain data
items. Be sure that all branches contain data items before you save the
hierarchy.

Add a level to a hierarchy Use the following procedure to add a level to a hierarchy.

............................................................................................................................................................................

1 Open the hierarchy that you want to change.

............................................................................................................................................................................

2 Right-click the level above where you want to add a level, and then
select Add Level.
Hierarchy Manager inserts a level named New Level.

............................................................................................................................................................................

3 Right-click New Level, and then select Rename.

............................................................................................................................................................................

4 Type a new name for the level (up to 20 characters), and then press
Enter.
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Add a data item to a hierarchy

Add a data item to a
hierarchy

Use the following procedure to add data items to a hierarchy. Hierarchy
Manager lets you add data items to only the bottom-most levels of the
hierarchy.

............................................................................................................................................................................

1 Open the hierarchy to which you want to add data items.

............................................................................................................................................................................

2 Select one or more items in the Available list, and then drag the items to
the appropriate level.
After an item is added to the hierarchy, Hierarchy Manager moves the
data item from the Available list to the Allocated list.

Tip

To select two or more adjacent items in the Available list, click the first
item, and then hold down Shift and click the last item.
To select two or more nonadjacent items, click the first item, and then
hold down Ctrl and click additional items.
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Move a level or item within a hierarchy

Overview As your organization changes, you might need to rearrange elements in
a hierarchy to reflect the changes. You can move data items from one
bottom level to another. For example, in an agent hierarchy you can
move an agent from one supervisor to another. You can also move a
level within a hierarchy. Items and levels that you move must maintain
their same level in the hierarchy. For example, a bottom level cannot be
moved to a middle level position.

Move a level or item within
a hierarchy

Use the following procedure to move a level or a data item within a
hierarchy.

............................................................................................................................................................................

1 Open the hierarchy that you want to change.

............................................................................................................................................................................

2 Select the level or data item that you want to move, and then drag it to
the hierarchy level above where you want the level or item to be listed.

............................................................................................................................................................................

3 Repeat step 2 for each level or item that you want to move.
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Rename a hierarchy level

Overview Hierarchy Manager lets you rename levels in a hierarchy to reflect
organizational changes. If you name two like levels the same under one
parent level, Hierarchy Manager combines them. For example, if a
hierarchy middle level contains two bottom levels named Supervisor,
Hierarchy Manager combines all data items assigned to both
Supervisor levels into one level and removes the duplicate level.

Rename a hierarchy level Use the following procedure to rename a hierarchy level.

............................................................................................................................................................................

1 Open the hierarchy in which you want to rename a level.

............................................................................................................................................................................

2 Right-click the hierarchy level name that you want to change, and then
select Rename.

............................................................................................................................................................................

3 Type a new name for the level (up to 20 characters), and then press
Enter.
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Remove a level from a hierarchy

Overview As your organization changes, you can use Hierarchy Manager to
reflect those changes in your hierarchies. You can remove a level from
your hierarchy to better represent your organization. To remove a top or
middle hierarchy level that contains a bottom level with data items, you
must first delete the bottom level (and data items).

Remove a level from a
hierarchy

Use the following procedure to remove a level from a hierarchy.

............................................................................................................................................................................

1 Open the hierarchy from which you want to remove a level.

............................................................................................................................................................................

2 Right-click the level that you want to remove, and then select Delete.
If the level you select to remove contains data items, Hierarchy Manager
asks you if you want to delete the selected level and all the agents
associated with that level.

............................................................................................................................................................................

3 Click Yes to delete the level.
Hierarchy Manager removes the level and moves the data items from the
Allocated list to the Available list.
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Remove a data item from a hierarchy

Remove a data item from a
hierarchy

Remove a data item from a hierarchy when the item no longer meets
your organizational needs. You can remove individual data items as
described in the following procedure. You can also remove all the data
items assigned to a bottom level by removing the bottom level.

............................................................................................................................................................................

1 Open the hierarchy from which you want to remove one or more data
items.

............................................................................................................................................................................

2 Right-click a data item that you want to remove, and then select Delete.
Hierarchy Manager removes the data item from the hierarchy, and
moves the data item from the Allocated list to the Available list.

............................................................................................................................................................................

3 Repeat step 2 for each data item you want to remove.
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Rename a hierarchy

Rename a hierarchy Use the following procedure to rename a hierarchy.

............................................................................................................................................................................

1 Open the hierarchy that you want to change.

............................................................................................................................................................................

2 Select Hierarchy > Save As.

............................................................................................................................................................................

3 In the Hierarchy Properties dialog box, type a unique name for the
hierarchy.
A hierarchy name can contain up to 64 characters and can include the
following special characters: parentheses ( ), comma (,), hyphen (-),
dollar sign ($), and the pound sign (#).

............................................................................................................................................................................

4 Click OK.
Hierarchy Manager saves the hierarchy settings with the new name.
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Delete a hierarchy

Delete a hierarchy As your organization changes, you might decide to no longer use a
particular hierarchy. You can delete a hierarchy from Hierarchy
Manager.

............................................................................................................................................................................

1 Open the hierarchy that you want to change.

............................................................................................................................................................................

2 Select Hierarchy > Delete.
Hierarchy Manager asks you to confirm the delete action.

............................................................................................................................................................................

3 Click Yes to delete the hierarchy.
Hierarchy Manager removes the selected hierarchy.
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22 Completion Code Manager

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses Completion Code
Manager to categorize completion codes as Right Party Contacts
(RPCs), Abandons, and Closures.

Contents This section contains the following topics:

• Completion code categories

• Start Completion Code Manager

• Set a completion code as RPC

• Set a completion code as a Closure

• Set a completion code as an Abandon

• Remove a completion code

• Change a completion code description

• View Completion Code Manager for another dialer
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Completion code categories

Overview During an Avaya PDS job, agents use a completion code to indicate the
outcome of a call, such as Promise to Pay or Left Message. You can
categorize completion codes for monitoring and reporting purposes
with Completion Code Manager.

Completion code
categories

There are three completion code categories: RPC (Right Party
Contact), Closure, and Abandon.

RPC indicates the agent called and talked to the correct party. This
designation may overlap with the Closure designation.

Closure indicates that the agent called and talked to a party. Closure
can represent a variety of outcomes, including the following examples:

• Balance paid in full

• Bankruptcy

• Deceased

• Sale verified and completed

This designation may overlap with the RPC designation.

Abandon indicates that a call has been abandoned and the Avaya PDS
has disconnected the call. An abandon can be caused by one of several
events:

• An inbound caller hung up in the inbound wait queue

• A customer hung up while in the outbound wait queue

• The time limit for a call being held in a queue was met
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Completion code
assignments

You can assign a completion code to more than one category. For
example, you can classify a verified sale as an RPC and a Closure. The
following illustration shows sample completion code assignments.

Multi-dialer environment Completion Code Manager lets you change the completion code
description and code designation for your completion codes. However,
if the multi-dialer feature is enabled on your system, you must take one
of the following two actions:

• Make the identical changes on each dialer’s set of completion
codes

• Copy the completion code file to each dialer

Completion code
designation changes

When an Avaya PDS job starts, it applies the current Completion Code
Manager settings. If you make changes to code designations (RPC,
Closure, or Abandon) while a job is running, you need to restart the job
to apply your new code designation changes.

Completion code
descriptions

If you change one or more completion code descriptions in Completion
Code Manager, Campaign Monitor automatically updates to use the
new descriptions. You do not need to restart a job for the Avaya PDS to
recognize new descriptions.

If you use the Campaign Analyst Agent Completion Code Summary
report, you need to designate which codes you want to appear on the
report. Insert an asterisk (*) as the first character of the description for
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each completion code you want to include in the report. You can define
up to 14 codes. If you define more than 14 codes, Campaign Analyst
uses the first 14 codes (in numerical order) and disregards the
remaining designated codes.
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Start Completion Code Manager

Start Completion Code
Manager

You can start Completion Code Manager from Campaign Editor,
Campaign Monitor, or Campaign Analyst. Use the following procedure
to start Completion Code Manager.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Editor, Campaign Monitor or Campaign Analyst.

............................................................................................................................................................................

2 Select Tools > Completion Code Manager. The Completion Code
Manager window appears.



2 2 - 3 0 4

...........................................................................................................................................................................................................................................................

Completion Code Manager

.............................................................................................................................................................................................................................................................
Set a completion code as RPC

Set a completion code as
RPC

Use the following procedure to set a completion code as an RPC.

............................................................................................................................................................................

1 From the list of completion codes in the right-hand pane, select a
completion code.

............................................................................................................................................................................

2 Drag the completion code to the left-hand pane and drop it under the row
labeled RPCs.
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Set a completion code as a Closure

Set a completion code as a
Closure

Use the following procedure to set a completion code as a Closure.

............................................................................................................................................................................

1 From the list of completion codes in the right-hand pane, select a
completion code.

............................................................................................................................................................................

2 Drag the completion code to the left-hand pane and drop it under the row
labeled Closures.
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Set a completion code as an Abandon

Set a completion code as
an Abandon

Use the following procedure to set a completion code as an Abandon.

............................................................................................................................................................................

1 From the list of completion codes in the right-hand pane, select a
completion code.

............................................................................................................................................................................

2 Drag the completion code to the left-hand pane and drop it under the row
labeled Abandons.
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Remove a completion code

Remove a completion code Use the following procedure to remove a completion code from an
RPC, Closure, or Abandon category.

............................................................................................................................................................................

1 From the list of completion codes in the left-hand pane, right-click the
completion code you want to remove.

............................................................................................................................................................................

2 Click Delete.

Note

When you delete the completion code from the list of categorized
completion codes, the code still appears it in the right-hand pane and is
available to be selected again.
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Change a completion code description

Change a completion code
description

Use the following procedure to change a completion code description.

............................................................................................................................................................................

1 From the list of completion codes in the left-hand pane of the window,
double-click the Description column of the completion code you want
to change.

............................................................................................................................................................................

2 Type the new description, and then press Enter.
Completion Code Manager displays the new description.
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View Completion Code Manager for another dialer

View Completion Code
Manager for another dialer

Use the following procedure to view Completion Code Manager for
another dialer.

............................................................................................................................................................................

1 Start Campaign Editor, Campaign Monitor, or Campaign Analyst.

............................................................................................................................................................................

2 (Campaign Editor only) On the button bar, select the dialer you want to
view.

............................................................................................................................................................................

3 Select Tools > Call Completion Codes.
In Campaign Editor, the Completion Code Manager window for the
selected dialer appears.

............................................................................................................................................................................

4 (Campaign Monitor and Campaign Analyst) Select a dialer from the
Dialer dialog box, and then click OK.
The Completion Code Manager window for the selected dialer appears.
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23 PC Analysis Telnet

.............................................................................................................................................................................................................................................................
Overview

Purpose The PC Analysis Telnet tool provides access to the character-based PC
Analysis menus. PC Analysis is a reporting and troubleshooting tool
included with the AvayaTM Predictive Dialing System (PDS). The PC
Analysis Telnet tool also lets you transfer extract output files to a
network location.

Contents This section contains the following topics:

• PC Analysis Telnet

• Toolbar icons

• Start PC Analysis Telnet

• Transfer PC Analysis extract output files
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PC Analysis Telnet

Overview The PC Analysis Telnet tool included in Campaign Analyst provides
access to the character-based PC Analysis menus, which you can use to
define extract files and generate extract output files. You can also use
PC Analysis Telnet to move PC Analysis extract output files from the
Avaya PDS to a network location.

After you transfer the extract output files, you can use spreadsheet,
word processing, and reporting packages available to you to create
reports, charts, and spreadsheets.

PC Analysis Telnet is available from the Campaign Analyst Tools
menu only. If access to Campaign Director is not available, you will
need to use a third-party telnet tool to access Avaya PDS menu system
and PC Analysis.
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Toolbar icons The PC Analysis Telnet window includes a set of tools that help you
use and navigate the character-based menus and PC Analysis screens.
The PC Analysis Telnet toolset is similar to that of System Telnet but
also includes four additional tools designed specifically for use with PC
Analysis.

Toolbar
Name

Icon Description

Connect Use the Connect tool to select the dialer
for which you want to generate or
transfer extract data files. This function
is not available while you are connected
to a system. You must disconnect from a
dialer before you can connect to a
different dialer.

Disconnect Use the Disconnect tool to end the
telnet session for the current dialer. If
you exit the menu system, PC Analysis
Telnet automatically disconnects your
session. After you disconnect, you can
connect to a different dialer or exit the
PC Analysis Telnet application.

Exit out of
entry

Use the Exit out of entry tool to move
back one screen in the character-based
screens. This provides the same
functionality as Ctrl-x.

Done with
entry

Use the Done with entry tool to move
to the next character-based screen. This
provides the same functionality as the
Done key (F1).

Select Use the Select tool from the PC
Analysis Extraction Configuration Edit
screen. Select moves your cursor to the
Select column. Press Enter after typing
the Select value.
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Criteria Use the Criteria tool from the PC
Analysis Extraction Configuration Edit
screen. Criteria moves your cursor to
the Criteria column. Press Enter after
typing the Criteria statement.

Run extract Use Run extract from the PC Analysis
Extraction Configuration Edit screen to
generate a PC Analysis extract output
file based on the configuration of the
open extract file.

Get file Use Get file to transfer one or more PC
Analysis extract output files from the
dialer to a network location.

Toolbar
Name

Icon Description
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Start PC Analysis Telnet

Start PC Analysis Telnet The PC Analysis Telnet tool provides access to the PC Analysis
character-based menus. Use the following procedure to start PC
Analysis Telnet.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Analyst.

............................................................................................................................................................................

2 Select Tools > PC Analysis Telnet.
The PC Analysis Telnet window appears.

............................................................................................................................................................................

3 Select File > Connect.
The Connect to PDS dialog box appears.

............................................................................................................................................................................

4 From the Name list, select the name of the dialer to which you want to
connect, and then click OK.
The dialer login: prompt appears in the Telnet window.

............................................................................................................................................................................

5 Use your system or PC Analysis login to access the PC Analysis menus.
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Transfer PC Analysis extract output files

Transfer PC Analysis
extract output files

Use the following procedure to transfer generated PC Analysis extract
output files from an Avaya PDS to a network location or to a personal
computer.

............................................................................................................................................................................

1 Start PC Analysis Telnet.

............................................................................................................................................................................

2 Connect to an Avaya PDS dialer.

............................................................................................................................................................................

3 Select Tools > Get File(s)....
The FTP Client dialog box appears. The name of the system to which
you are connected appears in the dialog box title.

............................................................................................................................................................................

4 Select one or more extract output files to transfer, and then click Get file.
The Save As dialog box appears.

............................................................................................................................................................................

5 Browse to the location where you want to transfer the selected extract
output file, and then click Save.
The system saves the file to the selected location.
If you selected more than one extract output file to transfer, the Save As
dialog box appears for the next file.

............................................................................................................................................................................

6 Repeat step 5 for each extract output file you selected to transfer.
After you click save for the last output file, the FTP Client dialog box
appears.

............................................................................................................................................................................

7 Click Cancel to close the FTP Client dialog box.



2 4 - 3 1 7

............................................................................................................................................................................................................................................................

24 System Telnet

.............................................................................................................................................................................................................................................................
Overview

Purpose The System Telnet tool provides access to the AvayaTM Predictive
Dialing System (PDS) character-based user interface.

Contents This section contains the following topics:

• System Telnet

• Toolbar icons

• Start System Telnet
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System Telnet

Overview Use the System Telnet tool to access the system and administrative
menus. The telnet session lets you access Avaya PDS features available
through character-based menu systems. For example, you can manage
user accounts, check calling list status, or manage agent job lists. You
can also access some Campaign Monitor and Campaign Editor features
through character-based menus.

System Telnet is available from the Tools menu in Campaign Editor,
Campaign Monitor, and Campaign Analyst. If access to Campaign
Director is not available, you will need to use a third-party telnet tool to
access Avaya PDS menu system and PC Analysis.

TIP

To access PC Analysis menus, use the PC Analysis Telnet tool in
Campaign Analyst. PC Analysis Telnet includes special tools designed
to help you navigate the PC Analysis extract screens.
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Toolbar icons The System Telnet window opens with a set of tools that help you use
and navigate the character-based menus.

Toolbar
Name

Icon Description

Connect Use the Connect tool to select the dialer
for which you want to access character-
based features. This function is not
available while you are connected to a
dialer. You must disconnect from a
dialer before you can connect to a
different dialer.

Disconnect Use the Disconnect tool to end the
telnet session for the current dialer. If
you exit the menu system, System
Telnet automatically disconnects your
session. After you disconnect, you can
connect to a different dialer or exit the
System Telnet application.

Exit out of
entry

Use the Exit out of entry tool to move
back one screen in the character-based
screens. This provides the same
functionality as Ctrl-x.

Done with
entry

Use the Done with entry tool to move
to the next character-based screen. This
provides the same functionality as the
Done key (F1).
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Start System Telnet

Start System Telnet Use the following procedure to start System Telnet to access the Avaya
PDS character-based menus.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Editor, Campaign Monitor, or Campaign Analyst.

............................................................................................................................................................................

2 Select Tools > System Telnet. A System Telnet window appears.

............................................................................................................................................................................

3 Select File > Connect. The Connect to PDS dialog box appears.

............................................................................................................................................................................

4 From the Name list, select the name of the dialer to which you want to
connect, then click OK.
The dialer login: prompt appears in the Telnet window.

............................................................................................................................................................................

5 Type your system login and password to access the system menus or the
administrator login and password to access the administrative menus.
The character-based menu system associated with your user name
appears in the Telnet window.
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Overview

Purpose The Agent Blending tool allows you to manage domains (ACD call
queues) and domain groups (every domain is a member of a domain
group). Start the Agent Blending tool from the Campaign Monitor or
Campaign Editor Tools menu.

Contents This section contains the following topics:

• Agent Blending

• Supported ACDs

• Switch terminology

• Domains

• Domain Groups

• Start the Agent Blending tool

• Create a domain group

• Create a domain

• Edit domain group settings

• Edit domain settings

• Delete a domain group

• Delete a domain

• Move a domain to a different group
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• Stop the blend engine

• Start the blend engine

• Reset the blend engine

• Resynch the blend engine

• View ACD statistics

• View alerts

• View transactions
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Agent Blending

Overview Agent Blending integrates outbound calling activities on your Avaya
PDS with inbound calling activities on your ACD. In an Agent
Blending system, ACD agents log on to the Avaya PDS and the ACD.
Agent Blending monitors the activity on the ACD and uses this
information to determine when to acquire agents for outbound calling
and when to release ACD agents to handle inbound calls.

The Avaya PDS uses a pool of ACD (blend) agents for outbound
calling. The system acquires the pooled agents for outbound calling
when the inbound calling activity decreases. It releases these agents to
inbound calling when the inbound calling activity increases. This
movement keeps the ACD blend agents busy while keeping the ACD
service level within your prescribed limits.

Predictive Agent Blending If your first priority is servicing your inbound customers and your
inbound volume is fairly high, you will benefit from using Predictive
Agent Blending. Predictive Agent Blending focuses on the inbound
mission and only acquires agents for outbound when the Service Level
or Average Speed to Answer parameters are above the desired value.
These agents take inbound calls until the Avaya PDS predicts that there
will be too many agents on inbound (the Avaya PDS bases the
prediction on the service level requirements you set). The Avaya PDS
then acquires agents from the ACD to handle outbound calls until the
inbound volume increases.

Call centers with moderate to heavy inbound traffic and more than 25
agents in an inbound pool benefit from using Predictive Agent
Blending.

Predictive Agent Blending uses events from the ACD to forecast call
volume and determine when to move ACD agents between inbound
and outbound calling.

There are two control method option within Predictive Agent Blending:
Average Speed to Answer and Service Level. To configure Predictive
Agent Blending, set up an Average Speed to Answer or a Service Level
domain group that contains one or more acquire domains and at least
one inbound domain. Each type requires different settings.

Average Speed to Answer (ASA)

This domain group type uses the target ASA field (MAAS) for
calculating when to acquire and release agents. Agents are acquired for
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outbound calls when the average speed to answer for all inbound
domains in the group is less than or equal to the targeted value. Agents
are released when the value rises above the target.

Service Level (SL)

This domain group type uses the Service Criterion (SC, seconds),
Desired Service Level (DSL, %), and Abatement Service Level (ASL,
%) fields for calculating when to acquire and release agents. Agents
are acquired for outbound calls when the percentage of inbound calls
answered within the Service Criterion is greater than or equal to the
Desired Service Level percentage. Acquisitions will stop when the
actual service level reaches the Abatement Service Level value.
Agents will be released back to inbound when the service level falls
below the desired value. The actual service level is calculated using all
inbound domains in the group.

Proactive Agent Blending If your focus is on outbound calling, but you need to service a low
volume of inbound customers, you will benefit from using Proactive
Agent Blending. Proactive Agent Blending focuses on outbound calls
and releases agents to inbound only when an inbound calls enters a
monitored queue on the ACD. When an ACD agent logs on, the Avaya
PDS immediately acquires the agent for outbound calling. When an
inbound call comes into the ACD queue, the Avaya PDS releases the
agent to handle the call. The number of queued calls before agents
release to inbound can be configured for each OB_ONLY domain
group. If inbound calls continue to come in, the Avaya PDS continues
to release agents. As soon as the queue is empty, the Avaya PDS
acquires the agent for outbound calls.
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Supported ACDs

Supported ACDs The system supports Agent Blending on the following ACDs:

• Aspect CallCenter

• DEFINITY G3

• PINNACLE 5ESS

• Northern Telecom Meridian 1

• Rockwell Spectrum

• Siemens ROLM 9751, Release 9005

The AvayaTM Predictive Dialing System (PDS) Installation Planner
contains a full description of the requirements for each supported
switch. Each switch has unique settings and terminology.

Regardless of the special terminology used by ACD vendors, you
configure your ACD to work with the Avaya PDS. The Avaya PDS
uses domains and domain groups to control Agent Blending.
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Switch terminology

Aspect Agent group A set of agents handling similar types of calls. Agents
log into an agent group when they log onto the Aspect CallCenter.
Agent groups may be part of an agent super group.

Agent groups correspond to Agent Blending domains. Agent Blending
monitors events for domains configured on the system as inbound or
acquire.

Call Control Tables (CCTs) Part of the Aspect CallCenter database.
CCTs control call routing, queuing, and messaging for agent groups
and agent super groups. You can view, set up, edit, or delete CCTs
from Aspect CallCenter management workstation. There can be
multiple CCTs for each agent group and agent super group.

Data System Interlink Table Part of the Aspect CallCenter database.
It controls communication between the Aspect CallCenter and the
system. You can view the Data System Interlink Table and set
application parameters using the Aspect CallCenter management
workstation. However, only an Aspect representative can set system-
level parameters.

DEFINITY G3 Expert Agent Selection (EAS) An optional Definity G3 feature. It
allows skill types to be assigned to a call type or Vector Directory
Number (VDN).

Hunt group An agent queue on an ACD configured without EAS. The
ACD hunts for the next available agent in each hunt group. It uses the
hunt method defined on the ACD.

Skill Skill types provide a method for call center managers to match
the needs of a caller to the talents of the agents. A skill designates a
work category such as sales or collections. It enables the ACD to route
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types of calls to queues. Administrators can assign up to four skills or
sets of skills to each agent login ID.

Skill hunt group Replaces ACD splits when the ACD is configured
with EAS. The ACD can be queued to up to three different skill hunt
groups at one time.

Split An ACD split is a hunt group that is designed for a high volume
of similar calls. Members of a split are called agents. At any one time,
an agent can be logged into a maximum of three splits.

Vector Vector settings determine how the switch handles incoming
calls based on the number dialed. When the DEFINITY G3 is
configured with EAS, the vector directs the incoming call to a split, a
hunt group, or a skill hunt group.

Vector Directory Number The extension number that accesses a
vector. Agent Blending uses the Vector Directory Number for the
domain address and domain extension.

Spectrum Agent Group A collection of one or more agents, based on equivalent
skills or a specific call center need. In Spectrum, agents may have a
primary and a secondary group assignment; however, the system
requires that agents belong to only one group. In addition to the agent’s
skill level, you must assign agents to groups as inbound or acquire.
Inbound agents take only inbound calls. Acquire agents take inbound
and outbound calls, or they can be outbound-only.

Application The system treats applications as domains. In Spectrum,
incoming calls are routed to applications. An application is a type or
category of call you want handled in a similar way. Applications may
include:

• Company functions (for example, Customer Service, Accounts

• Payable)

• Special skill groups (for example, bilingual or technical
troubleshooters)

• Types of products (for example, Savings, Checking Accounts,
Mortgages)

For each application, the Spectrum tracks performance data such as
average speed to answer, number of calls offered, and average handling
time.
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You associate each application with an Application Telescript. The
telescript contains a set of instructions for handling calls. For Agent
Blending, it queues agent groups, places calls in wait queues, and
allows the system to track the call while it is on the Spectrum.

Application Directory Number (DN) You assign an Application
Directory Number in Applications Parameters when you create the
Spectrum application. When dialed, this number calls the application.
The Application Directory Number is used as the domain extension in
Agent Blending.

Application Number (also called the Application ID) You assign an
Application Number in Applications Parameters when you create the
Spectrum application. The Application Number is used as the domain
address in Agent Blending.

Class of Service A collection of attributes associated with agents and
devices within the Spectrum. One of the class of service attributes is the
Host Transaction feature. Host Transaction controls whether or not the
Spectrum generates call progress messages on the Transaction Link for
the associated agent or device. Agent Blending requires that you enable
the Host Transaction feature.

Host The host for the Spectrum is the Predictive Dialing System.

Provisioning A set of actions that add, alter, or delete system
parameters. In the system documentation, “configuring” has the same
meaning as “provisioning” in Spectrum documentation.

Telescript A user-programmable sequence of steps associated with
various call routing points within the Spectrum. During inbound call
routing, error processing, and call queuing, the Spectrum invokes
Routing, Intercept, and Application Telescripts. Feature Telescripts
operate as subroutines for the other telescript types.

Configuring an Application Telescript to route to the desired agent
groups is key to making Agent Blending work with Spectrum.

Transaction Link Spectrum’s name for its Computer Telephony
Interface (CTI) link. Transaction Link is a communications channel
between the Spectrum and the system. It is operated over an X.25 or
TCP/IP transport facility.

Trunk Group A collection of trunk ports that have common
processing characteristics, such as ANI and DNIS. One of the
characteristics is the Host Transaction Link feature. It controls whether
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Spectrum generates call progress messages for calls associated with the
trunk group members.

You must enable this feature to allow the system to monitor calls on
Spectrum.

Meridian ACD-DN (directory number) The ACD address for a call queue. It is
the Agent Blending domain address.

ACD Agent Position ID The number that identifies an agent’s
telephone extension. Agent Blending agents log onto the system as
ACD agents using their ACD Agent Position ID as the ACD extension.
During calling operations, managers can assign agents to Agent
Blending domains by assigning agent positions to call queues, or agents
can log into call queues that are Agent Blending domains.

Multiple queue assignment A Meridian option that allows agents to
log into multiple call queues.

The domains and domain groups you define and how your agents log
into call queues depends on whether your Meridian uses multiple queue
assignment.

PINNACLE Call queue A destination for call routing, defined by an ACD address.
A call queue can be an Agent Blending domain.

Queue ID The ACD address associated with a call queue. Queue IDs
are Agent Blending domain addresses.

Queue pilot number The ACD extension associated with an ACD
address. Queue pilot numbers are Agent Blending domain extensions.

Serving Team A group of agent identifiers for agents who will work
on the same task. PINNACLE can route calls to the serving team for a
call queue. Agent Blending inbound agents belong to an inbound
serving team. Agent Blending outbound and blend agents belong to an
acquire serving team.

ROLM 9005 ACD group or agent group A group of agent extensions that receives
calls from the same pilot number. Each ACD group has its own
telephones and members.

Call-progress event Any change in a call’s state in ROLM 9005.
CallBridge passes call-progress event messages from ROLM 9005 to
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CallPath. Call-progress event messages provide the information Agent
Blending needs to acquire and release agents.

Class of service A code indicating the features, extensions, and trunk
access available to an ACD address. Agent Blending uses agent groups
with the CallPath class of service.

Directory Number (DN) An ACD address or extension associated
with an ACD-defined group (such as an agent group or a hunt group) or
with a device such as a telephone or a Voice Response Unit (VRU)
port.

Dummy hunt group A hunt group with no members defined on
ROLM 9005. It unconditionally forwards calls to an agent group.
Agent Blending requires dummy hunt groups to collect call-progress
event messages. It uses the dummy hunt group’s pilot number as the
auxiliary domain’s extension number.

Pilot number A directory number associated with a group of
extension numbers that comprise one ACD group. Agent Blending uses
pilot numbers as the domain address. It uses the dummy hunt group’s
pilot number as the domain extension.
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Domains

Overview No matter which type of switch your system uses, the Avaya PDS
requires domains and domain groups. Domains are the Avaya PDS’s
name for ACD call queues which are defined on the ACD and on the
Avaya PDS.

Each domain is a member of a domain group. Agent Blending collects
calling events for each domain and totals them by domain group for
statistic calculation. It uses these statistics to determine when to move
ACD agents between inbound and outbound calling. It does not total
statistics across domain groups and it does not monitor activity in call
queues that are not part of a domain group.

After your system is installed, assign your agents to domains. Usually
you assign agents to domains based on a skill set. For example, you
might divide agents into three sets:

• agents who handle only credit card customers

• agents who handle consumer loan customers

• agents with skills to handle both credit card customers and
consumer loan customers

Configure domains The types of domains you configure depend upon the ACD. The two
main domain types are inbound and acquire. All Agent Blending
systems must have an acquire domain.

Agent Blending uses inbound domains to determine agent availability
by monitoring and analyzing the traffic. It uses acquire domains to
acquire agents for outbound calling.

In addition to inbound and acquire domains, the Avaya PDS recognizes
two additional domains. Some ACDs use auxiliary domains to monitor
all calling activity in a domain group. Meridian switches without
multiple queues assignment (MQA) use transient domains to
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temporarily hold agents who are moving between inbound and
outbound.

Domain groups Each domain group must be defined using one of the following four
configurations:

• Outbound without inbound domain (OB_ONLY control method)

• Predictive-Average Speed to Answer (ASA control method)

• Predictive-Service Level (SL control method)

• Outbound with inbound domain (Proactive Blend, OB_ONLY
control method)

Outbound Agent Blend Outbound Agent Blending acquires ACD agents to handle outbound
calls as soon as they log on to the Avaya PDS and the ACD.

Since there is no inbound domain in the OB_ONLY domain group,
agents who are assigned to an Outbound domain will not be released to
handle inbound calls.
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Domain Groups During site preparation, you identify which domains you want grouped.
A domain group contains one or more domains. A domain can belong
to only one domain group. There are three domain group Control
Methods: Outbound Only, Average Speed to Answer, and Service
Level. The Agent Blending Administrator window changes
dynamically depending on which one of the three Control Methods you
choose.

Outbound Only The Avaya PDS acquires outbound-only agents to handle outbound
calls as soon as they log onto the system and the ACD. Outbound
Agent Blending allows you to take advantage of the least-cost routing
available on your ACD and to use the detailed reports available on the
ACD.

To configure an Outbound Agent Blending job, set up an outbound
domain that contains at least one acquire domain (no inbound domain).
Select Outbound as the domain group type. Assign at least one acquire
domain to the group (no inbound domain).

If you select Outbound Only, you are required to enter a Minimum
Queued for Release value. Type a value between 0 and 999. The
default value is 0.
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Average Speed to Answer If you select Average Speed to Answer, your dialog box changes
dynamically, and you need to set values for the required fields. The
Average Speed to Answer fields are described in the following table.

Parameter Definition

Time Interval
(required)

The interval that the system uses to calculate the
Average Speed to Answer. It influences how
responsive the system is to fluctuations in
answer delays. It is an interval that begins each
time you start the system or restart Agent
Blending. Select a value greater than 0.25, in
increments of .25. The interval is in hours, so
.25 is 1/4 of an hour or 15 minutes. The default
is .50 (30 minutes). The setting represents an
average calculated over the Average Speed to
Answer interval.

Average Speed to
Answer
(required)

The average time within which agents should
answer calls. Type a value between 1 and 999.
The default value is 60.

Agent Utilization
Threshold
(required)

The percentage of agents available to take calls.
This setting determines how quickly the system
moves agents between inbound and outbound
calls. The goal is to prevent agents from being
acquired or released too frequently.

Agents are available if they are not taking calls
or updating records.

Agent Blending tracks calling statistics and uses
this information to predict future availability.
To calculate the threshold, the system divides
the projected inbound call volume by the
projected number of available agents. Type a
value between 1 and 999. The default value is
200.
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Minimum Agents
on Outbound
(required)

The minimum number of ACD blend agents, in
this domain, dedicated to handling outbound
calls. This setting overrides Desired level. For
example, no matter how low the Average Speed
to Answer, there will always be this number of
agents unavailable to handle inbound calls. Use
this option when it is more important to meet
outbound goals than to service inbound calls.
Type a value between 0 and 999. The default
value is 0.

Initial Traffic
Rate (optional)

The estimated number of calls each second. The
system uses this rate for the first 30 calls. It
ensures that there are enough agents to handle
the first 30 calls. Type a value between 0 and
999.

Talk Time
(optional)

The estimated minimum seconds agents spend
connected on each inbound call. The system
adds Talk time and After Call Work Time to
determine agent availability. Agent availability
is sometimes called service capacity. Type a
value between 1 and 999.

After Call Work
Time (optional)

The estimated minimum seconds agents spend,
after a call, updating records and processing
information. Type a value between 1 and 999.

Parameter Definition



2 5 - 3 3 6

...........................................................................................................................................................................................................................................................

Agent Blending

Service Level If you select Service Level, your dialog box changes dynamically, and
you need to set values for the required fields. The Service Level fields
are described in the following table.

Parameter Definition

Desired Service
Level (required)

The percentage of calls agents should answer
within the Service Criteria. Type a value
between 0 and 100 (value must be less than
Abatement Service Level). The default value is
80.

Abatement
Service Level
(required)

The maximum percentage of inbound calls
agents should answer within the Service Level
interval. Select a setting from 40 percent to 100
percent. When the service level goes above the
abatement service level, the system acquires
ACD blend agents for outbound calling. When
the service level drops below the abatement
service level, the system releases ACD blend
agents for inbound calling. Type a value between
0 and 100 (value must be greater than Desired
Service Level). The default value is 95.

Service
Criterion
(required)

The maximum time within which an agent
should answer a call. As the system runs, it
measures the seconds an inbound call is in the
ACD queue. Type a value between 1 and 999.
The default value is 60.

Time Interval
(required)

Same definition as seen in previous section.

Agent
Utilization
Threshold
(required)

Same definition as seen in previous section.

Minimum
Agents on
Outbound
(required)

Same definition as seen in previous section.

Initial Traffic
Rate (optional)

Same definition as seen in previous section.
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Talk Time
(optional)

Same definition as seen in previous section.

After Call Work
Time (optional)

Same definition as seen in previous section.

Parameter Definition
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.............................................................................................................................................................................................................................................................
Start the Agent Blending tool

Start the Agent Blending
tool

Start the Agent Blending tool from either Campaign Monitor or
Campaign Editor.

............................................................................................................................................................................

1 Select Start > Programs > Avaya > Campaign Director > Campaign
Monitor or Campaign Editor.

............................................................................................................................................................................

2 Select Tools > Agent Blending.
The Agent Blending Administrator window appears.
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.............................................................................................................................................................................................................................................................
Create a domain group

Create a domain group You can edit domain group settings while your blend engine is running.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select File > Create
Domain Group.

............................................................................................................................................................................

2 In the New Domain Group box, type a descriptive name for the domain
group, such as MIDWEST, and then click OK.
The name must be 10 or fewer characters. You have now created the
domain group name and must now complete the domain group settings.

............................................................................................................................................................................

3 Set values for the domain group fields: Control Method (Outbound
Only, Service Level, or Average Speed to Answer) and the options that
change dynamically based on your Control Method selection. For help
with filling in your fields, see the earlier topics that discuss Outbound
Only, Service Level, and Average Speed to Answer.
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.............................................................................................................................................................................................................................................................
Create a domain

Create a domain You must stop your blend engine in order to create a domain. The
Create Domain option is not available until you select the name of a
domain group. The domain will be added to the domain group that you
select.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, click the domain group to
which you want the new domain to belong, and then, select File >
Create Domain.

............................................................................................................................................................................

2 In the New Domain dialog box, type the address of the domain.
Typical values for this box are 5-digit addresses, such as 20601, and
must match your PBX ID exactly to communicate with the PBX.

............................................................................................................................................................................

3 Click OK.
You have created the domains name and must now define in the domain
settings.

............................................................................................................................................................................

4 Define the domain settings: Domain Type (Inbound, Transient Acquire,
Team Acquire, and Overflow), Phone Number, Gateway ID,
Application ID, and PBX ID.
For help with filling in your fields, see the earlier topics that discuss
Domain Type, Phone Number, Gateway ID, Application ID, and PBX
ID.
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.............................................................................................................................................................................................................................................................
Edit domain group settings

Edit domain group settings You must stop your blend engine in order to edit domain group
settings.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select the domain group
you want to edit.

............................................................................................................................................................................

2 Double-click the Control Method field to select Outbound Only,
Service Level, or Average Speed to Answer.
For descriptions of these options, see their sections shown earlier.

............................................................................................................................................................................

3 The domain group fields change dynamically depending on which
Control Method option you select. See the Domain Groups section
shown earlier for descriptions of the domain group fields. To determine
whether the field has a drop-down list or an editable value for you to use,
double-click the field. Save your work.
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.............................................................................................................................................................................................................................................................
Edit domain settings

Edit domain settings You must stop your blend engine in order to edit domain settings.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select the domain you
want to edit.

............................................................................................................................................................................

2 Double-click the Domain Type field select Inbound, Transient Acquire,
Team Acquire, or Overflow.
For descriptions of these options, see the Domain section shown earlier.

............................................................................................................................................................................

3 Type values for the Phone Number, Gateway ID, Application ID, and
PBX ID fields.
For descriptions of these fields, see the Domains section shown earlier.
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.............................................................................................................................................................................................................................................................
Delete a domain group

Delete a domain group You must stop your blend engine in order to delete a domain group.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select the domain group
you want to delete.

............................................................................................................................................................................

2 Select File > Delete Domain Group, and then save your work.
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Delete a domain

Delete a domain You must stop your blend engine in order to delete a domain.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select the domain you
want to delete.

............................................................................................................................................................................

2 Select File > Delete Domain, and then save your work.
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.............................................................................................................................................................................................................................................................
Move a domain to a different group

Move a domain to a
different group

You must stop your blend engine in order to move a domain to a
different domain group. Moving a domain is possible by deleting the
domain and then adding it to a different domain (remember to write
down its existing settings so that you can recreate them when you add
the domain to the new domain group).

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select the domain you
want to move (write down its settings first, if necessary), and then, select
File > Delete Domain.

............................................................................................................................................................................

2 Select the domain group to which you want to add the new domain, and
then select File > Create Domain.

............................................................................................................................................................................

3 In the New Domain dialog box, type the domain address, such as 20601,
and then click OK.

............................................................................................................................................................................

4 Complete the domain settings.
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Stop the blend engine

Stop the blend engine The Stop button shuts down all but two of the Blend processes on a
dialer; cbamain and cbauser remain up. This state is also called
configure-only mode. It is required for editing or deleting domains.
You stop the blend engine by clicking Stop in the Agent Blending
Administrator dialog box. (You must have a dialer selected in the tree
view for the Stop button to be visible. The dialers are located at the top-
most level in the tree view.)

............................................................................................................................................................................

1 Open Campaign Monitor or Campaign Editor and select Tools > Agent
Blending.
The Agent Blending Administrator window appears.

............................................................................................................................................................................

2 In the tree view, select a dialer.

............................................................................................................................................................................

3 Select Blend Engine > Stop.
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Start the blend engine

Start the blend engine The Start button starts the Blend processes that were killed with the
Stop command on a dialer. You start the blend engine by clicking Start
in the Agent Blending Administrator dialog box. (You must have a
dialer selected in the tree view for the Start button to be visible. The
dialers are located at the top-most level in the tree view.)

............................................................................................................................................................................

1 Open Campaign Monitor or Campaign Editor and select Tools > Agent
Blending.
The Agent Blending Administrator window appears.

............................................................................................................................................................................

2 In the tree view, select a dialer.

............................................................................................................................................................................

3 Select Blend Engine > Start.
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Reset the blend engine

Reset the blend engine The Reset button stops and restarts the Blend processes on a dialer. If
Blend is not running, the Reset button starts the processes on a dialer.

............................................................................................................................................................................

1 Open Campaign Monitor or Campaign Editor and select Tools > Agent
Blending. The Agent Blending Administrator window appears.

............................................................................................................................................................................

2 In the tree view, select a dialer.

............................................................................................................................................................................

3 Select Blend Engine > Reset.
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.............................................................................................................................................................................................................................................................
Resynch the blend engine

Resynch the blend engine The Resynch button updates the Avaya PDS system with the current
ACD agent queue assignments. Use Resynch after a supervisor uses the
ACD to reassign agents to different inbound queues.

............................................................................................................................................................................

1 Open Campaign Monitor or Campaign Editor and select Tools > Agent
Blending. The Agent Blending Administrator window appears.

............................................................................................................................................................................

2 In the tree view, select a dialer.

............................................................................................................................................................................

3 Select Blend Engine > Resynch.
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View ACD statistics

View ACD statistics Use the following procedure to view ACD statistics.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select Statistics under
the domain group for which you want to view statistics.
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View alerts

Overview Agent Blending alerts list Avaya PDS system and status messages
about Predictive Blend. For example, the Avaya PDS system may
display updates on the status of its connection to the gateway. Alerts
contain a brief message. For example: “acdmn: domain 24122 (ext
24122) removed from acquire service; Gateway 1 not configured with
load management”.

View alerts You are able to view alerts by clicking Alerts in the tree view.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select Alerts under the
domain group for which you want to view alerts.
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View transactions

View transactions Use the following procedure to view transactions.

............................................................................................................................................................................

1 In the Agent Blending Administrator window, select Transactions
under the domain group for which you want to view transactions.
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Preventing Toll Fraud

Toll Fraud is the unauthorized use of your telecommunications system by an unauthorized party
(for example, a person who is not a corporate employee, agent, subcontractor, or working on
your company's behalf). Be aware that there is a risk of toll fraud associated with your system
and that, if toll fraud occurs, it can result in substantial additional charges for your
telecommunications services.
Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical assistance or
support, call the Technical Service Center's Toll Fraud Intervention Hotline at 1-800-643-2353.
Providing Telecommunications Security

Telecommunications security of voice, data, and/or video communications is the prevention of
any type of intrusion to, that is, either unauthorized or malicious access to or use of, your
company's telecommunications equipment by some party.

Your company's "telecommunications equipment" includes both this Avaya product and any other
voice/data/video equipment that could be accessed via this Avaya product (that is, "networked
equipment").

An "outside party" is anyone who is not a corporate employee, agent, subcontractor, or working
on your company's behalf. Whereas, a "malicious party" is Anyone, including someone who may
be otherwise authorized, who accesses your telecommunications equipment with either malicious
or mischievous intent.

Such intrusions may be either to/through synchronous (time multiplexed and/or circuit-based) or
asynchronous (character-, message-, or packet-based) equipment or interfaces for reasons of:

Utilization (of capabilities special to the accessed equipment)

Theft (such as, of intellectual property, financial assets, or toll-facility access)

Eavesdropping (privacy invasions to humans)

Mischief (troubling, but apparently innocuous, tampering)

Harm (such as harmful tampering, data loss or alteration, regardless of motive or intent)

Be aware that there may be a risk of unauthorized or malicious intrusions associated with your
system and/or its networked equipment. Also realize that, if such an intrusion should occur, it
could result in a variety of losses to your company, including but not limited to, human/data
privacy, intellectual property, material assets, financial resources, labor costs, and/or legal costs.
Your Responsibility for Your Company's Telecommunications Security
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The final responsibility for securing both this system and its networked equipment rests with you
- an Avaya customer's system administrator, your telecommunications peers, and your
managers. Base the fulfillment of your responsibility on acquired knowledge and resources from
a variety of sources including but not limited to:

Installation documents

System administration documents

Security documents

Hardware-/software-based security tools

Shared information between you and your peers

Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your peers should
carefully program and configure your:

Avaya provided telecommunications system and their interfaces

Avaya provided software applications, as well as their underlying hardware/software platforms
and interfaces

Any other equipment networked to your Avaya products
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interference to radio communications. Operation of this equipment in a residential area is likely
to cause harmful interference, in which case the user will be required to correct the interference
at his own expense.

Part 68: Network Registration Number. This equipment is registered with the FCC in accordance
with Part 68 of the FCC Rules. It is identified by FCC registration number AV1USA-28011-MA-T.
Refer to "Federal Communications Commission Statement" in "About This Book" for more
information regarding Part 68.
Canadian Department of Communications (DOC) Interference Information

This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the
radio interference regulations of the Canadian Department of Communications.

Le Présent Appareil Nomérique n'émet pas de bruits radioélectriques dépassant les limites
applicables aux appareils numériques de la class A préscrites dans le reglement sur le brouillage
radioélectrique édicté par le ministére des Communications du Canada.
Trademarks

DEFINITY and Mosaix are registered trademarks of Avaya Inc.

Other products and brand names are trademarks or registered trademarks of their respective
holders.
Ordering Information
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Campaign Director

Overview

Campaign Director is a suite of call management applications that serve as the interface
between a call center supervisor and the Avaya PDS. Campaign Director applications allow
you to easily and dynamically design, control, monitor, and analyze call center activity. The
Avaya PDS increases your call center's productivity and helps you achieve your campaign
goals.  

The Avaya PDS consists of software and networked components, including the Avaya PDS
cabinet, supervisor workstations, agent workstations, printers, and modems.  

The Campaign Director software provides a graphical user interface to the Avaya PDS
which runs on your supervisor workstation.  

New features of Campaign Director

The newest release of Campaign Director encompasses all existing functionality of earlier
versions. The following list describes the new features of Campaign Director.  

Integration of monitoring and control functions

The functionality of Campaign Monitor and Campaign Manager are combined into
Campaign Monitor to provide a single interface to all job and agent monitor and control
functions.

Enterprise-wide monitoring

Campaign Monitor allows you to view multiple dialers across the enterprise. Campaign
Monitor provides the ability to focus on a single agent on a single dialer as well as provide
an enterprise-view of a call center.

Customizable views

In order to satisfy the needs of a wider, more diverse audience, Campaign Monitor provides
tools for customizing views of enterprise data and saving view configurations.

Improved speed and performance

Files are retrieved from and stored directly to the PDS by means of the Command and
Control interface, therefore, eliminating the need to synchronize with each Avaya PDS.

Campaign Director 
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Improved User Interface (UI)

The current tabular layout of Campaign Editor is replaced with a single form to maintain the
same look and feel as Campaign Monitor. This new design is similar to MicrosoftTM
Outlook.

Improved usability

The job and record selection editor screens display additional information which lets you
view the current status of the jobs or record selections on a specified system.

Ease of use

Campaign Editor automaticallys execute the record selection (if needed) and then verifies
the job. If the job verification passes, you will be offered a choice of starting the job or
cancelling the operation. You still have the capability to run record selections as a separate
action.

Global Campaign Director features

With Campaign Director's new user interface, there are several features that have been
added in order to increase the ability to customize settings. The table below identifies some
of the new features that are used throughout the Campaign Director applications and tools.

New feature Description

Button bar  Allows you to use shortcuts and navigate more easily.  

Sort columns  
Allows you to sort data in ascending and descending order by
clicking a column's heading.  

Resize columns  
Allows you to make a column wider or narrower by clicking
the area between column headings and then dragging to the left
or right.  

Refresh  Allows you to refresh the data in the active window.  

Launch tools  
Allows you to launch various tools: Hierarchy Manager,
Completion Code Manager, Agent Blending, PC Analysis
telnet, and System telnet.  

Multiple dialer controls  
Allows you to save and retrieve record selections, phone
strategies, and jobs from multiple dialers if this feature is
enabled. Also allows you to run reports across dialers.  

Define main dialer  
Allows you to define the main dialer within a pod (up to four
dialers).  

 

Campaign Director 
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Multi-dialer
To see topics for this section, click + in the contents list at left.
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Shared features

Overview

A pod of Avaya PDS dialers contains up to four dialers connected through a middle-tier
server. Following is a list of features that are shared among dialers in a pod:  

calling lists●   

jobs●   

phone strategies●   

record selections●   

A single Avaya PDS can dial up to 130,000 outbound calls per hour. With the multi-dialer
feature enabled, you can manage up to four dialers with list sharing across a distributed
dialer network, enabling increased outbound call volume of up to 500,000 calls per hour.  

A multi-dialer office environment greatly increases your company's outreach capacity. The
functionality allows you to manage up to four dialers in a distributed architecture using a
single, unified administration and supervisor interface for faster implementation of
large-scale outreach programs.  

Campaign Director makes it easy for you to manage operations and monitor traffic and
workload across the multi-dialer network.  

Shared calling list

The Avaya PDS allows you to run a job using a calling list from a different dialer. Any
Avaya PDS in a pod can be used to dial another dialer's (in that same pod) calling list. This
allows multiple dialers to call on the same calling list at the same time, which provides
scalability on a single campaign above the physical agent limitation of one Avaya PDS.  

The primary advantage of a shared calling list is speed. Imagine a job with 11,277 records
finishing in 1/4 the normal time!  

The shared list feature allows the agent capacity of multiple Avaya PDSs to be used for a
single job. For example, one supervisor on dialer 1 (in a pod of 4) can use a calling list that
resides on dialer 3, start a job that resides on dialer 2, and have agents from all 4 Avaya
PDSs log in to the job to complete outbound calls.  

Shared features 
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Pod monitoring

The pod feature combines monitoring, control, and administration of all four dialers in a pod
from a single Campaign Director workstation.  

Multi-dialer agent login management

You can create and manage logins and passwords for multiple dialers from a single system.
For example, a login and password created on one dialer may be populated to all dialers in a
pod.  

Multi-dialer monitoring

Campaign Monitor supports multiple dialers across the pod. For example, real-time job data
from multiple dialers can be aggregated into a single view of the overall pod.  

Multi-dialer control

Campaign Monitor provides control functions across all dialers in a pod. This allows one
supervisor to stop jobs, adjust Expert Calling Ratio, assign line pools, and perform other job
control functions from a single Campaign Director workstation.  

Multi-dialer administration

Campaign Director applications and tools provide administration across all dialers in a pod.
For example, you can copy, delete, and modify phone strategies, record selections, or jobs,
regardless of the dialer they reside on. If you delete a record selection, you will first be
prompted for the dialer the record selection resides on, and then you will be prompted for
which record selection you want to delete.  
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Primary and secondary dialers

Overview

In a pod, there are dialers that are configured as the "primary" dialer and the "secondary"
dialer.  

Primary dialer

A pod's primary dialer is an Avaya PDS dialer that runs the mid-tier software and controls
that coordinations data management are. Every Avaya PDS pod must have a primary dialer.
Secondary dialers feed data to the primary dialer that processes the data and makes it
available for monitoring and reporting. In this way, the system supervisor can view status or
create reports that include the operation of all the dialers in the pod.  

Secondary dialer

The secondary dialer is any dialer of an Avaya PDS pod that reports data to and is
coordinated with other secondary dialers by a primary dialer. One secondary dialer can also
be configured to take over primary dialer functions in the event of a primary dialer failure.  
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Pod impacts

Overview

If you work with a pod (one to four dialers), there are special considerations to think about
as you create ways to manage, control, and administer settings across multiple dialers.  

Multi-dialer

Campaign Monitor always shows data for all dialers in a pod. However, the controls for
multi-dialer are turned off by default. You can turn on the multi-dialer control from Settings
> Options. Choose which dialers in a pod to view. See "View control functions" for more
information.  

Once the multi-dialer control is turned on, each job control dialog box (for example, Job
Linking or Change Time Zones) shows a check mark. If you want to control a single dialer,
clear the check box.  

Completion codes

Dialer completion codes and their corresponding code number and code description are
contained in a system file called compcode.cfg. Each dialer has one compcode.cfg file.  

Completion codes are used in a variety of ways. Initially, they are used by the agent to end a
call with a customer. This tells the Avaya PDS what the outcome of that call was.
Completion codes are also used as part of reporting. They are essential to accurate reporting
and can be used to determine the success of a campaign.  

If there are four dialers in a pod, that also means there are four compcode.cfg files. It is
important to keep these four completion code files synchronized for a variety of reasons:  

Agents use the same codes for the same call outcome●   

Reporting from completion codes is accurate●   

Eliminates the need for troubleshooting for reasons of inaccurate completion codes.
Keeps all dialer completion codes synchronized

●   

To aggregate data across dialer effectively, completion code descriptions and
completion code assignments (RPC, Abandon, Closure) must remain consistent
across all dialers in a pod

●   

Pod impacts 
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Jobs

Jobs should be named carefully. Use the following guidelines when creating or modifying
jobs:  

Do not create multiple jobs on multiple dialers with the same name if they have very
different job parameters.

●   

If you want control like jobs in a single step (jobs with similar or like parameters),
then name the jobs the same on different dialers. For example, if you want to change
the quota on job1 on all dialers, you can do so in one step.

●   

Agents

In a pod environment, agent logons must be unique across dialers.  
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Campaign Life Cycle
To see topics for this section, click + in the contents list at left.
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Overview

During an Avaya PDS job, agents use a completion code to indicate the outcome of a call, such as
Promise to Pay or Left Message. You can categorize completion codes for monitoring and reporting
purposes with Completion Code Manager.  

Completion code categories

There are three completion code categories: RPC (Right Party Contact), Closure, and Abandon.  

RPC

indicates the agent called and talked to the correct party. This designation may overlap with the Closure
designation.

Closure

indicates that the agent called and talked to a party. Closure can represent a variety of outcomes,
including the following examples:

Balance paid in full

Bankruptcy

Deceased

Sale verified and completed

This designation may overlap with the RPC designation.  

Abandon

indicates that a call has been abandoned and the Avaya PDS has disconnected the call. An abandon can
be caused by one of several events:

An inbound caller hung up in the inbound wait queue

A customer hung up while in the outbound wait queue

The time limit for a call being held in a queue was met

Completion code assignments

You can assign a completion code to more than one category. For example, you can classify a verified
sale as an RPC and a Closure. The following illustration shows sample completion code assignments.

Completion code categories 
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Multi-dialer environment

Completion Code Manager lets you change the completion code description and code designation for
your completion codes. However, if the multi-dialer feature is enabled on your system, you must take
one of the following two actions:  

Make the identical changes on each dialer's set of completion codes●   

Copy the completion code file to each dialer●   

Completion code designation changes

When an Avaya PDS job starts, it applies the current Completion Code Manager settings. If you make
changes to code designations (RPC, Closure, or Abandon) while a job is running, you need to restart the
job to apply your new code designation changes.  

Completion code categories 
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Completion code descriptions

If you change one or more completion code descriptions in Completion Code Manager, Campaign
Monitor automatically updates to use the new descriptions. You do not need to restart a job for the
Avaya PDS to recognize new descriptions.  

If you use the Campaign Analyst Agent Completion Code Summary report, you need to designate which
codes you want to appear on the report. Insert an asterisk (*) as the first character of the description for
each completion code you want to include in the report. You can define up to 14 codes. If you define
more than 14 codes, Campaign Analyst uses the first 14 codes (in numerical order) and disregards the
remaining designated codes.  
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Start Completion Code Manager 

Start Completion Code Manager

You can start Completion Code Manager from Campaign Editor, Campaign Monitor, or
Campaign Analyst. Use the following procedure to start Completion Code Manager.  

Select Start > Programs > Avaya > Campaign Director > Campaign Editor, Campaign
Monitor or Campaign Analyst.

1.  

Select Tools > Completion Code Manager. The Completion Code Manager window
appears.

2.  
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Set a completion code as RPC

Use the following procedure to set a completion code as an RPC.  

From the list of completion codes in the right-hand pane, select a completion code.1.  

Drag the completion code to the left-hand pane and drop it under the row labeled
RPCs.

2.  
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Set a completion code as a Closure

Use the following procedure to set a completion code as a Closure.  

From the list of completion codes in the right-hand pane, select a completion code.1.  

Drag the completion code to the left-hand pane and drop it under the row labeled
Closures.

2.  
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Set a completion code as an Abandon

Use the following procedure to set a completion code as an Abandon.  

From the list of completion codes in the right-hand pane, select a completion code.1.  

Drag the completion code to the left-hand pane and drop it under the row labeled
Abandons.

2.  
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Remove a completion code

Use the following procedure to remove a completion code from an RPC, Closure, or
Abandon category.  

From the list of completion codes in the left-hand pane, right-click the completion
code you want to remove.

1.  

Click Delete.2.  

Note

When you delete the completion code from the list of categorized completion codes, the
code still appears it in the right-hand pane and is available to be selected again.  
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Change a completion code description

Use the following procedure to change a completion code description.  

From the list of completion codes in the left-hand pane of the window, double-click
the Description column of the completion code you want to change.

1.  

Type the new description, and then press Enter.
Completion Code Manager displays the new description.

2.  
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View Completion Code Manager for another dialer

Use the following procedure to view Completion Code Manager for another dialer.  

Start Campaign Editor, Campaign Monitor, or Campaign Analyst.1.  

(Campaign Editor only) On the button bar, select the dialer you want to view.2.  

Select Tools > Call Completion Codes.
In Campaign Editor, the Completion Code Manager window for the selected dialer
appears.

3.  

(Campaign Monitor and Campaign Analyst) Select a dialer from the Dialer dialog
box, and then click OK.
The Completion Code Manager window for the selected dialer appears.

4.  
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Agent Blending

Overview

Agent Blending integrates outbound calling activities on your Avaya PDS with inbound
calling activities on your ACD. In an Agent Blending system, ACD agents log on to the
Avaya PDS and the ACD. Agent Blending monitors the activity on the ACD and uses this
information to determine when to acquire agents for outbound calling and when to release
ACD agents to handle inbound calls.  

The Avaya PDS uses a pool of ACD (blend) agents for outbound calling. The system
acquires the pooled agents for outbound calling when the inbound calling activity decreases.
It releases these agents to inbound calling when the inbound calling activity increases. This
movement keeps the ACD blend agents busy while keeping the ACD service level within
your prescribed limits.  

Predictive Agent Blending

If your first priority is servicing your inbound customers and your inbound volume is fairly
high, you will benefit from using Predictive Agent Blending. Predictive Agent Blending
focuses on the inbound mission and only acquires agents for outbound when the Service
Level or Average Speed to Answer parameters are above the desired value. These agents
take inbound calls until the Avaya PDS predicts that there will be too many agents on
inbound (the Avaya PDS bases the prediction on the service level requirements you set).
The Avaya PDS then acquires agents from the ACD to handle outbound calls until the
inbound volume increases.  

Call centers with moderate to heavy inbound traffic and more than 25 agents in an inbound
pool benefit from using Predictive Agent Blending.  

Predictive Agent Blending uses events from the ACD to forecast call volume and determine
when to move ACD agents between inbound and outbound calling.  

There are two control method option within Predictive Agent Blending: Average Speed to
Answer and Service Level. To configure Predictive Agent Blending, set up an Average
Speed to Answer or a Service Level domain group that contains one or more acquire
domains and at least one inbound domain. Each type requires different settings.  

Average Speed to Answer (ASA)

This domain group type uses the target ASA field (MAAS) for calculating when to acquire
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and release agents. Agents are acquired for outbound calls when the average speed to
answer for all inbound domains in the group is less than or equal to the targeted value.
Agents are released when the value rises above the target.  

Service Level (SL)

This domain group type uses the Service Criterion (SC, seconds), Desired Service Level
(DSL, %), and Abatement Service Level (ASL, %) fields for calculating when to acquire
and release agents. Agents are acquired for outbound calls when the percentage of inbound
calls answered within the Service Criterion is greater than or equal to the Desired Service
Level percentage. Acquisitions will stop when the actual service level reaches the
Abatement Service Level value. Agents will be released back to inbound when the service
level falls below the desired value. The actual service level is calculated using all inbound
domains in the group.  

Proactive Agent Blending

If your focus is on outbound calling, but you need to service a low volume of inbound
customers, you will benefit from using Proactive Agent Blending. Proactive Agent Blending
focuses on outbound calls and releases agents to inbound only when an inbound calls enters
a monitored queue on the ACD. When an ACD agent logs on, the Avaya PDS immediately
acquires the agent for outbound calling. When an inbound call comes into the ACD queue,
the Avaya PDS releases the agent to handle the call. The number of queued calls before
agents release to inbound can be configured for each OB_ONLY domain group. If inbound
calls continue to come in, the Avaya PDS continues to release agents. As soon as the queue
is empty, the Avaya PDS acquires the agent for outbound calls.  
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Supported ACDs

The system supports Agent Blending on the following ACDs:  

Aspect CallCenter●   

DEFINITY G3●   

PINNACLE 5ESS●   

Northern Telecom Meridian 1●   

Rockwell Spectrum●   

Siemens ROLM 9751, Release 9005●   

The AvayaTM Predictive Dialing System (PDS) Installation Planner contains a full
description of the requirements for each supported switch. Each switch has unique settings
and terminology.  

Regardless of the special terminology used by ACD vendors, you configure your ACD to
work with the Avaya PDS. The Avaya PDS uses domains and domain groups to control
Agent Blending.  
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Switch terminology

Aspect

Agent group

A set of agents handling similar types of calls. Agents log into an agent group when they log
onto the Aspect CallCenter. Agent groups may be part of an agent super group.

Agent groups correspond to Agent Blending domains. Agent Blending monitors events for
domains configured on the system as inbound or acquire.  

Call Control Tables (CCTs)

Part of the Aspect CallCenter database. CCTs control call routing, queuing, and messaging
for agent groups and agent super groups. You can view, set up, edit, or delete CCTs from
Aspect CallCenter management workstation. There can be multiple CCTs for each agent
group and agent super group.

Data System Interlink Table

Part of the Aspect CallCenter database. It controls communication between the Aspect
CallCenter and the system. You can view the Data System Interlink Table and set
application parameters using the Aspect CallCenter management workstation. However,
only an Aspect representative can set system-level parameters.

DEFINITY G3

Expert Agent Selection (EAS)

An optional Definity G3 feature. It allows skill types to be assigned to a call type or Vector
Directory Number (VDN).

Hunt group

An agent queue on an ACD configured without EAS. The ACD hunts for the next available
agent in each hunt group. It uses the hunt method defined on the ACD.

Skill

Skill types provide a method for call center managers to match the needs of a caller to the
talents of the agents. A skill designates a work category such as sales or collections. It

Switch terminology 
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enables the ACD to route types of calls to queues. Administrators can assign up to four
skills or sets of skills to each agent login ID.

Skill hunt group

Replaces ACD splits when the ACD is configured with EAS. The ACD can be queued to up
to three different skill hunt groups at one time.

Split

An ACD split is a hunt group that is designed for a high volume of similar calls. Members
of a split are called agents. At any one time, an agent can be logged into a maximum of three
splits.

Vector

Vector settings determine how the switch handles incoming calls based on the number
dialed. When the DEFINITY G3 is configured with EAS, the vector directs the incoming
call to a split, a hunt group, or a skill hunt group.

Vector Directory Number

The extension number that accesses a vector. Agent Blending uses the Vector Directory
Number for the domain address and domain extension.

Spectrum

Agent Group

A collection of one or more agents, based on equivalent skills or a specific call center need.
In Spectrum, agents may have a primary and a secondary group assignment; however, the
system requires that agents belong to only one group. In addition to the agent's skill level,
you must assign agents to groups as inbound or acquire. Inbound agents take only inbound
calls. Acquire agents take inbound and outbound calls, or they can be outbound-only.

Application

The system treats applications as domains. In Spectrum, incoming calls are routed to
applications. An application is a type or category of call you want handled in a similar way.
Applications may include:

Company functions (for example, Customer Service, Accounts

Payable)

Special skill groups (for example, bilingual or technical troubleshooters)

Types of products (for example, Savings, Checking Accounts, Mortgages)

For each application, the Spectrum tracks performance data such as average speed to
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answer, number of calls offered, and average handling time.  

You associate each application with an Application Telescript. The telescript contains a set
of instructions for handling calls. For Agent Blending, it queues agent groups, places calls in
wait queues, and allows the system to track the call while it is on the Spectrum.  

Application Directory Number (DN)

You assign an Application Directory Number in Applications Parameters when you create
the Spectrum application. When dialed, this number calls the application. The Application
Directory Number is used as the domain extension in Agent Blending.

Application Number (also called the Application ID)

You assign an Application Number in Applications Parameters when you create the
Spectrum application. The Application Number is used as the domain address in Agent
Blending.

Class of Service

A collection of attributes associated with agents and devices within the Spectrum. One of
the class of service attributes is the Host Transaction feature. Host Transaction controls
whether or not the Spectrum generates call progress messages on the Transaction Link for
the associated agent or device. Agent Blending requires that you enable the Host
Transaction feature.

Host

The host for the Spectrum is the Predictive Dialing System.

Provisioning

A set of actions that add, alter, or delete system parameters. In the system documentation,
"configuring" has the same meaning as "provisioning" in Spectrum documentation.

Telescript

A user-programmable sequence of steps associated with various call routing points within
the Spectrum. During inbound call routing, error processing, and call queuing, the Spectrum
invokes Routing, Intercept, and Application Telescripts. Feature Telescripts operate as
subroutines for the other telescript types.

Configuring an Application Telescript to route to the desired agent groups is key to making
Agent Blending work with Spectrum.  

Transaction Link

Spectrum's name for its Computer Telephony Interface (CTI) link. Transaction Link is a
communications channel between the Spectrum and the system. It is operated over an X.25
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or TCP/IP transport facility.

Trunk Group

A collection of trunk ports that have common processing characteristics, such as ANI and
DNIS. One of the characteristics is the Host Transaction Link feature. It controls whether
Spectrum generates call progress messages for calls associated with the trunk group
members.

You must enable this feature to allow the system to monitor calls on Spectrum.  

Meridian

ACD-DN (directory number)

The ACD address for a call queue. It is the Agent Blending domain address.

ACD Agent Position ID

The number that identifies an agent's telephone extension. Agent Blending agents log onto
the system as ACD agents using their ACD Agent Position ID as the ACD extension.
During calling operations, managers can assign agents to Agent Blending domains by
assigning agent positions to call queues, or agents can log into call queues that are Agent
Blending domains.

Multiple queue assignment

A Meridian option that allows agents to log into multiple call queues.

The domains and domain groups you define and how your agents log into call queues
depends on whether your Meridian uses multiple queue assignment.  

PINNACLE

Call queue

A destination for call routing, defined by an ACD address. A call queue can be an Agent
Blending domain.

Queue ID

The ACD address associated with a call queue. Queue IDs are Agent Blending domain
addresses.

Queue pilot number

The ACD extension associated with an ACD address. Queue pilot numbers are Agent
Blending domain extensions.
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Serving Team

A group of agent identifiers for agents who will work on the same task. PINNACLE can
route calls to the serving team for a call queue. Agent Blending inbound agents belong to an
inbound serving team. Agent Blending outbound and blend agents belong to an acquire
serving team.

ROLM 9005

ACD group or agent group

A group of agent extensions that receives calls from the same pilot number. Each ACD
group has its own telephones and members.

Call-progress event

Any change in a call's state in ROLM 9005. CallBridge passes call-progress event messages
from ROLM 9005 to CallPath. Call-progress event messages provide the information Agent
Blending needs to acquire and release agents.

Class of service

A code indicating the features, extensions, and trunk access available to an ACD address.
Agent Blending uses agent groups with the CallPath class of service.

Directory Number (DN)

An ACD address or extension associated with an ACD-defined group (such as an agent
group or a hunt group) or with a device such as a telephone or a Voice Response Unit
(VRU) port.

Dummy hunt group

A hunt group with no members defined on ROLM 9005. It unconditionally forwards calls to
an agent group. Agent Blending requires dummy hunt groups to collect call-progress event
messages. It uses the dummy hunt group's pilot number as the auxiliary domain's extension
number.

Pilot number

A directory number associated with a group of extension numbers that comprise one ACD
group. Agent Blending uses pilot numbers as the domain address. It uses the dummy hunt
group's pilot number as the domain extension.
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Domains

Overview

No matter which type of switch your system uses, the Avaya PDS requires domains and domain groups. Domains are the
Avaya PDS's name for ACD call queues which are defined on the ACD and on the Avaya PDS.  

Each domain is a member of a domain group. Agent Blending collects calling events for each domain and totals them by
domain group for statistic calculation. It uses these statistics to determine when to move ACD agents between inbound and
outbound calling. It does not total statistics across domain groups and it does not monitor activity in call queues that are not
part of a domain group.  

After your system is installed, assign your agents to domains. Usually you assign agents to domains based on a skill set. For
example, you might divide agents into three sets:  

agents who handle only credit card customers●   

agents who handle consumer loan customers●   

agents with skills to handle both credit card customers and consumer loan customers●   

Configure domains

The types of domains you configure depend upon the ACD. The two main domain types are inbound and acquire. All Agent
Blending systems must have an acquire domain.  

Agent Blending uses inbound domains to determine agent availability by monitoring and analyzing the traffic. It uses acquire
domains to acquire agents for outbound calling.  

In addition to inbound and acquire domains, the Avaya PDS recognizes two additional domains. Some ACDs use auxiliary
domains to monitor all calling activity in a domain group. Meridian switches without multiple queues assignment (MQA) use
transient domains to temporarily hold agents who are moving between inbound and outbound.
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Domain groups

Each domain group must be defined using one of the following four configurations:  

Outbound without inbound domain (OB_ONLY control method)●   

Predictive-Average Speed to Answer (ASA control method)●   

Predictive-Service Level (SL control method)●   

Outbound with inbound domain (Proactive Blend, OB_ONLY control method)●   

Domains 
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Outbound Agent Blend

Outbound Agent Blending acquires ACD agents to handle outbound calls as soon as they log on to the Avaya PDS and the
ACD.  

Since there is no inbound domain in the OB_ONLY domain group, agents who are assigned to an Outbound domain will not
be released to handle inbound calls.  
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Domain Groups

Domain Groups

During site preparation, you identify which domains you want grouped. A domain group
contains one or more domains. A domain can belong to only one domain group. There are
three domain group Control Methods: Outbound Only, Average Speed to Answer, and
Service Level. The Agent Blending Administrator window changes dynamically depending
on which one of the three Control Methods you choose.  

Outbound Only

The Avaya PDS acquires outbound-only agents to handle outbound calls as soon as they log
onto the system and the ACD. Outbound Agent Blending allows you to take advantage of
the least-cost routing available on your ACD and to use the detailed reports available on the
ACD.  

To configure an Outbound Agent Blending job, set up an outbound domain that contains at
least one acquire domain (no inbound domain). Select Outbound as the domain group type.
Assign at least one acquire domain to the group (no inbound domain).  

If you select Outbound Only, you are required to enter a Minimum Queued for Release
value. Type a value between 0 and 999. The default value is 0.  

Average Speed to Answer

If you select Average Speed to Answer, your dialog box changes dynamically, and you need
to set values for the required fields. The Average Speed to Answer fields are described in
the following table.

Parameter Definition

Domain Groups 
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Time Interval (required)  

The interval that the system uses to calculate
the Average Speed to Answer. It influences
how responsive the system is to fluctuations
in answer delays. It is an interval that begins
each time you start the system or restart
Agent Blending. Select a value greater than
0.25, in increments of .25. The interval is in
hours, so .25 is 1/4 of an hour or 15 minutes.
The default is .50 (30 minutes). The setting
represents an average calculated over the
Average Speed to Answer interval.  

Average Speed to Answer (required)  
The average time within which agents should
answer calls. Type a value between 1 and
999. The default value is 60.  

Agent Utilization Threshold (required)  

The percentage of agents available to take
calls. This setting determines how quickly the
system moves agents between inbound and
outbound calls. The goal is to prevent agents
from being acquired or released too
frequently.  

Agents are available if they are not taking
calls or updating records.  

Agent Blending tracks calling statistics and
uses this information to predict future
availability. To calculate the threshold, the
system divides the projected inbound call
volume by the projected number of available
agents. Type a value between 1 and 999. The
default value is 200.  

Minimum Agents on Outbound (required)
 

The minimum number of ACD blend agents,
in this domain, dedicated to handling
outbound calls. This setting overrides Desired
level. For example, no matter how low the
Average Speed to Answer, there will always
be this number of agents unavailable to
handle inbound calls. Use this option when it
is more important to meet outbound goals
than to service inbound calls. Type a value
between 0 and 999. The default value is 0.  

Domain Groups 
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Initial Traffic Rate (optional)  

The estimated number of calls each second.
The system uses this rate for the first 30 calls.
It ensures that there are enough agents to
handle the first 30 calls. Type a value
between 0 and 999.  

Talk Time (optional)  

The estimated minimum seconds agents
spend connected on each inbound call. The
system adds Talk time and After Call Work
Time to determine agent availability. Agent
availability is sometimes called service
capacity. Type a value between 1 and 999.  

After Call Work Time (optional)  

The estimated minimum seconds agents
spend, after a call, updating records and
processing information. Type a value
between 1 and 999.  

 

Service Level

If you select Service Level, your dialog box changes dynamically, and you need to set
values for the required fields. The Service Level fields are described in the following table.

Parameter Definition

Desired Service Level (required)  

The percentage of calls agents should
answer within the Service Criteria. Type a
value between 0 and 100 (value must be less
than Abatement Service Level). The default
value is 80.  

Abatement Service Level (required)  

The maximum percentage of inbound calls
agents should answer within the Service
Level interval. Select a setting from 40
percent to 100 percent. When the service
level goes above the abatement service
level, the system acquires ACD blend agents
for outbound calling. When the service level
drops below the abatement service level, the
system releases ACD blend agents for
inbound calling. Type a value between 0 and
100 (value must be greater than Desired
Service Level). The default value is 95.  

Domain Groups 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/10_AgentBlendingTool_BB7.html (3 of 4) [4/5/2002 3:25:30 PM]



Service Criterion (required)  

The maximum time within which an agent
should answer a call. As the system runs, it
measures the seconds an inbound call is in
the ACD queue. Type a value between 1 and
999. The default value is 60.  

Time Interval (required)  
Same definition as seen in previous section.
 

Agent Utilization Threshold (required)  
Same definition as seen in previous section.
 

Minimum Agents on Outbound (required)  
Same definition as seen in previous section.
 

Initial Traffic Rate (optional)  
Same definition as seen in previous section.
 

Talk Time (optional)  
Same definition as seen in previous section.
 

After Call Work Time (optional)  
Same definition as seen in previous section.
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Start the Agent Blending tool 

Start the Agent Blending tool

Start the Agent Blending tool from either Campaign Monitor or Campaign Editor.  

Select Start > Programs > Avaya > Campaign Director > Campaign Monitor or
Campaign Editor.

1.  

Select Tools > Agent Blending.
The Agent Blending Administrator window appears.

2.  
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Create a domain group 

Create a domain group

You can edit domain group settings while your blend engine is running.  

In the Agent Blending Administrator window, select File > Create Domain Group.1.  

In the New Domain Group box, type a descriptive name for the domain group, such
as MIDWEST, and then click OK.
The name must be 10 or fewer characters. You have now created the domain group
name and must now complete the domain group settings.

2.  

Set values for the domain group fields: Control Method (Outbound Only, Service
Level, or Average Speed to Answer) and the options that change dynamically based
on your Control Method selection. For help with filling in your fields, see the earlier
topics that discuss Outbound Only, Service Level, and Average Speed to Answer.

3.  
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Create a domain 

Create a domain

You must stop your blend engine in order to create a domain. The Create Domain option is
not available until you select the name of a domain group. The domain will be added to the
domain group that you select.  

In the Agent Blending Administrator window, click the domain group to which you
want the new domain to belong, and then, select File > Create Domain.

1.  

In the New Domain dialog box, type the address of the domain.
Typical values for this box are 5-digit addresses, such as 20601, and must match your
PBX ID exactly to communicate with the PBX.

2.  

Click OK.
You have created the domains name and must now define in the domain settings.

3.  

Define the domain settings: Domain Type (Inbound, Transient Acquire, Team
Acquire, and Overflow), Phone Number, Gateway ID, Application ID, and PBX ID.
For help with filling in your fields, see the earlier topics that discuss Domain Type,
Phone Number, Gateway ID, Application ID, and PBX ID.

4.  
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Edit domain group settings 

Edit domain group settings

You must stop your blend engine in order to edit domain group settings.  

In the Agent Blending Administrator window, select the domain group you want to
edit.

1.  

Double-click the Control Method field to select Outbound Only, Service Level, or
Average Speed to Answer.
For descriptions of these options, see their sections shown earlier.

2.  

The domain group fields change dynamically depending on which Control Method
option you select. See the Domain Groups section shown earlier for descriptions of
the domain group fields. To determine whether the field has a drop-down list or an
editable value for you to use, double-click the field. Save your work.

3.  
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Edit domain settings 

Edit domain settings

You must stop your blend engine in order to edit domain settings.  

In the Agent Blending Administrator window, select the domain you want to edit.1.  

Double-click the Domain Type field select Inbound, Transient Acquire, Team
Acquire, or Overflow.
For descriptions of these options, see the Domain section shown earlier.

2.  

Type values for the Phone Number, Gateway ID, Application ID, and PBX ID fields.
For descriptions of these fields, see the Domains section shown earlier.

3.  
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Delete a domain group 

Delete a domain group

You must stop your blend engine in order to delete a domain group.  

In the Agent Blending Administrator window, select the domain group you want to
delete.

1.  

Select File > Delete Domain Group, and then save your work.2.  
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Delete a domain 

Delete a domain

You must stop your blend engine in order to delete a domain.  

In the Agent Blending Administrator window, select the domain you want to delete.1.  

Select File > Delete Domain, and then save your work.2.  
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Move a domain to a different group 

Move a domain to a different group

You must stop your blend engine in order to move a domain to a different domain group.
Moving a domain is possible by deleting the domain and then adding it to a different domain
(remember to write down its existing settings so that you can recreate them when you add
the domain to the new domain group).  

In the Agent Blending Administrator window, select the domain you want to move
(write down its settings first, if necessary), and then, select File > Delete Domain.

1.  

Select the domain group to which you want to add the new domain, and then select
File > Create Domain.

2.  

In the New Domain dialog box, type the domain address, such as 20601, and then
click OK.

3.  

Complete the domain settings.4.  

 Volume I PDF

Legal Statement

Avaya Inc.

Move a domain to a different group  

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ab_domain_mvtogrp.html [4/5/2002 3:25:32 PM]

http://www.avaya.com/


 Avaya PDS User Guide

Page 16 of 22

Stop the blend engine 

Stop the blend engine

The Stop button shuts down all but two of the Blend processes on a dialer; cbamain and
cbauser remain up. This state is also called configure-only mode. It is required for editing or
deleting domains. You stop the blend engine by clicking Stop in the Agent Blending
Administrator dialog box. (You must have a dialer selected in the tree view for the Stop
button to be visible. The dialers are located at the top-most level in the tree view.)  

Open Campaign Monitor or Campaign Editor and select Tools > Agent Blending.
The Agent Blending Administrator window appears.

1.  

In the tree view, select a dialer.2.  

Select Blend Engine > Stop.3.  
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Start the blend engine 

Start the blend engine

The Start button starts the Blend processes that were killed with the Stop command on a
dialer. You start the blend engine by clicking Start in the Agent Blending Administrator
dialog box. (You must have a dialer selected in the tree view for the Start button to be
visible. The dialers are located at the top-most level in the tree view.)  

Open Campaign Monitor or Campaign Editor and select Tools > Agent Blending.
The Agent Blending Administrator window appears.

1.  

In the tree view, select a dialer.2.  

Select Blend Engine > Start.3.  
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Reset the blend engine 

Reset the blend engine

The Reset button stops and restarts the Blend processes on a dialer. If Blend is not running,
the Reset button starts the processes on a dialer.  

Open Campaign Monitor or Campaign Editor and select Tools > Agent Blending. The
Agent Blending Administrator window appears.

1.  

In the tree view, select a dialer.2.  

Select Blend Engine > Reset.3.  
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Resynch the blend engine

The Resynch button updates the Avaya PDS system with the current ACD agent queue
assignments. Use Resynch after a supervisor uses the ACD to reassign agents to different
inbound queues.  

Open Campaign Monitor or Campaign Editor and select Tools > Agent Blending. The
Agent Blending Administrator window appears.

1.  

In the tree view, select a dialer.2.  

Select Blend Engine > Resynch.3.  
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View ACD statistics 

View ACD statistics

Use the following procedure to view ACD statistics.  

In the Agent Blending Administrator window, select Statistics under the domain
group for which you want to view statistics.

1.  
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View alerts 

Overview

Agent Blending alerts list Avaya PDS system and status messages about Predictive Blend.
For example, the Avaya PDS system may display updates on the status of its connection to
the gateway. Alerts contain a brief message. For example: "acdmn: domain 24122 (ext
24122) removed from acquire service; Gateway 1 not configured with load management".  

View alerts

You are able to view alerts by clicking Alerts in the tree view.  

In the Agent Blending Administrator window, select Alerts under the domain group
for which you want to view alerts.

1.  
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View transactions

Use the following procedure to view transactions.  

In the Agent Blending Administrator window, select Transactions under the domain
group for which you want to view transactions.

1.  
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System Telnet
To see topics for this section, click + in the contents list at left.
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System Telnet

Overview

Use the System Telnet tool to access the system and administrative menus. The telnet
session lets you access Avaya PDS features available through character-based menu
systems. For example, you can manage user accounts, check calling list status, or manage
agent job lists. You can also access some Campaign Monitor and Campaign Editor features
through character-based menus.  

System Telnet is available from the Tools menu in Campaign Editor, Campaign Monitor,
and Campaign Analyst. If access to Campaign Director is not available, you will need to use
a third-party telnet tool to access Avaya PDS menu system and PC Analysis.  

TIP

To access PC Analysis menus, use the PC Analysis Telnet tool in Campaign Analyst. PC
Analysis Telnet includes special tools designed to help you navigate the PC Analysis extract
screens.  
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Toolbar icons

The System Telnet window opens with a set of tools that help you use and navigate the
character-based menus.

Toolbar Name Icon Description

Connect    

Use the Connect tool to select the dialer for which you want to
access character-based features. This function is not available
while you are connected to a dialer. You must disconnect from
a dialer before you can connect to a different dialer.  

Disconnect    

Use the Disconnect tool to end the telnet session for the
current dialer. If you exit the menu system, System Telnet
automatically disconnects your session. After you disconnect,
you can connect to a different dialer or exit the System Telnet
application.  

Exit out of entry    

Use the Exit out of entry tool to move back one screen in the
character-based screens. This provides the same functionality
as Ctrl-x.  

Done with entry    

Use the Done with entry tool to move to the next
character-based screen. This provides the same functionality
as the Done key (F1).  
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Start System Telnet

Use the following procedure to start System Telnet to access the Avaya PDS
character-based menus.  

Select Start > Programs > Avaya > Campaign Director > Campaign Editor, Campaign
Monitor, or Campaign Analyst.

1.  

Select Tools > System Telnet. A System Telnet window appears.2.  

Select File > Connect. The Connect to PDS dialog box appears.3.  

From the Name list, select the name of the dialer to which you want to connect, then
click OK.
The dialer login: prompt appears in the Telnet window.

4.  

Type your system login and password to access the system menus or the administrator
login and password to access the administrative menus.
The character-based menu system associated with your user name appears in the
Telnet window.

5.  
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) uses PC Analysis for reporting and
troubleshooting.  

Contents

This section contains the following topics:  

PC Analysis●   

Data sources●   

Job history●   

Agent history●   

Calling statistics●   

Calling list●   

Downloading an extract file●   

PC Analysis extract●   

Log in to PC Analysis using cdwanal password●   

Log in to PC Analysis using supervisor password●   

Create an extract file●   

Extract selection information●   

Set up the extract file●   

Edit an extract file●   

Copy an extract file●   

Delete extract and output files●   

Execute an extract configuration file●   

Display completion codes●   

Display available calling lists●   

Copy an extract print file●   

Delete an extract print file●   

Overview 
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View and print an extract file●   
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Data sources

Overview

When Avaya PDS places a call, information is put into "buckets" or files. The call's outcome
is written to the calling list (AGENT, DATE, TIME, and CODE) and to the statistics files.  

When the job is complete, summary information is gathered and written to the job and agent
files.  

 

We gather information from these files using PC Analysis.  

Data sources include Job History Files, Agent History Files, Calling Information Statistics,

Data sources 
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Calling Transaction Statistics, and Calling List Information.  

Job history and agent history files are created by an Avaya PDS binary application that uses
totals from the information and transaction statistics. Depending on what you want to do,
you choose the file containing the information you need as your source file.  

Note:

You can take information only from one source file per
extract. If you want information from more than one source
file on your PC, separate extracts and then combine the data
in your PC application.

Data Sources

Job History

This file contains data about the last 200 jobs run on Avaya PDS. Typical data consists of
job start and stop times, the total number of connects, the total number of agents working
the job, and the total number of minutes the job was run.

Agent History

This file contains data about each agent's calling activity during the last 200 jobs. Typical
data includes number of seconds the agent was talking with clients, the number of seconds
updating records, and the number of calls the agent answered.

Statistics

There are two statistics files

Information File

This file contains data about all calls placed during a job. It includes the times agents joined
and left jobs, and the time the job shut down.  

Transaction File

This file contains data about inbound and outbound call processing. Avaya PDS stores the
record numbers, phone numbers, recall attempt counts, agent names, talk and work times,
and calling results. Typically, these statistics are stored for the past five calendar days. Some
systems are configured to store up to 28 calendar days.  

Calling list

This file contains data about the client's account. It typically includes the person's name,
address, account information and the system-added and agent-added codes.

Data sources 
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Mandatory Customer Information

Preventing Toll Fraud

Toll Fraud is the unauthorized use of your telecommunications system by an unauthorized party (for
example, a person who is not a corporate employee, agent, subcontractor, or working on your company’s
behalf). Be aware that there is a risk of toll fraud associated with your system and that, if toll fraud occurs,
it can result in substantial additional charges for your telecommunications services.

Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call
the Technical Service Center’s Toll Fraud Intervention Hotline at 1-800-643-2353.

Providing Telecommunications Security

Telecommunications security of voice, data, and/or video communications is the prevention of any type of
intrusion to, that is, either unauthorized or malicious access to or use of, your company’s
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limited to:

• Installation documents
• System administration documents
• Security documents
• Hardware-/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your peers should carefully program
and configure your:

• Avaya provided telecommunications system and their interfaces
• Avaya provided software applications, as well as their underlying hardware/software platforms and
interfaces
• Any other equipment networked to your Avaya products
Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in
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accordance with the instructions, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be required
to correct the interference at his own expense.

Part 68: Network Registration Number. This equipment is registered with the FCC in accordance with
Part 68 of the FCC Rules. It is identified by FCC registration number AV1USA-28011-MA-T. Refer to
“Federal Communications Commission Statement” in “About This Book” for more information regarding
Part 68.

Canadian Department of Communications (DOC) Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the radio
interference regulations of the Canadian Department of Communications.

Le Présent Appareil Nomérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux
appareils numériques de la class A préscrites dans le reglement sur le brouillage radioélectrique édicté par
le ministére des Communications du Canada.

Trademarks

DEFINITY and Mosaix are registered trademarks of Avaya Inc.

Other products and brand names are trademarks or registered trademarks of their respective holders.

Ordering Information
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You can be placed on a standing order list for this and other documents you may need. Standing order will
enable you to automatically receive updated versions of individual documents or document sets, billed to
account information that you provide. For more information on standing orders, or to be put on a list to
receive future issues of this document, contact the Avaya Publications Center.

For information about Avaya products and services, go to www.avaya.com. For product documentation for
all Avaya products and related documentation, go to www.avayadocs.com.

European Union Declaration of Conformity

The “CE” mark affixed to the DEFINITY ONE equipment described in this book indicates that the
equipment conforms to the following European Union (EU) Directives:

• Electromagnetic Compatibility (89/336/EEC)

• Telecommunications Terminal Equipment (TTE) i-CTR3 BRI and i-CTR4 PRI
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About this information product

Purpose The purpose of this guide is to provide detailed information about the
operation of the AvayaTM Predictive Dialing System (PDS).

Reason for reissue The following list describes changes to the Avaya PDS User’s Guide
since the last release.

• This guide has been formatted for easier use.

• This guide has been branded to match the change of our product
names.

• This guide contains two volumes - one for the graphical,
Campaign Director interface, and the other for the Character-
Based User Interface, which uses menus to navigate through the
system (these two interfaces cannot be used simultaneously).

• This guide is arranged by task rather than by application. This
allows the information to flow according to user task rather than
individual tasks performed within certain applications.

Intended-Audience The audience for this manual includes any user of the Avaya PDS. This
includes, but is not limited to, system supervisors, integration
consultants, application consultants, and customer support engineers.
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1 Supervisor overview

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) also contains
Supervisor menus that help you manage your calling activities.

Contents This section contains the following topic:

• Supervisor main menu
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Supervisor overview

.............................................................................................................................................................................................................................................................
Supervisor main menu

Supervisor Main menu Supervisor menus contain commands for managing the agents by
assigning their login and permission levels, monitoring their calls, and
sending them messages. They also include options that determine how
the Avaya PDS uses your phone lines, and which records the system
calls. In addition, they provide a full reporting capability so you can
keep track of your calling activities.
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2 Campaign overview

.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses campaigns that
you design to achieve your call center goals. One element of a
campaign is a job. The objective of a job is to accomplish specific
campaign goals. Campaigns can include one or more jobs. A job
consists of a calling list, phone strategy, record selection, job
definition, and job screens. Multiple jobs can share screens if the jobs
are based on the same calling list or calling list format.

Contents This section contains the following topics:

• Start a campaign

• Create phone strategy

• Add initial phone

• Add alternate initial phone (optional)

• Add ring count and call connect criteria

• Add retries

• Edit a phone strategy

• Copy a phone strategy

• Delete a phone strategy

• Set Recall Times

• Record Selection
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Campaign overview

• Create a Record Selection

• Selecting Time Zones

• Selecting Call Completion Codes

• Selecting Field Names and Value

• Selecting Phone Strategies

• Sorting field names and direction (optional)

• Selecting recall field names and values

• Set ring count and call connect criteria

• Grouping expressions and statements

• Move fields and values

• Unit Record Selection

• Edit unit record selection

• Execute unit record selection

• Standard Record Edit

• Supervisor Menu Record Selection Preparation

• Edit a record selection

• Execute a record selection

• Copy a record selection

• Delete a record selection

• Create a job

• Edit an outbound job

• Managed Jobs

• Edit Managed Jobs

• Edit Sales Verification Jobs

• Edit Infinite Jobs

• Edit Virtual Jobs

• Edit Inbound Jobs

• Edit Blend Jobs

• Copy a Job

• Delete a Job

• Infinite Job Record Selection

• Manage Job Linking
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.............................................................................................................................................................................................................................................................
Start a campaign

Start a campaign Use the following procedure to start a campaign.

............................................................................................................................................................................

1 Set up or select phone strategies.

............................................................................................................................................................................

2 Set up or review and run record selections.

............................................................................................................................................................................

3 Set up and start jobs.
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Campaign overview

.............................................................................................................................................................................................................................................................
Create phone strategy

Create a phone strategy Use the following procedure to create a phone strategy.

............................................................................................................................................................................

1 Choose Create a phone strategy from the Phone Strategies menu.

............................................................................................................................................................................

2 If the system has more than one calling list, type the calling list number
and press Enter. (If you use only one calling list, the Avaya PDS skips
this step.) The phone strategy name prompt appears.

............................................................................................................................................................................

3 Type a strategy file name (not more than 8 characters). Do not use
special characters such as hyphens, slashes, or spaces.

............................................................................................................................................................................

4 Type Y at the prompt to process the changes or N to cancel. If you type
Y, the Select Initial Phone screen appears.
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.............................................................................................................................................................................................................................................................
Add initial phone

Add an initial phone Use the following procedure to add an initial phone.

............................................................................................................................................................................

1 In the Phone column, type the phone type number (1, 2, 3, …) of the first
phone number you want to call.

............................................................................................................................................................................

2 Select a field by typing the field name (uppercase letters) in the Field
column or press F4 (View) to select the field from the calling list.

............................................................................................................................................................................

3 Type a value in the Value column. For help in setting values, see “To
select field names and value criteria”.

............................................................................................................................................................................

4 To add a second field and value for this phone, type AND or OR in the
And/Or column; then repeat steps 2 and 3.

............................................................................................................................................................................

5 Repeat steps 1 through 4 for each selected phone. After you enter all the
fields and values for the initial phones, press F1 (Done). The Select
Alternate Initial Phone screen appears.
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Campaign overview

.............................................................................................................................................................................................................................................................
Add alternate initial phone (optional)

Add an alternate initial
phone

Use the following procedure to add an alternate initial phone (optional).

............................................................................................................................................................................

1 In the Phone column, type the phone type number (1, 2, 3, …) of the
alternate phone number you want to call.

............................................................................................................................................................................

2 In the Time Zones column, type the uppercase letter assigned to the time
zone or type an asterisk (*) for all time zones or press F4 (View) to select
a time zone from a list.

............................................................................................................................................................................

3 In the Time column, type the time you want the Avaya PDS to start
calling the alternate phone (24-hour clock). Use a period to separate
hours and minutes. For example, type 17.10 to enter 5:10 PM.

............................................................................................................................................................................

4 Repeat steps 1 through 3 for each alternate initial phone. Press F1
(Done). The Select System Set Recalls screen appears.
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.............................................................................................................................................................................................................................................................
Add ring count and call connect criteria

Add ring count and call
connect criteria

Use the following procedure to add ring count and call connect criteria.

............................................................................................................................................................................

1 In the Phone Field column, type the phone type number (1, 2, 3, ...).

............................................................................................................................................................................

2 Type the number of rings to allow in the # of Rings column. (Low
number recommended, such as 3.)

............................................................................................................................................................................

3 Type the letter(s) to designate the call detection mode in the Connect.

............................................................................................................................................................................

4 Repeat steps 1 through 3 for each initial phone type.

............................................................................................................................................................................

5 Press F1 (Done). The Record Selections menu reappears. For help
setting up record selections, see “Overview of Record Selections”.
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Add retries

Add retries Use the following procedure to add retries.

............................................................................................................................................................................

1 In the Phone Field column, type the phone type number (1, 2, 3, ...).

............................................................................................................................................................................

2 Press F4 (View) to view the call completion codes list. Use the arrow
keys to select a code, then press Enter. You can also type the call code
directly in the Call Result column. It must match upper and lowercase
characters.

............................................................................................................................................................................

3 Type the number of minutes between each calling attempts in the Min
(Minutes) column.

............................................................................................................................................................................

4 Type the number of retries in the Number column.

............................................................................................................................................................................

5 In the Next Phone column, type the phone type number (1, 2, 3, ...). The
Next Phone is the phone the Avaya PDS calls after it makes the last
attempt to call the initial phone. If you leave this field blank, the system
stops calling the record after the last retry.

............................................................................................................................................................................

6 Repeat steps 1 through 5 for each call result for which you want to
schedule retries.

............................................................................................................................................................................

7 Press F1 (Done). The Select Ring Count and Call Connect Criteria
screen appears.
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.............................................................................................................................................................................................................................................................
Edit a phone strategy

Edit a phone strategy Use the following procedure to edit an existing phone strategy.

............................................................................................................................................................................

1 Choose Edit a phone strategy from the Phone Strategies menu.

............................................................................................................................................................................

2 Type the item number for the strategy file you want to edit. The Select
Initial Phone screen appears. Complete the following steps or, if the
screen is correct, press F1 (Done) to move to the next screen.

............................................................................................................................................................................

3 Press down arrow to move to the field you want to change.

............................................................................................................................................................................

4 Type the new value.

............................................................................................................................................................................

5 Repeat steps 3 and 4 for each field you want to change.

............................................................................................................................................................................

6 Press F1 (Done) to continue to the next screen.

............................................................................................................................................................................

7 To edit the rest of the screens, follow the steps that begin with “Selecting
Alternate Initial Phones”.
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.............................................................................................................................................................................................................................................................
Copy a phone strategy

Copy a phone strategy Use the following procedure to copy an existing phone strategy.

............................................................................................................................................................................

1 Choose Copy a phone strategy from the Phone Strategies menu.

............................................................................................................................................................................

2 In the Enter Item Number field, type the item number of the phone
strategy to copy.

............................................................................................................................................................................

3 Type Y at the confirmation prompt to continue or N to cancel.

............................................................................................................................................................................

4 Type a new file name (not more than 8 characters) at the file name
prompt.

............................................................................................................................................................................

5 Type Y at the prompt to save the new file or N to cancel.
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.............................................................................................................................................................................................................................................................
Delete a phone strategy

Delete an initial phone Use the following procedure to delete and initial phone.

............................................................................................................................................................................

1 Select the initial phone to delete.

............................................................................................................................................................................

2 Choose Delete. Campaign Director removes the selected initial phone
setting.
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.............................................................................................................................................................................................................................................................
Set Recall Times

Set recall times Use the Select System Set Recalls screen to tell the system how long to
wait before recalling a number, how many times to retry a number, and
which phone to call next. The system determines the settings by the
result of the initial call. For example, you can tell the system to retry
the call in 15 minutes when the initial call result is busy and to stop
calling that record if there is no answer after three retries.

............................................................................................................................................................................

1 In the Phone Field column, type the phone type number (1, 2, 3, ...).

............................................................................................................................................................................

2 Press F4 (View) to view the call completion codes list. Use the arrow
keys to select a code, then press Enter. You can also type the call code
directly in the Call Result column. It must match upper and lowercase
characters.

............................................................................................................................................................................

3 Type the number of minutes between each calling attempts in the Min
(Minutes) column.

............................................................................................................................................................................

4 Type the number of retries in the Number column.

............................................................................................................................................................................

5 In the Next Phone column, type the phone type number (1, 2, 3, ...). The
Next Phone is the phone the system calls after it makes the last attempt
to call the initial phone. If you leave this field blank, the system stops
calling the record after the last retry.

............................................................................................................................................................................

6 Repeat steps 1 through 5 for each call result for which you want to
schedule retries.

............................................................................................................................................................................

7 Press F1 (Done). The Select Ring Count and Call Connect Criteria
screen appears.
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Note

To keep job productivity high, select retry times that are appropriate for
the initial call’s result. For example, retry a BUSY result twice, after
15-minute intervals. Retry a NOANSWER result twice, after 60-
minute intervals.
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Record Selection

Overview A record selection tells the system which records to use to call
customers. This feature gives you the ability to target specific
customers for calling. For example, you can select records from
specific time zones such as Eastern, Central, or Pacific, or you can
select records with specific call completion codes such as BUSY or
NOANSWER. You can also select records that help you satisfy
specific goals such as accounts more than 30 days overdue, accounts
with a balance over $2,000, or accounts in a particular city.

You can execute a record selection immediately after you define the
selection criteria or save it and execute the selection at a later time.

Choose Record selections from the Campaigns menu. The Record
Selections menu appears. These commands are also available in
Campaign Editor’s Selection Editor.

Use the following wildcard character in record selections.

Actions Keys

Done F1

Move a line F2

Group F3

View calling list F4

Previous page F5

Next page F6

View call detection modes or
phone strategies

F10

Clear the field Ctrl+E
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Create a Record Selection

Create a record selection Use the following procedure to create a record selection.

............................................................................................................................................................................

1 Choose Create a record selection from the Record Selections menu.

............................................................................................................................................................................

2 If your system has more than one calling list, type the calling list number
at the prompt. (The system skips this step if your system has only one
calling list.)

............................................................................................................................................................................

3 Type a name for this file (not more than 8 characters). Do not use special
characters such as hyphens, slashes, or spaces.

............................................................................................................................................................................

4 Type an optional report description (not more than 30 characters). The
system names the report if you leave the field blank.

............................................................................................................................................................................

5 Type Y at the prompt to confirm the name or N to cancel. The Select
Time Zones for Calling screen appears.
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Selecting Time Zones

Overview Use the Select Time Zones for Calling screen to select the time zones
the Avaya PDS uses to call customers. The screen displays a list of all
the time zones defined for the Avaya PDS. The time designated for the
various zones is your Avaya PDS time. The Avaya PDS time zones are
based on the local time zone where the Avaya PDS is located. An
uppercase letter code in the Zone column designates the time zone
code.

State laws differ about legal calling times. Therefore, your Avaya PDS
may list numerous time zones. If there are more zones than fit one
page, press Ctrl+N (next page) to see the additional screens. The screen
also shows the recommended start and stop times for each of these
zones.

Selecting Time Zone
parameters

Use the following procedure to select time zone paramters.

............................................................................................................................................................................

1 Type the Zone ID (uppercase letters only) in the Enter Time Zone Codes
field. Press Enter after each Zone ID. You need to enter at least one time
zone. To select all time zones, type an asterisk (*).

............................................................................................................................................................................

2 If you enter an incorrect letter or type a lowercase letter, an error
message appears. Press the arrow keys to move to the error. Make the
correction and press Enter. To clear an entry, press Spacebar.

............................................................................................................................................................................

3 Press F1 (Done). The Select Call Completion Codes screen appears.
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.............................................................................................................................................................................................................................................................
Selecting Call Completion Codes

Overview Call completion codes represent the result of the last completed call.
Use the Select Call Completion Codes screen to select records based on
call completion codes. In most cases, you select records that you have
not contacted, such as BUSY, NOANSWER, or NOTCALLED.

When the screen appears, the Avaya PDS positions the cursor in the
first field.

Selecting Call Completion
Codes

Use the following procedure to select call cmpletion codes

............................................................................................................................................................................

1 Press F4 (View) to see the Call Completion Code List.

............................................................................................................................................................................

2 To select additional codes, press Enter again. The cursor moves to the
next blank field.

............................................................................................................................................................................

3 Repeat steps 1 through 3 as necessary.

............................................................................................................................................................................

4 Press F1 (Done). When the entries are correct, press F1 (Done). The
Select Field Names and Values screen appears
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Selecting Field Names and Value

Overview Use the Select Field Names and Values screen to target a specific group
of clients for calling. Select records based on any field in the calling list
and a value for that field.

Enter values as they would appear in the calling list records. Use
expressions, comparison operator, and logical operators as needed.

Selecting Field Names and
Values

Use the following procedure to select field names and values.

............................................................................................................................................................................

1 In the Name column, type the field name in uppercase letters or press F4
(View) to select a field from the calling list.

............................................................................................................................................................................

2 Type a value in the Value column and press Enter.

Note

You can have up to 40 fields on multiple screen pages. Press Ctrl+N
next page) and Ctrl+P (previous page) to move through screen pages.
The Start Range column for the first row contains an opening
parenthesis. The End Range column of row 40 contains the closing
parenthesis.
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Selecting Phone Strategies

Overview Select a phone strategy file to tell the Avaya PDS how to call the
selected records. This is the last step in designing a record selection.

Selecting a phone strategy Use the following procedure to select a phone strategy to be used
within the record selection.

............................................................................................................................................................................

1 Type the Strategy File Name or press F10 (Search) to scroll through
the available phone strategies. Each time you press F10 a new strategy
appears. If you want to confirm that you are choosing the correct
strategy, press F4 (View) to review the parameters for the selected
strategy.

............................................................................................................................................................................

2 Press (F1) Done. If your system setup includes expanded Record
Selection reporting, the Select Fields for Report screen appears.
Continue to “Selecting Fields for the Record Selection Report” in the
following section. Otherwise, the Selection List Generation screen
appears.

............................................................................................................................................................................

3 From the Selection List Generation screen, start the record selection or
exit without generating the record selection.
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Sorting field names and direction (optional)

Overview Sorting records by field names is optional. If you choose to sort
records, the Avaya PDS calls the records in the order you set.
Otherwise, the system calls them in the order they appear in the calling
list.

Ascending is the default sort order. If you want to sort in descending
order, move the cursor to the Sort Direction column, type D and press
Enter. To skip the Sort Field Names and Direction screen, press F1
(Done).

Selecting Fields Names
and direction

Use the following procedure to select field names and direction.

............................................................................................................................................................................

1 In the Sort Direction column, press Enter to leave the sort direction as
Ascending or type D and press Enter to change to descending.

............................................................................................................................................................................

2 In the Field Name column, press F4 (View) to see a list of fields.
Choose the sort field.

............................................................................................................................................................................

3 To add a subcategory to sort by, press Enter to move to the next line and
repeat steps 1 and 2 for each subcategory. The Avaya PDS sorts first by
the field in priority 1, then priority 2, and so on.

............................................................................................................................................................................

4 Press F1 (Done). The Select Recall Field Names and Values screen
appears.
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Selecting recall field names and values

Overview Use the Select Recall Field Names and Values screen to tell the Avaya
PDS which agent set recalls to include in the record selection. If left
blank, the system includes all agent-set recalls. To skip this screen,
press F1 (Done). Set recall criteria the way you set field name and
value selection criteria.

Selecting recall criteria Use the following procedure to select recall criteria.

............................................................................................................................................................................

1 In the Name column, type a field name or press F4 (View) to select a
field name from the calling list.

............................................................................................................................................................................

2 Type a value in the Value column and press Enter.

............................................................................................................................................................................

3 Press Done (F1). The Select Call Strategy File screen appears.
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Set ring count and call connect criteria

Overview Use the Select Ring Count and Call Connect Criteria screen to specify
two settings:

• The number of rings to allow before the system records a
NOANSWER call completion code.

• The call detection mode (Connect Criteria) to tell the system
which calls to pass to agents.

Call detection modes are the type of response the system detects when
it dials a number. Detection modes include voice, answering machine,
and special information tones.

The type of connect criteria determines what type of connects the
system will pass to an agent. Remember, as you decide which ones to
use, that you will increase your hit rate with each additional criteria
selected, as more calls will be handled by your agents instead of by the
system.

The connect criteria abbreviations are as follows:

• V - Voice

• AV - Autovoice

• INT- Operator Intercept

• NCN- Nonconnect

• DIS- Disconnected Number

• VAC- Vacant Number

• ORD - Reorder

Set ring count and call
connect criteria

Use the following procedure to set ring count and call connect criteria:

............................................................................................................................................................................

1 In the Phone Field column, type the phone type number (1, 2, 3, ...).

............................................................................................................................................................................

2 Type the number of rings to allow in the # of Rings column. (Low
number recommended, such as 3.)
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............................................................................................................................................................................

3 Type the letter(s) to designate the call detection mode in the Connect
Criteria column.

............................................................................................................................................................................

4 Repeat steps 1 through 3 for each initial phone type.

............................................................................................................................................................................

5 Press F1 (Done). The Record Selections menu reappears.
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Grouping expressions and statements

Overview When grouping expressions or statement in order to organize sets of
selection criteria, subgroups are created.

When expressions and statements are grouped, the Avaya PDS supplies
the closing parenthesis and inserts the double arrow to indicate the
beginning of the next group. It also places an opening parenthesis on
the next available line.

The closing parenthesis is on line 40 or the last line possible. Enter
values on all the lines that you intend to put into the group and then
create the group. You can also create groups (or subgroups) consisting
of only one line. This allows you to differentiate one line from other
groups.

Group statements Use the following procedure to group statesments with and AND or
OR.

............................................................................................................................................................................

1 Type all the statements that will go into a group and press F3 (Group).
The following prompt appears at the bottom of the screen: Group line 
# to line #

............................................................................................................................................................................

2 Type the number of the first line in the first group and press Enter.

............................................................................................................................................................................

3 Type the number of the last line in the first group and press Enter. To
create a group consisting of only one line, both numbers should be the
same.

............................................................................................................................................................................

4 Repeat steps 1 through 3 to make more group statements.

............................................................................................................................................................................

5 Press F1 (Done) to move o the next screen. The Sort Field Names and
Direction screen appears.
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Move fields and values

Move fields and values Use the move command to move an entire expression or statement to
another location.

............................................................................................................................................................................

1 To move a field name and its value, press F2 (Move). The following
prompt appears at the bottom of the screen: Move line # to line #

............................................................................................................................................................................

2 Type the number of the line to move and press Enter.

............................................................................................................................................................................

3 Type the number for the target line and press Enter.

............................................................................................................................................................................

4 To move to the next screen, press F1 (Done) and the Sort Field Names
and Direction screen appears.



2 - 4 6

...........................................................................................................................................................................................................................................................

Campaign overview

.............................................................................................................................................................................................................................................................
Unit Record Selection

Create unit record
selection

A unit record selection works with an outbound job that uses unit work
lists. Unit work lists sort the calling list records into groups based on
the value in the unit work list key field. In a unit work list job, agents
handle calls from a specific set of records. This can be useful when
agents are paid on commission or when a group of agents only handle
specific product lines. Agents assigned to unit work lists type the Unit
ID when they join the job. For example, you can assign agents to
handle the accounts from a specific ZIP code. The unit IDs are unique
values in the key field. For example, if you set ZIP codes as a key field,
the unit IDs will be numbers such as 98292, 98293, and so on.

Creating a unit record selection is the same process as creating a
standard record selection except for setting a key field for the unit work
lists.

............................................................................................................................................................................

1 Choose Create a unit record selection from the Record Selections
menu.

............................................................................................................................................................................

2 To complete the screens, follow the steps in “Creating Record
Selections”.

............................................................................................................................................................................

3 After you complete the Recalls screen, the Unit Work List Sort Field
screen appears.

............................................................................................................................................................................

4 Type the field name in uppercase letters in the Key Field Name field or
press F4 (View) to select a name from the list.

............................................................................................................................................................................

5 Press F1 (Done). The Select Phone Strategy screen appears.

............................................................................................................................................................................

6 Type the strategy file name or press F10 (Search) to scroll through a list
of available strategy files.
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............................................................................................................................................................................

7 Press F1 (Done). The Call Selection List Generation screen appears.
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Edit unit record selection

Edit unit record selection Edit a unit record selection when the file’s settings no longer meet your
campaign goals or when you need a new unit record selection file. If
you are creating a new file, copy a similar file and edit it to reflect the
new goals.

............................................................................................................................................................................

1 Choose Edit a unit record selection from the Record Selections menu.

............................................................................................................................................................................

2 Follow the steps in “Creating, Editing, and Executing Record
Selections”.
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.............................................................................................................................................................................................................................................................
Execute unit record selection

Execute unit record
selection

You can execute a unit record selection immediately after you create it
or edit it or save the selection criteria and execute it at a later time.

............................................................................................................................................................................

1 Choose Execute a unit record selection from the Record Selections
menu.

............................................................................................................................................................................

2 Type the item number for the unit record selection file you want to
execute.

............................................................................................................................................................................

3 Type a report description (not more than 30 characters).

............................................................................................................................................................................

4 Type Y at the prompt to confirm your selection or N to cancel.
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Standard Record Edit

Standard record edit Record Edit has two options: Quick Search and Standard Record Edit.
Your Avaya PDS representative configures your system with both
options unless you request otherwise.

With Standard Record Edit, the Avaya PDS searches through a calling
list from top-to-bottom based on the values entered in one or more
fields.

Standard Record Edit is a slower method than Quick Search; however,
it accepts field values that contain special characters such as hyphens (-
) and wildcards (*). In addition, it allows you to search on multiple
fields.
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Supervisor Menu Record Selection Preparation

Overview There are action keys and shortcut keys that can be used when creating,
editing, or deleting information from record selections in the menu
systems.

Use the following shortcut keys when modifying record selections:

Action Keys

Done F1

Move a line F2

Group F3

View calling list F4

Previous page F5

Next page F6

View call detection modes or
phone strategies

F10

Clear a field Ctrl+E
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Edit a record selection

Edit a record selection Edit a record selection when the file’s settings no longer meet your
campaign goals or when you need a new record selection file. If you are
using copy and edit to create a record selection, choose a record
selection file that has similar criteria to your campaign’s goals. Copy
the file and edit it to reflect the new goals.

............................................................................................................................................................................

1 Choose Edit a record selection from the Record Selections menu.

............................................................................................................................................................................

2 Type the item number for the file you want to edit.

............................................................................................................................................................................

3 Type a report description.

............................................................................................................................................................................

4 Type Y at the prompt to confirm your choice or N to cancel.

............................................................................................................................................................................

5 Use the arrow keys to move to the value you want to change on the
current screen and type the new value or press F1 (Done) to skip to the
screen you want to edit. For help on the individual screens, see
“Creating Record Selections”.

............................................................................................................................................................................

6 Press F1 (Done). The Call Selection List Generation screen appears.
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.............................................................................................................................................................................................................................................................
Execute a record selection

Execute a record selection You can execute a record selection immediately after you create or edit
it or save the selection criteria and execute it at a later time.

............................................................................................................................................................................

1 Choose Execute a record selection from the Record Selections menu.

............................................................................................................................................................................

2 Type the item number for the record selection file you want to generate.

............................................................................................................................................................................

3 Type a report description (not more than 30 characters).

............................................................................................................................................................................

4 Type Y at the prompt to confirm your selection or N to cancel.

............................................................................................................................................................................

5 The system generates the report and returns to the Record Selections
menu.
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Copy a record selection

Copy a record selection Copy an existing file and assign a new file name. You can then edit the
copied file. Use this procedure when an existing record selection meets
most but not all of a campaign’s goals.

............................................................................................................................................................................

1 Choose Copy a record selection from the Record Selections menu.

............................................................................................................................................................................

2 Type the item number of the file to copy.

............................................................................................................................................................................

3 Type Y at the prompt to confirm your choice or N to cancel.

............................................................................................................................................................................

4 Type the new file name (not more than 8 characters) at the prompt.

............................................................................................................................................................................

5 Type Y at the prompt to save the file or N to cancel.
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Delete a record selection

Delete a record selection Use the following procedure to delete a record selection:

............................................................................................................................................................................

1 Choose Delete a record selection from the Record Selections menu.

............................................................................................................................................................................

2 Type the item number of the file.

............................................................................................................................................................................

3 Type Y at the prompt to confirm the deletion or N to cancel.
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Create a job

Create a job Before creating a job for a campaign, load the calling list and prepare
the phone strategy and record selection files. Execute the record
selection file, then copy the job definition and edit the copy.

............................................................................................................................................................................

1 Choose Jobs from the Campaigns menu. The Jobs menu appears.

............................................................................................................................................................................

2 Choose Copy a job from the Jobs menu and press Enter. Type the item
number for the job you want to copy and press Enter.

............................................................................................................................................................................

3 Type Y in response to the prompt.

............................................................................................................................................................................

4 Type a new name for the job.

............................................................................................................................................................................

5 On the Jobs menu, choose one of the following: Edit and start an
outbound job, Edit and start an inbound job, Edit and start a blend
job, Edit and start a unit work list job, or Edit and start an infinite
job.

............................................................................................................................................................................

6 Type the item number of the job you want to edit. The Job Run
Verification screen appears. See the following sections for details on
each screen.
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Edit an outbound job

Edit an outbound job Use the Outbound Job Run Verification screen to set and verify
outbound job settings.

............................................................................................................................................................................

1 Choose Edit and start an outbound job from the Jobs menu.

............................................................................................................................................................................

2 Type the item number for the job you want to edit. The Outbound Job
Run Verification screen appears. The cursor is in the first field.

• If the value is correct, press Enter to go to the next field. If a value
is incorrect, press Ctrl+C (Change). Type the new information and
press Enter to move to the next field.

• If a field uses only a yes or no response, use Ctrl+C to switch
between YES and NO.
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Managed Jobs

Minimum hit rate Type a number from 0 to 100 (without the percent sign) in increments
of 5. Thirty (30) is the recommended setting. Minimum hit rate
determines the maximum number of calls the system will make in
attempting to make an agent connection. For example, a minimum hit
rate of 30% means the system will make no more than three dialing
attempts for each agent.

Use minimum hit rate to limit the number of lines a job can use, even if
the hit rate falls below this rate. This prevents the system from
allocating more pooled lines to a poorly performing job at the expense
of a more successful job.

Initial hit rate Type a number from 0 to 100 (without the percent sign) in increments
of 5. Fifty (50) is the recommended setting.

Initial hit rate determines the average number of calls per agent the
system makes during the job’s first five minutes. The initial hit rate is
the number of call completions compared with call attempts. For
example, an initial hit rate of 50% means the system must make
approximately two dialing attempts for each agent to get one successful
connection.

When the system accumulates statistics from actual call attempts (after
about five minutes), it readjusts the hit rate automatically to meet the
minimum hit rate setting.

Use the following guidelines to set the initial hit rate.

The initial hit rate controls dialing attempts for the first five minutes
only. If you set the rate too low (20 to 30), the system could make more

If you want to
make

Set rate
to

Description

Daytime home calls 30 3 calls per agent for 1
connection

Evening home calls 50 2 calls per agent for 1
connection

Weekend home
calls

50 2 calls per agent for 1
connection

Daytime office calls 70 1 call per agent for 1 connection
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connects than your agents can handle during the initial dialing period.
If you set the rate too high (over 70), the system could fail to make
enough connections to keep your agents busy.

Expert calling ratio Type a Q, a W, or a U followed by a number from 0 to 100. For
example, type Q30 to tell the system to allow 30% of the calls into the
wait queue. The major difference among Expert Calling ratio settings is
that the system bases W and U on agent productivity and Q settings
affect customer wait time. When you use W or U settings, the average
agent idle time can be short; but there may be a large percentage of
customers in the wait queue at any given time.

See the following table for recommended settings.

The Expert Calling ratio tells the system how to predict when it should
make the next call. You can select one of the following:

• Q mode The system achieves a balance between agents waiting
for a call and customers placed in the wait queue. On average,
when you use Q the agent idle time is longer to make sure that
customers spend less time in the wait queue.

• W mode The system monitors the time agents take to complete
calls and update records and adjusts the calling pace accordingly.
When you use W, the average agent idle time can be short, but
there may be a large percentage of customers in the wait queue at
any given time.

• U mode The system monitors the time agents take to update
records and adjusts the calling pace accordingly. When you use W
or U, the average agent idle time can be short, but there may be a
large percentage of customers in the wait queue at any given time.

Line types Type the line type code(s). Separate multiple codes with commas. If
your system has only one outbound line pool, this feature is not
available for outbound calls. Line type codes are the same thing as line
group (line pool) names. The ability to manage the phone lines depends
upon your system configuration. If your system has multiple line

Parameter Value Recommended setting

Q 0-100 Q4 through Q31

W 0-100 W29 through W71

U 0-100 U32 through U78
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groupings, use this parameter to select or clear the groups of lines the
system uses for a job.

Control the number of lines available for a particular job by assigning it
additional groups or by moving a competing job to another line group.
If you designate more than one line group, separate them with a
comma. For example, type REG1, REG2, REG3.

Job description Type a job description (not more than 30 characters). The job
description appears on reports and in job history files. You can sort job
reports by the job description.

Selection

Type the name of the record selection file. The file contains the criteria
the system uses to select records from the calling list. It also includes
the phone strategy.

Note

Always execute the record selection before you define or run a job.

End job when quota is met Type YES to tell the system to end a job when the agents reach the
quota. You set this quota with the Quota parameter.

Type NO to tell the system to disregard the quota setting. Use NO when
using unit work list jobs, unless you are going to set a quota for the
entire job. Once you start the job, you can set quotas for individual unit
work lists using Job Monitor.

A job can end in one of the following ways:

• You can manually stop a job.

• You can tell the system to continue making calls until it calls all
initial phones at least once.

• You can tell the system to continue calling until it has called all
recalls at least once.

• You can tell the system to call scheduled recalls but stop calling
when it has called all initial phones at least once.

• You can tell the system to stop calling when the agents meet the
quota you set.

In any of the above cases, the system stops calling when the system
time reaches the time set in the Latest time to stop calling parameter.

Order by time zone Type YES to turn on time zone ordering or NO to call customers in
mixed time zones.
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When you set this parameter to YES, the system calls all the records in
the eastern most time zone; then it calls the records in the next time
zone to the west.

When you set this parameter to NO, the system calls records round
robin through the time zones. This is useful when broad coverage is
more important than completing calls in time zone order.

Quota Type the call completion code number, a comma, and the quota. For
example, type 16,4.

The system defines the quota as a specific number of successful calls
assigned a call completion code. This parameter is only effective when
you set the End job when quota is met parameter to YES. When a job
reaches the quota, the system stops making calls.

You have the following choices:

• Set no quota for the job. Leave the field blank or erase the existing
entry by pressing Ctrl+E.

• Set one quota for the entire job. When the job meets the quota, the
job ends.

• Set one quota to apply to all unit work lists. Each unit shuts down
when the agent reaches the quota for that list.

• Set different quotas for each unit work list. To do this, set the
quota, then set individual quotas in the Settings menu on the Job
Monitor Screen. See “Editing Unit Record Selections”.

Allocate all units to agents Type YES to let agents work all available unit work lists or NO to
assign theagents to specific unit work lists. Use this parameter with unit
work list jobs. If this is not a unit work list job, leave this field blank or
type NO.

History reports by unit Type YES to generate a report by unit work lists or NO to report by job.
Use this parameter with unit work list jobs. If this is not a unit work list
job, leave this field blank or type NO.

Managed dialing Type YES to turn on Manage Dialing or NO to turn it off. Managed
Dialing is an optional feature that lets agents preview records before
the system dials the number. See “Editing Managed Jobs” for
guidelines on other Managed Dialing settings.

Note Use Managed Dialing with normal outbound jobs, not unit work
list or Predictive Blend jobs.
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The Preview limit and Allow agents to cancel calls parameters
determine the Managed Dialing settings.

Preview limit (sec.) Type a number between 0 and 999 to set the seconds to allow for
preview time. It sets the time that an agent can preview a record before
the system dials the number.

Type 0 to specify unlimited preview time. This parameter is only
effective if you set the Managed Dialing parameter to YES.

Allow agents to cancel
calls

Type YES to allow agents to cancel calls before the system dials the
number or NO to let them preview records but not cancel calls. This
parameter is only effective if you set the Managed Dialing parameter to
YES.

Earliest start time Leave the field blank to accept the system recommended time or type
the time using the 24-hour clock. Use a period to separate hours and
minutes. For example, type 17.10 to enter 5:10 PM and 8.30 to enter
8:30 AM.

Change this setting to meet the objective of a particular job.

The system is preset with recommended start and stop times for
different time zones. If you enter a time that is earlier than the
recommended start time, the system does not begin dialing until the
system clock reaches the recommended time.

Latest start time Leave the field blank to accept the recommended time or type the time
using the 24-hour clock. For example, type 17.10 to enter 5:10 PM and
8.30 to enter 8:30 AM.

The latest stop time tells the system when to stop making outbound
calls. If you set a time that is later than the recommended stop time, the
system stops dialing at the recommended time.

Outbound list Type the name of the calling list. Choose the outbound calling list for
the job. The outbound calling list needs to be the same for the job, the
record selection, and the agent screen(s).

Agent key definition file Type the name of the agent keys file. Choose the keys file that was
designed to run with the job. These are the keys that agents use during
an outbound job.

Start script label Type the message script name or press Ctrl+D to choose from a list.
Choose the message the customer hears in the wait queue.
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Main data process label Type the name of the data process label for an outbound job or press
Ctrl+D to choose from a list.

Outbound screen(s) Type the screen name. If agents use more than one screen, separate the
screen names with a comma. For example, type screen1, screen2,
screen3. Choose the outbound screen(s) that were designed to run with
the job. These are the screens that agents see on their workstations
during an outbound job.

Total Wait Delay Type the maximum number of seconds (0-999) that a customer can
wait in an outbound queue before the system hangs up on the caller.

Next linked job Type the job name to run when the current job ends.

Link jobs when you want the system to start a job as the current job
ends. When you link a job, the system transfers each agent to the next
job after the agent completes the last call and releases the record. The
system displays a message telling the agents that they are changing
jobs. You can link an outbound job to any job that is not a unit work list
job or a managed job. You can link multiple managed jobs to each
other. Remember to run the record selection for the next job before it
starts. If you do not, the job will not start.

Transfer to job

Type the name of the inbound or blend job to which agents can transfer
calls.

Do not call group name Type the Do Not Call group name if you want agents to mark records
as Do Not Call. Do Not Call groups contain one or more inbound or
outbound calling lists. To use the Supervisor menus to mark a record as
Do Not Call, see “Marking Records as Do Not Call”.

Recall notify (mins) Type the number of minutes before the recall that the system will notify
the agent who owns it. Use this parameter to set up the Agent Owned
Recall feature. Leave it blank to disable Agent Owned Recall.

Recall reschedule (min) Type the number of minutes the system will wait before attempting to
notify an agent again.

Use this parameter to set up the Agent Owned Recall feature. Leave it
blank to disable Agent Owned Recall.

Recall tries (times) Type the number of times the system will attempt to find the agent who
set the recall before it treats the call as a standard recall.
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Type 0 (zero) to tell the system to look for the original agent
indefinitely. Use this parameter to set up the Agent Owned Recall
feature. Leave it blank to disable Agent Owned Recall.

Infinite job resort field Type the name of the field from the calling list record that is used to
sort records for infinite jobs.
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Edit Managed Jobs

Edit a managed job A managed job is a job that uses Managed Dialing. It allows agents to
preview a record before the system dials the number. You can also give
agents the option to cancel a call before the system dials the number.
To set up a managed job, choose Edit and start an outbound job from
the Jobs Menu. The Outbound Job Run Verification screen appears.

Set managed job parameter Follow the steps in “Editing Outbound Jobs” for all parameters that are
not specifically for managed jobs. Follow the directions below for
managed job settings.

............................................................................................................................................................................

1 Set Minimum hit rate to 100. Since the agents are previewing one record
at a time, the hit rate must be set to 100. This forces the system to dial
only one number per agent.

............................................................................................................................................................................

2 Leave Expert Calling ratio blank. The system sets it to the appropriate
level after the first five minutes.

............................................................................................................................................................................

3 Type a Job description.

............................................................................................................................................................................

4 In the Start script label field, select a Managed Dialing script. The
managed script tells the system to first pass the record to the agent for
preview.

............................................................................................................................................................................

5 Set Managed Dialing to YES by pressing Ctrl+C to switch between NO
and YES.

............................................................................................................................................................................

6 Set a Preview limit. The range is 0 seconds to 999 seconds. If the setting
is 0, the agents have unlimited time to preview the record.

............................................................................................................................................................................

7 Set Allow agents to cancel calls to YES or NO. YES allows the agents
to cancel the call.
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Edit Sales Verification Jobs

Edit sales verification jobs A sales verification job is an outbound (target) job used to verify a sale
or commitment that a customer made during a different (source) job.
The system uses a different group of agents for the target and source
jobs. For more information about sales verification jobs, contact your
system vendor.

When setting up a sales verification job, follow the steps in “Using
Verify Record Selections,” “Creating Jobs,” and “Editing Outbound
Jobs”. Use the following special instructions.

When executing a verify record selection file

• If prompted, choose the source job’s calling list.

To set up the source job

• On the Outbound Job Run Verification screen, verify that the

• Completion Code parameter is 93. If it isn’t, press Ctrl+D and
choose this code.

To create the sales verification job (target)

• Choose the outbound job named Verify as the job you want to
copy.

• Type a job name that identifies it as a verification job, such as
verifyam.

• On the Jobs menu, choose Edit and start an outbound job.

To set up Outbound Job Run Verification screen parameters

• Calling List: choose the source job’s calling list.

• Verification job: press Ctrl+C to change the setting to Yes.

• Main data process label: confirm that the setting is Verify. If it
isn’t, press Ctrl+C and choose Verify.
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Edit Infinite Jobs

Edit infinite jobs An infinite job is an optional outbound job that can receive new records
for calling while the job is active. An infinite job runs until you stop it
manually. An infinite job uses a special record selection called an
infinite record selection. Using this record selection, the system can
add new records (downloaded from your host) to an existing calling list
on an active infinite job. The system adds the new records to a list
segment. See “Using Infinite Record Selections”.

For more information about infinite jobs, contact your system vendor.

To edit an infinite job, choose Edit and start an outbound job from
the Jobs Menu. Select the predefined infinite job (usually called
infinity). Follow the steps in “Editing Outbound Jobs” for all
parameters that are not specifically for infinite jobs.

Follow the directions below for infinite job settings.

1. Type infinity for the Job Description.

2. Set the End job when quota is met parameter to No.

To download and append a new list segment, use the Transfer and
Process Records menu. See “Downloading Records for Infinite Jobs”.

Type Y at the prompt to continue or N to cancel. The system receives
the new calling list records. An infinite job runs for long periods and
must be shut down manually. If you need to restart the job, run the
infinity record selection again before restarting. This ensures that the
new list segments are properly incorporated into the calling list.
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Edit Virtual Jobs

Edit virtual jobs A virtual agent job is an optional outbound job during which the system
manages calling activities without agents. This type of job places a call,
connects the customer or answering machine to the system, and plays a
recorded message. For more information about virtual agent jobs,
contact your system vendor.

When setting up a virtual agent job, follow the steps in “Creating Jobs”
on and “Editing Outbound Jobs” using the following special
instructions.

When setting up a record selection file

• Select the phone strategy named virtual.

To create the virtual agent job

• Choose the outbound job named Virtual as the job to copy.

• Type a job name that identifies it as a virtual job, such as virtpm.

• On the Jobs menu, choose Edit and start an outbound job.

To set up Outbound Job Run Verification screen parameters

• Agents: press Ctrl+C to change the setting to No.

• Selection: press Ctrl+D and select the record selection file to
which you assigned the virtual phone strategy.

• Start script label: press Ctrl+D and select the virtual job script
label you want to use with this job.

• Main data process label: confirm that the setting is Virtual. If it
isn’t, press Ctrl+D and choose this setting.



Campaign overview

2 - 6 9

............................................................................................................................................................................................................................................................

.............................................................................................................................................................................................................................................................
Edit Inbound Jobs

Edit inbound jobs (Intelligent Call Blending systems only) Use the Inbound Job Run
Verification screen to set and verify inbound job settings on Intelligent
Call Blending systems. These settings do not affect Predictive Blend
systems.

............................................................................................................................................................................

1 Choose Edit and start an inbound job from the Jobs menu.

............................................................................................................................................................................

2 Type the item number for the job you want to edit or start. The Inbound
Job Run Verification screen appears. The cursor is in the first value
field.

Set inbound job parameters

The following table describes each inbound job parameter listed on the
Inbound Job Run Verification screen. The settings and parameters on
your system vary depending upon your system configuration.

Parameter Value Recommended
setting

Inbound list Inbound list file name inbnd1

Inbound screen(s) Inbound screen name(s)
separated by commas

inbnd1,inbnd2

Wait queue limit
(secs)

0-999 seconds 0 to 5 seconds set
an unlimited wait
queue time

Job description Up to 30 characters/
spaces

Agent key
definition file

Agent keys file name op_cmd

Line type(s) REG INB

OTHER

INB1

Start answer label Answer script starting
label

in_wait_1
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Inbound List

Type the name of the calling list. The inbound calling list is a template
that contains the information you need from the customer. Each time
the system receives a call, it adds a record to the inbound list. Some call
centers upload this information to the system. In other call centers, the
agents connect directly to the host and interactively update records.

Inbound Screen(s)

Type the name of the screen. If the agents use more than one screen,
separate the screen names with a comma. For example, type screen1,
screen2, screen3. Choose the inbound screen(s) that were designed to
run with the job. These are the screens that the agents use during an
inbound job.

Wait Queue Limit (Secs)

Type the maximum seconds (from 0-999) the system permits a call to
remain in the inbound wait queue before it hangs up on the caller.

Job Description

Main data process
label

Data process label generic

Enable call
forwarding on
ACD

YES or NO NO

Activate lines at
logon

YES or NO YES

Max agent wait
(secs)

0-999 seconds 60

Max % of clients
in queue

100 - 200 100

Verification job NO

Next linked job Job name

Transfer wait
queue label

Do Not Call
group name

Do Not Call group file
name

Parameter Value Recommended
setting
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Type a job description (not more than 30 characters). The job
description appears on reports and in job history files. You can sort job
reports by the job description.

Agent Key Definition File

Type the name of the agent keys file. Choose the keys file that was
designed to run with the job. These are the keys that agents use during
an inbound job.

Line Type(s)

Type the line type code(s). Separate multiple codes with commas.

Note

If your system uses line pooling, this feature is not available for
inbound calls. Line type codes are the same as line group names. The
ability to manage the phone lines depends upon your system
configuration. If your system has multiple line groupings, use this
parameter to select or clear the groups of lines the system uses for a job.
Control the number of lines available for a particular job by assigning it
additional groups or by moving a competing job to another line group.
If you designate more than one line group, separate them with a
comma. For example, type INB1,INB2,INB3 (no spaces).

Start Answer Label

Type the name of the message file. Press Ctrl+D to see a list of options.
Choose the message that customers hear when they are in the wait
queue.

Main Data Process Label

Type the name of the data process label for an inbound job or press
Ctrl+D to choose from a list.

Enable Call Forwarding on ACD

Type YES to tell the system to pass an inbound call from the ACD to
an available Avaya PDS agent. If an agent isn’t available the system
passes the call back to the ACD. Type NO to keep the call in the ACD
wait queue. A confirmation prompt appears.

To use this parameter, your ACD must be configured to allow call
forwarding through the system. For more information, consult your
system vendor.

Activate Inbound Lines at Logon

Type YES to activate the lines as agents log on or NO to activate all
lines at the start of the job.
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You can activate an inbound line whenever a blend or inbound agent
logs on. The system continues activating lines until it has activated all
the inbound lines assigned to the job. Similarly, the system inactivates
lines when agents log off. This keeps unused lines available to other
jobs.

When this setting is on, the system keeps the number of ACD

extensions equal to the number of agents available to service the calls.
When the ACD sends a call to the system and there is no agent
available, the system returns a busy signal to the ACD. This keeps a
caller from being placed on hold by both the ACD and the system.

Maximum Time Client Wait (Secs)

Type the maximum seconds from 0-999. This setting determines the
maximum time a call can be in the wait queue before the system
transfers a blend agent to take inbound calls. Decrease agent wait time
if you want to emphasize call center productivity. The Maximum % of
clients in queue overrides the Maximum client wait.

This parameter is used only for blend jobs. (This is the same parameter
on the Blend Job Run Verification screen.)

Maximum % of Clients in Queue

Type a number from 100-200 to represent the maximum percentage of
calls to be in the wait queue. This parameter is used only for blend jobs.
(This is the same parameter on the Blend Job Run Verification screen.
We suggest that you leave it blank on the Inbound screen and complete
the setting on the Blend Job Run Verification screen.) It determines the
percentage of calls that can be in the wait queue before the system
moves a blend agent to take calls.

Verification Job

This parameter appears only if your system has the Sales Verification
feature. Type yes if this job uses sales verification.

Next Linked Job

Type the name of the job to run when this job ends. Although it is
unusual, you can link an inbound job to any job that is not a managed
job or a unit work list job. Link jobs when you want the system to start
a job as the current job ends. When you link a job, the system transfers
each agent to the next job after the agent completes the last call and
releases the record. The system displays a screen message telling the
agents that they are changing jobs.

Transfer Wait Queue Label
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Type the name of the message file to be used with the Native Voice and
Data Transfer feature. Choose the message that your customers hear
when they are in the wait queue on a blind transfer to an inbound agent.

Do Not Call Group Name

Type the Do Not Call group name if you want agents to mark records
as Do Not Call. Do Not Call groups contain one or more inbound or
outbound calling lists. To use the Supervisor menus to mark a record as
Do Not Call, see “Marking Records as Do Not Call”.
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Edit Blend Jobs

Edit blend jobs (Intelligent Call Blending systems only) A blend job is a combination
of inbound and outbound jobs. The system moves agents between
inbound and outbound calls to achieve a balance between customer
service and agent activity. Before editing a job, create or edit the phone
strategy and record selection for the outbound job. Execute the record
selection file; then use the Blend Job Run Verification screen to set and
verify the blend job settings.

............................................................................................................................................................................

1 Choose Edit and start a blend job from the Jobs menu.

............................................................................................................................................................................

2 Type the item number for the job you want to edit. The Blend Job Run
Verification screen appears. The cursor is in the first field.

............................................................................................................................................................................

3 If the value is correct, press Enter and go to the next field. If a value is
incorrect, press Ctrl+C (Change). Type the new information and press
Enter to move to the next field. If a field uses only a YES or NO
response, use Ctrl+C to switch between YES and NO.

Because a blend job is a combination of an inbound and outbound job,
most of the blend job parameters are the same as the inbound or
outbound side of the job.

The following section describes only the parameters that are unique to
blend jobs. Refer to the outbound and inbound parameter sections for
all other settings.

Maximum Time Client Wait (Secs)

Type the maximum seconds from 0-999. Determines the maximum
time a call can be in the wait queue before the system transfers a blend
agent to take inbound calls. Decrease agent wait time if you want to
emphasize call center productivity. The Maximum % of client in queue
overrides the Maximum client wait. This parameter is used only for
blend jobs. (This is the same parameter on the Blend Job Run
Verification screen.)

Maximum % of Clients in Queue
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Type a number from 100-200. Specifies the percentage of inbound calls
that can be in the wait queue before the system assigns a blend agent to
inbound calling. The system bases this on the ratio of the wait queue
calls to the number of inbound and blend agents. The minimum and
recommended setting is 100. The Maximum % of clients in queue
overrides the Maximum client wait.

In the following example, there are two blend agents and three inbound
agents on a job. The example illustrates how Maximum % of clients in
queue affects the system.

• If Maximum % of clients in queue is set to 100%, five calls must
be in the wait queue before the system moves a blend agent to take
inbound calls.

• If Maximum % of clients in queue is set to 200%, ten calls must be
in the wait queue before the system moves a blend agent to take
inbound calls.

Blend Agent Return Time

Type the maximum seconds from 5-995. This parameter sets the
maximum time a blend agent on inbound can be idle before the system
transfers an agent to take outbound calls. The minimum setting is 5; the
recommended setting is 20.
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Copy a Job

Copy a job To create a job, first copy an existing job. Assign the copy a new name
and change the settings to meet your job’s goals. If the new job doesn’t
use the same calling list as the original job, you need to select a new
calling list and job screen(s).

............................................................................................................................................................................

1 Choose Copy a job from the Jobs menu.

............................................................................................................................................................................

2 In the Enter Item Number field, type the number of the job to copy.

............................................................................................................................................................................

3 Type Y at the prompt.

............................................................................................................................................................................

4 Type the new job name.

............................................................................................................................................................................

5 Type Y at the prompt to continue or N to cancel.
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Delete a Job

Delete a job Use the following procedure to delete a job:

............................................................................................................................................................................

1 Choose Delete a job from the Jobs menu.

............................................................................................................................................................................

2 Type the item number in the Enter Item Number field.

............................................................................................................................................................................

3 Type Y at the prompt to delete the job or N to cancel.
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Infinite Job Record Selection

Overview Use an infinite record selection with an infinite, outbound job to enable
the Avaya PDS to call new records received from your host. The new
records are called a list segment when the system adds them to an
existing calling list.

When an infinite job receives new records from your host, the Avaya
PDS processes the file and generates an index. The system sorts the
index by category code (also called behavioral score) in descending
order and recall time in ascending order. A behavioral score is a value
the Avaya PDS assigns to a record that typically identifies the fraud
risk associated with a given customer. If a record has no category code,
the system treats it as if the code is zero.

Create, copy, & edit Infinite
record selection

Creating an Infinite record selection is the same as creating a general
record selection, but with one difference. To create an Infinite record
selection, first copy and edit any existing record selection. Follow the
procedure below to create an Infinite record selection.

............................................................................................................................................................................

1 Choose Execute infinite record selection from the Record Selections
menu.

............................................................................................................................................................................

2 Type the item number for the infinite record selection file you want to
execute.

............................................................................................................................................................................

3 Type a report description (not more than 30 characters).

............................................................................................................................................................................

4 Type Y at the prompt to confirm your selection or N to cancel.
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Manage Job Linking

Job linking Link jobs when you want the Avaya PDS to start a job as another job
ends. When you link a job, the Avaya PDS transfers agents to the next
job after they complete their calls and release the records. The system
displays a screen message telling the agents that they are changing jobs.
Before the new job begins, the agent receives a message on their screen
saying, “You are now being transferred to Job Jobname.”

The second job begins as the Avaya PDS releases lines from the first
job. You can link the selected job to any job that is not a unit work list
or a managed job. For example, you realize that you have scheduled
four small unlinked jobs. You can link the first job to the second job,
then link the second to the third, and the third to the fourth.

Note

As with all jobs, you must run a call selection to select records for the
linked job.

The Job Linking feature eliminates the down time between jobs that
occurs when there are no more calls to be placed for a job, but all
agents have not completed their current call. For the agents who finish
first, this waiting period can be several minutes.

With the Job Linking feature, that down time can be avoided. Agents
can move right along to the next campaign and continue to be
productive. A supervisor uses Job Linking to set up several jobs in
sequence for the day. The linked job will begin as soon as one agent on
the prior job has no more calls for that job. Agents and telephone lines
(trunks) are automatically transferred to the linked job, with no
supervisory intervention. A message at the bottom of the agent screen
informs agents about the job change.

Job Linking is accessed through the Campaign Manager application in
Campaign Director. A call center with 12 agents has six campaigns to
complete. The supervisor links the jobs so that agents move smoothly
from one job to the next. Before Job Linking, each agent had about 3.5
minutes of down time between jobs, and used this time to learn about
the new job and sign in to that new job. With Job Linking, the agent can
use those 3.5 minutes on calls with customers. Look at how this
seemingly small amount of time adds up:

• Number of agents: 12

• Time saved per agent for each job link: 3.5 minutes
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• Number of job links: 6

• Total recovered agent time per day: 252 minutes (12 agents x 3.5
minutes per agent x 6 job links)

• 252 minutes per day = 4.2 hours per day

• Total recovered agent time per year: 1050 hours (4.2 hours per day
x 250 working days per year) The call center gains 1050 hours of
productive calling time each year!

Shut the job down More than likely, jobs that run throughout the day will be configured to
stop and start automatically through job linking. Also the last jobs to
run for the day will be set to stop a few minutes before the latest guard
time. This is to insure that the Avaya PDS does not call past the legal
calling time. At this time the agents will be automatically logged off of
the job as well. The system supervisor can stop the job manually in
Campaign Manager or via the CUI in Campaign Control.

Next linked job If you want to link this job to another job, enter the job name in this
field. When this job nears completion it will start up the next job and
start transitioning agents from one job to another. Be sure that the call
selection has been executed for the linked job at least 10 minutes prior
to the end of the first job. Otherwise when the job linking attempts to
start the next linked job, it will fail.
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3 Calling lists and users

.............................................................................................................................................................................................................................................................
Overview

Purpose After the customer records are downloaded from the host, the system
adds several fields to each record to help track calling results. After the
system adds the fields, it may check for and reject duplicate records and
uncallable phone numbers. This process depends upon your system
configuration. The system refers to the modified records as the calling
list. To use the calling list and users commands, choose Calling lists
and users from the Supervisor Main Menu.

Contents This section contains the following topics:

• Calling list

• Count calling list records

• User accounts and permission levels

• Add user accounts

• Delete user accounts

• Edit user accounts

• Record Edit

• Edit a record

• Delete a record

• Restore a deleted record

• Campaign Update
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• Create an outbound Campaign Update report

• Mark records as Do Not Call
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Calling list

Overview After the customer records are downloaded from the host, the system
adds several fields to each record to help track calling results. After the
system adds the fields, it may check for and reject duplicate records and
uncallable phone numbers. This process depends upon your system
configuration. The system refers to the modified records as the calling
list. To use the calling list and users commands, choose Calling lists
and users from the Supervisor Main Menu.

The following table describes some typical added fields. You can see a
complete list of all the calling list fields for your system by pressing F4
or Ctrl+V (View) when the cursor is in a calling list field on a screen.

Field name Description

COUNTER Record attempt counter. Number of times the
system called the record.

AGENT The agent who handled the call.

DTE The date of the last attempt on the record.

TME The time of the last attempt on the record.

CODE Call completion code.

STATUSFLAG The status of the record. If blank, the record
is available for calling.

B = all bad numbers; the Reject Report lists
the records rejected by the system because
the system could not match them to a time
zone or the number was not callable (bad
number).

C = received inbound call from account; so
cancelled outbound call

D = maximum days on the system

E = manually deleted in Record Edit

R = repeated (duplicate) account

T = time zone could not be determined
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DAYSCNT Days on the system calling lists (optional).
The number of days a record has been on the
system. The Days on the System Report lists
accounts that the system has downloaded for
a certain number of days.

ENTRYDATE The date a record was first downloaded.

ZONEPHONE# The time zone stamp of a phone number.
(For example, Pacific, Mountain.) The
system calls a record only during the
recommended calling time for that record’s
time zone. The system determines time
zoning by the area code plus the phone
number prefix.

DUPE Indicates a duplicate record. The system can
reject a record because there are two or more
records in the calling list with the same
phone number or account number, or any
other field that you choose for duplicate
checking.

During system configuration, you choose
whether you want to do duplicate checking,
and if so, on which fields. The system lists
these duplicate records on the Reject Report.
Duplicate checking adds time to the
processing time, but it eliminates
unnecessary calls.

An * in DUPE field tells you that there are
duplicate records. The system places an R in
the STATUSFLAG field of the second, third,
and subsequent records to show that they are
repeated records and won’t be called.

Field name Description
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Count calling list records

Overview Use this option to display the number of records in your calling lists,
the lists’ creation dates, and the amount of unused disk space (in
kilobytes). You can use this information to confirm that you received
new lists. For example, if list1 is the same size as list1.old, you may not
have received a new list in the last download period.

In addition, the number of records in a list can help you determine how
many agents you’ll need to reach your campaign goal.

Count Calling List Records If you need more information about the contents of a list, use list
distribution reports.

............................................................................................................................................................................

1 Choose Count calling list records from the Calling Lists and Users
menu.

The Calling Lists screen appears. It displays all the calling lists and the
number of records in each list.

............................................................................................................................................................................

2 Press Ctrl+X followed by Ctrl+N to return to the Calling Lists and Users
menu.
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User accounts and permission levels

User accounts Use manage user accounts to add or delete users and set or change their
access to the system. A user account consists of the user name,
password, and permission level. The systemsystem determines the
permission level based on the group you assign to the user. The
permission level determines a user’s access to system features. For
example, you usually assign agents to the Agent group, which grants
permission to the Agent Main Menu where they have access only to
call handling; you assign system administrators to the system group,
which grants permission to the Administrator Main Menu, giving them
access to the system maintenance functions.

Permission levels The following table lists typical user levels, menu file names, and the
corresponding system menus.

User type Group name Menu name

agent agent Agent Main Menu

supervisor system Supervisor Main Menu

analyst cdwanal PC Analysis main menu
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Add user accounts

Overview Use the following guidelines when creating user accounts:

• User Name (also called login ID) should contain at least three but
not more than eight alphanumeric characters. It’s recommended
that you use a letter as the first character of a user name. User
names cannot contain spaces or special characters.

• Password should contain from six to eight characters. Passwords
should contain at least two letters and one numeric or special
character. Also, the password should not be the same as the user
name or a variation of the user name.

• Group for Login The name of the group to which the user belongs.

• Description (optional) Not more than 30 characters and spaces.

Add user accounts Use the following procedure to add a user account:

............................................................................................................................................................................

1 Choose Manage user accounts from the Calling Lists and Users menu.
The Manage User Accounts screen appears. The system lists the
commands on the bottom of the screen.

............................................................................................................................................................................

2 Press Ctrl+L (Login).

............................................................................................................................................................................

3 Type the user name, password, group (agent, system, cdwanal), and an
optional description. Both user names and passwords are case
sensitive.If you create a user name using lowercase letters, the user must
type lowercase letters when logging in.

............................................................................................................................................................................

4 Press Enter after you complete the last line. The system rewrites the
screen and encrypts the password.

............................................................................................................................................................................

5 Press Ctrl+X (Exit).

............................................................................................................................................................................

6 Type Y to save the changes or N to abandon them.
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Delete user accounts

Delete user accounts Use the following procedure to delete user accounts:

............................................................................................................................................................................

1 Choose Manage user accounts from the Calling Lists and Users menu.
The Manage User Accounts screen appears.

............................................................................................................................................................................

2 Press Ctrl+F (Find).

............................................................................................................................................................................

3 Type the user name for the account you want to delete. The matching
account appears on the screen.

............................................................................................................................................................................

4 Press Ctrl+D (Delete).

............................................................................................................................................................................

5 Type Y at the prompt to confirm the deletion or N to cancel.

............................................................................................................................................................................

6 Press Ctrl+X (Exit).

............................................................................................................................................................................

7 Type Y to save the changes or N to abandon them.
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Edit user accounts

Edit user accounts When editing an account, make sure the user is not logged into the
system. You can change the password, login group, and description but
not the user’s name. To change the user’s name, delete the old account,
then add a new user account.

............................................................................................................................................................................

1 Choose Manage user accounts from the Calling Lists and Users menu.
The Manage User Accounts screen appears.

............................................................................................................................................................................

2 Press Ctrl+F (Find).

............................................................................................................................................................................

3 Type the user’s name for the account you want to change. The matching
account appears on the screen.

............................................................................................................................................................................

4 Move the cursor to the field you want to change and press Ctrl+C
(Change).

............................................................................................................................................................................

5 Type the changes and press Enter after each change.

............................................................................................................................................................................

6 Press Ctrl+X (Exit).

............................................................................................................................................................................

7 Type Y to save the changes and exit or N to cancel and exit.
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Record Edit

Overview Record Edit allows you to access and edit a customer record within a
calling list. Use the Record Edit menu to view a calling list record,
change the contents of a field in an outbound calling list, or delete a
record. Use Record Edit when you do not have access to the person’s
account on your host computer. If you upload data to the host
computer, the changes are included in the upload. On some systems,
the system uploads the changes to the host computer each night.

Many companies use Record Edit to correct a call completion code
when an agent entered an incorrect code. Record Edit is also useful to
mark records that you do not want contacted during the current job.

The menu shows two ways to edit and delete records: standard search
and Quick Search. Not all systems have both methods. The procedures
for the two methods are similar except Quick Search finds the record
faster. Quick Search is an indexed method that searches on a specific
field. To use Quick Search, you need to know the exact information for
the indexed field, and the search must return an exact match.

You may have several fields available for standard search. (The fields
were specified during the system configuration.) An advantage to
standard search is the ability to use wild cards. For example, if you are
unsure about the spelling of a name, you can search using the asterisk
(*). An input of Wil* returns Williams, Williamsons, Willis, and so on.

Shortcut keys Use the following shortcut keys when editing calling list records.

Actions Keys

Done F1

Search for a record F10

Delete a record Esc,D

Undelete a record Esc,U
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Edit a record

Edit a record Use the following procedure to edit a record.

............................................................................................................................................................................

1 Choose Record Edit from the Calling Lists and Users menu.

............................................................................................................................................................................

2 Choose Edit a record or Edit a record with Quick Search.

............................................................................................................................................................................

3 Type Y at the prompt to continue or N to cancel.. The Record Search
Criteria screen appears.

............................................................................................................................................................................

4 Type the search values in the screen field(s). (Quick Search screens have
only one field.)

............................................................................................................................................................................

5 Press F10 (Search). If the systemsystem cannot find a match, the Record
Search Criteria screen reappears. Type different criteria and press F10
(Search). If the system finds a match, the record appears on your screen.
To see if there is more than one match, press F10 (Search) again.

............................................................................................................................................................................

6 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

7 Press Ctrl+C (Change) and type your changes.

............................................................................................................................................................................

8 Press F1 (Done) to save your changes or Ctrl+X to abandon them. The
system prompts you to confirm the command.

............................................................................................................................................................................

9 Press Y to save the changes or N to abandon them.

............................................................................................................................................................................

10 Press Ctrl+X to return to the Record Search Criteria screen.
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Delete a record

Delete a record When you use Delete a record or Delete a record with Quick Search,
the system does not actually delete the record. It marks it as deleted in
the STATUSFLAG field. This keeps the system from calling the
record, but you can restore the record.

............................................................................................................................................................................

1 Choose Record Edit from the Calling Lists and Users menu.

............................................................................................................................................................................

2 Choose Delete a record or Delete a record with Quick Search.

............................................................................................................................................................................

3 Type Y to continue or N to cancel.

............................................................................................................................................................................

4 If the system has more than one calling list, type the calling list number
and press Enter. (If your system has only one calling list, the system
skips this step.) The Record Search Criteria screen appears.

............................................................................................................................................................................

5 Type the search values in the screen field(s). (Quick Search screens have
only one field.)

............................................................................................................................................................................

6 Press F10 (Search). If the systemsystem cannot find a match, the Record
Search Criteria screen reappears. Type different criteria and press F10
(Search). If the system finds a match, the record appears on your screen.
To see if there is more than one match, press F10 (Search) again.

............................................................................................................................................................................

7 When the record appears, press Esc,D (Delete) to mark it as “manually
deleted in Record Edit.” The system enters an E in the STATUSFLAG
field.

............................................................................................................................................................................

8 Press Y to confirm the deletion or N to cancel.



Calling lists and users

3 - 9 3

............................................................................................................................................................................................................................................................

............................................................................................................................................................................

9 Press F1 (Done) and press Ctrl+X.
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Restore a deleted record

Restore a deleted record Use the following procedure to restore a deleted record:

............................................................................................................................................................................

1 Choose Record Edit from the Calling Lists and Users menu.

............................................................................................................................................................................

2 Choose Delete a record or Delete a record with Quick Search.

............................................................................................................................................................................

3 Type Y to continue or N to cancel.

............................................................................................................................................................................

4 If the system has more than one calling list, type the calling list number
and press Enter. (If your system has only one calling list, the system
skips this step.) The Record Search Criteria screen appears.

............................................................................................................................................................................

5 Type the search values in the screen field.

............................................................................................................................................................................

6 Press F10 (Search). If the systemsystem cannot find a match, the Record
Search Criteria screen reappears. Type different criteria and press F10
(Search). If the system finds a match, the record appears on your screen.
To see if there is more than one match, press F10 (Search) again.

............................................................................................................................................................................

7 When the record appears, press Esc,U (Undelete). The system removes
the E from the STATUSFLAG field.

............................................................................................................................................................................

8 Press F1 (Done) and press Ctrl+X.
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Campaign Update

Overview Use outbound Campaign Update to cancel a scheduled outbound call.
This command marks a record as uncallable when an inbound call has
come in from a customer whose record may be included in an outbound
list. This is similar to deleting a record, except the system enters a C
instead of an E in the STATUSFLAG field.

Outbound Campaign Update works with one outbound calling list. To
use this feature with more than one outbound calling list, contact your
system vendor.

If you have an Intelligent Call Blending system, the system
automatically enters a C in a record’s STATUSFLAG field, canceling
the call, when an agent releases the inbound call with the appropriate
code. (See your call completion codes list for the codes used on your
system.)

Campaign Update If you have an Agent Blending system, the system updates all records
at a predefined time, or you can perform the update manually using the
following procedure.

............................................................................................................................................................................

1 Choose Campaign Update from the Record Edit menu.

............................................................................................................................................................................

2 Type the calling list number to update and press Enter.

............................................................................................................................................................................

3 Type the search criteria (for example, account number or phone
number). Then press F10 to search for the record.

............................................................................................................................................................................

4 A message appears if there are no matching records. If the system finds
a match, it enters a C in the STATUSFLAG field.
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Create an outbound Campaign Update report

Create an outbound
Campaign Update report

Use the following procedure to create a Campaign Update report.

............................................................................................................................................................................

1 Choose Record Edit from the Calling Lists and Users menu.

............................................................................................................................................................................

2 Choose Create Outbound Campaign Update Rep from the Record
Edit menu.

............................................................................................................................................................................

3 Type a date in the format CCYYMMDD. For example, type 19990921
for September 21, 1999. A message appears confirming the report
generation. Use the Reports menu to view or print the report.
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Mark records as Do Not Call

Overview Use mark calling list records as DO NOT CALL to tell the sAvaya PDS
not to call specific customers. After you mark a customer record, the
system immediately searches the outbound calling lists specified in the
Do Not Call group and marks all the customer’s records. The system
will not call a customer during any job if the customer’s record is
marked as do not call.

Mark records as do not call Use the following procedure to mark records as DO NOT CALL.

............................................................................................................................................................................

1 Choose Mark calling list records as DO NOT CALL from the Calling
Lists and Users menu. The Do Not Call menu appears.

............................................................................................................................................................................

2 Choose Mark DNC Group.

............................................................................................................................................................................

3 Type the item number for the Do Not Call group.

............................................................................................................................................................................

4 Type Y at the prompt to confirm your choice or N to cancel. The Set DO
NOT CALL Status screen appears, which displays the selected group’s
unique identifier.

............................................................................................................................................................................

5 In the screen field, type the specific value for the customer whose record
you want to mark as Do Not Call.

............................................................................................................................................................................

6 Press Enter.

............................................................................................................................................................................

7 Repeat steps 5 and 6 for each record you want to mark as Do Not Call.

............................................................................................................................................................................

8 Press Ctrl+X to exit the Set DO NOT CALL Status screen.
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Overview

Purpose This section describes the how active jobs are managed.

Contents This section contains the following topics:

• Overview of job monitor

• Open a job

• Close a job

• Remove agents

• View job statistics

• View completion codes

• View phone line usage

• View call types

• View agent screens

• Agents on active jobs

• Send a message to an agent

• Send a message to all agents

• Control jobs

• Shut down a job

• Stop a job immediately

• Link a job
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• Monitor agents

• Transfer agents to another job

• Change phone line allocations

• Change maximum time a customer waits

• Change maximum % of client in queue

• Change blend agent return time

• Job settings

• Change Minimum Hit Rate

• Change Expert Calling Ratios

• Change Managed Dialing settings

• Change cancel mode

• Change time zone ordering

• Change time zone status

• Unit Work List settings

• Set different quotas for each Unit Work List

• Change Unit Work List controls

• Change phone strategy detection mode

• Change phone strategy recall parameters

• Change phone strategy alternate phone lines

• Analyze Job Activity Screens

• Agent Activity Fields

• Line Usage Fields

• Calling activities fields for outbound calls
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Overview of job monitor

Job monitor Choose Manage an active job from the Supervisor Main Menu. The job
monitor appears.

The top of the screen contains the menu bar. Below the menu bar is the

information line which gives a brief description of the active menu
item. The bottom of the screen displays a line of additional help, such
as how to choose a command or a message responding to an action.

You can make the menu bar active from any screen in Job Monitor by
pressing Ctrl+X or F1. When the menu bar is visible, you are in menu
mode. When it isn’t visible, you are in edit mode.

To choose a menu
command

Some menu commands have shortcut keys listed in the right column.
Use these keys when you are in menu mode, without the menu open.
For example, F4 opens the Phone Lines command.

To exit a menu To exit a drop-down menu, press Ctrl +X.

To exit the main menu, press Q and press Enter.
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Open a job

Oveview Managing a job begins with opening the job you want to manage. Use
the Jobs menu to open and close jobs. All tasks on the Job Monitor
menus are job related. If you try to use a command without selecting a
job, the Avaya PDS will not complete the action. The system does not
display an error message.

Open jobs Use the following procedure to open jobs.

............................................................................................................................................................................

1 Open the Job menu.

............................................................................................................................................................................

2 Choose Open Job from the Jobs menu. A list of all active jobs appears.
(If there is only one active job, the Avaya PDS automatically opens

............................................................................................................................................................................

3 Use the down arrow to choose the job you want to manage. A Job
Activity Summary Statistics screen appears.

Use the Job Activity Summary Statistics screen to monitor job status.
Press Tab to cycle through three additional screens: Call Completion

Code Results, Phone Line Usage, and Line Usage for All Lines on All

Jobs.
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Close a job

Close a job Use the following procedure to close a job.

............................................................................................................................................................................

1 Open the Job menu.

............................................................................................................................................................................

2 Choose Close Job from the Jobs menu to stop managing a job. Choosing
Close does not end the job.

............................................................................................................................................................................

3 Choose a different job to monitor, or press Q (Quit) and Enter to return
to the Supervior Main Menu.
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Remove agents

Removing agents You can immediately disconnect an agent from a call. Use it only for
emergencies when you cannot use a normal disconnect. Not only does
it remove the agent from the job, it removes the agent from the Avaya
PDS. Therefore, the agent needs to log in again.

............................................................................................................................................................................

1 Open the Job menu.

............................................................................................................................................................................

2 Choose Remove Agent from the Jobs menu. The Agent Selection screen
appears.

............................................................................................................................................................................

3 Use the down arrow to choose the agent you want to remove. A
countdown message appears. When the count reaches 1, the Avaya PDS
has removed the agent.
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View job statistics

View job statistics The Displays menu provides a variety of screens for monitoring job
activity, phone line usage, and agent activity. In addition, you can send
messages to agents using the Notify option. The menu groups the
commands into three categories: Display Types, Display Options, and
Notify.

............................................................................................................................................................................

1 Open the Job menu.

............................................................................................................................................................................

2 Choose Remove Agent from the Jobs menu. The Agent Selection screen
appears.

............................................................................................................................................................................

3 Use the down arrow to choose the agent you want to remove. A
countdown message appears. When the count reaches 1, the Avaya PDS
has removed the agent.
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View completion codes

View completion codes This screen gives a statistical count of calling results by call completion
codes.A call completion code represents the result of the last completed
call the Avaya PDS made. The system records the results for calls it
doesn’t pass to agents. Agents record the results of the calls that the
Avaya PDS passes to them. The codes displayed on your screen reflect
the specific setup of your system and may be different from the sample.

............................................................................................................................................................................

1 Open the Displays menu.

............................................................................................................................................................................

2 Choose Completion Codes from the Displays menu or press F3.

............................................................................................................................................................................

3 The Call completion Code Results screen appears.

Note

The following table describes the fields on the Call Completion Code
results screen.

Field Description

Code The number the system assigned
to the call completion code

Count The number of calls assigned to
each code since the job began

Description A description of each call
completion code.
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View phone line usage

View phone line usage The Phone Line Usage screen shows how the system is using each line
for a specific active job. It shows which lines are in use, the status of
the lines, the time the status began, and the agent’s ID. You can view
the status of all lines for all jobs by pressing Tab after you choose
Phone Lines.

............................................................................................................................................................................

1 Open the Displays menu.

............................................................................................................................................................................

2 Choose Phone Lines from the Displays menu or press F4. (You can also
reach this screen from the Job Activity Summary Statistics screen by
pressing F4 or Tab.) The Phone Line Usage screen appears.

No. The number line.

the type of activity
on the line.

Time System line status begins.

Agent No. Agent ID
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View call types

View call types The phone line usage screen shows how the system is using each line
for a specific active job. It shows which lines are in use, the status of
the lines, the time the status began, and the agent’s ID. You can view
the status of all lines for all jobs by pressing Tab after you choose
Phone Lines.

............................................................................................................................................................................

1 Open the Displays menu.

............................................................................................................................................................................

2 Choose View Call Types from the Displays menu.

............................................................................................................................................................................

3 If this is a unit work list job, the screen displays unit IDs. Choose a unit
ID from the list, or choose Summary to monitor all IDs (ALLID)

............................................................................................................................................................................

4 If this is a blend job, you may choose to view the job’s inbound or
outbound call activity. The Job Statistics screen appears with data for
theselected unit ID or detail for the outbound or inbound call activity of
a blend job.
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View agent screens

View agent screens Use the Agent Screen option to view the Client Information screen for the

selected agent’s current call. (The screen does not show agent updates.) You
can use this command with Monitor Agent to simultaneously view the agent

screen and listen to the agent’s conversation.

............................................................................................................................................................................

1 Open the Displays menu.

............................................................................................................................................................................

2 .Choose Agent Screen from the Displays menu.

............................................................................................................................................................................

3 Choose Agent Screen from the Displays menu.
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Agents on active jobs

Overview The List Agent command displays a list of all the agents that have
logged into the active job. Choose List Agent from the Displays menu
and the Agent screen appears.

Talk time How long an agent talks to each customer. The Avaya PDS
measures talk time from initial connect to the release of the phone line.

Update time How long an agent takes to update a customer record.
The Avaya PDS measures update time from the release of the phone
line to the release of the record.

Idle time The total time an agent waits for a call.

Elapsed time The time since the agent logged in.



Manage active jobs

4 - 1 1 1

............................................................................................................................................................................................................................................................

.............................................................................................................................................................................................................................................................
Send a message to an agent

Send a message to an
agent

Send a message to a single agent or to all agents on the job. The
message appears on the agent’s screen after the agent releases the
current record

............................................................................................................................................................................

1 Open the Displays menu.

............................................................................................................................................................................

2 .Choose Single Agent from the Displays menu. The text message box
appears.

............................................................................................................................................................................

3 Type a message up to 40 characters.

............................................................................................................................................................................

4 Press Enter to end the message. The Select Agent screen appears. Use
the down arrow to select an agent



4 - 1 1 2

...........................................................................................................................................................................................................................................................

Manage active jobs

.............................................................................................................................................................................................................................................................
Send a message to all agents

Send a message to all
agents

Use the following procedurre to send a message to all agents.

............................................................................................................................................................................

1 Open the Displays menu.

............................................................................................................................................................................

2 .Choose All Agent from the Displays menu. the text message box appears.

............................................................................................................................................................................

3 Type a message up to 40 characters. Press Enter to end the message.

............................................................................................................................................................................

4 Use the down arrow to select an agent.
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Control jobs

Overview The Control menu provides you with commands to manage the job, the
agent, the phone lines, and inbound call activity. Changes made during
a job affect it only while the job is running. These changes do not alter
the settings in the phone strategy, record selection, or the Job Run
Verification screen.
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Shut down a job

Overview A job ends when the Avaya PDS completes the call activity for the job.

You can stop a job early. For example, some companies temporarily
stop a job for meal breaks and meetings.

Whenever possible, use the Shutdown option to stop a job. Shutdown
allows agents to finish their current calls and update records.

For rare circumstances, you can use the Abort option. For example, if
there is a telephone company outage, you can end the job using Abort.
Abort immediately stops a job. Calls are disconnected, and agents
cannot update records.

Shut down a job Use the following procedures to shutdown jobs:

............................................................................................................................................................................

1 Open the Control menu

............................................................................................................................................................................

2 .Choose Shutdown from the Control menu or proess Ctrl + E.

............................................................................................................................................................................

3 Type Y at the prompt to confirm the shutdown or N to cancel. .

............................................................................................................................................................................

4 Press Ctrl+X to return to the Job Monitor menu

............................................................................................................................................................................

5 Press Enter to end the message. The Select Agent screen appears.

............................................................................................................................................................................

6 Use the down arrow to select an agent.
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Stop a job immediately

Overview It is important to note that Abort is only used in unusual situations that
require immediate action. When you use the Abort command, the
Avaya PDS instantly cuts off all calls and often cannot retrieve data for
reporting.

Stop a job immediately Use the following procedure to stop a job immediately.

............................................................................................................................................................................

1 Open the Control menu

............................................................................................................................................................................

2 .Choose Abort from the Control menu.

............................................................................................................................................................................

3 Type Y at the prompt to confirm the shutdown or N to cancel. A

............................................................................................................................................................................

4 Press Ctrl + X to return to the Job Monitor menu.

............................................................................................................................................................................

5 Press Ctrl+X to return to the Job Monitor menu.

............................................................................................................................................................................

6 Press Enter to end the message. The Select Agent screen appears.

............................................................................................................................................................................

7 Use the down arrow to select an agent.
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Link a job

Linking jobs Link jobs when you want the Avaya PDS to start a job as another job
ends. When you link a job, the system transfers agents to the next job
after they complete their calls and release the records. The system
displays a screen message telling the agents that they are changing jobs.
Unlink a job when you don’t want it to start a job automatically when
the selected job ends or if you want to start the job ahead of schedule.

............................................................................................................................................................................

1 Open the Control menu

............................................................................................................................................................................

2 Choose Job Link Modification from the Control menu. The Job Link
screen appears.

............................................................................................................................................................................

3 Choose Delete from the Control menu. The Job Link screen appears.

............................................................................................................................................................................

4 Choose the job to delete.

............................................................................................................................................................................

5 Type Y to delete the designated job. A confirmation message appears at
the bottom of the screen.
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Monitor agents

Monitor agents You can listen to the conversation between an agent and a customer.
No warning tone sounds in the agent’s headset. This option may not be
legal in some areas. If it is, it is useful for training and quality control.

............................................................................................................................................................................

1 Open the Control menu

............................................................................................................................................................................

2 Choose Monitor Agent from the Control menu.

............................................................................................................................................................................

3 Choose the agent’s logon ID from the logon ID list.

Note

If the agent is talking with a customer, the Avaya PDS immediately
connects your headset to the agent’s port. If the agent is not talking
with a customer, a message appears to tell you the agent is not on a line.

When you finish listening to an agent’s conversation, choose
Disconnect Agent from the Control menu.
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Transfer agents to another job

Transfer agents to different
jobs

You can transfer an agent to another job. The transfer takes place after
the agent releases the record for the current call. The Avaya PDS
displays a transfer message on the agent’s screen.

............................................................................................................................................................................

1 Open the Control menu

............................................................................................................................................................................

2 Choose Transfer Agent from the Control menu.

............................................................................................................................................................................

3 Choose yes to confirm the transfer or No to cancel.



Manage active jobs

4 - 1 1 9

............................................................................................................................................................................................................................................................

.............................................................................................................................................................................................................................................................
Change phone line allocations

Change phone line
allocations

Use Phone Line Allocation to change the phone lines used by the active
job.Phone lines remain assigned for the duration of a job. Even if they
are idle, another job cannot use them. The only way for another job to
use these idle lines is for the current job to release them. You can
acquire or release groups of phone lines with the Phone Line Allocation
command on the Control menu. The changes you make affect only the
current job.

............................................................................................................................................................................

1 Open the Control menu.

............................................................................................................................................................................

2 Choose Phone Line Allocation from the Control menu.

............................................................................................................................................................................

3 Choose Add or Delete.

............................................................................................................................................................................

4 Type the name of the group of lines to acquire or release and press Enter.

Note

If your system uses line pooling, this feature affects only the inbound
lines. If the lines are available, the system immediately assigns the lines
to the active job and displays the number of lines it releases. However,
if the lines are in use by another job or system, the system waits until
the designated lines are available. The system displays a 0 if it is using
all the phone lines and cannot release them.
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Change maximum time a customer waits

Change the maximum time
a client waits

Inbound Service Time is the time an inbound call can be in the wait
queue before the system assigns a blend agent to handle the call.
Decrease client wait time if you want to emphasize customer service.

............................................................................................................................................................................

1 Open the Control menu.

............................................................................................................................................................................

2 Choose Inbound Service Time from the Control menu.

............................................................................................................................................................................

3 Type the number of seconds (5-999).
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Change maximum % of client in queue

Overview (Intelligent Call Blending systems only) The commands grouped in the
Inbound Parameters option affect only inbound calls on blend jobs. Use
these settings to ensure maximum coverage of inbound calls in a blend
job. For more details on these settings, see “Editing Blend Jobs.”

Change the maximum % of
clients in queue

The Queue Factor setting determines the percentage of inbound calls
that can be in the wait queue before the system assigns a blend agent to
inbound calling.

............................................................................................................................................................................

1 Open the Control menu.

............................................................................................................................................................................

2 Choose Queue Factor from the Control menu.

............................................................................................................................................................................

3 Type a number of 100 or above.



4 - 1 2 2

...........................................................................................................................................................................................................................................................

Manage active jobs

.............................................................................................................................................................................................................................................................
Change blend agent return time

Change blend agent return
time

Return Time is the time a blend agent assigned to inbound calling can
be inactive before the system reassigns them to outbound calling.

............................................................................................................................................................................

1 Open the Control menu.

............................................................................................................................................................................

2 Choose Return Time from the Control menu.

............................................................................................................................................................................

3 Type a number of seconds (0-999).
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Job settings

Job settings The Settings menu allows you to change settings for active jobs. This
ability lets you fine tune your settings and make adjustments to meet
changing circumstances. Changes made during a job affect it only
while the job is active. These changes do not alter the settings displayed
on the Job Run



4 - 1 2 4

...........................................................................................................................................................................................................................................................

Manage active jobs

.............................................................................................................................................................................................................................................................
Change Minimum Hit Rate

Change Minimum Hit Rate Change the Minimum Hit Rate setting when you need to alter the
calling pace. The Minimum Hit Rate predicts how many calls the
system makes before it gets a connection.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Minimum Hit Rate from the Settings menu.

............................................................................................................................................................................

3 Type a Q, W, or U and a number between 1-100.

............................................................................................................................................................................

4 The new setting appears in the status field at the bottom of the Job
Activity screen.

Note

Although the settings change immediately, allow a minimum of fifteen
minutes to permit the new value to run and set its pace. Frequent
changes to the Minimum Hit Rate setting can disrupt the calling pace.
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Change Expert Calling Ratios

Change expert calling
ratios

Change the Expert Calling ratio when you want to change the method
the system uses to determine when to make the next call.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Expert Calling from the Settings menu.

............................................................................................................................................................................

3 Type a number between 1-100.

............................................................................................................................................................................

4 The new setting appears in the status field at the bottom of the Job
Activity screen.
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Change Managed Dialing settings

Overview Managed Dialing lets agents preview a call before the system dials the
number. You can also give the agents the option of canceling a call
before the system dials. Your changes affect all agents on the selected
job.

Change preview length Change the time an agent can preview a record before the system

dials the number.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Preview Length from the Settings menu.

............................................................................................................................................................................

3 Type the new preview length from 0 to 999 (seconds). Type 0 to allow
unlimited preview time.
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Change cancel mode

Change cancel mode Cancel Mode lets agents stop a dialing attempt and continue with the
next record.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Cancel Mode from the Settings menu.

............................................................................................................................................................................

3 Choose Activate to enable the Cancel key or Inactivate to disable the
Cancel key.
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Change time zone ordering

Overview Time zone ordering sets the pattern of calls by time zone. When turned
on, the system starts calling in the eastern most time zone. The calling
pattern continues from east to west as the system exhausts numbers or
they become ineligible. When time zone ordering is turned off, the
system dials numbers at random.

Change time zone ordering Use the following procedure to change time zone ordering:

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Order Time Zone(s) from the Settings menu.

............................................................................................................................................................................

3 Choose Activate to turn on time zone ordering or choose Inactivate to
turn it off.
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Change time zone status

Change time zone status When calls are unproductive in a time zone, you can inactivate that
time zone. Inactivating a time zone shuts off calls to that time zone.
When it becomes advantageous to resume calling, reactivate the time
zone.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Time Zone(s) Control from the Settings menu. The Time Zone
screen appears.

............................................................................................................................................................................

3 Choose the time zone and press Enter. Pressing Enter causes the status
to switch between active and inactive.

Time zone status

The following status information appears for all time zones defined on
the active job.

Column Description

1st column Lists each time zone by capital
letter

Start/Stop The recommended start and stop
time for each zone

Status The status for each zone: A
(active) or I (inactive)

First The total initial phone numbers
that are available in each zone

Subseq The total subsequent numbers in
each zone

Recall The current number of recall
phone numbers that are available
for

calling in each zone
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Unit Work List settings

Overview You can turn off unit work lists for the active job and change the quota
for a call completion code.

You cannot turn a job into a unit work list job by activating the unit
work list control. You must first define a unit work list job with a unit
work list record selection file.

Quotas: A quota is the designated number of calls with a particular a call
completion code. When a job or a unit ID reaches the quota, the system
stops making calls. You have the following choices:

• Set no quota for the job. Leave the field blank or erase the existing
entry by pressing Ctrl+E.

• Set one quota for the entire job. When the job meets the quota, the
job ends.

• Set one quota to apply to all unit work lists. Each unit shuts down
when the agent reaches the quota for that list. To do this, type the
call completion code number, a comma, and the quota. For
example, type 16,4.

Set different quotas for each unit work list. To do this, set the quota as
you did in the previous step; then, set individual quotas in the Settings

menu.
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Set different quotas for each Unit Work List

Set different quotas for
each unit work list

Use the following procedure to set different quotas for each unit work
list.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Quota from the Settings menu.

............................................................................................................................................................................

3 Press Tab to move to the Quota column.

............................................................................................................................................................................

4 If you have multiple Unit IDs, use the arrow keys to move to the quota
you want to change.

............................................................................................................................................................................

5 Type the new quota.
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Change Unit Work List controls

Change unit work list(s)
controls

Unit Work List(s) Control options let you turn on or off a unit work list.
The system ignores this command for standard jobs.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Unit Work List(s) Control from the Settings menu.

............................................................................................................................................................................

3 Choose Activate or Inactivate.

............................................................................................................................................................................

4 Choose the unit ID you want to activate or inactivate.
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Change phone strategy detection mode

Overview The commands grouped under Phone Strategy Control let you change
some of the phone strategy settings for this job. These changes do not
change the settings in the phone strategy file.

Change detection modes The Detection Mode controls the number of rings the system allows
before recording a NOANSWER and which detection modes it passes
to agents.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Detection Mode from the Settings menu. The Select Ring
Count and Call Detection Mode screen appears.

............................................................................................................................................................................

3 Use the down arrow to move to the line you want to change.

............................................................................................................................................................................

4 Press Tab to move across the line to the # of Rings column.

............................................................................................................................................................................

5 Type a new number; the new number replaces the old number.

............................................................................................................................................................................

6 Choose Yes to save your changes.
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Change phone strategy recall parameters

Change recall parameters Select the recall intervals and the number of retries for each phone type
in the phone field column. The change does not affect records marked
for recall before your changes.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Recalls from the Settings menu. The Select System Set Recalls
screen appears.

............................................................................................................................................................................

3 Type the phone type number (1, 2, 3 …) to recall in the Phone Field
column. Press Enter to move to the Call Result field.

............................................................................................................................................................................

4 Press Enter to display the call completion codes.

............................................................................................................................................................................

5 To choose the call completion codes, use the arrow keys to move to a
code and press Spacebar to mark it. Repeat the process until you have
selected all the codes you want to include. Press Enter to return to the
screen.

............................................................................................................................................................................

6 To change the time between retries, type a number in the Min (minutes)
column and press Enter.

............................................................................................................................................................................

7 To change the number of retries, type a number in the Number column
and press Enter.

............................................................................................................................................................................

8 To select a phone to call after the last retry, type a phone type number
(1, 2, 3 …) in the Next Phone column. Leave Next Phone blank if you
do not want the system to call an alternate phone.
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............................................................................................................................................................................

9 Press Ctrl+X to exit the screen. Choose Yes to save your changes and
return to the Job Activity screen.
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Change phone strategy alternate phone lines

Change alternate phone
lines

Change the alternate initial phone, the time zone(s), and the time to
switch to the alternate initial phone. For more details, see “Selecting
Alternate Initial Phones”.

............................................................................................................................................................................

1 Open the Settings menu.

............................................................................................................................................................................

2 Choose Alternate from the Settings menu. The Select Alternate Initial

............................................................................................................................................................................

3 Phone screen appears. Use Overstrike edit mode because Tab does not

............................................................................................................................................................................

4 work in Insert mode.

............................................................................................................................................................................

5 Type the phone type number (1, 2, 3 …) for the alternate initial phone in

............................................................................................................................................................................

6 the Phone field and press Tab.

............................................................................................................................................................................

7 If the Time Zones column is blank, press Enter to display the time zones.

• Use the down arrow to move to the time zone you want to select.

• If you are selecting only one time zone, press Enter.

• If you want to select multiple time zones, press Spacebar; then
press

• the down arrow to move to the next zone.

• When you have selected all the zones, press Enter.

............................................................................................................................................................................

8 Move to the Time column and type the time (24-hour clock) to start

............................................................................................................................................................................

9 calling that alternate initial phone. For example, type 18.00 for 6:00 PM.
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............................................................................................................................................................................

10 Repeat steps 2 through 5 for each alternate initial phone you selected.

............................................................................................................................................................................

11 Press Ctrl+X to exit the screen.

............................................................................................................................................................................

12 Choose Yes to save your changes and return to the Job Activity screen.
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Analyze Job Activity Screens

Analyze job activity
screens

The Job Activity screens display the activity status of outbound,
inbound, and blend agents, the dialing statistics for outbound and
inbound calls, and the operating status of each phone line. The system
divides the screen into four sections: job information header, agent
activity area, line usage area, and call activity area. The Job Activity
Summary Statistics screen shows the activity for the current

job, including information about agent activity, line usage, and record
status. Press Tab to cycle through three additional screens: Call
Completion Code Results, Phone Line Usage, and All Lines on All
Jobs. You can also access these screens directly from the Displays
menu.
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Agent Activity Fields

Agent Activity Fields The agent activity area provides information on how many agents you
assigned to the job and how many have logged in and are on a call. This
screen is particularly useful for blend jobs because it indicates the
volume of outbound versus inbound calls.

Field Description

Logged in The number and type of agents
logged in to the job

Assigned Current agent assignments

All Total number of agents working
in the current job

Outbd (Outbound) Agents handling
calls made to the customers

Inbd (Inbound) Agents receiving calls
from customers

Blnd (Blend) Agents handling both
outbound and inbound calls

PTP (Person to Person) Agents
handling the overflow of
outbound

calls

On a Phone The number of each type of
agent currently handling calls
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Line Usage Fields

Line usage fields The line usage area shows the status of each line group or line type. It
compares the number of lines needed to the number of lines available.
It displays only the lines with the label requested by the job. Line usage
settings reflect the type of active job. For example, both outbound and
inbound line usage appear only if a blend job is running.

Field Description

Outbound Demand The current, average, and peak
number of lines needed to handle
the current number of agents and
the call activity.

The average and peak statistics
reflect job activity since you

started the job monitor. system
calculates the

statistics in regular intervals.

Outbound Available The current, average, and peak
number of outbound lines

that are available for calling. The
system calculates

the average and peak statistics
during the last interval

(usually 5 minutes).

Inbound Activate The current number of lines
activated for the job. The

system activates lines based on
the number of agents

on the job and the job state.

Inbound Available The number of inbound lines that
are assigned to the job.
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Calling activities fields for outbound calls

Overview Calling Activities Fields for Outbound Calls

Field Description

Records selected The number of records available
for calling based on the

record selection and initial phone
type selected in the phone

strategy.

Phone calls made The number of calls since the job
began.

Cur/Run Hit Rate The percentage of connects for
the last five minutes and the

percentage of dialing attempts
resulting in connects since

the job began.

Agent connects The number of calls passed to
agents.

Queue The number of calls that are
currently in the wait queue.

Recalls The number of records that the
system scheduled

for recall.

Calls left The number of records that the
system has not

called or the number of
subsequently loaded records
after

the job began. It does not include
the recalls.
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Calling Activities Fields for Inbound Calls

Field Description

Received The number of calls received by
the system.

Agents Connects The number of calls handled by
agents.

Queue The number of calls in the wait
queue.

Average Wait Time The average time a caller was on
hold.

Average speed to answer The average number of seconds
it takes for the system to answer
a call.

Percent calls delayed The total calls placed in wait
queue divided by total calls
received, converted to a
percentage.

Percent abandoned The total number of abandoned
calls in the queue divided by the
total calls received, converted to
a percentage.
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Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses Screenbuilder to
create custom agent screens.

Contents This section contains the following topics:

• Screenbuilder overview

• Screenbuilder menus

• Open Screenbuilder

• Create a screen

• Add text to screen

• Copy a screen

• Find a screen

• Edit a screen

• Delete field and text in a screen

• Save screen changes

• Edit screens with Menu System

• Add screens to jobs

• Spell-check your screen

• Delete screens from a job

• Change screens and calling lists
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• Field Attributes

• Change field appearance

• Set field edit capabilities

• Change field sequence order

• Field verification formats

• Set field verification formats

• Validate delimiters

• Acceptable field entries

• Set acceptable field entries

• Field reference information

• Set field reference information

• Build helpful screens

• Screenbuilder reports

• Create and view reports

• Print a report
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Screenbuilder overview

Overview Screenbuilder is an optional Avaya PDS tool set that lets you change
the information that agents see on their workstation screens. Use
Screenbuilder to design up to 20 screens for each job. With
Screenbuilder’s tools, you can easily adapt your agent’s screens to meet
your changing needs.

Background information Before you change or create a job screen, you need to understand how
it fits into the Avaya PDS.

A campaign is a strategy that you design to achieve your call center
goals. One element of a campaign is a job. It is a job’s objective to
accomplish specific campaign goals. Campaigns can include one or
more jobs. A job consists of a calling list, phone strategy, record
selection, job definition, and job screens. Multiple jobs can share
screens if the jobs are based on the same calling list or calling list
format.

Agents see job screens on their workstations when the Avaya PDS
passes them a call. If a job uses more than one screen, the agent uses
the function keys to move to the subsequent screens. F2 moves to the
second screen, F3 to the third, and so on. The Avaya PDS fills some of
the fields with customer information from the calling list. The agents
may complete additional information.

A job screen is always based on a specific calling list. The calling list
determines the available fields for a screen. The Avaya PDS maintains
a separate file, the calling list dictionary, with lists of the fields. The
calling listdictionary also contains information about the size of each
field and the kind of information in the field.

Screen information Screens contain the following information for the agent:

• Fields contain information specific to the current record. The
Avaya PDS may complete some of the fields and the agents may
complete others.

• Field Labels give a brief description of the information in a field.
For example, the label Last Name tells an agent that the
information in that field is the customer’s last name.

• Scripts contain the questions you want asked or the information
you want the agents to distribute.
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• General Information provides function key names and system
instructions.
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Screenbuilder menus

Overview Screenbuilder starts in menu mode with the menu bar across the top of
the screen. It stays in menu mode until you open a screen, then you are
in edit mode. (You are in menu mode if you can see the menu.) Switch
between menu and edit modes by pressing Ctrl+X. Use edit mode to
create, delete, or edit screens, and use menu mode to choose a menu
command.

The Screenbuilder menu is a menu bar with drop-down menus for
different tasks.

The top of the screen contains the menu bar. Below the menu bar is the
information line which gives a brief description of the active menu
item. The bottom of the screen displays a line of additional help, such
as how to choose a command or a message responding to an action.

You can make the menu bar active from any screen in Screenbuilder by
pressing Ctrl+X or F1. When the menu bar is visible, you are in menu
mode. When it is not visible, you are in edit mode.

When you decide to create a screen, compare the new screen to existing
screens. If the new screen does not resemble any of the screens on the
system, create a screen to meet your needs. Otherwise, make a copy of
an existing screen and edit the copy. You can often save time by
copying a screen from another job, and copying helps to keep the
screen design consistent.

Screenbuilder has two typing modes: Overwrite and Insert. Th ere is an
asterisk (*) on the lower right corner when the screen is in Overwrite
mode. Press Ctrl+O to switch between Overwrite and Insert. The
default edit mode is Overwrite. In Overwrite mode, the characters you
type replace the existing text to the right of the cursor. Use Backspace
to delete characters. Use Insert mode to type characters between
existing characters, then switch back to Overwrite mode. In Insert
mode, Screenbuilder moves existing text to the right as you type new
characters. Use the arrow keys to move around the screen.

Action keys Use the following action keys when using Screenbuilder.

Action Key Function

Shift+F1 Open Screen

Shift+F3 Save Screen As
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Shift+F4 Close Screen

F2 Insert line

F3 Delete line

F4 Save Screen

F5 Cut block

F6 Copy block

F7 Paste block

F8 Clear block

F9 Tag all fields

F10 Quit Screenbuilder

Ctrl+A Add field

Ctrl+C Clear all tags

Ctrl+D Clear to end of line

Ctrl+O Switch between insert and overwrite

Ctrl+X Switch between menu and edit mode

Ctrl+Z Undo edit

Action Key Function
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Open Screenbuilder

Open Screenbuilder Use the following procedure to open Screenbuilder.

............................................................................................................................................................................

1 Choose Calling lists and users from the Supervisor Main Menu.

............................................................................................................................................................................

2 Choose Start Screenbuilder from the Calling Lists and Users menu. Use
these shortcut keys when you are in menu mode.

Shortcut Key Description

Ctrl+X To exit a drop-down menu

Q + Enter To exit the main menu

Shift+F4 To close a screen

Ctrl+A adds a field

Tab To move through the drop-down
menus
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Create a screen

Create a screen Use the following procedure to create a screen using Screenbuilder.

............................................................................................................................................................................

1 Choose Screen from the Screenbuilder menu.

............................................................................................................................................................................

2 Choose New Screen from the Screen menu.

............................................................................................................................................................................

3 Type a name for the screen (not more than 9 characters). The
NEWSCRN: Select File Dictionary screen appears. It lists the calling
lists for your system.

............................................................................................................................................................................

4 Use the arrow key to move the cursor to the callin g list you want to
elect. Press Enter and a blank screen appears.
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Add text to screen

Add text to screen Use the following procedure to add text to a screen using
Screenbuilder.

............................................................................................................................................................................

1 Use the arrow keys to move the cursor to where you want the text to
begin.

............................................................................................................................................................................

2 Type the text you want to appear on the screen.

............................................................................................................................................................................

3 Repeat steps 1 and 2 for each text entry you want to add.
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Add fields to screen

Add fields in screen Use the following procedure to add fields in your screen using
Screenbuilder.

............................................................................................................................................................................

1 Use the arrow keys to move to where you want the field to begin.

............................................................................................................................................................................

2 Press Ctrl+A (Add) and Enter. The field list appears.

............................................................................................................................................................................

3 Press down arrow to move to the field you want to add and press Enter.

............................................................................................................................................................................

4 Repeat steps 1 through 3 for each field you want to add.

............................................................................................................................................................................

5 Choose Save Screen from the Screen menu, then choose Close from the
Screen menu.
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Copy a screen

Copy a screen Use the following procedure to copy a screen using Screenbuilder.

............................................................................................................................................................................

1 Choose Open Screen from the Screen menu.

............................................................................................................................................................................

2 Press the down arrow to move to the screen you want to copy and press
Enter.

............................................................................................................................................................................

3 Choose Save Screen As from the Screen menu.

............................................................................................................................................................................

4 Type a new name for the screen. The original screen file remains
unchanged and the copy is open on your screen.

............................................................................................................................................................................

5 To make changes, follow the steps in “To change or add text.”
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Find a screen

Find a screen More than one job can use a screen. Before editing a screen, determine
which jobs use the screen. Use the following procedure to determine
what job(s) use the screen.

............................................................................................................................................................................

1 Choose Jobs from the Screenbuilder menu.

............................................................................................................................................................................

2 Choose All Jobs.

............................................................................................................................................................................

3 Choose either Outbound or Inbound.

............................................................................................................................................................................

4 Press down arrow to move to the job you want to view.

............................................................................................................................................................................

5 Press Enter and the screen list for the selected job appears.

............................................................................................................................................................................

6 Note the screens the job uses.

............................................................................................................................................................................

7 Press Ctrl+X to exit the list.

Important

Do not edit a screen on an active job.



Screenbuilder

5 - 1 5 5

............................................................................................................................................................................................................................................................

.............................................................................................................................................................................................................................................................
Edit a screen

Change or add text in
screens

Use the following procedure to add or change text in screens using
Screenbuilder.

............................................................................................................................................................................

1 Choose Open Screen from the Screen menu.

............................................................................................................................................................................

2 Use the arrow keys to move to the screen you want to edit.

............................................................................................................................................................................

3 Press Enter and the screen appears.

............................................................................................................................................................................

4 Use the arrow keys to move to the text you want to change or to the place
where you want to add text.

............................................................................................................................................................................

5 Make your changes or additions.
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Delete field and text in a screen

Delete fields and text Use the following procedure to add fields using Screenbuilder.

............................................................................................................................................................................

1 Use the arrow keys to move the cursor to the information you want to
delete.

............................................................................................................................................................................

2 Position the cursor at the beginning of the field label or text. Press F5
(Cut) and use the right arrow to highlight the area to cut. Press Enter to
select the highlighted area.

............................................................................................................................................................................

3 Type Y at the prompt to confirm the deletion or N to abandon the
change.
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Save screen changes

Save changes Use the following procedure to save changes to screens.

............................................................................................................................................................................

1 Switch to menu mode (Ctrl+X).

............................................................................................................................................................................

2 Choose Save Screen from the Screen menu or press F4 (Save).
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Edit screens with Menu System

Using the Menu to edit
screen fields

If you need to make many changes to a screen, you may find it easier to
use the menu edit method. Use the following procedure to edit screen
fields using the menus.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Tag the field by pressing T. (You can clear a tag by pressing T when the
cursor is in a tagged field.)

............................................................................................................................................................................

4 Tag all the fields that you want to change.

............................................................................................................................................................................

5 Choose Change Field(s) from the Field menu. The Field Attribute screen
appears.

............................................................................................................................................................................

6 Choose the first letter of the attribute for the first field. The attribute list
appears.

............................................................................................................................................................................

7 When you finish making changes to the first field, press Tab or choose
NEXT to move to the next field, PREVIOUS to move to the previous
field, or DONE to save the changes and quit.

............................................................................................................................................................................

8 Clear all tags by pressing Ctrl+C (Clear all tags).
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Add screens to jobs

Overview You can use the same screen(s) for more than on e active job as long as
the jobs use the same calling list or calling list format. Use
screenbuilder to change which screens the agents see at their
workstations.Agents see the first screen of a job when the Avaya PDS
passes them a record. The agents use function keys to choose the next
screen. The second function key (F2) accesses the second screen, the
third function key (F3) accesses the third screen and so on.

Add screens to a job Use the following procedure to add a screen to a job.

............................................................................................................................................................................

1 Choose All Jobs from the Jobs menu.

............................................................................................................................................................................

2 Choose either Outbound or Inbound.

............................................................................................................................................................................

3 Press the down arrow to move to the job you want to change. Press Enter
and the screen list for the selected job appears.

............................................................................................................................................................................

4 Position the cursor where you want to add the screen name. If necessary,
switch to Insert mode (Ctrl+O).

............................................................................................................................................................................

5 Type a comma, then the name of the screen that you want to add. Usethe
appropriate uppercase and lowercase letters. Use a comma to separate
screen names. The order in which they appear is agent, outbound,
inbound. List the agent screen name first, then the outbound screen
name, then the inbound screen name.

............................................................................................................................................................................

6 Press Ctrl+X to switch to menu mode.

............................................................................................................................................................................

7 Choose Save Screen from the Screen menu or press F4 (Save).
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Spell-check your screen

Spell-check your screen The exact spelling and capitalization of screen names is crucial. Before
you add the new screen name, use the following steps to check the
spelling. Use the following procedure to check to spelling on your new
screens.

............................................................................................................................................................................

1 Choose Open Screen from the Screen menu. The screen list appears.

............................................................................................................................................................................

2 Use the arrow keys to move to the screen name you want to add.

............................................................................................................................................................................

3 Verify the spelling and capitalization. (job1 is not the same as Job1 or
JOB1.)

............................................................................................................................................................................

4 Use Ctrl+X to exit the selection box without opening a screen.
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Delete screens from a job

Delete screens from a job Use the following procedure to delete a screen from a job.

............................................................................................................................................................................

1 Choose All Jobs from the Jobs menu.

............................................................................................................................................................................

2 Choose either Outbound or Inbound.

............................................................................................................................................................................

3 Press the down arrow to move to the job you want to change. Press Enter
and the screen list for the selected job appears.

............................................................................................................................................................................

4 Move the cursor to the comma before the screen name you want to
delete.

............................................................................................................................................................................

5 Press Spacebar repeatedly to type over the screen name up to the next
comma or the end of the list, then press Enter. Screenbuilder cleans up
the extra spaces and commas in the list.

............................................................................................................................................................................

6 Press Ctrl+X to switch to menu mode.

............................................................................................................................................................................

7 Choose Save Screen from the Screen menu or press F4 (Save).
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Change screens and calling lists

Overview The screen’s calling list determines the screen fields. If the job’s calling
list changes, you need to update the screens. The following actions
require that you change a screen’s calling list:

• When you change a job’s calling list(s)

• When you use a copied screen in a job that has a different calling
list than the one used by the original screen

• When you change a calling list’s name

Change screen calling lists Use the following procedure to change screen calling lists.

............................................................................................................................................................................

1 Choose Open Screen from the Screen menu. The screen list appears.

............................................................................................................................................................................

2 Use the arrow keys to move to the screen name you want to open, then
press Enter.

............................................................................................................................................................................

3 Choose Change Dictionary from the Fields menu.

............................................................................................................................................................................

4 Choose either Deleting (D) or Remapping (R).

............................................................................................................................................................................

5 Choose OK to proceed or Cancel to quit.

............................................................................................................................................................................

6 Choose a new calling list.

............................................................................................................................................................................

7 If you choose Remapping, confirm the substitutions.

............................................................................................................................................................................

8 Choose Save Screen from the Screen menu or press F4 (Save).
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Field Attributes

Overview Each field in a calling list has a set of properties known as attributes.

Changing a field’s attributes changes the field’s appearance on the
screen, how the screen displays data, and what type of data the field
accepts. The changes you make do not change the calling list fields;
they change only the way the screen uses these fields.

Although the field attributes are predetermined and you do not need to
change them, changes often enhance the screen’s appearance and
usability.

How field attributes work Each field attribute affects one of four aspects of the screen:

• Appearance affects how the field appears on the screen. For
example, do the blank spaces fill with dots?

• Use order affects the sequence in which agents use the fields.

• Acceptable entries limits agents’ field entries three ways: edit
capabilities, verification format, and acceptable entries. For
example, you can require that certain fields always have an entry,
accept only dates, or restrict entries to specific responses such as
yes or no.

• Reference information contains the following information about
the field: field name, maximum number of characters, field type,
and field location on the screen.

Shortcut
letter

Attribute Value Description

N Name Field names The labels assigned
to fields.

P Position 1-23 rows

1-79 columns

Location on the
screen.

C Comment 1-256
characters

Clarifies the use of
a field. If CP are the
first two letters in a
comment, the field
is a cut-and-paste
field.
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You can change field attributes in several ways. Use the following
guidelines to choose an edit method.

F Edit format Accessible
Protected
Optional
Required

Determines if and
how agents enter
information in the
field.

V Verification
format

Time

Date

Numeric

Verifies that fields
contain valid
entries.

A Acceptable entry
list

Spaces

Dots

Displays list of
acceptable field
entries.

L Edit acceptable
entry list

Alphanumeric -
Lets you change the
acceptable entries.

D Filler characters Specifies whether
to fill field blanks
with spaces or dots.

S Sequence
number

Specifies the order
that agents use
fields.

Number of Edits Action

One attribute for one field Move the cursor to the field you want
to change. Press the shortcut letter for
the attribute you want to change.

Shortcut
letter

Attribute Value Description
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Fields can be from 1 to 78 characters long; however, a record’s data
may not fill all the spaces in a field. For example, a name field may be
30 characters, but a record with Jones in the name field uses only 5
spaces. You still need to allow for all 30 characters on the screen.

Several attributes for one
field

Move your cursor to the field you
want to change. Press E (Edit). Press
the shortcut letter for the attribute you
want to change. Use Tab to move
between buttons or type the requested
information. Press Enter. Press
Shift+F2 (Save current screen).

Several attributes for
several fields

Move your cursor to each field you
want to change. Press T (Tag). After
you tag all fields, press E (Edit). Press
the shortcut letter for the attribute that
you want to change. When you finish
making the changes for the first field,
choose either NEXT or PREV to edit
more fields. Move your cursor to the
DONE button. Press Shift+F2 (Save
current screen).

Number of Edits Action
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Change field appearance

Change field appearance The dot or space-filled attribute determines what goes into the empty
spaces in a field. You can have any combination of field fills on a
screen. During cut, copy, clear, and paste operations, Screenbuilder
fills spaces with vertical lines or dots. If an agent updates a dot-filled
field, the Avaya PDS replaces the dots with blank spaces.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Press D, the shortcut key for fill characters. The fill attributes list
appears.

............................................................................................................................................................................

4 Use Tab to switch between Spaces and Dots. Press Enter when the
cursor is on the attribute you want to use.

............................................................................................................................................................................

5 Repeat steps 2 through 4 for each change.

............................................................................................................................................................................

6 Switch to menu mode (Ctrl+X).
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Set field edit capabilities

Set field edit capabilities Field edit capabilities specify fields in which agents can or must enter
data. The following table lists edit capabilities.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Press F, the shortcut key for edit format. The Edit Format list appears.

............................................................................................................................................................................

4 Select Accessible, Protected, Optional, or Required. Press Enter when
the cursor is on the format you want to use.

............................................................................................................................................................................

5 Repeat steps 2 through 4 for each change.

............................................................................................................................................................................

6 Choose Save Screen from the Screen menu.

Capability Description

Accessible The cursor does not automatically go to
accessible fields. Agents can move the
cursor to these fields but can’t change the
data.

Optional Agents can choose whether to enter data.
Comment fields are usually optional entry
fields.

Protected Agents cannot change protected fields.

Required Agents must enter information into required
entry fields before they can release a record.
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Hint

You can improve data quality using three options to limit the
information the agents put in a field

• field editing capabilities

• field verification formats

• acceptable field entries
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Change field sequence order

Overview Field sequence is the order in which an agent’s cursor moves. It does
not have to move in the same order as the fields appear on a screen.

Screenbuilder has two field sequencing modes: auto-sequencing and
manual-sequencing. You can turn auto-sequencing on or off by
changing the default settings in the Command menu. When auto
sequencing is on, the Avaya PDS displays fields from left-to-right, top-
to-bottom. When it is off, the system determines the field order by the
order in which you added the fields to the screen.

Each field has a sequence number. You can see the current field’s
sequence number in the status bar. It is the value that follows S-. When
you rearrange fields on a screen with auto-sequencing turned on,
Screenbuilder changes the field sequence to left-to-right, top-to-
bottom. When you manually sequence fields, you determine the order
in which you want agents to use the fields.

Change field sequence
order

Use the following procedure to change the field sequence order.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Press S, the shortcut key for Sequencing. The sequencing attribute list
appears.

............................................................................................................................................................................

4 Type the new sequence number.

............................................................................................................................................................................

5 Repeat steps 2 through 4 for each change.

............................................................................................................................................................................

6 Choose Save screen from the Screen menu.
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Field verification formats

Overview Verification format determines the format of the information that
agents enter into a field.

Verification formats are valid for only three types of fields

• time

• date

• numeric

The Avaya PDS validates both the format elements and delimiters. For
example, if you specify a time format of HH.MM, the agent must
include the period between the hour and minute values for the system
to successfully validate the information.

The acceptable entry list limits agents’ entries to specific choices. For
example, limit a field to a Yes or No response.

Format name Format elements Sample formats

time HH hours

MM minutes

SS seconds

HH.MM.SS

HH.MM

date CCYY year

MM month

DD day

CCYY/MM/DD

MM/DD/CCYY

DD/MM/CCYY

numeric Numbers only #######
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Set field verification formats

Set field verification
formats

Use the following procedure to set field verification formats using
Screenbuilder.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Press V, the shortcut key for Verification Edit. The Verification Edit list
appears.

............................................................................................................................................................................

4 Type the appropriate format structure.

............................................................................................................................................................................

5 Repeat steps 2 through 4 for each change.

............................................................................................................................................................................

6 Choose Save Screen from the Screen menu.
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Validate delimiters

Validate delimiters The Avaya PDS validates both the format elements and delimiters. For
example, if you specify a time format of HH.MM, the agent must
include the period between the hour and minute values for the system
to successfully validate the information.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Press V, the shortcut key for Verification Edit. The Verification Edit list
appears.

............................................................................................................................................................................

4 Type the appropriate format structure.

............................................................................................................................................................................

5 Repeat steps 2 through 4 for each change.

............................................................................................................................................................................

6 Choose Save Screen from the Screen menu.
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Acceptable field entries

Overview The acceptable entry list limits agents’ entries to specific choices. For
example, limit a field to a Yes or No response.

You control which entries are acceptable in a field by creating a list of
acceptable entries and assigning it to the field. The Avaya PDS assigns
a number to each list. Multiple jobs can use the same list and you can
edit the list as long as it is not being used by a current job.
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Set acceptable field entries

Set acceptable field entries Use the following procedure to set acceptable field entries.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Press A, the shortcut key for Acceptable entry list. The Acceptable entry
list appears.

............................................................................................................................................................................

4 Choose the acceptable entry list number.

............................................................................................................................................................................

5 Repeat steps 2 through 4 for each change.

............................................................................................................................................................................

6 Choose Save screen from the Screen menu.
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Field reference information

Overview The field attributes screen includes five types of information
(attributes) for each field

• name position, and comments

• width

• type

• position

• comments

However, you cannot change the name, width, or type of field. You
can, however, change the position on the screen and edit the comments
attribute.

When you change the comment for a screen field, your change does not
affect the comment in the calling list. This is helpful when you use a
field for different purposes on different screens.

The other use of the comment field is to designate a field as a cut-and-
paste field. The Avaya PDS uses cut-and-paste fields to transfer
information to the host computer. The system designates cut-and-paste
fields with CP in the first two spaces of the comment field.

Note

Do not move these fields to different locations. This will disable the
cut-and-paste function.
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Set field reference information

Set field reference
information

Use the following procedure to set field reference information.

............................................................................................................................................................................

1 Open the screen.

............................................................................................................................................................................

2 Use the arrow keys to move to the field you want to change.

............................................................................................................................................................................

3 Press C, the shortcut key for Comment. The comment box appears.

............................................................................................................................................................................

4 Type the new comment. If the field is a CP field, add the comment after
the CP. You cannot have more than 256 characters in a comment.

............................................................................................................................................................................

5 Repeat steps 2 through 4 for each change.

............................................................................................................................................................................

6 Choose Save screen from the Screen menu.
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Build helpful screens

Tips and hints A well-designed screen is effective and easy to use. The easier a screen
is to use, the better your agents can communicate with your customers.
A well-designed screen provides agents with the information they need
about an account, product, or job.

Thoughtful questions Ask yourself the following questions when designing screens:

• What should these screens accomplish?

• Is this information useful to your agents’ success?

• Can agents find the information that they need quickly?

• Are the screens consistent?

Layout tips Use the following tips when designing the layout for your new screen.

• Present information in the order that the agents use it.

• Group related pieces of information.

• Leave blank rows between groups of data.

• Maintain consistent left and right margins.

• Arrange field labels and fields so that they visually go together.

Reference
Information

Description Change?
Yes or No

Name Calling list field name No

Width Maximum number of characters in
the field

No

Type N - number, C - alphanumeric
characters, D - date, $- monetary
value, or T - time.

No

Position Location on screen. Row and
column of the first field character

Move
only

Comments Field information. If “CP” appears
if the field, it is a cut-and-paste
field. Do not change field locations
for cut-and-paste fields.

Yes
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• Align field labels and the starting point of data fields.

Tips for fields Think of the following items when naming fields.

• Carefully named field labels save time and prevent confusion.

• Keep field labels less than 16 characters or not longer than four
words.

• Start field labels with an uppercase letter, followed by lowercase
letters.

Example: Label a field Name instead of NAME. This helps to
distinguish labels from data, which are always uppercase letters.

• Use consistent wording, abbreviations, and labels.

Miscellaneous Finally, a couple of tips that will help agents use the screens designed
for them.

• Include a list of the function keys on the screen that display the
next screen and release the record.

• Take extra care to associate an inbound calling list with inbound
screens and inbound jobs, and an outbound calling list with
outbound screens and outbound jobs.
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Screenbuilder reports

Overview Screenbuilder reports include field attribute labels and field content
descriptions. Empty comment fields do not appear on the reports. Use
Screenbuilder reports to compare two screens or to train agents on a
new screen.
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Create and view reports

Create and view a report Use the following procedure to create and view Screenbuilder reports.

............................................................................................................................................................................

1 Press Shift+F2 (Open).

............................................................................................................................................................................

2 Press Ctrl+X to switch to menu mode.

............................................................................................................................................................................

3 Choose Report from the Screen menu.

............................................................................................................................................................................

4 Press Ctrl+X to switch to edit mode. Choose Y to create the report.

............................................................................................................................................................................

5 Press F10 (Quit). Choose Reports from the Supervisor Main Menu to
print the report.
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Print a report

Print a report Use the following procedure to print Screenbuilder reports.

............................................................................................................................................................................

1 Choose Reports from the Supervisor Main Menu.

............................................................................................................................................................................

2 Choose View or print reports from the Reports menu.

............................................................................................................................................................................

3 To view a report, press F4 or Ctrl+V (View). Type the number that
corresponds to the report you want to view and press Enter.

............................................................................................................................................................................

4 The report appears on the screen. Press Ctrl+N (Next) or Ctrl+P
(Previous) to see the entire report.

............................................................................................................................................................................

5 To print the report, press F2 or Ctrl+O (Print).

............................................................................................................................................................................

6 Press Ctrl+X (Exit) to return to the Report Files Status screen.
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.............................................................................................................................................................................................................................................................
Overview

Purpose The purpose of this section is to explain AvayaTM Predictive Dialing
System (PDS) reports.

Contents This section contains the following topics:

• Avaya PDS reports overview

• Agent history report fields

• Generate agent history reports

• View or print an agent history report

• Job history report fields

• Generate job history reports

• Generate a previously run job history report

• List distribution

• Calling list data

• List distribution report design

• Generate list distribution reports

• Select list distribution fields

• Select list distribution field values

• Select range in list distribution

• Set list distribution filters
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• Change list distribution report titles

• Move fields and values

• Clear fields and values

• Delete fields

• Change or delete a value

• Edit filters

• Copy a list distribution report

• Delete a list distribution report file

• Execute and print list distribution reports

• List distribution report analysis

• Calling list reports

• Generate calling list reports

• System reports

• Generate system reports
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Avaya PDS reports overview

Overview Use the Reports commands to analyze and track the progress of your
daily call activities. Throughout the day, the Avaya PDS collects data
about your calling lists, jobs, and agents. The system uses this data to
generate various reports. You can also use PC Analysis to create
reports. See the next section for details about PC Analysis.

Choose Reports from the Supervisor Main Menu.
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Agent history report fields

Overview The following list describes agent history report fields.

Name Description

For the period... Specifies the date or period when
the system captured the report
information.

Report date Displays the date that the Avaya
PDS created the report.

Time Displays the time that the Avaya
PDS created the report.

Agent name Displays the agent’s logon ID.

Job information Describes the job. The
information includes job name,
system identification number,
job type, and the record selection
file name. It displays the day and
time the job started and finished.

Total Activity time on job
(hh:mm)

Displays the total time the agent
spent on each job. Active time is
the time the agent worked with
the customer record, was on the
phone, or waited between calls.

Total inbound connects Displays the total inbound calls
passed to the agent.

Total outbound connects Displays the total dialing
attempts passed to the agent.

Total connects per active hour Displays the average call
connects made each hour. The
system calculates the total call
connects and divides by the

total active time on the job. The
Avaya PDS calculates the

average hours to one decimal
place.
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Avg. Agent Related Time
Intervals

Provides a heading for the report
field that shows the average time
the agent performed specific
tasks on each job.

Time Agent Working with
Record

Calculates the average work time
the agent talked with a customer
and worked on customer records.
Time begins with the call
connection and ends with record
release. This is the total of Time
Agent on Phone and Time Agent
on Record After Call.

Time Agent on Phone Calculates the average talk time
the agent was on the phone with
each job. Time begins with the
call connection and ends with the
phone line release.

Time Agent on Record After
Call

Calculates the average time to
update records. Time begins
with the phone line release and
ends when the record release

Time Waiting Between Calls Calculates the average time the
agent waited between calls. If
this time is too long, you may
want to change the Expert
Dialing setting.

Name Description
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Generate agent history reports

Overview Agent history reports provide data on agent performance. The menu
offers two types of reports: Agent History Reports (based on job type)
and the Agent Activity Report. The following illustration shows the
items on the Agent History Reports menu.

You have a choice of outbound, inbound, or blend reports. Each report
shows data on all the jobs worked by the agent for a specified period.
Information includes the total time an agent was on a job and how the
agent spent the time.

Generate agent history
reports

Use the following procedure to generate agent history reports.

............................................................................................................................................................................

1 Choose Agent history reports from the Reports menu.

............................................................................................................................................................................

2 Choose Outbound, Inbound, or Blend Agent History Report from
the Agent History Reports menu.

............................................................................................................................................................................

3 Type a Sort Field name. The sort name labels the columns in your report
and organizes the information in alphanumeric order. To generate an
agent history report, enter one or more of the following selection
criteria:

Job Name(s) Specify one job or a range of jobs.

Job Description Label not more than 30 characters

Record Selection file
name(s)

Separate multiple files with a comma.

Phone Strategy file
name(s).

Separate multiple files with a comma
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4 Type the number of the Totalling Strategy. Here are what the numbers
mean:

............................................................................................................................................................................

5 Type Y at the prompt if the entries are correct or type N to edit your
selections. The cursor returns to the first field. Press Enter to move to the
field you want to correct. When all the fields are correct, type Y and the
Agent History Reports menu appears.

Job Start Date The system retrieves job information
based on this date. The start date can be
one day or a range of days. Type dates
in the CCYY/MM/DD format. Separate
a range with a comma or a hyphen. For
example, to include jobs that started on
June 14 and 15, 1999 type 1999/06/14-
1999/06/15 or 1999/06/14, 1999/06/15.
To limit the report summary to one day,
enter the date as a range. For example,
to enter June 14, 1999, type 1999/06/
14-1999/06/14.

Job Number(s) Separate a range with a dash and
multiple job numbers with a comma.
For example, type 1-3 or 1,2,3.

Agent Name Include only one agent

Report Description not more than 30 characters

0 Details by job

1 Details by job and totals for a
selected period

2 Totals for a selected period

3 Totals for a selected period

4 Subtotals for each job type and totals
for a selected period

5 Details by job, subtotals by job type,
and totals for a selected period
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6 Choose View or print reports from the Agent History Reports menu.
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View or print an agent history report

View or print an agent
history report

Use the following procedure to generate an agent history report.

............................................................................................................................................................................

1 Choose Agent Activity Report from the Agent History Reports menu.
The Avaya PDS displays a prompt to tell you it’s generating the report.
The Agent History Reports menu appears when the system completes
the report.

............................................................................................................................................................................

2 Choose View or print reports from the Agent History Reports menu.
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Job history report fields

Overview The job history reports provide data on job performance. The menu
offers two types of reports: Job History Reports (based on job type) and
the Previously Run Jobs Report. The following illustration shows the
items on the Job History Reports menu.

Name Description

For the period … Specifies the date or period when
the system captured the report
information.

Report Date Displays the date that the Avaya
PDS created the report.

Time Displays the time that the Avaya
PDS created the report.

Job Information Describes the job. The
information includes job name,
system identification number,
job type, and the record selection
file name. It displays the day and
time the job started and finished.

Time System on Line (hh:mm) Displays the active time for an
outbound job. It does not include
start up time and job suspension

time.

Total Agent Hrs on Line Displays the time agents were on
the job.

Average Agents On line Records the average number of
agents logged

into each job.

Total Number of Inbound Calls Displays the total inbound calls
received by the

system.
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Inbound Calls per System Hour Displays the average number of
inbound calls

received per system hour.

Inbound Calls per Agent Hour Displays the average number of
inbound calls received per agent
hour. (Total calls divided by
total agent hours logged to the
job)

Total Connects Displays the total inbound calls
passed to agents.

Total Number of Outbound Calls Displays the total dialing
attempts made by the Avaya
PDS. It includes all attempts,
including those not passed to
agents.

Dials per System Hour Displays the average call
connects made each hour. The
Avaya PDS calculates the total
call connects and divides by the
total active time on the job. The
system calculates the average
hours to one decimal place.

Dials per Agent Hour Displays the average number of
dial attempts per

agent hour.

Total Connects Displays the total outbound calls
passed to agents.

Connects per System Hour Displays the average number of
connects for the

time the job was active.

Connects per Agent Hour Displays the average number of
inbound calls

received per agent hour.

Name Description
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Rate of Connects to Calls
(inbound)

Displays a decimal amount
based on the number of inbound
calls passed to agents divided by
the number of inbound calls
received by the system.

Rate of Connects to Calls
(outbound)

Displays a decimal amount
based on the total number of
connects divided by the total
number of dial attempts received
by the system.

Average Agent Related Intervals Provides a heading for the report
fields that classify the average
time agents spent performing
specific tasks on each job.

Time Agent on Record After
Call

Calculates the average time to
update records. Time begins
with the line release and ends
with the record release.

Time Agent Working with
Record

Calculates the average time
agents spent talking

with a customer and working on
the records. Time begins with
the call connection and ends
when the agent releases the
record. This is the total Time
Agent on Record After Call and
Time

Agent on Call.

Time Agent on Call Calculates the average time
agents spent on the

phone for each job.

Time Waiting Between Calls Calculates the average time
agents waited between calls.

Queue Statistics Displays the number of
outbound and inbound calls that
were placed in wait queue.

Name Description
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Connect Release Classification
(Agent)

Displays the different call
completion codes and the
corresponding number of calls
released.

System Release Classification Displays the number of calls
released by the system according
to standard release
classifications or call completion
codes such as NOANSWER and
BUSY.

Name Description
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Generate job history reports

Overview The Job History Reports menu allows you to generate reports for
outbound jobs, inbound jobs, blend jobs, or combination reports. The
reports provide information on the selected job for a specific period. It
includes the number of dials and connects, call completion codes, agent
work time, agent update time, and agent wait time between calls.

Generate job history
reports

Use the following procedure to generate job history reports.

............................................................................................................................................................................

1 Choose Job history reports from the Reports menu.

............................................................................................................................................................................

2 Choose Outbound, Inbound, or Blend Job Report from the Job
History Reports menu.

............................................................................................................................................................................

3 Type the name of the sort field.

............................................................................................................................................................................

4 To generate the report, type one or more of the following report
selection criteria:

Job Name(s) Specify one job or a range of jobs.

Job Description Label not more than 30 characters

Record Selection file
name(s)

Separate multiple files with a comma.

Phone Strategy file
name(s).

Separate multiple files with a comma
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............................................................................................................................................................................

5 Type the number of the Totalling Strategy.

............................................................................................................................................................................

6 Type Y at the prompt if the entries are correct or type N to edit your
selections. The cursor returns to the first field. Press Enter to move to the
field you want to correct. When the entries are correct, type Y and the
Job History Reports menu appears.

............................................................................................................................................................................

7 Choose View or print reports from the Job History Reports menu.

Job Start Date The system retrieves job information
based on this date. The start date can be
one day or a range of days. Type dates
in the CCYY/MM/DD format. Separate
a range with a comma or a hyphen. For
example, to include jobs that started on
June 14 and 15, 1999 type 1999/06/14-
1999/06/15 or 1999/06/14, 1999/06/15.
To limit the report summary to one day,
enter the date as a range. For example,
to enter June 14, 1999, type 1999/06/
14-1999/06/14.

Job Number(s) Separate a range with a dash and
multiple job numbers with a comma.
For example, type 1-3 or 1,2,3.

Agent Name Include only one agent

Report Description not more than 30 characters
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Generate a previously run job history report

Overview This report provides a list of the last 200 to 500 jobs run by the Avaya
PDS. (The actual number of jobs depends on how your system was set
up.) It includes the name, number, unit work list, job date, job start
time, job stop time, and the number of calls the system placed. You can
use it as a reference to help you to select appropriate categories for job
or agent history reports.

Generate a previously run
job history report

Use the following procedure to generate a previously run job history
report.

............................................................................................................................................................................

1 Choose Job History Reports from the Reports menu.

............................................................................................................................................................................

2 Choose Previously Run Jobs Report from the Job History Reports
menu. The system displays a confirmation prompt.

............................................................................................................................................................................

3 Type Y to generate the report or N to quit without generating a report.
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List distribution

Overview Although List Distribution is easy to use, it involves several words and
ideas that may be new to you.

List Distribution is a reporting tool that helps you analyze the records
in your outbound calling list. Analyze records before you run an
outbound job. It creates reports that count the records in the categories
(or distributions) you set. Using List Distribution allows you to focus
on your campaign objective by assisting with the following topics:

• Job planning

By understanding how many accounts are in different categories,
you can estimate the size of the record selection. If the selection is
too large, you can change the record selection criteria to select
fewer records. The information helps you design effective record
selections.

• Job analysis

By viewing the results of call activity during a job, you can adjust
your calling operations to get the best results.

The criteria you set for List Distribution reports do not affect the
calling list. The settings only determine how the Avaya PDS displays
the data in the reports.

Use the following shortcut keys when working with List Distribution.

Actions Keys

Done F1

Insert field F2

Delete field F3

View calling list F4

Next page F5

Previous page F6

Change F7

Filter F8

Move F9

Clear F11
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Calling list data

Overview Each calling list record consists of fields containing data for each
record. You can sort the calling list data by any field; then tell the
Avaya PDS to give you totals for the records in ranges for each field.
For example, you can ask for a count of records by balances in $1,000
increments. The system displays numbers of records in each
incremental group in a row format.

You can further sort the information in the report by adding other
criteria. For example, you can sort the records in each $1,000 group
into subgroups by credit rating. The Avaya PDS displays the numbers
of records that fall into each subgroup in a row and column format.

You can add other criteria sorting the numbers in the report by another
calling list field. For example, you could add the type of account,
personal or business to the previous example. The new report separates
the totals into groups called tables.

Filter data The Avaya PDS gives you the ability to further refine your selection by
using filters. The use of filters is always optional. A filter is a set of
requirements that eliminate records that don’t match the settings. Use
filters to narrow your selection of records to specific values. You can
also use a call completion code filter to count the records based on call
completion codes. If you set filters, they apply to all the reports you
generate from that List Distribution file.

For example, you can use filters to limit the report to customers in
Colorado or Washington, and you can add a call completion code filter
that eliminates all records except those marked NOTCALLED.
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List distribution report design

Overview Now that you are familiar with the types of reports, let’s take a look at
how you design them. Your first decision is the type of report: row, row
and column, or table.

• Design a row report if you want information from only one field.

• Design a row and column report if you want information from two
fields.

• Design a table report if you want information from three fields.

When trying to decide which fields to use for the row, column, or table
headings, use the following guidelines:

• When deciding between columns and rows, use the field name that
has the largest number of categories for the row label. For
example, you want to sort by AREA_CODE and the amount in the
LAST_ORDER field. You have divided LAST_ORDER into four
separate ranges, and the calling list has 50 area codes. Make
AREA_CODE the row label because it has the largest number
(50) of categories. Make LAST_ORDER the column label
because it has the fewest number (4) of categories. You can add
column criteria at the same time you are entering row criteria.

• When deciding between row, column, and table groups, use the
field name with the fewest categories for the table groups.

• The Avaya PDS assumes a 0 (zero) for the first increment in a
range of values. You do not have to enter 0.

There are spaces on the List Distribution Field Selection screen for
entering many row and column criteria. We recommend keeping the
list distributions simple and creating as many as you need to keep the
reports simpler to read.
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Generate list distribution reports

Generate list distribution
reports

Use the following procedure to generate list distribution reports.

............................................................................................................................................................................

1 Choose List Distribution from the Reports menu.

............................................................................................................................................................................

2 Choose Create a list distribution from the List Distribution menu.

............................................................................................................................................................................

3 Type the item number of the calling list.

............................................................................................................................................................................

4 Type a List Distribution file name (not more than 10 characters). It is
helpful to give the file the same name as the record selection you create
with the information.

............................................................................................................................................................................

5 Type an optional report title (not more than 30 characters). If you do not
name it, the Avaya PDS names the report “List Distribution Report.”

............................................................................................................................................................................

6 Type Y at the prompt to continue or N to cancel. The List Distribution
Field Selection screen appears.
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Select list distribution fields

Overview You can choose fields by typing the field name or by choosing them
from the calling list. Because you need to type the name exactly as it
appears in the calling list, it is often easier and faster to choose from the
list.

Select list distribution
fields

Use the following procedure to select list distribution fields

............................................................................................................................................................................

1 To select a row label, press F4 to see the list of fields. Type the number
associated with the field. If you are sorting by only one field, see “To
select List Distribution field values”; otherwise, go to the next step.

............................................................................................................................................................................

2 To select the column label, press Enter to move the cursor to the blank
cell under the Column heading.

............................................................................................................................................................................

3 To select a column label, press F4 to see the list of fields. Type the
number associated with the field. If you are sorting by only two fields,
see “To select List Distribution field values”; otherwise, go to the next
step.

............................................................................................................................................................................

4 To select the table label, press Enter to move the cursor to the blank cell
under the Table heading.

............................................................................................................................................................................

5 To select a table label, press F4 to see the list of fields. Type the number
associated with the field.

............................................................................................................................................................................

6 When you complete your selection(s), move the cursor to the first field.

............................................................................................................................................................................

7 If you want to choose values for additional reports, complete the next
line by following steps 1 through 6. You can design 15 reports for each
List Distribution.
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8 When you finish selecting fields, press F7 (Change). The List
Distribution Field Value Selection screen appears.
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Select list distribution field values

Overview The following guidelines must be followed:

• Range sorts records into sets based on ranges. Use the following
guidelines when using ranges to sort report data:

• Ranges must be numbers.

• Ranges cannot contain commas or decimals.

• Ranges must be in ascending order (low to high).

• Item selects records to match a value. For example, you can search
for area codes in the 206 region. Use the following guidelines
when using Item to sort report data:

– Items can be in ascending or descending order.

– Items can be letters, numbers, or symbols.

Select list distribution field
values

Use the following procedure to select list distribution field values.

...........................................................................................................................................................................

1 Type R for Range or I for Item (uppercase or lowercase) and press
Enter. The cursor moves to the first blank line in the left column.

............................................................................................................................................................................

2 If you choose Range, complete the steps on the following page:

............................................................................................................................................................................

3 When you have entered all the values for the first field, press Done. The
List Distribution Field Selection screen reappears.

............................................................................................................................................................................

4 Move to the next field and repeat steps 1 and 2.

............................................................................................................................................................................

5 Press Done when you have entered all the values or press F8 (Filters) to
enter filters.
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Select range in list distribution

Select range in list
distribution

Use the following procedure to select range in a list distribution report.

............................................................................................................................................................................

1 Type the first value in the range. The cursor moves down to the next line.
The number represents the upper limit of the first range. For example, to
include all records from 0-500, type 500.

............................................................................................................................................................................

2 Type the next value.

............................................................................................................................................................................

3 Repeat until you have set all the values. If you want an unlimited upper
value, type 9999999999 (ten nines).

............................................................................................................................................................................

4 If you choose Item, complete the following steps:

............................................................................................................................................................................

5 Type the value for the item(s) you want to include in the list. The cursor
moves down to the next line.

............................................................................................................................................................................

6 Type the value for the next item.
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Set list distribution filters

Overview Use the List Distribution Filter Criteria screen to set List Distribution
filters. Press F8 (Filter) with the cursor on any line in the List
Distribution Field Selection screen to display the following screen.

When you specify criteria for a field in a filter, you use an expression.
An expression is a combination of comparison operators (such as < or
>) and values (letters or numbers).

With List Distribution, use the following comparison operators.

Set list distribution filters Use the following procedure to set list distribution filters.

............................................................................................................................................................................

1 In the filter screen, press F4 (View) to view the calling list fields. Then
type a field number and press Enter.

............................................................................................................................................................................

2 Type a value for the field in the Value column.

............................................................................................................................................................................

3 To use call completion codes as filters, position the cursor on the blank
line beneath Call Completion Code Selections. Press F4 (View) to view
the list of available codes. Then type a code number. To continue adding

Operator Description

> greater than

< less than

>= greater than or equal to

<= less than or equal to

= equal to

~ not equal to

* wild card character

- range

, or

! list wild card
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call completion codes, press Enter to move to the next line and repeat
steps 1 and 2.

............................................................................................................................................................................

4 Press F1 (Done) to return to the List Distribution Field Selection screen.

............................................................................................................................................................................

5 Press F1 (Done) again. The List Distribution Report Generation screen
appears.

............................................................................................................................................................................

6 Type C and press Enter to generate the report, or press Ctrl+X to save
the file and return to the List Distribution menu.
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Change list distribution report titles

Overview Once you create a List Distribution file, you can change it to adjust the
report results. You can edit a report file to change and delete sort fields,
values, and filters, or rename the report.

For example, if the results show many customers with balances
between $100 and $500, you may want to refine the BALANCE value
criteria. You can redefine the range to 100, 200, 300, 400, and 500 to
show the distribution of customers for smaller ranges.

Change list distribution
report titles

Use the following procedure to change a list distribution report title.

............................................................................................................................................................................

1 Choose List Distribution from the Reports menu.

............................................................................................................................................................................

2 Choose Edit list distribution from the List Distribution menu.

............................................................................................................................................................................

3 Type the item number of the List Distribution file.

............................................................................................................................................................................

4 Type the calling list name.

............................................................................................................................................................................

5 Type a new List Distribution report title (not more than 30 characters).
The Avaya PDS names the report “List Distribution Report” if you do
not name the report.

............................................................................................................................................................................

6 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

7 Press F1.

............................................................................................................................................................................

8 If you want to generate the report now, press C and press Enter;
otherwise, press Ctrl+X to save the file and return to the List
Distribution menu.
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Move fields and values

Move fields and values Use the following procedure to move fields and values.

............................................................................................................................................................................

1 On the List Distribution Field Selection screen, position the cursor on
the field you want to move and press F9 (Move).

............................................................................................................................................................................

2 Type R to move the field to a row, C to a column, or T to a table; then
press Enter.

............................................................................................................................................................................

3 Type the line number to which you want to move the field.

............................................................................................................................................................................

4 When you finish moving fields, press F1 (Done).

............................................................................................................................................................................

5 If you want to generate the report now, type C and press Enter;
otherwise, press Ctrl+X to save the file and return to the List
Distribution menu.
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Clear fields and values

Clear fields and values Use the following procedure to clear fields and values.

............................................................................................................................................................................

1 Open the List Distribution Field Selection screen.

............................................................................................................................................................................

2 Position the cursor on the field that you want to clear and press F11
(Clear).

............................................................................................................................................................................

3 Type Y at the prompt to remove the field and its value or N to cancel.

............................................................................................................................................................................

4 When you finish clearing fields, press F1 (Done).

............................................................................................................................................................................

5 Type C and press Enter to generate the report, or press Ctrl+X to save
the file and return to the List Distribution menu.
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Delete fields

Delete fields Use the following procedure to delete fields.

............................................................................................................................................................................

1 Open the List Distribution file you want to edit.

............................................................................................................................................................................

2 Position the cursor on the field you want to delete. Press F3 (Delete).

............................................................................................................................................................................

3 Press Y at the prompt to delete the field or N to cancel.

............................................................................................................................................................................

4 When you finish deleting fields, press F1 (Done).
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Change or delete a value

Change or delete a value Use the following procedure to change or delete a value.

...........................................................................................................................................................................

1 Open the List Distribution file you want to change.

............................................................................................................................................................................

2 Move to the field whose value you want to change.

............................................................................................................................................................................

3 Press F7 (Change).

............................................................................................................................................................................

4 Position the cursor on the value. Press F3 (Delete).

............................................................................................................................................................................

5 Type a new value or go to step 6.

............................................................................................................................................................................

6 Press F1 (Done).
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Edit filters

Edit filters Use the following procedure to edit filters.

............................................................................................................................................................................

1 Open the List Distribution file you want to edit.

............................................................................................................................................................................

2 On the List Distribution Field Selection screen, press F8 (Filter). The
Distribution Filter Criteria screen appears.

............................................................................................................................................................................

3 Position the cursor on the line you want to edit, and press F3 (Delete) or
F11 (Clear).

............................................................................................................................................................................

4 To add a filter, press F4 (View) to select a field from the list. Type the
field number. Type a field value, if necessary.

............................................................................................................................................................................

5 Press F1 (Done) to return to the List Distribution Field Selection screen.

............................................................................................................................................................................

6 If you want to generate the report now, type C and press Enter;
otherwise, press Ctrl+X to save the file and return to the List
Distribution menu.
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Copy a list distribution report

Copy a list distribution
report

Use the following procedure to copy a list distribution report.

............................................................................................................................................................................

1 Choose List Distribution from the Reports menu.

............................................................................................................................................................................

2 Choose Copy a list distribution from the List Distribution menu.

............................................................................................................................................................................

3 Type the item number of a List Distribution file.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel. The List Distribution
Report Generation screen appears.

............................................................................................................................................................................

5 Type a new file name for the copy.

............................................................................................................................................................................

6 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

7 Press any key to return to the List Distribution menu.
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Delete a list distribution report file

Delete a list distribution
report file

Use the following procedure to delete a list distribution report file.
After you delete a list distribution file, any report files generated from
the file remain on the Avaya PDS until the end of the following day.

............................................................................................................................................................................

1 Choose List Distribution from the Reports menu.

............................................................................................................................................................................

2 Choose Delete a list distribution from the List Distribution menu.

............................................................................................................................................................................

3 Type the item number of the List Distribution file you want to delete.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

5 Press any key to return to the List Distribution menu.
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Execute and print list distribution reports

Overview When you execute a List Distribution file, the Avaya PDS creates a
report with the records organized according to the criteria you set in the
List Distribution file. You can view and print the report or save the
results for later use.

You can execute a List Distribution file two ways:

• Press Ctrl+C after completing the steps for creating or editing a
file.

• Use the Execute a list distribution file command.

Execute and print list
distribution reports

Use the following procedure to execute and print list distribution
reports.

............................................................................................................................................................................

1 Choose List Distribution from the Reports menu.

............................................................................................................................................................................

2 Choose Execute a list distribution from the List Distribution menu.

............................................................................................................................................................................

3 Type the item number for the file.

............................................................................................................................................................................

4 Type an optional report title (not more than 30 characters). The Avaya
PDS names the report “List Distribution Report” if you don’t name the
report.

............................................................................................................................................................................

5 Type Y at the prompt to continue or N to cancel. The List Distribution
Report Generation screen appears.

............................................................................................................................................................................

6 If you want to generate the report now, press C and press Enter;
otherwise, press Ctrl+X to store the List Distribution results and
generate the report later.

............................................................................................................................................................................

7 Press any key to return to the List Distribution menu.
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List distribution report analysis

Overview The top portion of each report lists the Avaya PDS call completion
codes. It helps determine how many records you have left to call based
on the last recorded calling result. These totals are independent of the
list distribution criteria you enter. The totals may change if you have
jobs running.

The bottom portion of each report displays how many records match
the criteria you set when you defined your list distribution. The
information will help you design your record selections. Once you’ve
looked at the results, you may want to go back and change the criteria
fields values you chose. For example, if you have a large number that
appears between the balance ranges of $1000 and $5000, you can edit
the criteria to add a $2500 range.
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Calling list reports

Overview During the download process, the Avaya PDS extracts the data for
three calling list reports:

• Days on PDS Report shows the nonproductive contact records.
Nonproductive contact records are records for which no customer
contact has occurred within a certain time. The time is determined
during the Avaya PDS configuration. The system marks these
records and includes them on a report after the specified number
of days. Depending on your system configuration, the system will
either continue to call the records or not call those records again.

• Reject Report shows the records the Avaya PDS rejected due to
duplicate account numbers, invalid telephone numbers, or time
zone sorting failures.

• Release Code Report (call completion codes) shows all records
with a specific call completion code. For example, you can request
a report of all calls that resulted in a customer who has promised
to make a payment.
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Generate calling list reports

Overview During the Avaya PDS configuration, the intervals at which the system
generates reports and the call completion codes for the reports were set.
The system generates calling list reports during the daily download
process.

Generate calling list
reports

Use the following procedure to generate a calling list report.

............................................................................................................................................................................

1 Choose Calling list reports from the Reports menu.

............................................................................................................................................................................

2 Choose Days on PDS Report, Reject Report, or Release Code Report
(Call Completion Code Report) from the Calling List Reports menu.

............................................................................................................................................................................

3 Type a report description (not more than 30 characters).

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel. The Avaya PDS
generates the report.

............................................................................................................................................................................

5 Choose View or print reports.
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System reports

Overview The Avaya PDS generates four system reports:

• Agent Login Report shows the agent number, the login menu, and
the agent ID.

• Multiple Call Report sorts records by phone numbers. It lists the
number of times the Avaya PDS called the record, the date, the
account number(s), call completion code, agent, and calling list
record number.

• Program Information File (PIF) Report shows a list of the
previous data processing programs run on the Avaya PDS. Use
this report to help troubleshoot system problems.

• Hourly Inbound Activity Report shows the number of inbound
calls received as well as the number of inbound calls placed on
hold or abandoned.
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Generate system reports

Generate system reports Use the following procedure to generate a system report.

...........................................................................................................................................................................

1 Choose System reports from the Reports menu.

............................................................................................................................................................................

2 Choose Agent Login Report, Multiple Call Report, Program
Information File Report, or Hourly Inbound Activity Report from
the System Reports menu.

............................................................................................................................................................................

3 If you chose Multiple Call Report, type a phone number in the format
NNN-NNN-NNNN.

............................................................................................................................................................................

4 Type a report description (not more than 30 characters).

............................................................................................................................................................................

5 Type Y at the prompt. The Avaya PDS generates the report.

............................................................................................................................................................................

6 Choose View or print reports.
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.............................................................................................................................................................................................................................................................
Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses PC Analysis for
reporting and troubleshooting.

Contents This section contains the following topics:

• PC Analysis

• Data sources

• Job history

• Agent history

• Calling statistics

• Calling list

• Downloading an extract file

• PC Analysis extract

• Log in to PC Analysis using cdwanal password

• Log in to PC Analysis using supervisor password

• Create an extract file

• Extract selection information

• Set up the extract file

• Edit an extract file

•  Copy an extract file
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• Delete extract and output files

• Execute an extract configuration file

• Display completion codes

• Display available calling lists

• Copy an extract print file

• Delete an extract print file

• View and print an extract file
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PC Analysis

Overview PC Analysis allows you to use data from the Avaya PDS to prepare
reports, charts, mail merge letters, and spreadsheets using PC software.

Using PC Analysis, you can extract five statistics files:

• job history

• agent history

• calling information

• calling transactions

• calling lists

The extract is in a comma delimited file without headings. In order to
use the information, you need to import it into a PC program such as
Excel, Lotus, a word processing merge file, or database. You can then
create the reports, charts, letters and spreadsheets from the PC program.

When you run PC Analysis, you may see a significant reduction in
system performance. For this reason, we suggest that you run the
extract when there are no active jobs. Understanding the information in
the Avaya PDS files helps you create extracts that contain the data you
need.



7 - 2 2 6

...........................................................................................................................................................................................................................................................

PC Analysis

.............................................................................................................................................................................................................................................................
Data sources

Overview When Avaya PDS places a call, information is put into “buckets” or
files. The call’s outcome is written to the calling list (AGENT, DATE,
TIME, and CODE) and to the statistics files.

When the job is complete, summary information is gathered and
written to the job and agent files.

We gather information from these files using PC Analysis.

Data sources include Job History Files, Agent History Files, Calling
Information Statistics, Calling Transaction Statistics, and Calling List
Information.

Job history and agent history files are created by an Avaya PDS binary
application that uses totals from the information and transaction
statistics. Depending on what you want to do, you choose the file
containing the information you need as your source file.

Important! You can take information only from one source file
per extract. If you want information from more than one source
file on your PC, separate extracts and then combine the data in
your PC application.
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Data Sources Job History This file contains data about the last 200 jobs run on
Avaya PDS. Typical data consists of job start and stop times, the total
number of connects, the total number of agents working the job, and
the total number of minutes the job was run.

Agent History This file contains data about each agent’s calling
activity during the last 200 jobs. Typical data includes number of
seconds the agent was talking with clients, the number of seconds
updating records, and the number of calls the agent answered.

Statistics There are two statistics files

• Information File

This file contains data about all calls placed during a job. It
includes the times agents joined and left jobs, and the time the job
shut down.

• Transaction File

This file contains data about inbound and outbound call
processing. Avaya PDS stores the record numbers, phone
numbers, recall attempt counts, agent names, talk and work times,
and calling results. Typically, these statistics are stored for the
past five calendar days. Some systems are configured to store up
to 28 calendar days.

Calling list This file contains data about the client’s account. It
typically includes the person’s name, address, account information and
the system-added and agent-added codes.
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Job history

Overview The job history file contains data on the last 200 completed jobs. Avaya
PDS separates the data into inbound and outbound job information. The
information is taken from the information and transactions statistics
files. Unlike the statistics files, the job history file provides averages
and group totals.

Information in this file includes the following:

• Last 200 jobs

• Job start and stop times

• Number of connects

• Number of agents on the job at any given time

• Number of minutes the job was suspended

Job information The following table describes the fields in the job history file:

Name Description

JOBNAME Job name.

JOBNUMBER Avaya PDS identification number
assigned to a job. The number
increases each time Avaya PDS runs
the job.

JOBTYPE Indicates the job type: inbound,
outbound or blend.

UNITID Unit work list key value for a unit
work list job. For example, if you
base the unit work lists on ZIP codes,
the field contains the ZIP codes used
by that job.

JOBDATE Job start date.

STARTTIME Job start time.

ENDTIME Job stop time.

ACTIVETIME Total job call processing time. It does
not include start time or suspension
time.
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JOB_CLOCKTIME Total agent hours on a job.
JOB_TALKTIME +
JOB_UPDATETIME +
JOB_IDLETIME.

JOB_IDLETIME Total time agents were idle. Does not
include the time between an agent’s
login and the first call or the time
between the release of an agent’s
final record and log off. For a blend
job, it includes the transfer time
between jobs.

JOB_TALKTIME Total talk time for all agents on all
jobs.

JOB_UPDATETIME Total update time for all agents on all
jobs.

JOB_WORKTIME Total work time for all agents on all
jobs. JOB_TALKTIME +
JOB_UPDATETIME

JOB_IDLECOUNT Number of times agents were idle.

JOB_CALLSWORKED Total calls handled by agents on all
jobs.

JOB_CALLSANSWERED Total calls handled on inbound jobs.

JOB_WAITQUEUETIME Time (in seconds) clients spent in
wait queue.

JOB_CALLSINWAIT Total calls placed in wait queue.

OUT_CLOCKTIME Total time agents were on outbound
jobs.

OUT_IDLETIME Total idle time on outbound jobs.

OUT_TALKTIME Total talk time on outbound jobs.

OUT_UPDATETIME Total update time on outbound jobs.

OUT_WORKTIME Total work time on outbound jobs.
OUT_TALKTIME +
OUT_UPDATETIME

Name Description
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OUT_IDLECOUNT Number of times agents were idle on
outbound jobs.

OUT_CALLSWORKED Total outbound calls handled by
agents.

OUT_CALLSANSWERED Total outbound calls answered.

OUT_WAITQUEUETIME Total time outbound clients spent in
the wait queue.

OUT_CALLSINWAIT Total number of outbound calls
placed in the wait queue.

OUT_CALLSPLACED Total outbound calls placed.

OUT_RECALLSPLACED Total recalls placed.

INB_CLOCKTIME Total time on inbound calls.
INB_TALKTIME +

INB_UPDATETIME +
INB_IDLETIME

INB_IDLETIME Total idle time on inbound calls.

INB_TALKTIME Total talk time on inbound calls.

INB_UPDATETIME Total update time on inbound calls.

INB_WORKTIME Total work time on inbound calls.
INB_TALKTIME +
INB_UPDATETIME

INB_IDLECOUNT Number of times agents were idle on
inbound calls.

INB_CALLSWORKED Total inbound calls handled.

INB_CALLSANSWERED Total inbound calls received per job.

INB_WAITQUEUETIME Total time clients spent in the
inbound wait queue.

INB_CALLSINWAIT Total calls placed in the inbound wait
queue.

XOUT_CLOCKTIME Total time spent as Person to Person
(PTP) agent.

Name Description
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XOUT_IDLETIME Total PTP idle time.

XOUT_IDLECOUNT Number of times PTP agents were
idle.

XOUT_CALLSWORKED Total PTP calls.

PREVIEWTIME Total time agents spent previewing
records during Managed Dialing.

LISTNAME Calling list name.

JOBLABEL Job description from job file

SELECTNAME Record selection file name.

STRATEGYNAME Phone strategy file name.

COMPCODE01-
COMPCODE99

Call completion codes 01-99.

Name Description
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Agent history

Overview The agent history files contain data on each agent's calling activity
during the last 200 jobs. There is a file for each agent. Information
within each file is separated for outbound and inbound calls.

The file provides the following data:

• Last 200 jobs

• Number of seconds an agent was online

• Number of seconds agent spent talking, idle, and updating records

• Number of calls the agent answered

Agent information The following table describes the fields in the agent history file:

Name Description

JOBNAME Job name.

JOBNUMBER The Avaya PDS identification number
assigned to a job. It increases each
time a job runs.

UNITID Unit work list identification.

JOBDATE Job run date.

STARTTIME Job start time.

ENDTIME Job end time.

LOGINTIME Agent’s first log in time.

LOGOUTTIME Agent’s first log off time.

AGENTNAME Agent’s user name.

JOB_CLOCKTIME Total agent hours on a job.
JOB_TALKTIME +
JOB_UPDATETIME +
JOB_IDLETIME
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JOB_IDLETIME Total agent idle time. Does not include
time between an agent’s login and the
first call or time between the release of
an agent’s final record and log off. For
a blend job, includes transfer time
between jobs

JOB_TALKTIME Total talk time.

JOB_UPDATETIME Total update time.

JOB_WORKTIME Total work time. JOB_TALKTIME +
JOB_UPDATETIME

JOB_IDLECOUNT Number of times agent was idle.

JOB_CALLSWORKED Total calls handled during a job

OUT_CLOCKTIME Total time on outbound jobs

OUT_IDLETIME Total idle time on outbound jobs

OUT_TALKTIME Total talk time on outbound jobs

OUT_UPDATETIME Total update time on outbound jobs

OUT_WORKTIME Total work time on outbound jobs.
OUT_TALKTIME +
OUT_UPDATETIME.

OUT_IDLECOUNT Number of times agent was idle on
outbound jobs

OUT_CALLSWORKED Total outbound calls handled.

INB_CLOCKTIME Total time on inbound calls.
INB_TALKTIME +
INB_UPDATETIME +
INB_IDLETIME

INB_IDLETIME Total idle time on inbound calls

INB_TALKTIME Total talk time on inbound calls

INB_UPDATETIME Total update time on inbound calling

INB_WORKTIME Total work time on inbound calls.
INB_TALKTIME +
INB_UPDATETIME

Name Description
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INB_IDLECOUNT Number of times agent was idle on
inbound calls

INB_CALLSWORKED Total inbound calls handled.

XOUT_CLOCKTIME Total time as Person to Person (PTP)
agent.

XOUT_IDLETIME Total PTP idle time.

XOUT_IDLECOUNT Number of times PTP agent was idle.

XOUT_CALLSWORKED Total PTP calls.

PREVIEWTIME Total time agent spent previewing
records during Managed Dialing.

LISTNAME Calling list name.

OFFLINE Total time spent off-line (i.e. logged in
but not on a job).

RELEASE Time spent released to the ACD in
Predictive Blend.

COMPCODE01-
COMPCODE99

Call completion codes 01-99.

Name Description
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Calling statistics

Information statistics
overview

Calling information statistics provide information about the duration of
certain events. For example, hit rate statistics every ten minutes, line
usage statistics every two minutes, and events.

Avaya PDS stores the calling statistics in two files:

• Information Statistics

• Transaction Statistics

Reports from both of these files give you information about the job up
to the time Avaya PDS generates the report. Avaya PDS uses the
concept of a job as that day’s calling activity and tracks it with the job
number. Job numbers increase each time Avaya PDS runs a job.

The information statistics file contains general data sorted by job
number. The information statistics file provides information about the
duration of certain events.

The transaction statistics file contains data about each call.

Avaya PDS generates statistics for the events at different intervals. For
example, Avaya PDS generates hit rate statistics every ten minutes and
line usage statistics every two minutes. Some events have fields
assigned to them and others use the INF_EVENTLABL and
INF_FREE fields. For example, when an agent joins a job, log on
appears in the INF_EVENTLABL field and either blend, outbound, or
inbound appears in INF_FREE. The other fields used by this event are
INF_AGENTNAME, INF_CALLTYPE, and INF_LOGTYPE. The
data is a running history of events.

Information statistics The following table describes the fields in the information statistics
file:

Name Description

INF_JOBNUM The Avaya PDS identification number
assigned to a job. It increases each time
Avaya PDS runs the job.

INF_DATE Date the event occurred.

INF_TIME Time the event occurred.
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Note

If you transferred an agent from any other job, it would be the time on
this job.

Transaction statistics
overview

The transaction statistics file contains data about each call the Avaya
PDS processed for a particular job. Avaya PDS stores the record
numbers, phone numbers, recall attempt counts, agent names, talk and
work times, and calling results for each call.

INF_EVENTLABL The name of the event being reported; for
example, line usage, hit rate, acquire,
release, log on.

INF_FREE Data for the event in the event label field.
For example, hit rate would show the
current hit rate; line usage would show the
current line usage.

INF_AGENTNAME Agent’s user name.

INF_CLOCKTIME Has several uses: For LOG OFF events it
is the total work time for last assignment,
not the time since log on. For JOBTIME,
the last entry in the file, it is the total

INF_IDLETIME Amount of idle time between calls of the
same type.

INF_IDLETYPE The job type to which the idle agent is
assigned.

INF_CALLTYPE The type of call: outbound, inbound,
blend.

INF_UNITED Unit work list identification.

INF_LOGTYPE Agent’s log on type: outbound, inbound,
blend, managed, PTP.

Name Description
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Transaction statistics The following table describes the fields in the transactions statistics
file:

Name Description

TRN_JOBNUM The Avaya PDS identification number
assigned to a job.

TRN_DATE Date the event occurred.

TRN_TIME Time the event occurred.

TRN_WAITTIME Total time this client was in wait queue.

TRN_USERFIELD User defined field.

TRN_TELELINE Line number used by this call.

TRN_COMPCODE Call completion code entered by system
for this call.

TRN_RECNUM Record number.

TRN_PHONENUM Phone number (outbound).

TRN_AGENTNAME Agent’s user name.

TRN_RECALLCNT Number of times Avaya PDS has
recalled this record.

TRN_TALKTIME Agent talk time for this call.

TRN_WORKTIME Agent work time for this call.

TRN_V_TO_HANG Time from client answer to line release.

TRN_OFF_TO_HNG Time from the Avaya PDS initiating call
to line release.

TRN_P_FIELDNUM Phone number (inbound).

TRN_CONNECT Connect flag.

TRN_UNITID Unit ID for this call.

TRN_UPDATETIME Agent update time for this record.

TRN_PREVTIME Time agent spent previewing record on a
managed job.

TRN_TRANSTYPE Call type: inbound or outbound.
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TRN_AGCOMPCODE Call completion code entered by agent.

TRN_LOGTYPE Agent log on type: outbound, inbound,
blend, managed, PTP.

Name Description
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Calling list

Overview If your agents update the host or you update information to the host, the
calling list file contains information about your calling list for the past
two days. The contents of your calling lists are unique to your
installation. Use PC Analysis to extract data from this file to generate
mailing lists, form letters, and status reports.

Avaya PDS added calling
list fields

The following table describes the Avaya PDS added calling list fields.

Name Description

OPER Agent that took call (left blank if no agent)

DTE Date call was completed

TME Time call was completed

CODE Release code

ENTRYDATE Date that the record first loaded on the system
(consecutively downloads)

STATUSFLAG Record status, if anything other than a “null”
(might appear as a blank entry), then record is
considered uncallable:

• T = failed time zone

• B = bad phone number

• D = too many days on system

• R = duplicate record

• E = manual delete via record edit

• C = call on inbound campaign, cancelled in
outbound campaign

• N = Do Not Call

RECALLDATE Date set for agent set recall

RECALLTIME Time set for agent set recall

RECALLPHONE Phone to call for agent set recall

DAYSCNT Number of days consecutively that the record
has been loaded on system

PHONESTAT System status of Phones (1 byte for each
phone, position 1 for phone1 etc.) *
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Note

PHONESTAT is initially set when setzones is executed. PHONESTAT
is constantly changing during daily processing. Each phone in the
calling list will have a corresponding byte in PHONESTAT. For
example, if list1 has two phones, the PHONESTAT field will be two
bytes long. Byte 1 corresponds to PHONE1, byte 2 corresponds to
PHONE2. Each byte in PHONESTAT may contain one of five
different characters:

• N = notcalled

• B = bad number

• C = called

• O = passed to agent

• A = active/set for recall

PHONESTAT is used by Avaya PDS to determine which phone is bad.
Phones that have a B in their corresponding PHONESTAT byte will

ZONEPHONE1 Time zone flag for PHONE1

ZONEPHONE2 Time zone flag for PHONE2

CURPHONE Current active phone

PHONECNT1 Number of attempts on PHONE1

PHONECNT2 Number of attempts on PHONE2

DUR4 System talk time

DUPE Duplicate flag (if field contains an * duplicate
records exist)

FRSTDATE1 Date of first attempt on PHONE1

FRSTTIME1 Time of first attempt on PHONE1

FRSTSTAT1 Result of first attempt on PHONE1

FRSTDATE2 Date of first attempt on PHONE2

FRSTTIME2 Time of first attempt on PHONE2

FRSTSTAT2 Result of first attempt on PHONE2

JOBNAME Name of job last attempting record

CALLTYPE Type of call (I=inbound, O=outbound)

Name Description
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not be attempted. When a callselection is executed, PHONESTAT’s
with C or O are reset back to N.

Example of PHONESTAT field from calling list:

Function keys used with
PC Analysis

You can use function keys and other key-combinations to work in PC
Analysis.

Def Name Len Typ Pos Data

PHONESTAT 4 C 613 NCBB

Action Keys

Toggle Help Esc,H

Select a field Esc,S

Select criteria Esc,C

Quit without saving Esc,Q

Change output file name Esc,O

Change input file name Esc,I

Toggle quoting on and off Esc,T

Done Esc,X

Run an extract Ctrl+G
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Downloading an extract file

Overview The download process includes the following:

• extract file

• download options

• downloading the output file

The download process using Campaign Directory includes the
following:

• connecting to the Avaya PDS call management system

• transferring the extract file

Popular software packages The following software can be used to display your extract file once it
is populated with data:

• Word

• Access

• Excel

• PowerPoint

• Lotus 1 2 3

Filename.prn
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All data will have “quotes” around the data unless Esc,T is used to
remove them, otherwise the default is with quotes.

Using the executed PC
Analysis extract

When you execute an extract configuration file, you create an output
file with the extension prn (e.g., filename.prn). PC Analysis lists the
available files in the ITEMS column. You can download the file to a
PC using the transfer utility in PC Analysis Tools with Campaign
Director.

Using the executed letter
generation extract

Some spreadsheet, database, and word processing applications require
fields to be separated by quotation marks. PC Analysis allows you to
separate by quotation marks. At the PC Analysis Extracts Menu, select
item 5 to Execute a Letter Generation extract. The output file will have
a .txt extension. Check with your administrator to ensure that your
format is acceptable for your worksite.

Download extracts PC Analysis creates files in standard ASCII file format. ASCII files are
compatible with a wide range of PC software programs. The
downloaded file contains one line per data record with fields separated
by commas or quotation marks.

After you have downloaded your output file to your PC, you can
manipulate your data by loading it into a PC program. The files are in
standard ASCII comma or quote delimited format. You can use these
files with Microsoft Excel, Access, Word or other mail merge
applications, and databases.
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PC Analysis extract

PC Analysis extract You can take information only from one source file per extract. If you
want information from more than one source file, perform separate
extracts and then combine stats in your PC application.

When you design a PC Analysis extract, you create an extract
configuration file. The file is a template that determines the type of
information PC Analysis retrieves from the Avaya PDS. The extract
configuration file defines the data fields you want to select, the values
for the fields, and the order in which the reports display the
information.
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Log in to PC Analysis using cdwanal password

Overview On most systems there are two ways to log into PC Analysis. You may
log in using the cdwanal password, which allows access to PC Analysis
only or you may login as system supervisor.

If logging in with the cdwanal password, the login you use must be set
up as an analysis operator in the “Manage user accounts” menu
accessed from the Supervisor Main Menu on the Avaya PDS.

Log in to PC Analysis using
cdwanal password

Use the following procedure to log in to PC Analysis.

............................................................................................................................................................................

1 At the Avaya PDS login prompt, type your login name.

............................................................................................................................................................................

2 Type a PC Analysis password (pcanal or cdwanal). Press the Enter key.
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Log in to PC Analysis using supervisor password

Log in to PC Analysis using
supervisor password)

Use the following procedure to log in to PC Analysis using the
supervisor password.

............................................................................................................................................................................

1 To use PC Analysis, select Reports.

............................................................................................................................................................................

2 From the Reports menu, the PC Analysis Extracts and PC Analysis
Tools menu options are available.

Note

The following procedures assume that you are using this method.
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Create an extract file

Create an extract file Use the following procedure to create an extract file.

............................................................................................................................................................................

1 Select PC Analysis extracts from the Reports menu.

............................................................................................................................................................................

2 Select Create an extract.

............................................................................................................................................................................

3 Type Y at the prompt to continue or N to abandon.

............................................................................................................................................................................

4 Type a name for the extract file.

............................................................................................................................................................................

5 Select the type of extraction you desire to perform. For example, to
select Job History, type J. Your available choices include the following:
J-Job History, A-Agent History, I-Calling Info Statistics, T-Calling
Trans Statistics, and L-Calling List.

............................................................................................................................................................................

6 Type Y at the prompt to continue or N to cancel.

An Input and Output File Definition screen will appear for you to fill
out. An input file is the information type and an output file is the
filename (.cfg) of the configuration file to hold the extracted data.

............................................................................................................................................................................

7 Use the table below as a naming convention when choosing an input file
name.
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............................................................................................................................................................................

8 Type the name of the output file to receive the data.
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Extract selection information

Extract selection
information

Use the PC Analysis Extraction Configuration Edit screen to select
fields, determine their order, and define field value criteria for the
extract file. Each file you create requires a list of fields arranged in a
specific order. Adding criteria for fields is optional.

The available fields differ with the type of information you select.
Generally, you need to page through two or more screens to see all the
possible file selections. Use Ctrl+N to go to the next screen, and Ctrl+P
to go to the previous screen.

If any of the fields contains commas, such as addresses, turn quoting on
by pressing Esc,T. When quoting is turned on, Avaya PDS separates
the fields with quote marks. When quoting is off, Avaya PDS separates
fields with commas. This may cause a problem when importing the
information into some applications that use commas as field separators.
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Set up the extract file

Set up the extract file Use the following procedure to set up the extract file.

............................................................................................................................................................................

1 Select the information fields by pressing the down arrow to move to the
field you want to select and press Enter.

............................................................................................................................................................................

2 To set the extract order, press Esc,S to move to the Select column. Type
a number for each chosen field in the Select column and press Enter. The
cursor returns to the Field column.

............................................................................................................................................................................

3 If you don’t want to specify an order, type 1 in all Select fields. Avaya
PDS processes the fields in the order they appear.

............................................................................................................................................................................

4 To select field values, press Esc,C to move to the Criteria Column.
Type the desired value in the Criteria column then press Enter.

............................................................................................................................................................................

5 You can set values using commas as separators or set a range of values
using a hyphen as a separator. In addition, you can use the following
comparison symbols:
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6 Repeat these steps for each field you want to use as a selection criteria.

............................................................................................................................................................................

7 Press Done to save the extract configuration file.
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Edit an extract file

Overview Use the following shortcut keys while you are in the PC Analysis
Extraction Configuration Edit screen:

Edit an extract file Use the following procedure to edit an extract file.

............................................................................................................................................................................

1 Choose PC Analysis extracts from the menu.

............................................................................................................................................................................

2 Choose Edit an extract from the PC Analysis Extracts menu.

............................................................................................................................................................................

3 Type the number of the extract file to edit.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel. The PC Analysis
Extraction Configuration Edit screen appears.

............................................................................................................................................................................

5 Press Done to save your changes and return to the menu.

............................................................................................................................................................................

6 Type Y at the prompt to continue or N to cancel.

Actions Keys

Change the criteria for a field Esc,C

Displays a field description Esc,H

Change the input file name Esc,I

Change the output file Esc,O

Change the selection order Esc,S

Remove Quotes Esc,T
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Copy an extract file

Copy an extract file Use the following procedure to copy an extract file.

............................................................................................................................................................................

1 Choose PC Analysis extracts from the menu.

............................................................................................................................................................................

2 Choose Copy an extract from the PC Analysis Extracts menu.

............................................................................................................................................................................

3 Type the extract file number to copy.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

5 Type a name of the new output file.

............................................................................................................................................................................

6 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

7 Press any key to return to the menu.
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Delete extract and output files

Delete extract and output
files

Use the following procedure to delete extract and output files.

............................................................................................................................................................................

1 Choose PC Analysis extracts from the menu.

............................................................................................................................................................................

2 Choose Delete an extract from the PC Analysis Extracts menu.

............................................................................................................................................................................

3 Type the extract file number to delete.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

5 Press any key to return to the menu.
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Execute an extract configuration file

Execute an extract
configuration file

Use the following procedure to execute an extract configuration file.

............................................................................................................................................................................

1 Choose PC Analysis Extracts from the menu.

............................................................................................................................................................................

2 Choose Execute an extract.

............................................................................................................................................................................

3 Type the number of the extract file to execute.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel. The screen shows you
the number of records selected and the number of records checked.

............................................................................................................................................................................

5 Press any key to return to the menu.
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Display completion codes

Display completion codes Use the following procedure to display completion codes.

............................................................................................................................................................................

1 Choose PC Analysis extracts from the menu.

............................................................................................................................................................................

2 Choose Display call completion codes from the PC Analysis Extracts
menu.

............................................................................................................................................................................

3 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

4 Type the name of the job whose call completion codes you want to view;
then press Enter.

............................................................................................................................................................................

5 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

6 Press any key to return to the menu.
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Display available calling lists

Overview The display has two parts. The top shows you the current date and time
along with free disk space available on the calling list area of the hard
disk. This is helpful if running out of disk space is a concern. The
bottom displays the calling lists and number of records in the list.

Display available calling
lists

Use the following procedure to display available calling lists.

............................................................................................................................................................................

1 Choose PC Analysis extracts from the menu.

............................................................................................................................................................................

2 Choose Display available calling lists from the PC Analysis Extracts
menu.

............................................................................................................................................................................

3 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

4 The screen shows the current date and time along with a breakdown of
space available on the calling area of the hard disk. Press any key to
return to the menu.
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Copy an extract print file

Copy an extract print file Use the following procedure to copy an extract print file.

............................................................................................................................................................................

1 Choose PC Analysis Tools from the Reports menu.

............................................................................................................................................................................

2 Choose Copy an extract print file from the PC Analysis Tools menu.

............................................................................................................................................................................

3 Type the item number of the file to copy.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel.



7 - 2 6 0

...........................................................................................................................................................................................................................................................

PC Analysis

.............................................................................................................................................................................................................................................................
Delete an extract print file

Delete an extract print file Use the following procedure to delete an extract print file.

............................................................................................................................................................................

1 Choose PC Analysis Tools from the Reports menu.

............................................................................................................................................................................

2 Choose Delete an extract print file from the PC Analysis Tools menu.

............................................................................................................................................................................

3 Type the item number of the file to copy.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel.
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View and print an extract file

View and print an extract
file

Use the following procedure to view and print an extract file.

............................................................................................................................................................................

1 Choose Analysis Tools from the PC Analysis Main menu.

............................................................................................................................................................................

2 Choose View or print extracts.

............................................................................................................................................................................

3 Type the number of the output file to display. The Report Files Status
Screen appears, press F2 to print or F4 to view the contents of the output
file.
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8 Administrator overview
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Overview

Purpose The following chapters describe how to perform administrative tasks,
back up and restore the Avaya PDS files, maintain the inbound calling
list, and transfer and process calling list records. These commands are
on the Administrator Main Menu.

Contents This section contains the following topic:

• Log in to the Avaya PDS



8 - 2 6 6

...........................................................................................................................................................................................................................................................

Administrator overview

.............................................................................................................................................................................................................................................................
Log in to the Avaya PDS

Log in to the Avaya PDS Log into the Avaya PDS as an administrator and type the password to
use the Administrator Main Menu commands. The Administrator
Main Menu appears.
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9 Avaya PDS administrative tasks
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Overview

Purpose The purpose of this section is to describe administrative tasks that you
can perform in the Administrator menus on the AvayaTM Predictive
Dialing System (PDS).

Contents This section contains the following topics:

• Change administrator passwords

• Restart the Avaya PDS

• Shut down the Avaya PDS

• Set the Avaya PDS date and time

• Monitor agent lines

• Stop monitoring an agent

• Terminate user session

• Area codes and prefixes

• Edit area codes and prefixes

• View current area codes and prefixes

• View time zones

• Add an area code or a prefix to a time zone

• View current area code and prefix settings

• Delete an area code or prefix
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• Change a country code

• Save area code and prefix changes

• Discard area code and prefix changes

• Restore a previous version of area code and prefix settings

• Start the Avaya PDS
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Change administrator passwords

Change administrator
passwords

The Administrator Main Menu includes sensitive features such as
shutting down and restarting the Avaya PDS. To protect your system,
change the administrator’s password often.

............................................................................................................................................................................

1 Choose Change administrator password from the Administrative Tasks
menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

3 Type the current password and press Enter.

............................................................................................................................................................................

4 Type the new password and press Enter. It must contain at least 6
characters, 3 of which need to be different from the old password. It also
needs to contain at least 2 letters and 1 number. After you press Enter,
the Avaya PDS prompts you to type the new password again.

............................................................................................................................................................................

5 Type the new password again and press Enter.
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Restart the Avaya PDS

Restart the Avaya PDS This procedure must be completed from the Administrator’s console. If
you attempt to restart the Avaya PDS from any other workstation, an
error message will appear. Make sure to shut down all jobs and tell all
users to log off before restarting the Avaya PDS.

............................................................................................................................................................................

1 Choose Restart system from the Administrative Tasks menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel. A series of messages
appear. When the restart is complete, the system displays the login
prompt.
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Shut down the Avaya PDS

Overview The Avaya PDS should always remain on except for the following
situations:

• You plan to stop calling operations for several days.

• There is the possibility of large power surges and electrical
damage.

• You plan to move your system.

Shut down the Avaya PDS To avoid damaging the system components or losing data in active
jobs, stop all jobs and log all users off before shutting down the Avaya
PDS.

............................................................................................................................................................................

1 Choose Shut down system from the Administrative Tasks menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel. The following prompt
appears: Are you sure you want to shutdown HP-UX? Enter Y or N.

............................................................................................................................................................................

3 Type Y at the prompt to continue or N to cancel. The following message
appears: Halted, you may now cycle power.

............................................................................................................................................................................

4 Go to the Avaya PDS cabinet and turn off the power to all components.
Most systems have the components connected to a power strip. The
easiest way to turn off the equipment is to turn off the power strip.
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Set the Avaya PDS date and time

Overview This option is used to reset the Avaya PDS date and time. It is
important to keep the system time accurate due to time zone legalities.
Make sure to log all other users off and shut down all jobs before
choosing this option.

Warning

If you change the date or time during the Avaya PDS operations, you
can critically affect system operation and data.

Note

If you have automatic file procedures such as an automatic download
of data from the host, setting the time forward can affect the timed
event.

Set the Avaya PDS date
and time

Log off all other users and shut down all jobs before choosing this
command. You can critically affect system operation and data if you
change the date or time during Avaya PDS operations.

............................................................................................................................................................................

1 Choose Set system date and time from the Administrative Tasks
menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

3 Type a new time in the format HH.MM. The Avaya PDS uses a 24 hour
clock and requires a period between the hours and minutes. For
example, type 15.25 for 3:25 PM.

............................................................................................................................................................................

4 Type a new date in the format CCYY/MM/DD. For example, type 1999/
06/01 for June 1, 1999.

............................................................................................................................................................................

5 Press any key to return to the menu. The new time and date take effect
immediately.



Avaya PDS administrative tasks

9 - 2 7 3

............................................................................................................................................................................................................................................................

.............................................................................................................................................................................................................................................................
Monitor agent lines

Overview The Monitor agent lines command lets you silently monitor an agent’s
conversation. A beep does not sound in the agent’s headset when you
monitor the call. Therefore, this command is for troubleshooting
purposes only and may be illegal in your area.

Monitor agent lines Use the following procedure to begin monitoring an agent’s line

............................................................................................................................................................................

1 Choose Monitor agent lines from the Administrative Tasks menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

3 Type Y at the prompt. The Job Control menu appears.

............................................................................................................................................................................

4 Choose Open Job (Ctrl+C) from the Jobs menu. If there is more than one
current job, choose the job name from the list.

............................................................................................................................................................................

5 Choose Monitor Agent from the Control menu.

............................................................................................................................................................................

6 Choose the agent’s user name from the list. If the agent is talking with a
customer, the Avaya PDS immediately connects your headset to the
agent’s port. If the agent is not talking with a customer, a message
appears to tell you the agent is not on a line.
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Stop monitoring an agent

Stop monitoring an agent Use the following procedure to stop monitoring an agent.

............................................................................................................................................................................

1 When you finish listening to an agent’s conversation, choose
Disconnect Agent from the Control menu.
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Terminate user session

Overview Use this command to end a user session when users log off incorrectly
or their workstations malfunction. When you terminate a user session,
the Avaya PDS stops the process associated with the user and restores
control to the system.

If more than one user is using the same login name, this process may
terminate the wrong session. Tell all users who are logged in with that
login name to log off. For example, if two users are logged in as
“system” and one session is frozen, then the other user should log off
before continuing.

Terminate user session Use the following procedure to terminate a user session.

............................................................................................................................................................................

1 Choose Terminate a user session from the Administrative Tasks
menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

3 Type the login name for the session you want to terminate, or press
Enter to exit.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

5 The Avaya PDS searches for the user session and displays a message
when it finds the process or if it cannot find a session for the login name
you entered.

............................................................................................................................................................................

6 Press any key to return to the menu.
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Area codes and prefixes

Overview Telephone companies frequently add new area codes and prefixes to
existing phone systems. The Avaya PDS needs the up-to-date area code
and prefix information to call phone numbers that use the new codes.
The Edit Area Codes and Prefixes option lets you update the area code
and prefix settings on your Avaya PDS.

Telephone numbers generally consist of three parts: an area code, a
prefix (also known as an exchange), and a line number. For example, in
the telephone number 206-555-1212, the area code is 206, the prefix is
555, and the line number is 1212.

The Avaya PDS associates prefixes with area codes based on system-
defined time zones. The Avaya PDS configuration includes the
standard time zones, such as Eastern, Central, Mountain, and Pacific.
The Avaya PDS configuration also includes several additional time
zones designed to accommodate local and regional ordinances
regarding legal calling hours. For example, the Illinois time zone
addresses laws specific to the state of Illinois. Several other Avaya PDS
time zones accommodate areas that do not follow daylight savings
time. See “Time Zones” beginning on page 267 for a list of Avaya PDS
time zones.

Avaya PDS time zones have associated zone codes. A zone code is a
one-letter designation that the Avaya PDS uses to reference a time
zone. Zone codes are case-specific. For example, zone code C (upper
case) represents the Atlantic No Daylight time zone while zone code c
(lower case) represents the United Kingdom time zone. The Time Zone
and Exchange Prefix Editor prompts you to type the zone code to
which you add (or remove) area code and prefix settings. The list of
Avaya PDS time zones on page 267 includes the corresponding zone
codes.

Another important telephone system designation is country code. The
Time Zone and Exchange Prefix Editor default country code is 1,
which represents the United States and Canada. Usually, you’ll make
time zone and prefix setting changes to country code 1. The editor,
however, includes an option to select a different country code if
necessary. See “Country Codes” for a list of selected country codes.

Note

Some states limit or prohibit placing certain types of telephone
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calls during specific times, usually before a certain time in the morning
or after a certain time at night. Area code fields in the System controls
may be modified by the customer in order to respond to regional area
code changes. Such modifications may result in telephone calls being
made in violation of after-hours calling limitations. The customer is
solely responsible for any violations of applicable laws or regulations
resulting from area code modifications.
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Edit area codes and prefixes

Edit area codes and
prefixes

Use the following procedure to edit area codes and prefixes.

............................................................................................................................................................................

1 From the Administrative Tasks menu, choose Edit area codes/prefixes.
The Area Code & Exchange Prefix Editor menu appears.

............................................................................................................................................................................

2 Type the option number or the first letter of the command name.

............................................................................................................................................................................

3 The Avaya PDS saves changes you make using the Area Code and
Exchange Prefix Editor to a temporary file. When the Avaya PDS
restarts, it activates the changes.
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View current area codes and prefixes

Overview The Query option displays the area codes and area code and prefix
combinations that currently exist on the Avaya PDS. It lists the settings
according to time zones. Use the Query option to determine if you need
to change any existing settings. You can also use the Query option to
identify zone codes for which you need to change area code and prefix
settings. You need to know the zone code(s) when you add or delete
area code and prefix settings.

Note

You can also view current area codes and prefixes from the Add and
Delete options. See the following sections, “Adding an Area Code or a
Prefix to a Time Zone” and “Deleting an Area Code or a Prefix,” for
more information.

View current area codes
and prefixes

Use the following procedure to view current area codes and prefixes.

............................................................................................................................................................................

1 Choose Query from the Area Code & Exchange Prefix Editor menu. The
Query Area Codes and Prefixes screen appears.

............................................................................................................................................................................

2 Type an area code; area code and prefix combination; zone code; or
zone code, area code, and prefix combination. See the following section,
“Query Options,” for more information.

The query results appear at the bottom of the query screen. If the query
results fill more than one screen, press Enter to view subsequent pages.

Query Options

The Query Area Codes and Prefixes option accepts the following four
types

of queries:

• Area Code

The Avaya PDS lists all zone codes that contain the pecified area
code. For each zone code, it also lists the prefixes associated with
the area code.

• Area Code and Prefix, separated by a colon
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The system identifies the zone code in which the specific area
code and prefix combination is listed.

• Zone Code (for example, L, the zone code for Pacific Daylight
time zone)

The system generates a list of all area codes and prefixes for the
specified zone code.

• Zone Code followed by a space and an area code or an area code
and prefix combination

Use this option to query for a very specific item. If your criteria is
too limited and the system finds no matches, the system reports
the area code or prefix as “not found.”

An asterisk (*) in query results represents all prefixes for this area code
that aren’t explicitly listed under another zone code. There can be only
one asterisk entry for any given area code. Other entries must contain
specific, unique exchange prefixes. For example, area code 709 exists
under two zones, Newfoundland Daylight time zone (A) and Atlantic
Daylight time zone (B). The asterisk in the Newfoundland Daylight
Prefix List represents all prefixes that don’t appear in the Atlantic
Daylight prefix list.
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View time zones

Overview The Timezone/Guard Time Query option lists the Avaya PDS time
zones and calling guard times. Guard times define the earliest and latest
times of day that the Avaya PDS can place phone calls.

Use this option to identify to which time zones you need to add a new
area code or area code and prefix combination.

You can query Avaya PDS time zones using a descriptive string (such
as eastern or pacific), by zone code, or using an asterisk (*). An asterisk
returns a listing of all Avaya PDS time zones.

If you don’t know a particular zone code, query using the asterisk or
see “Time Zones” on page 267 for a list of Avaya PDS time zones and
associated zone codes. You need to know the zone code(s) when you
add or delete area code and prefix settings.

View time zones Use the following procedure to view time zones.

............................................................................................................................................................................

1 Choose Timezone/Guard Time Query from the Area Code & Exchange
Prefix Editor menu. The Timezone/Guard Time Query screen appears.

............................................................................................................................................................................

2 Type a time zone code, search string, or asterisk (*), then press Enter.
Avaya PDS displays the results below your query. If the results fill more
than one screen, press Enter to view the following page.
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Add an area code or a prefix to a time zone

Overview Use the Add option to add area codes or area code and prefix
combinations to your Avaya PDS. You add area code information
based on a time zone that you specify. When you select Add from the
Area Code and Exchange Prefix Editor menu, the Avaya PDS prompts
you to type a time zone code. For example, to add an area code to the
Central Daylight time zone, specify zone code G.

You can add one area code at a time, add more than one area code
separated by commas, or add area code and prefix combinations. To
add one or more area codes (implicitly including all prefixes) to the
selected zone code, type an area code or a list of area codes separated
by commas. For example, to add the 218, 219, 220, and 221 area codes,
type 218,219,220,221.

To add an area code with specific prefixes or to add new prefixes to an
existing area code, type the area code, a colon, and one or more
prefixes separated by commas. For example, to add the 282 and 285
prefixes to area code 709 type 709:282, 285.

The Avaya PDS compares your request to the current area code and
prefix settings to identify duplicate area codes or area code prefix
combinations. If the settings do exist, Avaya PDS doesn’t add the
duplicate settings and displays a message. The Avaya PDS displays a
status message if it successfully adds your requested area code and
prefix information.

Note

You can’t add a prefix to an area code that has an asterisk listed as its
prefix. The asterisk indicates that the prefix is included implicitly in
this area code, provided it’s not explicitly listed elsewhere. Also, verify
that you’re adding the area code and prefix to the correct time zone.

Add an area code or an
area code/prefix

combination

Use the following procedure to add an area code or an area code/prefix
combination.

............................................................................................................................................................................

1 Choose Add from the Area Code & Exchange Prefix Editor menu. The
Add Area Codes and Prefixes screen appears.
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............................................................................................................................................................................

2 Type the zone code for the time zone to which you want to add an area
code or prefix.

............................................................................................................................................................................

3 Type one or more area codes or area code and prefix combinations to
add to the selected time zone.

............................................................................................................................................................................

4 To change the time zone, press Enter with nothing typed on the Enter
Choice line.

............................................................................................................................................................................

5 Type a different time zone code to continue adding area codes, or press
Enter with no selection to exit the Add option.
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View current area code and prefix settings

View current area code and
prefix settings

You can query the current area code and prefix settings (same as the
Query menu option) from the Add feature. Do this to verify your
changes.

............................................................................................................................................................................

1 Type q or Q at the prompt instead of an area code or prefix. The Query
Area Codes and Prefixes screen appears.

............................................................................................................................................................................

2 Type the area code, area code and prefix combination, or zone code that
you want to view.
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Delete an area code or prefix

Overview Use the Delete option to delete area codes and prefixes from specific
time zones. When you select the Delete option from the Area Code and
Exchange Prefix Editor menu, the Avaya PDS prompts you to type a
zone code for the time zone you want to modify.

You can delete one or more area codes or area code and prefix
combinations. To delete one or more area codes from the selected zone,
type a single area code or a list of area codes separated by commas. For
example, to delete the 418 and 419 area codes, type 418, 419.

To delete specific prefixes from an area code, type the area code
followed by a colon and one or more prefixes, separated by commas.
For example, to delete the 937, 938, and 229 prefixes from the 418 area
code, type 418:937,938,229.

Delete an area code or
prefix

To delete an area code or an area code and prefix combination

............................................................................................................................................................................

1 Choose Delete from the Area Code & Exchange Prefix Editor menu.
The Delete Area Codes and Prefixes screen appears.

............................................................................................................................................................................

2 Type the zone code for the time zone from which you want to delete an
area code or prefix.

............................................................................................................................................................................

3 Type one or more area codes or area code and prefix combinations to
delete. The system displays the results of delete action.

............................................................................................................................................................................

4 To change the time zone, press Enter with nothing typed on the Enter
Choice line.

............................................................................................................................................................................

5 Type a different time zone code to delete area codes from another time
zone, or press Enter with no selection to exit the Delete option.
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Change a country code

Change a country code Each country has a unique telephone system. Country codes are used to
differentiate one country’s settings from another. The Area Code and
Exchange Prefix Editor default country code is 1, which represents the
United States and Canada. If you want to view or change area code and
prefix information for another country, use the Change Country Code
option to change the country code. See “Country Codes” for a list of
selected country codes.

............................................................................................................................................................................

1 Choose Change Country Code from the Area Code & Exchange Prefix
Editor menu. The Change Country Code screen appears.

............................................................................................................................................................................

2 Type a country code, then press Enter. The new country code appears on
the Area Code and Exchange Prefix Editor main menu.
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Save area code and prefix changes

Overview Use the Save Changes menu option to save the area code and prefix
modifications you make. The Avaya PDS saves area code and prefix
information to a temporary file. When the system is restarted, manually
or during the nightly restart, the changes take effect.

Note

If you exit the Area Code and Exchange Prefix editor without saving
your changes, the system automatically prompts you to save current
changes, discard current changes, or cancel the exit command.

Save area code and prefix
changes

Use the following procedure to save area code and prefix changes.

............................................................................................................................................................................

1 Choose Save Changes from the Area Code & Exchange Prefix Editor
menu. The Confirm: Save Current Changes screen appears.

............................................................................................................................................................................

2 Type Y to confirm the save or N to cancel the save command.



9 - 2 8 8

...........................................................................................................................................................................................................................................................

Avaya PDS administrative tasks

.............................................................................................................................................................................................................................................................
Discard area code and prefix changes

Overview The Discard Changes option lets you abandon changes you made since
the most recent save (or since you started the editor if you haven’t
saved yet). The Discard Changes option restores the original file that
the system loaded when you started the editor or the last saved version.

If there are no changes to discard, the system notifies you and cancels
the command.

Discard area code and
prefix changes

Use the following procedure to discard area code and prefix changes.

............................................................................................................................................................................

1 Choose Discard Changes from the Area Code & Exchange Prefix Editor
menu. The Confirm: Discard Current Changes screen appears.

............................................................................................................................................................................

2 Type Y to discard the changes or N to cancel the discard command.
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Restore a previous version of area code and prefix settings

Overview The Rollback option allows you to cancel saved area code and prefix
changes. You can recover area code and prefix settings under two
different circumstances: Rollback to current live version and Rollback
to last backup version.

Choose the Rollback to current live version option if you saved
changes in error but have not restarted the Avaya PDS. Avaya PDS
loads the current live area code and prefix settings into the editor. Save
the restored settings as is or make additional changes. You must save
the restored version and restart the Avaya PDS for the restored settings
to take effect.

Choose the Rollback to last backup version if you saved changes in
error and have since restarted the Avaya PDS. Avaya PDS loads the
most recently backed up version of the live area code and prefix
settings into the editor. Save the restored settings as is or make
additional changes. You must save the restored version and restart the
Avaya PDS for the restored settings to take effect.

Restore a previous version
of area code and prefix

settings

Use the following procedure to restore a previous version of area code
and prefix settings.

............................................................................................................................................................................

1 Choose Rollback from the Area Code & Exchange Prefix Editor menu.
The Rollback to Previous Version screen appears.

............................................................................................................................................................................

2 Choose 1 to restore the current live version or choose 2 to restore to the
last backup version.

............................................................................................................................................................................

3 Add or delete area codes or prefixes as necessary.

............................................................................................................................................................................

4 Save the restored area code and prefix settings.
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Start the Avaya PDS

Start the Avaya PDS Starting the Avaya PDS reloads all of the system’s programs and files.

............................................................................................................................................................................

1 Turn on the power to the following equipment: Administrator
workstation, digital switch rack, digital switch controller, terminal
server, mass storage unit, bridge

............................................................................................................................................................................

2 Wait at least 10 seconds, then turn on the power to the tape drive,
modem, and central processing unit (CPU). Start up is successful when
you see the login prompt on the screen.
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Overview

Purpose The purpose of this section is to explain how file transfers on the
AvayaTM Predictive Dialing System (PDS) work.

Contents This section contains the following topics:

• File transfer

• Record formats

• FTP

• Download host records to the Avaya PDS

• Downloads

• Upload the Avaya PDS records to a host computer

• Recover calling list

• Count calling list records

• Download records for infinite jobs
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File transfer

Overview The Avaya PDS uses data from the host computer database. This
database may reside on a mainframe, a minicomputer, a server, or any
other kind of host. The data must be transferred in the form of one or
more files from the host system to the Avaya PDS.

All file transfers on the Avaya PDS are controlled by a series of scripts.
These scripts allow automatic processing by the system or when
invoked from the Transfer and Process Records menu. Transfers to the
Avaya PDS are called downloads. Transfers from the Avaya PDS are
called uploads.

The Avaya PDS supports the FTP (file transfer protocol) transfer
method. To use the FTP method, your host must support the TCP/IP
protocol and contain the FTP utility software. There must also be a
direct link between your host and the Avaya PDS Ethernet connection.

If you are not sure about your file transfer configuration, contact your
Avaya PDS vendor for details.

File transfer Account information comes from the host in raw data form, in an
ASCII or EBCDIC file format.

The raw data is transferred to the PDS in one of two ways. Anonymous
FTP, also known as host-initiated FTP, is the most common. In this
method, the Avaya PDS waits for the raw data to be sent to it from the
host.

The PDS uses data from the customer’s database. This database may
reside on an IBM mainframe, a minicomputer, a Windows NT server,
or any other kind of host. The data must be transferred in the form of
one or more text files from the customer’s host system to the Avaya
PDS.

A convenient, reliable, and inexpensive solution for file transfer is FTP,
the user interface to the ARPANET standard File Transfer Protocol. It
is widely used on the Internet for transferring files between disparate
platforms, and FTP software exists for almost every system type. FTP
works in a client/server arrangement.

FTP uses TCP/IP and the ethernet connection of the Avaya PDS to
connect to the host. Either the Avaya PDS waits for the files to be sent
to it, or the Avaya PDS initiates a file transfer retrieval from the host. In
either case, FTP is generally easier to set up, troubleshoot, support, and
test than any other file transfer solution.
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A typical file transfer might look like this:

1. At 4:00am the host system initiates an FTP session with the Avaya
PDS via the TCP/IP connection.

2. The host logs on and sends specified data files into a directory on
the Avaya PDS, then disconnects.

3. At 4:10am the Avaya PDS finds the files and processes them into
one or more callable lists.

The method illustrated in this example is known as anonymous or host-
initiated FTP, which allows the host to send file(s) to the Avaya PDS.
The host was the client and the Avaya PDS acted as the FTP server.
After this happens, either an automatic or manual process on the Avaya
PDS can convert the received data into one or more calling lists.

The Avaya PDS can instead be configured to directly connect to the
host and retrieve files from it before creating calling lists. This method
is known as direct-connect or Avaya PDS-initiated FTP. With this
approach there is more Avaya PDS control over the file transfer and
more responsibility for it. It is slightly more difficult to configure but is
preferred by customers who lack the ability to schedule FTP transfers
on the host.

FTP is the best transfer method to use with the Avaya PDS. It does not
require the use of any additional hardware and is fast and reliable. Also,
changes are easy to make, including changing hosts or adding
additional lists. FTP is the recommended option for any host system
that can support it.

Not all host systems can use FTP. The host must support the TCP/IP
protocol and FTP utility software, and there must be a network link
between the host and the Avaya PDS. Some older mainframes do not
support TCP/IP.
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Record formats

Download record formats The download record formats contain field definitions for the records
that will be downloaded from the host to the Avaya PDS.

Your host application contact writes a script (such as JCL procedures)
that instructs the host to generate one or more files (ASCII or EBCDIC)
that contain customer records. After the Avaya PDS receives the files,
the system converts each file into a format it can use. It then creates a
calling list.

Upload Record Formats Upload record formats are optional. If your agents update customer
records on the host during calling operations, you may not require
Avaya PDS-to-host uploads. If you will upload records to the host, read
the following information.

Upload record formats define the customer data that you want the
Avaya PDS to return to your host computer. Your host application
contact will write a script that instructs the host to accept one or more
files that contain customer records. At scheduled times, the Avaya PDS
converts the customer records in a specific calling list into the host
computer’s format and creates an upload file. When the host receives
this file, it follows the script and updates the host database.
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FTP

Overview FTP is a convenient, effective, and inexpensive file transfer method. It
does not require the use of any additional hardware and is fast and
reliable. Also, changes are easy to make, including changing hosts or
adding calling lists.

FTP is the user interface to the ARPANET standard File Transfer
Protocol. It is widely used on the Internet for transferring files between
disparate platforms, and FTP software exists for almost every system
type.

FTP uses TCP/IP and the Ethernet connection of the Avaya PDSPDS to
connect to the host. Either the system waits for the files to be sent to it,
or it initiates a file transfer retrieval from the host. In either case, FTP is
easy to set up, troubleshoot, support, and test.

Note

If you are using the FTP file transfer method, an Ethernet board and the
file sets needed to run TCP/IP and the FTP application are already
installed on your Avaya PDS.

Anonymous FTP Anonymous (or host-initiated FTP), allows the host to send file(s) to
the Avaya PDS. After this happens, you can use either an automatic or
manual process on the system to convert the received data into one or
more calling lists.

A typical file transfer using FTP might look like this:

1. At 4:00 AM, the host system connects to the Avaya PDS using
TCP/IP.

2. The host uses FTP to place specified data files into a directory on
the Avaya PDS and disconnects.

3. At 4:10 AM, the Avaya PDS finds the files and processes them
into one or more callable lists.

Typically, the FTP file transfer processes occur automatically. If,
however, the file transfers are not automated or an automated process
fails, you can use the Transfer and Process Records menu to manually
start a transfer.

Direct-connect FTP The Avaya PDS can also be configured to directly connect to the host
and retrieve files from it before creating calling lists. This method is
known as direct-connect (Avaya PDS-initiated) FTP. With this
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approach, the Avaya PDS has more control over the file transfer and
more responsibility for it.

It is slightly more difficult to configure but is preferred by customers
who lack the ability to schedule FTP transfers on the host or who need
the increased security.
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Download host records to the Avaya PDS

Download host records to
the Avaya PDS

Use the following procedure to download host records to the Avaya
PDS.

............................................................................................................................................................................

1 At the Administrator workstation, choose Download host records to
PDS from the Transfer and Process Records menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel. The host transmits the
calling list records to the Avaya PDS.



1 0 - 2 9 8

...........................................................................................................................................................................................................................................................

File transfers

.............................................................................................................................................................................................................................................................
Downloads

Downloads All file transfers on the Avaya PDS platform are controlled by a series
of scripts. These scripts allow automatic processing of the transfer
method when invoked by the crontab (an automatic scheduler for HP-
UX) or by manual control when invoked from a menu. Transfers to the
Avaya PDS are called downloads. Transfers from the Avaya PDS are
called uploads.

Test Downloads During
Configuration

At least four weeks before the scheduled Avaya PDS installation, send
your Avaya PDS representative a sample file of customer data. Include
a printout of each file. After configuring your Avaya PDS, your vendor
uses the sample data to test your system by simulating calling
operations.

Use the following guidelines to create one sample file for each record
format you use:

• Include a minimum of 250 actual or simulated host records in
ASCII or EBCDIC format.

• If you use simulated records, assign unique account and telephone
numbers to each record.

• Include a range of host customer data rather than repeating one
record.

• Don’t use packed or signed fields.

• Don’t include record headers or trailers.

Test the Upload Process at Your Site

Upon your request, your Avaya PDS representative will send you
sample upload files. Use these files to test the script that updates the
host database with the Avaya PDS data.
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Upload the Avaya PDS records to a host computer

Overview The Avaya PDS can operate independently of your host computer to
protect your calling operations. After operating in no-host mode, you
need to upload the system’s data to your host computer system.

Upload the Avaya PDS
records to a host computer

The Avaya PDS sites where agents directly update the host customer
database do not need to upload data files to the host computer regularly.
These call centers use uploads after the system resumes operations
when the host is down or inaccessible..

............................................................................................................................................................................

1 Choose Upload records to host from the Transfer and Process Records
menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel. The Avaya PDS
transmits the calling list records to the host computer.
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Recover calling list

Overview If you do not receive a new calling list from your host computer, you
can recover the old calling list to use for your daily calling activities.
Every evening the Avaya PDS saves your calling list to a backup file
named list.old. This list usually contains enough uncalled records for
you to use until you receive a new list from the host.

Recover calling list Restoring an old calling list writes over the existing calling list. Be sure
to print your reports, back up your list, or perform any other required
procedures before proceeding.

............................................................................................................................................................................

1 Choose Recover old calling list from the Transfer and Process
Records menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel.
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Count calling list records

Count calling list records Use this command at any time to display the number of records in a
calling list, its creation date, and the amount of disk space it occupies.

............................................................................................................................................................................

1 Choose Count calling list records from the Transfer and Process
Records menu.

............................................................................................................................................................................

2 Type Y at the prompt to process the changes or N to cancel.
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Download records for infinite jobs

Overview This command is available if you have set up infinite jobs on the Avaya
PDS. For more information about infinite jobs, contact your Avaya
PDS vendor.

Use this command to manually download and process new records to
add to a calling list used by an infinite job. It downloads and processes
a list segment while the job is active.

This download command also performs a duplicate record check, if
required. The Avaya PDS then executes the infinity record selection
only on the new list segment and makes the new records available for
calling on the infinite job. The new number of records will appear in
the Records Selected and Calls Left fields of the Job Monitor screen.
These records have the same priority as first attempt records.

Before using this command, set up an infinity record selection and edit
and start an infinite job.

Download records for an
infinite job

Use the following procedure to download records for an infinite job.

............................................................................................................................................................................

1 Choose Download records for Infinite Job from the Transfer and
Process Records menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel. The host transmits the
calling list records to the Avaya PDS.
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Overview

Purpose The AvayaTM Predictive Dialing System (PDS) uses inbound lists to
capture information from inbound calls.

These commands are available if your Avaya PDS uses Intelligent Call
Blending.

An inbound calling list contains the fields that the agents use when
handling inbound calls. Once created, the inbound calling list file is a
permanent part of the Avaya PDS.

Contents This section contains the following topics:

• Create an empty inbound calling list

• Clear existing inbound calling lists

• Count calling list records
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Create an empty inbound calling list

Create an empty inbound
calling list

Use the following procedure to create an empty inbound calling list.

............................................................................................................................................................................

1 Choose Create empty inbound data list from the Inbound Lists menu.

............................................................................................................................................................................

2 Type Y at the prompt. If the list already exists, the Avaya PDS does not
create a new one.

............................................................................................................................................................................

3 When the system completes the process, press any key to return to the
Inbound Lists menu.
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Clear existing inbound calling lists

Clear existing inbound
calling lists

Use this command to clear the data in the inbound calling list. Clear
this list after completing inbound calling and uploading all data to your
host.

............................................................................................................................................................................

1 Choose Clear an existing inbound data list from the Inbound Lists
menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

3 When the Avaya PDS completes the process, press any key to return to
the Inbound Lists menu.
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Count calling list records

Count calling list records Use this command to display the name of each calling list and the
number of records in each list. You can also check the available disk
space on your system.

............................................................................................................................................................................

1 Choose Count calling list records from the Inbound Lists menu.

............................................................................................................................................................................

2 The date and disk free space (in kilobytes) appears along with the
outbound and inbound calling lists and the number of records in each
list.
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Overview

Purpose Backup is a method used to archive software, which provides a way to
restore operations should the system or its software be damaged.

The Administrator menus allow you to perform a variety of
administrative tasks on your AvayaTM Predictive Dialing System
(PDS). From here you can shutdown or restart the Avaya PDS, backup
and restore the system, manage inbound lists, and a host of other
functions.

Contents This section contains the following topics:

• Back up and restore commands

• Backup Avaya PDS

• Verify backup files

• Maintain backup tapes

• Restore Avaya PDS

• Monitor DAT drive status

• Back up a calling list

• Restore a calling list
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Back up and restore commands

Back up commands From the Administrator Backup Menu you can access sub-menus to
backup the Avaya PDS. You can backup/restore the entire Avaya PDS,
the calling lists only, or the host gateway files.

Full or Incremental Backup - If you choose any of the backup menu
options you will be asked if you want to perform a full or incremental
backup A full backup will backup all the files in a selected category.
An incremental backup will backup only those files that have been
changed since the last backup.

The following table describes the available backup commands.

Command Description

Back up complete
system

This is the most comprehensive backup
option. The backup includes the entire root
file system, the Avaya PDS, and all calling
lists. Use this option to prepare for events
such as major system upgrades and service
pack installations.

Back up Avaya
PDS & calling lists

This command backs up the entire Avaya
PDS and all customer calling lists. Use this
option for routine daily system backups.

Back up Avaya
PDS only

This command backs up the entire Avaya
PDS excluding the calling lists (specifically,
all data in the /usr/vl/xfer/clist directory).

Back up Avaya
PDS configuration
files

This command backs up all the Avaya PDS
configuration files. These are the files
needed to customize a newly installed
Avaya PDS to the customer’s applications.

Back up Avaya
PDS data/stat files

This command backs up the data files

needed to run reports using the Avaya PDS

PC Analysis tools.
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Restore Commands The following table describes the available restore commands.

Command Description

Restore all from tape This command restores all files from the
backup tape.

Restore a file from tape This command attempts to restore a
single user-specified file from the
backup tape.

List/verify a file on tape This command attempts a search for a
single user-specified file on the backup
tape.

List/verify tape contents This command lists the entire contents
of the backup tape.

List tape volume info This command displays the creation
information of the backup tape.
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Backup Avaya PDS

Overview The standard backup medium is a 4mm, 90-meter, 2.2 GB digital data
storage (DDS) tape. However, you can also use a 9-track tape.

Back up the following files on a regular basis:

• outbound calling lists

• inbound calling results

• call activity statistics

• files containing user passwords

• files containing host network (IP) addresses

Backup Avaya PDS Use the following procedure to back up the Avaya PDS.

............................................................................................................................................................................

1 Locate the tape drive in the Avaya PDS cabinet.

............................................................................................................................................................................

2 Insert a new DDS tape in the drive.

............................................................................................................................................................................

3 Choose a command from the Back Up and Restore Avaya PDS menu.
For routine daily system backups, choose option 3, Back up Avaya PDS
& Calling Lists.

............................................................................................................................................................................

4 Select full or incremental backup.

............................................................................................................................................................................

5 After the backup is complete, rewind and remove the tape.

............................................................................................................................................................................

6 Store the tape in antistatic environment at the proper temperature and
humidity.
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Verify backup files

Verify backup files Use the following procedure to verify that you have a successful
backup of your files.

............................................................................................................................................................................

1 Choose a List/Verify command from the Back Up and Restore menu.

............................................................................................................................................................................

2 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

3 Follow the tape loading instructions on the screen.

............................................................................................................................................................................

4 Type C to continue or press Ctrl+X to exit. Byte count, date, size, and
file names appear on the screen during the tape verification process.

............................................................................................................................................................................

5 After verifying the tape, follow the unloading instructions on the screen.

............................................................................................................................................................................

6 Type C to return to the Back Up and Restore menu.
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Maintain backup tapes

Maintain backup tapes Each day, use the eject button to remove the previous day’s tape from
the tape drive. Before loading the new tape, check to make sure it is
write-enabled. To prevent data loss, we recommend that you observe
the following items:

• Keep a minimum of two sets of backup tapes. In each set, keep
one tape for each day.

• Store one backup set away from your Avaya PDS site.

• Store backup tapes in a controlled environment. Optimal tape
storage environment is 50% relative humidity at 22° C.

• Replace each DDS tape after 100 uses, approximately two years.

• Clean the tape drive monthly using a cleaning tape.

• Replace cleaning tapes after 25 uses.
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Restore Avaya PDS

Overview You can restore files from any backup tape created from the Avaya
PDS backup menus or with the HP-UX fbackup utility. You can restore
a single user-specified file or all files from a backup tape.

Note

You cannot restore files from backup tapes created on earlier versions
of the Avaya PDS.

Restore Avaya PDS Use the following procedure to restore the Avaya PDS from a backup
tape.

............................................................................................................................................................................

1 Locate the tape drive in the Avaya PDS cabinet.

............................................................................................................................................................................

2 Insert the backup tape containing the files to be restored.

............................................................................................................................................................................

3 Choose a restore command from the Back Up and Restore Avaya PDS
menu.

............................................................................................................................................................................

4 After the backup is complete, rewind and remove the tape.

............................................................................................................................................................................

5 Store the tape in an antistatic environment at the proper temperature and
humidity.
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Monitor DAT drive status

Overview You need to monitor the tape drive status during backup and restore
procedures. There are two LEDs on the tape drive. The LED on the left
is the cassette LED. The LED on the right is the drive LED. When the
Avaya PDS uses the tape drive, both lights flash in different color
combinations.

LED color These combinations identify the tape drive’s status.

Cassette LED
Color

Drive LED Color Status

Flashing green Flashing green Write-enabled tape loading
or unloading.

Green Green Write-enabled tape loaded
and online.

Flashing amber Flashing green Write-protected tape loading
or unloading.

Amber Green Write-protected tape loaded
and online.

Green Flashing green
and amber

Media wear. Replace tape or
clean tape drive.

Amber Amber High room humidity. Tape
cannot load or unload.

Flashing amber Flashing amber Successful power-on self-
test.

Flashing amber Amber Unsuccessful power-on self-
test. Contact your Avaya
PDS vendor.
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Back up a calling list

Overview Making a backup of your calling list allows you to keep working if
your host information becomes damaged. You can back up all calling
lists on the Avaya PDS or select specific calling lists to back up.

The records on a backup calling list remain in the Avaya PDS format,
not in your host computer format.

Back up a calling list Use the following procedure to backup a calling list.

............................................................................................................................................................................

1 Locate the tape drive in the Avaya PDS cabinet.

............................................................................................................................................................................

2 Insert a new DDS tape in the drive.

............................................................................................................................................................................

3 Choose a backup command from the Back Up and Restore Avaya PDS
Calling Lists menu.

............................................................................................................................................................................

4 After the backup is complete, rewind and remove the tape.

............................................................................................................................................................................

5 Store the tape in an antistatic environment at the proper temperature and
humidity.
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Restore a calling list

Restore a calling list If a calling list becomes unusable, you can restore a previously backed
up list. When you restore calling list data, the Avaya PDS writes over
all, same-named calling list data stored on the system. Be sure to print
reports, upload lists, or perform any other required procedures before
continuing.

............................................................................................................................................................................

1 Locate the tape drive in the Avaya PDS cabinet.

............................................................................................................................................................................

2 Insert a DDS tape with the backup calling list in the drive.

............................................................................................................................................................................

3 Choose a restore command from the Back Up and Restore Avaya PDS
Calling Lists menu.

............................................................................................................................................................................

4 Type Y at the prompt to continue or N to cancel.

............................................................................................................................................................................

5 After the restoration is complete, rewind the tape.

............................................................................................................................................................................

6 Remove the tape from the tape drive.
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13 System security event monitor

.............................................................................................................................................................................................................................................................
Overview

Purpose The purpose of this section is to provide information about monitoring.

Contents This section contains the following topics:

• Monitor security logs

• Use the system log monitor

• Change the monitor interval
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Monitor security logs

Overview Use the Monitor security log command to monitor security-related
system activity. The System Log Monitor, at a specified time interval,
continually checks the status of critical system and log files.
Specifically, the security monitor checks whether critical system files
have been modified since the last status check and whether the Avaya
PDS recorded particular events in the system audit and log files. Events
include users logging into and out of the Avaya PDS; changes to the
permissions, ownership, and content of sensitive system files; attempts
to log into restricted user accounts, and changes to the system date and
time.

The System Log Monitor displays results including the date and time of
the event, the event type, whether the event succeeded or failed, and
other event details such as the user name associated with the event. The
monitor also provides additional file information when the file has been
changed. For example, for the current and previous versions of a file,
the System Log Monitor lists the permissions, owner, group, file size,
and date and ti me stamps.

Note

The System Log Monitor tracks system events only when it is active.
Events that occur when the monitor is not running are not reported.
However, if you have ESP access to your Avaya PDS, it is possible to
identify security events that occurred while the monitor was not
running.
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Use the system log monitor

Use the system log monitor Use the following procedure to use the system log monitor.

............................................................................................................................................................................

1 To start the System Log Monitor, choose Monitor security log from the
System Log Monitor main menu. At a specified interval, the monitor
updates the screen with information about targeted events.

............................................................................................................................................................................

2 To close the System Log Monitor, type X, then press Enter.
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Change the monitor interval

Overview The System Log monitor checks system files and log files at regular
intervals, for example, every 60 seconds. The Change Monitor refresh
interval command lets you change the interval setting to increase or
decrease the monitor’s update frequency.

You can set the interval to any positive whole number. Recommended
settings are between 15 and 300 seconds.

After you type and confirm a new refresh interval, the Avaya PDS
automatically starts the System Log Monitor.

Change the monitor
interval

Use the following procedure to change the monitor interval.

............................................................................................................................................................................

1 From the System Log Monitor main menu, choose Change Monitor
refresh interval. The Additional Entry for Change Monitor refresh
interval screen appears.

............................................................................................................................................................................

2 Type a new refresh interval, in seconds, then press Enter.

............................................................................................................................................................................

3 At the Are above entries correct prompt, type Y for yes or N for no.



............................................................................................................................................................................................................................................................

Part III: Agent Blending



............................................................................................................................................................................................................................................................



1 4 - 3 2 3

............................................................................................................................................................................................................................................................

14 Agent Blending

.............................................................................................................................................................................................................................................................
Overview

Purpose The purpose of this section is to provide procedural information
regarding CUI agent blending. For a thorough discussion of agent
blending, please refer to the Avaya PDS Installation Planner.

Contents This section contains the following topics:

• Agent Blending menus

• Exit a Menu

• Control Predictive Blend

• Modify domain groups

• Modify Service Level domain groups

• Modify Average Speed to Answer domain groups

• Modify Outbound only groups

• Modify domain group optional fields

• Modify control methods

• Delete domain groups

• Display groups

• Control and monitor domains

• Delete a domain

• Monitor a domain
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• Display system alerts

• Change extensions

• Add extensions

• List extensions

• Delete extensions
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Agent Blending menus

Agent blending menu Choose Predictive Blend from the Supervisor Main Menu. The
following screen appears.

The top of the screen contains the menu bar. Below the menu bar is the
information line which gives a brief description of the active menu
item. The bottom of the screen displays a line of additional help, such
as how to choose a command or a message responding to an action.
You can make the menu bar active from any Predictive Blend screen by
pressing Ctrl+X or F1. When the menu bar is visible, you are in menu
mode. When it isn’t visible, you are in edit mode.

To choose menu
commands

Some menu commands have shortcut keys listed in the right column.
Use these keys when you are in menu mode, without the menu open.
The drop-down menus list the shortcut keys in the column on the right.
Use these keys when you are in menu mode, with the menu open. For
example, F3 starts Predictive Blend and Ctrl+Y quits the menu. You do
not have to press Enter after choosing a shortcut key.
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Exit a Menu

Exit a menu Use the following procedure to exit a menu.

............................................................................................................................................................................

1 To exit a drop-down menu, press Ctrl+X.

............................................................................................................................................................................

2 To exit the main menu, press Q and press Enter.
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.............................................................................................................................................................................................................................................................
Control Predictive Blend

Control Predictive Blend Choose Admin from the Predictive Blend menu to stop, start, and reset
Predictive Blend, as well as to resynchronize blend agents (Meridian 1
only). The Admin menu appears.

Stop predictive blend Choose Stop Predictive Blend from the Admin menu to make
configuration changes such as installing ACD hardware or performing
other maintenance. Agents continue to make and receive calls, but the
system cannot acquire or release agents. When you restart Predictive
Blend, the system starts accumulating new statistics on call
performance.

Note

Stopping Predictive Blend does not affect other processes running on
the system.

It is not necessary to stop Predictive Blend to change domain group
parameters, such as adding domains and domain groups. These changes
take effect immediately. However, when you delete domains and
domain groups, you must reset Predictive Blend for the changes to take
effect.

Start Predictive Blend Choose Start Predictive Blend from the Admin menu to restart
Predictive Blend. The system starts accumulating new statistics on call
performance.
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Reset predictive blend Choose Reset Predictive Blend from the Admin menu to stop
Predictive Blend and immediately restart it. Use this command to
update the system after deleting domains and domain groups and start
accumulating new statistics.

This command has the same effect as choosing Stop Predictive Blend,
then choosing Start Predictive Blend.

Resynchronize agents (For Meridian systems only)

Choose Resynch Agents from the Admin menu to update the ACD
agent queue assignments. Use this command after you reassign agents
to different domains.

Control and monitor
domain groups

Use commands on the Domain Group menu to create and modify
domain groups. Because there are innumerable variables in the calling
environment, including agent availability and talk time, it is impossible
to ensure that the settings are absolutes. Use them as goals.

Choose Domain Group from the Predictive Blend menu. The Domain
Group menu appears.

Domain group control
methods

Predictive Blend manages agents within each domain group based on a
control method you choose. The three control methods are:

• Average Speed to Answer (ASA)

• Service Level (SL)

• Outbound-only (OB_ONLY)

A blend domain group blends inbound and outbound calling. It uses
either the ASA or SL control method. Each control method has an



Agent Blending

1 4 - 3 2 9

............................................................................................................................................................................................................................................................

associated set of parameters, which the system supervisor specifies
during calling operations.

An outbound-only domain group uses the OB_ONLY control method.



1 4 - 3 3 0

...........................................................................................................................................................................................................................................................

Agent Blending

.............................................................................................................................................................................................................................................................
Modify domain groups

Overview Although changes to domain group settings take effect immediately, it
may take some time before you see the results of your modifications.
Allow at least 30 minutes before you readjust them.

Warning

It is possible to cause Predictive Blend to malfunction if you set the
parameters incorrectly. If you have any doubt about settings, please
talk to your ACD programmer or your system vendor.
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Modify Service Level domain groups

Modify Service Level
domain groups

Use the following procedure to modify Service Level domain groups.

............................................................................................................................................................................

1 Choose Modify SL Group from the Domain Group menu. The screen
appears with all SL domain groups listed.

............................................................................................................................................................................

2 Move to the field that you want to modify and make your changes, or
move to the last line and add a domain group.

............................................................................................................................................................................

3 Press Ctrl+X to exit.
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Modify Average Speed to Answer domain groups

Modify Average Speed to
Answer domain groups

Use the following procedure to modify Average Speed to Answer
domain groups.

............................................................................................................................................................................

1 Choose Modify ASA Group from the Domain Group menu. The screen
appears with all ASA domain groups listed.

............................................................................................................................................................................

2 Move to the field that you want to modify and make your changes, or
move to the last line and add a domain group.

............................................................................................................................................................................

3 Press Ctrl+X to exit.
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Modify Outbound only groups

Modify Outbound only
groups

Use the following procedure to add groups to the Outbound only
domain group.

............................................................................................................................................................................

1 Choose Modify OB_ONLY Group from the Domain Group menu. The
screen appears with all OB_ONLY domain groups listed.

............................................................................................................................................................................

2 Move to the last line and add the new domain.

............................................................................................................................................................................

3 Press Ctrl+X to exit.
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Modify domain group optional fields

Modify domain group
optional fields

Edit a domain group’s three optional fields: initial Traffic Rate,
minimum Talk Time, and minimum After Call Work Time.

............................................................................................................................................................................

1 Choose Modify Domain Group Optional Fields from the Domain
Group menu. The screen appears with all domain groups listed.

............................................................................................................................................................................

2 Move to the field that you want to modify and make your changes.

............................................................................................................................................................................

3 Press Ctrl+X to exit the screen. A confirmation prompt appears.

............................................................................................................................................................................

4 Press Enter to accept Yes or press Tab to move to Cancel and press
Enter.
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Modify control methods

Modify control methods Use the following procedure to modify control methods.

............................................................................................................................................................................

1 Choose Modify Control Method from the Domain Group menu. The
screen appears with all the domains listed.

............................................................................................................................................................................

2 Use the down arrow to move to the domain you want to change and press
Enter. The Select a Control Method screen appears. To leave the screen
without making a change, use Tab to move to Cancel and press Enter.

............................................................................................................................................................................

3 Use the down arrow to move to the method you want to use and press
Enter. The Modify screen appears.

............................................................................................................................................................................

4 Enter settings as appropriate for your ACD. (See the Avaya Predictive
Dialing System Installation Planner for information about specifying
each ACD supported by the system.)

............................................................................................................................................................................

5 Press Ctrl+X to exit the screen. A confirmation prompt appears.

............................................................................................................................................................................

6 Press Enter to accept Yes or press Tab to move to Cancel and press
Enter.
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Delete domain groups

Delete domain groups Deleting a domain group takes effect only after you restart Predictive
Blend using the Reset Predictive Blend command on the Admin menu.

............................................................................................................................................................................

1 Choose Delete Group from the Domain Group menu.

............................................................................................................................................................................

2 Choose the group to delete from the list of domain group names.

............................................................................................................................................................................

3 Press Enter to accept Yes or press Tab to move to Cancel and press
Enter.

............................................................................................................................................................................

4 Choose Reset Predictive Blend from the Admin menu for your changes
to take effect.
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Display groups

Display Service Level (SL)
Groups

Choose Display SL Group from the Domain Group menu to view
current settings for all SL groups. The SL Domain Groups screen
displays the status of the following fields:

• Time Interval

• Service Criteria

• Desired Service Level (DSL)

• Abatement Service Level (ASL)

• Minimum Agents on Outbound

Display Average Speed to
Answer (ASA) Groups

Choose Display ASA Group from the Domain Group menu to view
current settings for all ASA groups. The ASA Domain Groups screen
displays the status of the following fields:

• Time Interval

• Control Method

• Average Speed to Answer (ASA)

• Traffic Intensity

• Minimum Agents on Outbound

Display Outbound-Only
(OB_ONLY) Groups

Choose Display OB_ONLY Group from the Domain Group menu to
view a list of all OB_ONLY groups.

Display Group Optional
Fields

Choose Display Group Optional Fields from the Domain Group
menu to view the Traffic Rate, Talk Time, and After Call Work Time
for all jobs.

Display ACD Statistics Choose Display Statistics from the Domain Group menu to view the
Performance, Acquisitions, and Releases for all jobs.

Performance is the average answer delay (Service Level).

Releases are the number of completed releases that the system
requested. It does not include releases caused by the agent ending the
acquired call or the agent logging off of the system. If the domain is
outbound only, the releases represent the number of agents that have
logged off or hung up on an acquired call.
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Control and monitor domains

Control and monitor
domains

Choose Domain from the Predictive Blend menu. The Domain menu
appears.

Use these commands to create or delete domains and view domain
activity.

Acquire domains can belong to one or more domain groups, or they
may be floating acquire domains that don’t belong to any domain group
(Meridian 1 only).

Create domains New domains take effect immediately. To create a domain, choose
Create Domain from the Domain menu.
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Delete a domain

Delete a domain Deleting a domain does not take effect until you restart the Predictive
Blend system using the Reset Predictive Blend command on the Admin
menu.

............................................................................................................................................................................

1 Choose Delete Domain from the Domain menu.

A box appears with a list of all domains.

............................................................................................................................................................................

2 Use the down arrow to choose the domain to delete.

............................................................................................................................................................................

3 Press Enter.

............................................................................................................................................................................

4 Choose Reset Predictive Blend from the Admin menu for the changes
to take effect.
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Monitor a domain

Monitor a domain Use the following procedure to monitor a domain.

............................................................................................................................................................................

1 Choose Display Domain from the Domain menu to see a list of all
domains.
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Display system alerts

Display system alerts Choose Alerts from the Predictive Blend menu and the Alerts menu
appears.

Press Enter and all system alerts for the calling day appear on the
screen.
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Change extensions

Change extensions Choose Extensions from the Predictive Blend menu to add, list, and
delete ACD extensions.
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Add extensions

Add extensions Use the following procedure to add an extension.

............................................................................................................................................................................

1 Choose Add from the Extension menu to add an ACD extension.

............................................................................................................................................................................

2 Type an SCAI Link ID and press Tab to move to the next column.

............................................................................................................................................................................

3 Type an Extension number and press Tab.

............................................................................................................................................................................

4 Press Ctrl+X to exit.



1 4 - 3 4 4

...........................................................................................................................................................................................................................................................

Agent Blending

.............................................................................................................................................................................................................................................................
List extensions

List extensions Use the following procedure to list extensions.

............................................................................................................................................................................

1 Choose List from the Extension menu to display a list of ACD
extensions.

............................................................................................................................................................................

2 Press Ctrl+X to return to the Predictive Blend menu.
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Delete extensions

Delete extensions Use the following procedure to delete extensions.

............................................................................................................................................................................

1 Choose Delete from the Extension menu.
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Preventing Toll Fraud

Toll Fraud is the unauthorized use of your telecommunications system by an unauthorized party
(for example, a person who is not a corporate employee, agent, subcontractor, or working on
your company's behalf). Be aware that there is a risk of toll fraud associated with your system
and that, if toll fraud occurs, it can result in substantial additional charges for your
telecommunications services.
Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical assistance or
support, call the Technical Service Center's Toll Fraud Intervention Hotline at 1-800-643-2353.
Providing Telecommunications Security

Telecommunications security of voice, data, and/or video communications is the prevention of
any type of intrusion to, that is, either unauthorized or malicious access to or use of, your
company's telecommunications equipment by some party.

Your company's "telecommunications equipment" includes both this Avaya product and any other
voice/data/video equipment that could be accessed via this Avaya product (that is, "networked
equipment").

An "outside party" is anyone who is not a corporate employee, agent, subcontractor, or working
on your company's behalf. Whereas, a "malicious party" is Anyone, including someone who may
be otherwise authorized, who accesses your telecommunications equipment with either malicious
or mischievous intent.

Such intrusions may be either to/through synchronous (time multiplexed and/or circuit-based) or
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The final responsibility for securing both this system and its networked equipment rests with you
- an Avaya customer's system administrator, your telecommunications peers, and your
managers. Base the fulfillment of your responsibility on acquired knowledge and resources from
a variety of sources including but not limited to:

Installation documents

System administration documents

Security documents

Hardware-/software-based security tools

Shared information between you and your peers

Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your peers should
carefully program and configure your:

Avaya provided telecommunications system and their interfaces

Avaya provided software applications, as well as their underlying hardware/software platforms
and interfaces

Any other equipment networked to your Avaya products
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at his own expense.

Part 68: Network Registration Number. This equipment is registered with the FCC in accordance
with Part 68 of the FCC Rules. It is identified by FCC registration number AV1USA-28011-MA-T.
Refer to "Federal Communications Commission Statement" in "About This Book" for more
information regarding Part 68.
Canadian Department of Communications (DOC) Interference Information

This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the
radio interference regulations of the Canadian Department of Communications.

Le Présent Appareil Nomérique n'émet pas de bruits radioélectriques dépassant les limites
applicables aux appareils numériques de la class A préscrites dans le reglement sur le brouillage
radioélectrique édicté par le ministére des Communications du Canada.
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GUI versus CUI
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GUI applications

Name Tasks

Campaign Editor Create record selections, phone strategies, and jobs.

Campaign Monitor Manage and monitor jobs and agents.

Campaign Analyst Report on jobs, agents, and dialers.

Hierarchy Manager Manage agent, job and dialer hierarchies.

Completion Code Manager Modify some completion code setting.

Blend Manager Modify blend settings.

Telnet/FTP Connect to the CUI.

CUI applications

Name Tasks

System Menus Used for routine tasks - duplicates much of the functionality
usually accomplished in the GUI applications.

Administrator Menus Used for system administration tasks, such as creating and
editing user logins, system backups and system reboots.

  Copyright© 2002 Avaya Inc.
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 Additional resources

Your instructor will demonstrate the tasks you need to perform using the supervisor menu. The new
NIS+ feature automatically duplicates user logons and passwords on every dialer in the pod. Any user
only needs to be added to one dialer in order to be able to log onto any dialer.

You can find additional information about these tasks, and related discussions, at the following links.

System Telnet supervisor menu Overview Procedure

Overview System Telnet

Logging in to the Avaya PDS

Counting Calling List Records

Download verification

Add user accounts

Record edit  

Job monitor

Campaign Update  

Mark Records Do Not Call  
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 Additional resources

Your instructor will demonstrate the Hierarchy Manager and Completion Code Manager briefly. These
can have an important role in preparation, but are discussed later in this class in more detail.

Completion Code Manager Overview Procedure

Overview of Completion Code Manager

Start Completion Code Manager  

Set a Completion Code as RPC

Set a Completion Code as Closure

Set a Completion Code as a Abandon

Change completion Code description  

Hierarchy Manager Overview Procedure

Overview of Hierarchy Manager  

Create a hierarchy

Open a hierarchy  

Adding levels to Hierarchies

Adding data items to hierarchies

Moving levels within hierarchies

Blend Manager Overview Procedure

Blend Manager  
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Avaya PDS Agent
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The Avaya PDS Agent application is a simplified customer contact agent application designed for those
customers who need a basic tools for agents to use with the Avaya PDS. This application is not included
in the Beta release of the Avaya PDS. Customers will have a choice between using the Avaya PDS Agent
application, Vlterm, or a variety of other agent applications that can be integrated with the Avaya PDS.

 Additional resources

Avaya PDS Agent Overview Procedure

Overview of Avaya PDS Agent  

Using the Avaya PDS Agent

Avaya PDS Agent
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Menu exercise
March 2002

Complete the exercise found in your Student Workbook.
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Supervisor main menu

Supervisor Main menu

Supervisor menus contain commands for managing the agents by assigning their login and
permission levels, monitoring their calls, and sending them messages. They also include
options that determine how the Avaya PDS uses your phone lines, and which records the
system calls. In addition, they provide a full reporting capability so you can keep track of
your calling activities.  
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Count calling list records

Overview

Use this option to display the number of records in your calling lists, the lists' creation dates,
and the amount of unused disk space (in kilobytes). You can use this information to confirm
that you received new lists. For example, if list1 is the same size as list1.old, you may not
have received a new list in the last download period.  

In addition, the number of records in a list can help you determine how many agents you'll
need to reach your campaign goal.  

Count Calling List Records

If you need more information about the contents of a list, use list distribution reports.  

Choose Count calling list records from the Calling Lists and Users menu.1.  

The Calling Lists screen appears. It displays all the calling lists and the number of records in
each list.  

Press Ctrl+X followed by Ctrl+N to return to the Calling Lists and Users menu.2.  
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Downloads

Downloads

All file transfers on the Avaya PDS platform are controlled by a series of scripts. These
scripts allow automatic processing of the transfer method when invoked by the crontab (an
automatic scheduler for HP-UX) or by manual control when invoked from a menu.
Transfers to the Avaya PDS are called downloads. Transfers from the Avaya PDS are called
uploads.  

Test Downloads During Configuration

At least four weeks before the scheduled Avaya PDS installation, send your Avaya PDS
representative a sample file of customer data. Include a printout of each file. After
configuring your Avaya PDS, your vendor uses the sample data to test your system by
simulating calling operations.  

Use the following guidelines to create one sample file for each record format you use:  

Include a minimum of 250 actual or simulated host records in ASCII or EBCDIC
format.

●   

If you use simulated records, assign unique account and telephone numbers to each
record.

●   

Include a range of host customer data rather than repeating one record.●   

Don't use packed or signed fields.●   

Don't include record headers or trailers.●   

Test the Upload Process at Your Site

Upon your request, your Avaya PDS representative will send you sample upload files. Use
these files to test the script that updates the host database with the Avaya PDS data.  
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Add user accounts

Overview

Use the following guidelines when creating user accounts:  

User Name (also called login ID) should contain at least three but not more than eight
alphanumeric characters. It's recommended that you use a letter as the first character
of a user name. User names cannot contain spaces or special characters.

●   

Password should contain from six to eight characters. Passwords should contain at
least two letters and one numeric or special character. Also, the password should not
be the same as the user name or a variation of the user name.

●   

Group for Login The name of the group to which the user belongs.●   

Description (optional) Not more than 30 characters and spaces.●   

Add user accounts

Use the following procedure to add a user account:  

Choose Manage user accounts from the Calling Lists and Users menu. The Manage
User Accounts screen appears. The system lists the commands on the bottom of the
screen.

1.  

Press Ctrl+L (Login).2.  

Type the user name, password, group (agent, system, cdwanal), and an optional
description. Both user names and passwords are case sensitive.If you create a user
name using lowercase letters, the user must type lowercase letters when logging in.

3.  

Press Enter after you complete the last line. The system rewrites the screen and
encrypts the password.

4.  

Press Ctrl+X (Exit).5.  

Type Y to save the changes or N to abandon them.6.  
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Record Edit

Overview

Record Edit allows you to access and edit a customer record within a calling list. Use the
Record Edit menu to view a calling list record, change the contents of a field in an outbound
calling list, or delete a record. Use Record Edit when you do not have access to the person's
account on your host computer. If you upload data to the host computer, the changes are
included in the upload. On some systems, the system uploads the changes to the host
computer each night.  

Many companies use Record Edit to correct a call completion code when an agent entered
an incorrect code. Record Edit is also useful to mark records that you do not want contacted
during the current job.  

The menu shows two ways to edit and delete records: standard search and Quick Search.
Not all systems have both methods. The procedures for the two methods are similar except
Quick Search finds the record faster. Quick Search is an indexed method that searches on a
specific field. To use Quick Search, you need to know the exact information for the indexed
field, and the search must return an exact match.  

You may have several fields available for standard search. (The fields were specified during
the system configuration.) An advantage to standard search is the ability to use wild cards.
For example, if you are unsure about the spelling of a name, you can search using the
asterisk (*). An input of Wil* returns Williams, Williamsons, Willis, and so on.  

Shortcut keys

Use the following shortcut keys when editing calling list records.

Actions Keys

Done  F1  

Search for a record  F10  

Delete a record  Esc,D  

Undelete a record  Esc,U  

 

Record Edit 
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Overview of job monitor

Job monitor

Choose Manage an active job from the Supervisor Main Menu. The job monitor appears.  

The top of the screen contains the menu bar. Below the menu bar is the  

information line which gives a brief description of the active menu item. The bottom of the
screen displays a line of additional help, such as how to choose a command or a message
responding to an action.  

You can make the menu bar active from any screen in Job Monitor by pressing Ctrl+X or
F1. When the menu bar is visible, you are in menu mode. When it isn't visible, you are in
edit mode.  

To choose a menu command

Some menu commands have shortcut keys listed in the right column. Use these keys when
you are in menu mode, without the menu open. For example, F4 opens the Phone Lines
command.  

To exit a menu

To exit a drop-down menu, press Ctrl +X.  

To exit the main menu, press Q and press Enter.  
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Campaign Update

Overview

Use outbound Campaign Update to cancel a scheduled outbound call. This command marks
a record as uncallable when an inbound call has come in from a customer whose record may
be included in an outbound list. This is similar to deleting a record, except the system enters
a C instead of an E in the STATUSFLAG field.  

Outbound Campaign Update works with one outbound calling list. To use this feature with
more than one outbound calling list, contact your system vendor.  

If you have an Intelligent Call Blending system, the system automatically enters a C in a
record's STATUSFLAG field, canceling the call, when an agent releases the inbound call
with the appropriate code. (See your call completion codes list for the codes used on your
system.)  

Campaign Update

If you have an Agent Blending system, the system updates all records at a predefined time,
or you can perform the update manually using the following procedure.  

Choose Campaign Update from the Record Edit menu.1.  

Type the calling list number to update and press Enter.2.  

Type the search criteria (for example, account number or phone number). Then press
F10 to search for the record.

3.  

A message appears if there are no matching records. If the system finds a match, it
enters a C in the STATUSFLAG field.

4.  
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Mark records as Do Not Call

Overview

Use mark calling list records as DO NOT CALL to tell the sAvaya PDS not to call specific
customers. After you mark a customer record, the system immediately searches the
outbound calling lists specified in the Do Not Call group and marks all the customer's
records. The system will not call a customer during any job if the customer's record is
marked as do not call.  

Mark records as do not call

Use the following procedure to mark records as DO NOT CALL.  

Choose Mark calling list records as DO NOT CALL from the Calling Lists and Users
menu. The Do Not Call menu appears.

1.  

Choose Mark DNC Group.2.  

Type the item number for the Do Not Call group.3.  

Type Y at the prompt to confirm your choice or N to cancel. The Set DO NOT CALL
Status screen appears, which displays the selected group's unique identifier.

4.  

In the screen field, type the specific value for the customer whose record you want to
mark as Do Not Call.

5.  

Press Enter.6.  

Repeat steps 5 and 6 for each record you want to mark as Do Not Call.7.  

Press Ctrl+X to exit the Set DO NOT CALL Status screen.8.  
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Planning
March 2002

Module contents

CLC activity

Quiz

Objectives
At the end of this module you will be able to:

Describe the Campaign Life Cycle and understand the purpose of each component●   

Identify which Campaign Director software application is used in each of the Campaign Life
Cycle phases

●   
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Menus quiz - update
March 2002

The two CUI menus on the Avaya PDS are:  Where can you verify your download?
 System and Manager

 System and Administrator

 Administrator and Supervisor

  There is only one menu

  System menu under Manage User Accounts

 Administrator menu under back up

 System menu under Count Calling List

 Administrator menu under Administrative Tasks

  
When adding users, each name must be  What is option #1 on these CUI menus?

 Lower case letters only

 alphanumeric

 numeric only

 a unique name

  Edit

 Copy

 Create

 Help
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) also contains Supervisor menus that help
you manage your calling activities.  

Contents

This section contains the following topic:  

Supervisor main menu●   
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Campaign overview
To see topics for this section, click + in the contents list at left.
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Calling list

Overview

After the customer records are downloaded from the host, the system adds several fields to
each record to help track calling results. After the system adds the fields, it may check for
and reject duplicate records and uncallable phone numbers. This process depends upon your
system configuration. The system refers to the modified records as the calling list. To use
the calling list and users commands, choose Calling lists and users from the Supervisor
Main Menu.  

The following table describes some typical added fields. You can see a complete list of all
the calling list fields for your system by pressing F4 or Ctrl+V (View) when the cursor is in
a calling list field on a screen.

Field name Description

COUNTER  
Record attempt counter. Number of times the system called the
record.  

AGENT  The agent who handled the call.  

DTE  The date of the last attempt on the record.  

TME  The time of the last attempt on the record.  

CODE  Call completion code.  

STATUSFLAG  

The status of the record. If blank, the record is available for calling.  

B = all bad numbers; the Reject Report lists the records rejected by
the system because the system could not match them to a time zone or
the number was not callable (bad number).  

C = received inbound call from account; so cancelled outbound call  

D = maximum days on the system  

E = manually deleted in Record Edit  

R = repeated (duplicate) account  

T = time zone could not be determined  

Calling list 
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DAYSCNT  

Days on the system calling lists (optional). The number of days a
record has been on the system. The Days on the System Report lists
accounts that the system has downloaded for a certain number of days.
 

ENTRYDATE  The date a record was first downloaded.  

ZONEPHONE#  

The time zone stamp of a phone number. (For example, Pacific,
Mountain.) The system calls a record only during the recommended
calling time for that record's time zone. The system determines time
zoning by the area code plus the phone number prefix.  

DUPE  

Indicates a duplicate record. The system can reject a record because
there are two or more records in the calling list with the same phone
number or account number, or any other field that you choose for
duplicate checking.  

During system configuration, you choose whether you want to do
duplicate checking, and if so, on which fields. The system lists these
duplicate records on the Reject Report. Duplicate checking adds time
to the processing time, but it eliminates unnecessary calls.  

An * in DUPE field tells you that there are duplicate records. The
system places an R in the STATUSFLAG field of the second, third,
and subsequent records to show that they are repeated records and
won't be called.  
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User accounts and permission levels

User accounts

Use manage user accounts to add or delete users and set or change their access to the
system. A user account consists of the user name, password, and permission level. The
systemsystem determines the permission level based on the group you assign to the user.
The permission level determines a user's access to system features. For example, you
usually assign agents to the Agent group, which grants permission to the Agent Main Menu
where they have access only to call handling; you assign system administrators to the
system group, which grants permission to the Administrator Main Menu, giving them access
to the system maintenance functions.  

Permission levels

The following table lists typical user levels, menu file names, and the corresponding system
menus.

User type Group name Menu name

agent  agent  Agent Main Menu  

supervisor  system  Supervisor Main Menu  

analyst  cdwanal  PC Analysis main menu  
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Download host records to the Avaya PDS

Use the following procedure to download host records to the Avaya PDS.  

At the Administrator workstation, choose Download host records to PDS from the
Transfer and Process Records menu.

1.  

Type Y at the prompt to continue or N to cancel. The host transmits the calling list
records to the Avaya PDS.

2.  
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Upload the Avaya PDS records to a host
computer

Overview

The Avaya PDS can operate independently of your host computer to protect your calling
operations. After operating in no-host mode, you need to upload the system's data to your
host computer system.  

Upload the Avaya PDS records to a host computer

The Avaya PDS sites where agents directly update the host customer database do not need
to upload data files to the host computer regularly. These call centers use uploads after the
system resumes operations when the host is down or inaccessible..  

Choose Upload records to host from the Transfer and Process Records menu.1.  

Type Y at the prompt to continue or N to cancel. The Avaya PDS transmits the
calling list records to the host computer.

2.  
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Delete user accounts

Delete user accounts

Use the following procedure to delete user accounts:  

Choose Manage user accounts from the Calling Lists and Users menu. The Manage
User Accounts screen appears.

1.  

Press Ctrl+F (Find).2.  

Type the user name for the account you want to delete. The matching account appears
on the screen.

3.  

Press Ctrl+D (Delete).4.  

Type Y at the prompt to confirm the deletion or N to cancel.5.  

Press Ctrl+X (Exit).6.  

Type Y to save the changes or N to abandon them.7.  
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Edit user accounts

When editing an account, make sure the user is not logged into the system. You can change
the password, login group, and description but not the user's name. To change the user's
name, delete the old account, then add a new user account.  

Choose Manage user accounts from the Calling Lists and Users menu. The Manage
User Accounts screen appears.

1.  

Press Ctrl+F (Find).2.  

Type the user's name for the account you want to change. The matching account
appears on the screen.

3.  

Move the cursor to the field you want to change and press Ctrl+C (Change).4.  

Type the changes and press Enter after each change.5.  

Press Ctrl+X (Exit).6.  

Type Y to save the changes and exit or N to cancel and exit.7.  
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Edit a record

Edit a record

Use the following procedure to edit a record.  

Choose Record Edit from the Calling Lists and Users menu.1.  

Choose Edit a record or Edit a record with Quick Search.2.  

Type Y at the prompt to continue or N to cancel.. The Record Search Criteria screen
appears.

3.  

Type the search values in the screen field(s). (Quick Search screens have only one
field.)

4.  

Press F10 (Search). If the systemsystem cannot find a match, the Record Search
Criteria screen reappears. Type different criteria and press F10 (Search). If the system
finds a match, the record appears on your screen. To see if there is more than one
match, press F10 (Search) again.

5.  

Use the arrow keys to move to the field you want to change.6.  

Press Ctrl+C (Change) and type your changes.7.  

Press F1 (Done) to save your changes or Ctrl+X to abandon them. The system
prompts you to confirm the command.

8.  

Press Y to save the changes or N to abandon them.9.  

Press Ctrl+X to return to the Record Search Criteria screen.10.  
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Overview

Purpose

This section describes the how active jobs are managed.  

Contents

This section contains the following topics:  

Overview of job monitor●   

Open a job●   

Close a job●   

Remove agents●   

View job statistics●   

View completion codes●   

View phone line usage●   

View call types●   

View agent screens●   

Agents on active jobs●   

Send a message to an agent●   

Send a message to all agents●   

Control jobs●   

Shut down a job●   

Stop a job immediately●   

Link a job●   

Monitor agents●   

Transfer agents to another job●   

Change phone line allocations●   

Change maximum time a customer waits●   

Change maximum % of client in queue●   

Change blend agent return time●   

Overview 
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Job settings●   

Change Minimum Hit Rate●   

Change Expert Calling Ratios●   

Change Managed Dialing settings●   

Change cancel mode●   

Change time zone ordering●   

Change time zone status●   

Unit Work List settings●   

Set different quotas for each Unit Work List●   

Change Unit Work List controls●   

Change phone strategy detection mode●   

Change phone strategy recall parameters●   

Change phone strategy alternate phone lines●   

Analyze Job Activity Screens●   

Agent Activity Fields●   

Line Usage Fields●   

Calling activities fields for outbound calls●   
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Open a job

Oveview

Managing a job begins with opening the job you want to manage. Use the Jobs menu to
open and close jobs. All tasks on the Job Monitor menus are job related. If you try to use a
command without selecting a job, the Avaya PDS will not complete the action. The system
does not display an error message.  

Open jobs

Use the following procedure to open jobs.  

Open the Job menu.1.  

Choose Open Job from the Jobs menu. A list of all active jobs appears. (If there is
only one active job, the Avaya PDS automatically opens

2.  

Use the down arrow to choose the job you want to manage. A Job Activity Summary
Statistics screen appears.

3.  

Use the Job Activity Summary Statistics screen to monitor job status. Press Tab to cycle
through three additional screens: Call Completion  

Code Results, Phone Line Usage, and Line Usage for All Lines on All  

Jobs.  
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Restore a deleted record

Use the following procedure to restore a deleted record:  

Choose Record Edit from the Calling Lists and Users menu.1.  

Choose Delete a record or Delete a record with Quick Search.2.  

Type Y to continue or N to cancel.3.  

If the system has more than one calling list, type the calling list number and press
Enter. (If your system has only one calling list, the system skips this step.) The
Record Search Criteria screen appears.

4.  

Type the search values in the screen field.5.  

Press F10 (Search). If the systemsystem cannot find a match, the Record Search
Criteria screen reappears. Type different criteria and press F10 (Search). If the system
finds a match, the record appears on your screen. To see if there is more than one
match, press F10 (Search) again.

6.  

When the record appears, press Esc,U (Undelete). The system removes the E from the
STATUSFLAG field.

7.  

Press F1 (Done) and press Ctrl+X.8.  
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Create an outbound Campaign Update report

Use the following procedure to create a Campaign Update report.  

Choose Record Edit from the Calling Lists and Users menu.1.  

Choose Create Outbound Campaign Update Rep from the Record Edit menu.2.  

Type a date in the format CCYYMMDD. For example, type 19990921 for September
21, 1999. A message appears confirming the report generation. Use the Reports menu
to view or print the report.

3.  
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Manage active jobs
To see topics for this section, click + in the contents list at left.
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Campaign Life Cycle activity
March 2002

Complete the exercise found in your Student Workbook.
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CLC quiz
March 2002

The Implementation phase uses which Avaya
PDS application most?

 The Evaluation phase uses which Avaya PDS
application most?

 Agent Monitor

 Campaign Monitor

  Campaign Analyst

  Hierarchy Manager

  Campaign Analyst

 Completion Code Manager

 Blend Manager

 Hierarchy Manager

  
Which phase uses Campaign Monitor the most?  In which phase do you create phone strategies?

 Implementation

 Sustaining

mid tier

 Planning

  Development

 Planning

 Evaluation

 Implementation
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Implementation
March 2002

Module Contents

Campaign Editor

Phone strategies

Record selections

Jobs

Completion Code Manager

Campaign Editor activity
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Campaign Editor
March 2002

Use Campaign Editor to create phone strategies, record selections and jobs. There are three different
displays available: jobs, selections, and strategies.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Campaign Editor Overview Procedure

Campaign Editor  

Enable/disable multi-dialer features  
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Campaign Editor

http://pds.au.avaya.com/esp/mos12/Redtrain/UsingPDS/Imp/100.html [4/5/2002 3:26:35 PM]

javascript:Docs/CD_Help/Editor/ed_settings_multidialer.html')
http://www.avaya.com/


  

Phone strategies
March 2002

A phone strategy tells the Avaya PDS when and how to call clients, which client phone number to call,
and the frequency of those calls.

The Avaya PDS applies the criteria and settings specified in the phone strategy to the calling list records.

Following are parameters defined in a phone strategy:

Which phone number to call first●   

The number of rings to allow before disconnecting●   

The time to wait before re-trying a phone number that was busy, unanswered, or disconnected●   

The phone number to call if the first phone number is unanswered●   

The number of times to retry a busy phone number●   

The number of times to call a phone number before switching to an alternate phone number●   

The types of calls to be passed to an agent, when the Avaya PDS detects an answer●   

Tip

You must create your phone strategies first because you will need to assign specific strategies when
setting up your record selections. Once you have designed an effective phone strategy you can re-use it
on all calling campaigns with similar characteristics.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Phone strategy Overview Procedure

Phone strategy  

Phone strategy preparation

Phone strategy settings  

Create a phone strategy
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Record selections
March 2002

A record selection contains the set of instructions that tells the Avaya PDS which customer records to
select from a calling list. Record selections allow supervisors to define the criteria for selecting records
and target specific customers to be called during a job. Record selections consist of selection criteria and
a phone strategy. Each job uses a record selection and a phone strategy to call customers.

Record selection chooses records based on the following criteria:

Calling list fields●   

Time zones●   

Previous calling results●   

Agent set recalls●   

Unit work lists●   

Phone strategy●   

You assign a phone strategy to a record selection so that the Avaya PDS knows how to place the calls
that are selected.

Before you start a job, you must run a record selection to identify the records that will be called during
the job.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Record selection Overview Procedure

Record selection

Record selection organization

Record selection wildcards

Create a record selection

Run a record selection
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Jobs
March 2002

Jobs are part of campaign. A job, depending on what type of system configuration you have, can make
outbound calls, receive inbound calls, verify a sale, or a variety of other tasks.

If you have an Intelligent Call Blending system, you can use Campaign Editor to set up three types of
jobs:

Outbound jobs●   

Inbound jobs●   

Blend jobs●   

If you have an Agent Blending system, you can use Campaign Editor to set up outbound jobs. There are
various types of outbound jobs.

 Additional resources

Use the following links would take you to the relevant material in the online Avaya PDS User's Guide.

Jobs Overview Procedure

Jobs Overview

Job settings

Job Types

Create a job
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Completion Code Manager
March 2002

The Completion Code Manager allows you to categorize one or more completion codes as either right
party connects (RPCs), abandons, or closures.

For each code, enter a description, and designate it as an RPC, Closure, or Abandon. You can view
reports via Monitor and Analyst to view the percentages of these three codes.

Right party connects, abandons and closures account for a percentage of all the calls the dialer considers
as “answered”.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Completion Code Manager Overview Procedure

Overview of Completion Code Manager

Start Completion Code Manager  

Completion Code Manager
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Set a Completion Code as RPC

Set a Completion Code as Closure

Set a Completion Code as a Abandon

Change completion Code description  
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Campaign Editor project
March 2002

Complete the exercise found in your Student Workbook.

   Copyright© 2002 Avaya Inc.

Campaign Editor Project

http://pds.au.avaya.com/esp/mos12/Redtrain/UsingPDS/Imp/600.html [4/5/2002 3:26:37 PM]

http://www.avaya.com/


  

Phone strategy exercise
March 2002

Complete the exercise found in your Student Workbook.
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Phone strategy overview

Overview

A phone strategy is a set of instructions that tells the Avaya PDS to call customers during a
calling campaign. A phone strategy tells the Avaya PDS when and how to call clients, which
customer phone number to call, and the frequency of calls.  

The Avaya PDS applies the criteria and settings specified in the phone strategy to the calling
list records.  

The following parameters define a phone strategy:  

Which phone number to call first●   

The number of rings to allow before disconnecting●   

The time to wait before retrying a phone number that was busy, unanswered, or
disconnected

●   

The phone number to call if the first phone number is unanswered●   

The number of times to retry a busy phone number●   

The number of times to call a phone number before switching to an alternate phone
number

●   

The types of calls to be passed to an agent when the Avaya PDS detects an answer●   

Phone strategy parameters

Phone strategy parameters are grouped into four areas: Initial Phone, Alternate Initial Phone,
Call Detection Mode, and Retries. The following table describes each group of parameters.

Initial Phone  The first phone number the system will call.  

Alternate Initial Phone  
The phone number that becomes the initial phone at a specified
time of day.  

Call Detection Mode  
The system detects how the phone number is answered (such as
live voice, answering machine, and operator). This determines
which calls are passed to agents.  

Retries  
This parameter tells the system to retry a phone number
depending on the previous outcome.  

 

Phone strategy overview 
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Phone strategy preparation

Overview

The Avaya PDS receives and prepares the host data file and creates a calling list. A phone
strategy is used to specify the phone numbers to call during a job and how to place the calls.
 

Before you create a new phone strategy, you must decide which phone strategy parameters
to use to define how the system places calls.  

Wildcard characters

Phone strategies use one or more wildcard characters to clarify which phones are called,
how often, and in what order.  

Using wildcard characters

Wildcard characters are symbols used to increase productivity by selecting ranges in the
phone strategy.  

Wildcard characters include:

Wildcard character Description  

=  is equal to  

<> or ~  is not equal to  

>  is greater than  

<  is less than  

>=  is greater than or equal to  

<=  is less than or equal to  

 

Phone strategy preparation 
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Phone strategy settings

Initial phone

The initial phone is the first phone number the Avaya PDS calls for each record. In the
calling list, phone numbers are stored in phone fields. These fields are labeled PHONE1,
PHONE2, and so on. If a record does not match the criteria you set, the system will not call
the record.  

The Avaya PDS classifies phone numbers by phone type and assigns a number to each type.
For example, the home phone might be phone number 1 and the business phone number 2.
The Avaya PDS phone type numbers are set during your system configuration.  

Alternate initial phone

The alternate initial phone setting is used to set up one or more phones that the Avaya PDS
will use as alternate initial phones based on the time of day. At a particular time of day, the
alternate initial phone replaces the initial phone as the first phone number to call. The
system can switch to calling the alternate initial phone number at the time you specify in the
alternate initial phone settings.  

Alternate initial time settings are also defined in this parameter, which changes the time the
system starts calling the alternate initial phone. The system starts calling based on the local
time in the selected time zone.  

Example

You can tell the Avaya PDS to switch from calling business phones during the day (initial
phone) to calling home phones (alternate initial phone) during the evening starting at 6 PM.  

Call detection mode

The call detection mode is used to determine the types of calls the Avaya PDS passes to
agents. Call detection modes correspond to responses that the system detects when it dials a
number. Typical call detection modes include voice, autovoice, and operator intercept. The
system passes calls to agents based on the selected modes.  

The type of connect criteria determines what type of connects the Avaya PDS will pass to an
agent.  

Define the following parameters for call detection mode settings:  

Phone strategy settings 
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The ring count is the number of rings to allow before the system records a
NOANSWER completion code.

●   

The call detection mode tells the system which calls to pass to agents.●   

When the Avaya PDS places a call, the system detects what type of answer occurs for each
call. The following table lists the codes that are used in the Call Detection Mode tab:

Code Answer type

V  Voice  

AV  Autovoice  

INT  Operator intercept  

NOCIRC  No circuit available  

DISCON  Disconnected number  

VAC  Vacant number  

REORD  Reorder  

 

Tip

Increase your hit rate by deciding which detection modes to use. With each additional
criteria you select, more calls can be handled by your agents instead of by the system.  

Retries

The retries setting is used to determine how long the Avaya PDS waits before retrying a
number, how many times it retries the same phone number, and which phone it calls next.  

The Avaya PDS determines the settings by the result of the initial call. For example, you can
tell the system to retry the call in 15 minutes when the initial call result is busy and to stop
calling that record if there is no answer after three retries.  

Note

It is important to understand the difference between a system retry and a customer recall.  

Retries are computer generated retries. If the Avaya PDS detects a busy signal on the
first call attempt, it will retry based on the retry parameters set in the phone strategy.

●   

Recalls are set by agents. An agent can set either an Agent Owned Recall (the system
routes the recall to the agent who set it) or a general recall (any available agent talks
to the customer when the system recalls the account).

●   
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Phone strategy quiz
March 2002

Which of these is NOT a detection mode  The Alternate initial phone:
 Voice

 Reject

 Vacant

 No Circuit

  determines when to start calling

 determines what number to call

 indicates the alternate phone

 restricts dialing to one phone

  
Phone strategies do not define:  What defines how and when you call customers?

 How many times to call phone 1

 Time to wait before re-dialing

 The next number to call

 Whether to dial pulse or tone

  Record selection

 Job

 Verify records

 Phone strategy

   Copyright© 2002 Avaya Inc.
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Record selection activity
March 2002

Complete the exercise found in your Student Workbook.
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Record selection

Overview

A record selection contains the set of instructions that tells the Avaya PDS which customer
records to select from a calling list. Record selections allow supervisors to define the criteria
for selecting records and target specific customers to be called during a job. A record
selection consists of selection criteria and a phone strategy. Each job uses the results of a
record selection and a phone strategy to call customers.  

When starting a record selection, the Avaya PDS chooses records based on the following
criteria:  

calling list fields●   

time zones●   

previous calling results●   

agent set recalls●   

phone strategy settings●   

You can verify a record selection before you start a job to determine how many records are
chosen.  

Target Time Zones

You can use your record selection to target time zones such as Eastern, Central, or Pacific.
This allows only records from specific time zones to be targeted. If not specified, the Avaya
PDS defaults to a "follow the sun" method, meaning it calls records from east to west.  

Target completion codes

You can use your record selection to target completion codes such as BUSY or
NOANSWER. Use this to also select SIT tone completion codes to run a job to look for
disconnected or redirected numbers, or numbers that are no longer in service.  

Target goals

You can use your record selection to target goals, such as accounts more than 30 days
overdue, accounts with a balance over $2,000, or records in a particular state.  

Record selection 
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Record selection use

Create a record selection when an existing record selection does not meet your current
needs. Edit a record selection when you want to modify an existing record selection.  

To view a record selection, open Campaign Editor and click Selections in the button bar.
Then, double-click a record selection title. Record selection settings populate the right-hand
pane, which serves as a wizard. Back and Next buttons located at the bottom of the screen
allow you to switch among the various wizard screens.  

The wizard screens guide you through the record selection editing process. If you are ever
unsure what to enter in a field, you should double-click or single-click the field to see if
there is a list of values to choose from or a blinking cursor that indicates you can type your
own value in the field.  

The difference between Selections and Selection Reports in the button bar is that Selections
causes all of the record selections that you have created to appear and Selection Reports
causes reports for all of the record selections that have already run to appear. Selection
Reports provides detailed information about the results of the record selection, while
Selections serves as an editor (and not a reporting mechanism).  
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Record selection organization

Overview

A record selection contains options defined by the supervisor. The system chooses a record
if it meets specific criteria. Use the record selection in conjunction with the phone strategy
to determine who you want to call (record selection) and how you want to call (phone
strategy) those selected records.  

As soon as you click Selections in the button bar, your screen becomes divided into two
areas: a left-hand pane and a right-hand pane. The left-hand pane lists your record selections
that you have created, while the right-hand side allows you to edit a record selection's
settings by using the various panes.  

Record selection panes

The following table describes the various panes that appear on the right-hand area of the
window; click the Next and Back buttons to switch among these panes.

Pane name Pane description

Miscellaneous pane  
Use the Miscellaneous pane to select a calling list, phone strategy
file, unit work list field, time zone ignore option, or selection type
(infinite or verify).  

Records pane  
Use the Records pane to define which records the system uses
during a job based on logic statements that you create.  

Time Zones pane  
Use the Time Zones pane to select time zones that the system
uses to determine which phone numbers to call.  

Calling Results pane  
Use the Calling Results pane to tell the system which phone
numbers to call based on previous calling results.  

Recalls pane  
Use the Recalls pane to determine which agent-set recalls to
include in the record selection.  

Sort pane  
Use the Sort pane to determine the record order that the system
uses to call clients.  

 

Record selection organization 
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Record selection wildcard characters

Wildcard characters

Like phone strategies, record selections use wildcard characters to specify criteria for a field.
Use wildcard character expressions to define the subset of records you want to call. A
wildcard character expression is a combination of wildcard characters (such as < or >) and
values.  

Use wildcard characters

Use wildcard characters in the Records and Recalls panes. Each wildcard character
expression specifies a field name (from the records in your calling list), a wildcard
character, and a value.  

Values can be numbers, letters, dates, and times. For example, account balances consist of
numbers, while client names consist of letters. Wildcard characters include the following:

Wildcard characters Description

>  greater than  

<  less than  

=  equal to  

~  not equal to  

>=  greater than or equal to  

<=  less than or equal to  

-  use between a range of values  

,  use between multiple values  

*  wildcard character  

!  list wildcard character  

?  single character wildcard character  

 

Example record selection statements include the following:

Record selection wildcard characters 
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Field Value What is selected?

ACCT_BALANCE  >=500  
Customer records with account balances greater than
or equal to $500.  

CITY  =Chicago  Customer records with Chicago addresses.  

 

Consider the following tips when you create your record selection statement:  

You can connect two or more statements using the operators AND and OR.

Use AND to narrow the selection to the client records that meet the criteria in both
statements.

Use OR to broaden the selection to select the client records that meet the conditions in
either statement.

●   

Click Append to add a line to the bottom of the selection area.●   

Click Insert to insert a line below the cursor.●   

Click Delete to delete the selected line.●   
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Record selection quiz
March 2002

You can specify any of these comparison
operators except:

 Use Recalls to define

 > greater than

 {} excludes

  < less than

  ? matches single character

  When to redial customers

 If you allow agents to redial customers

 If you allow agents to login to this job

 When to set up retries for an agent

  
Verifying a record selection means:  Use the records pane to complete:

 It will result in calls made

 Jobs that use it will run

 It has been saved

 It can run on the dialer

  A calling list

 Verified records

 record edits

 Selection criteria

  Copyright© 2002 Avaya Inc.
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Jobs activity
March 2002

Complete the exercise found in your Student Workbook.
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Overview

Purpose

A job contains all the information the AvayaTM Predictive Dialing System (PDS) needs to
call clients. A job integrates a calling list, phone strategy, record selection, and other settings
to place outbound calls and receive inbound calls.  

Contents

This section contains the following topics:  

Job types●   

Outbound job●   

Job settings●   

Create a job●   

View job settings●   

Save a job●   

Save a job as another name or on a different dialer●   

Start a job on one or more dialers●   

Start multiple jobs on currently selected dialer●   

Copy a job●   

Edit a job●   

Verify a job on one or more dialers●   

Verify multiple jobs on the currently selected dialer●   

Delete a job on one or more dialers●   

Delete multiple jobs on the currently selected dialer●   

List all jobs on a selected dialer●   
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Job types

Overview

Jobs are part of a campaign. A job, depending on what type of system configuration you
have, can make outbound calls, receive inbound calls, verify a sale, or a handle variety of
other tasks.  

If you have an Intelligent Call Blending system, you can use Campaign Editor to set up
three types of jobs:  

Outbound jobs●   

Inbound jobs●   

Blend jobs●   

If you have an Agent Blending system, you can use Campaign Editor to set up outbound
jobs.  

Outbound jobs

During outbound jobs, the Avaya PDS uses a calling list, phone strategy, record selection,
and other settings to place outbound calls to customers. There are many settings to configure
for an outbound job. These are discussed more in depth in the following section.  

Inbound jobs

During inbound jobs, the Avaya PDS automatically routes inbound calls to agents. There are
no inbound jobs on an Agent Blending system. All inbound calls are handled by inbound
ACD agents. Because the Avaya PDS does not control the inbound call activity on the
Agent Blending system, the system does not consider it a job.  

Blend jobs

The term blend job refers to job run on an Intelligent Call Blending system. During an
Intelligent Call Blending job, the Avaya PDS moves agents between outbound and inbound
calls. Blend agents receive inbound calls during peak inbound activity and outbound calls
when inbound activity decreases.  

An Avaya PDS blend agent handles both inbound and outbound calls with Intelligent Call
Blending.  

Job types 
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Job settings

Overview

There are several settings that you define for each outbound job. The settings on your
system may vary depending on your configuration. The settings are grouped in the
following way:  

Basic●   

Outbound●   

Managed●   

Interactive Voice Response●   

Unit Work List●   

Basic job settings

Basic settings are for every type of job, regardless of whether it is outbound, inbound, or
blend. The following settings are listed in the BASIC tree structure.  

Main data processing label

Use the drop-down list to select the correct main data processing label. The main data
process label instructs the Avaya PDS to begin job processing and tells the system what to
display on the agent screens.  

Note

If you run a virtual or sales verification job, select the appropriate data process label. For
example, select virtual for a virtual job, verify for a sales verification job, and generic for an
outbound job.  

Job description

Double-click in the text box and type a job description. This is a description of the job. For
example, type a description that reflects the goal of the job such as 30-day Accounts.  

Link to job

You can tell the Avaya PDS to automatically start a job when this job ends. Use the Link to
job setting to select the next job to start.  

Job settings 
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When you link a job, the system transfers each agent to the next job after the agent
completes the last call and releases the record. The system displays a message telling the
agents that they are changing jobs.  

The following table describes the types of jobs that can link together:

Job type Can link to

outbound job  outbound or blend job (includes Unit Work List jobs)  

Managed Dialing job  ONLY to managed jobs (includes Unit Work List jobs)  

inbound job  ONLY to inbound job  

blend job  blend job (blend job cannot link to outbound job)  

virtual job  ONLY virtual job  

 

Note

If you stop a job that has a job linked to it, the Avaya PDS will automatically start the next
job.  

Agent keys definition file name

Use the drop-down list to select the agent keys file name to use during a job. An agent keys
file is configured with different sets of functions for keys used during differently types of
jobs.  

Line type(s) for use on job

Double-click and the line types to use during a job. Use this setting to select or clear the
groups of lines the Avaya PDS uses for a job.  

Earliest start time

Double-click to set the time (numbers only) you want the Avaya PDS to begin calling
customer records.  

The Avaya PDS is preset with recommended start and stop times for different time zones. If
you enter a time that is earlier than the recommended start time, the system does not begin
dialing until the system clock reaches the recommended time.  

Latest stop time

Double-click to set the time (numbers only) you want the Avaya PDS to stop calling
customer records.  

Job settings 
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Run job without agents

Select this option if you want to run your job without agents. This field does not appear
unless you select Virtual in the Campaign Editor Job Wizard (when you create a new job).  

Transfer on hold message number

Double-click and type the number of the message that users should hear during the
call-transfer process.  

Outbound job settings

Outbound settings are for outbound jobs. The following settings are listed in the
OUTBOUND tree structure.  

Do Not Call group name

Use the drop-down list to select the Do Not Call Group file name.  

Initial hit rate

Double-click and enter the initial hit rate (number only).  

Initial hit rate determines the average number of calls per agent the Avaya PDS makes
during the first five minutes of the job. The initial hit rate is the number of call completions
compared with call attempts.  

For example, an initial hit rate of 50% means the system must make approximately two
dialing attempts for each agent to get one successful connection. When the Avaya PDS
gathers statistics from actual call attempts, it readjusts the hit rate automatically to meet the
minimum hit rate setting. Set the rate too low (20 to 30) and the Avaya PDS could make
more connects than your agents can handle during the initial dialing period. Set the rate too
high (over 70) and the system could fail to make enough connections to keep your agents
busy.  

Use the following table to adjust the initial hit rate according to the particular needs of the
job:

If you want to make Set rate to Description

Daytime home calls  30  3 calls per agent for 1 connection  

Evening home calls  50  2 calls per agent for 1 connection  

Weekend home calls  50  2 calls per agent for 1 connection  

Daytime office calls  70  1 call per agent for 1 connection  

 

Job settings 
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Expert Calling ratio

Double-click for text boxes to enter in Expert Calling ratio settings.  

Following are the three choices for setting Expert Calling ratio:

Setting Description & recommended setting

Calls in the wait queue  

The Avaya PDS achieves a balance between agents waiting for
a call and customers placed in the wait queue.  

Enter a percent value between 1 and 100. The recommended
setting is between 4 and 31.  

Agent Work Time  

The Avaya PDS monitors the time agents take to complete calls
and update records and adjusts the calling pace accordingly.  

Enter a percent value between 1 and 100. The recommended
setting is between 29 and 71.  

Agent Update Time  

The Avaya PDS monitors the time agents take to update
records and adjusts the calling pace accordingly.  

Enter a percent value between 1 and 100. The recommended
setting is between 32 and 78.  

 

Remember, when you use Calls in Wait Queue, customer wait times are affected. When you
use Agent Work Time or Agent Update Time, the average agent idle time can be short, but
there may be a large percentage of customers in the wait queue at any given time.  

End jobs when no more calls remain

Select this option if you want the Avaya PDS to end jobs when each customer has been
called at least once.  

Clear this option if you want the Avaya PDS to end jobs after all calls are completed,
including recalls.  

Outbound calling list

Select a list name from the drop-down list. The outbound calling list is the list you will use
for the job.  

The calling list name contains the host dialer name (where the list is stored) and the calling
list name. The calling list description (if any) is listed in the right-hand column drop-down
list.  

Minimum hit rate

Job settings 
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Double-click to set the minimum hit rate (number only). The minimum hit rate determines
the maximum number of calls the Avaya PDS will make in order to make an agent
connection.  

Use minimum hit rate to limit the number of lines a job can use, even if the hit rate falls
below this rate. For example, a minimum hit rate of 30% means the system will make no
more than three dialing attempts for each agent. This prevents the Avaya PDS from
allocating more pooled lines to a poorly performing job at the expense of a more successful
job.  

Enter a value between 1 and 100 in increments of 10. A typical setting is 30.  

Order calls by time zone

Select this option if you want the Avaya PDS to order calls by times zones. This means the
Avaya PDS calls "following the sun," or east to west.  

With either choice, time zone laws are still applied.  

Quota setting (completion code, quota)

Double-click to use a drop-down list and a box. Use the drop-down list to select a
completion code. Use the text box to enter a quota (for example, a quota number of 500
would mean that a job automatically stops if the number of completion codes reaches 500).  

Save quota setting when the job ends

Select this option to save the quota setting when the jobs ends.  

Quota settings file name

Double-click to type a file name in the field.  

Recall reschedule interval (mins)

If Agent Owned Recall is configured on your system, this field will be visible. Double-click
to enter the minimum amount of time that must pass before the system tries to pass the agent
a recall.  

Recall notification time (min)

If Agent Owned Recall is configured on your system, this field will be visible. Double-click
to enter the amount of time that the system will look for the agent (to pass the recall to the
agent who set it up).  

Number of recall attempts

If Agent Owned Recall is configured on your system, this field will be visible. Double-click

Job settings 
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to enter the number of times to look for the agent that set up the recall.  

Script label for call

Select the script label from the drop-down list. The script label is the name of the script
being used for the job. This determines the messages the customer hears when placed in the
wait queue.  

If a customer is placed in a wait queue, the customer hears a message. The wait queue
messages are created for different jobs. The message or string of messages a customer hears
is the message script.  

Outbound screen(s)

Select the outbound screen name from the drop-down list. This determines the outbound
screen that agents see on their workstations during an outbound job.  

Record selection file name

Select the record selection name from the drop-down list. The Selection parameter identifies
which record selection is used for the outbound job. The record selection contains the phone
strategy used for the job.  

Transfer to inbound job name

Select the transfer to inbound job name from the drop-down list of inbound or blend job
names that agents can transfer calls to.  

Total wait delay (sec.)

Double-click the total wait delay field and enter in the number of seconds (from 0 to 999)
that the customer can wait in the Avaya PDS wait queue before the system ends the call.  

Managed job settings

Managed settings are settings for Managed Dialing jobs. The following settings are listed in
the MANAGED tree structure.  

The following settings become active only if the MANAGED check box is selected.  

Allow dialing from deleted record

Select this option to allow an agent to dial a deleted record.  

Clear the check box to prevent agents from dialing a deleted record.  

This setting can only be used if the MANAGED check box is selected.  

Allow agents to cancel call

Job settings 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/10_Performance_Jobs_BB5.html (6 of 8) [4/5/2002 3:26:42 PM]



Select this option to allow an agent to cancel a Managed Dialing call.  

Clear this option to prevent agents from cancelling a Managed Dialing call.  

This setting can only be used if the MANAGED check box is selected.  

Display empty record at preview

Select this option to allow an agent to display an empty record at preview.  

Clear this option to prevent agents from displaying empty record at preview.  

This setting can only be used if the MANAGED check box is selected.  

Time limit (sec.) for preview

Double-click the time limit field and enter in a value (in seconds) between 1 and 999. This
parameter sets the time that an agent can preview a record before the Avaya PDS dials the
number. Use 0 (zero) to set an unlimited amount of preview time.  

This setting can only be used if the MANAGED check box is selected.  

Allow record search type at preview

Select one of the following three options from the drop-down list:  

NONE - No search is allowed. The only way for the agent to make a call is by
manually entering a phone number.

●   

HASH - The search is done through the PDS QuickSearch method. The calling list is
searched until the matching record is found.

●   

LIS - The search is accomplished through the List Indexed Sequential method. The
LIS method processes the calling list into a table that is indexed on a key field from
the calling list. That key field is specified during configuration.

●   

This setting can only be used if the MANAGED check box is selected.  

Interactive Voice Response job settings

The INTERACTIVE VOICE RESPONSE tree structure becomes active when its check box
is selected.  

IVR identifier

Double-click the field to enter the IVR identifier.  

Script to run on the IVR

Double-click the field to enter the script to be used for the IVR.  

Job settings 
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Unit Work List job settings

The UNIT WORK LIST tree structure becomes active when its check box is selected.  

Record selection with units

Select a unit work list record selection from the drop-down list to use with this job.  
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Operation
March 2002

Module contents

Introduction to Campaign Monitor

Manage jobs

Manage agents

Hierarchy Manager

Agent Blending

Campaign Manager project

Objectives
At the end of this module you will be able to:

To open and operate the Campaign Monitor application●   

To view dialer, job, and agent statistics●   

To create, save and share customized views of statistics●   

To modify the execution of jobs to meet campaign objectives●   

To monitor agent operations●   

To set alerts to notify you of job performance issues●   

To create hierarchies using Hierarchy Manager●   

  Copyright© 2002 Avaya Inc.
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) uses phone strategies to call customers
more effectively.  

Contents

This section contains the following topics:  

Phone strategy overview●   

Phone strategy preparation●   

Phone strategy settings●   

Create a phone strategy●   

Copy a phone strategy●   

View phone strategy settings●   

Edit a phone strategy●   

Delete a phone strategy●   

List all phone strategies on a selected dialer●   

Append a phone strategy row●   

Insert a row in a phone strategy●   

Delete a row in a phone strategy●   

Move a row up in a phone strategy●   

Move a row down in a phone strategy●   

Select all rows in a phone strategy●   

Unselect all rows in a phone strategy●   
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Create a phone strategy 

Create a phone strategy

Use the following procedure to create a phone strategy:  

Start Campaign Editor.1.  

In your button bar, click the name of the dialer where you want your phone strategy to
reside. (You can save it to other dialers or delete it from this dialer later.)

2.  

On the button bar, click Strategies.3.  

Select File > New.4.  

On the right side of the window, click the List field, select a calling list, and then click
Next.

5.  

In the Initial Phone pane, click the Phone field and select a phone. Double-click the
other fields to define your initial phone settings, and then click Next.

6.  

(Optional) In the Alternate Initial pane, specify alternate initial phone settings.
Right-click and select Append Row. Double-click the fields to enter values. Select
options as needed. Right-click and select Select All to select all options. Right-click
and select Unselect All to clear all options. Click Next.

7.  

In the Detection Mode pane, select the detection modes to pass to the agents, and then
click Next.

8.  

In the Retries pane, select the call results to retry. For each result you select, type a
value in the Retry Interval (mins), Attempts, and Next Phone columns.

9.  

Select File > Save. The strategy is automatically saved to the dialer that you had
selected in the button bar. If multi-dialer is enabled, select additional dialers where
the strategy should be saved. Type a file name for your strategy, and then click OK.
(If the check boxes are unavailable, enable them in the Settings > Options dialog
box.)

10.  
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) uses record selections to determine which
records to call during a job. You can create your own customized record selections that
contain your own rules. For example, call only customers with an outstanding balance of <
$5,000 and who live in California. After you have defined your customized record selection,
you can save that record selection for use on any future calling campaign.  

Contents

This section contains the following topics:  

Record selection●   

Record selection organization●   

Record selection wildcard characters●   

Understand the Selection Reports pane●   

Open and view a record selection●   

Complete the Miscellaneous pane●   

Complete the Records pane●   

Complete the Calling Results pane●   

Complete the Time Zone pane●   

Complete the Recalls pane (optional)●   

Complete the Sort pane (optional)●   

Create a record selection●   

Save a record selection●   

Edit a record selection●   

Delete a record selection●   

Verify a record selection●   

Run a record selection●   

Copy a record selection●   

List all record selections on a selected dialer●   

Overview 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/U...uide/vol1/10_Performance_RecordSelection_BB2.html (1 of 2) [4/5/2002 3:26:43 PM]

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ch_ed_rs.html
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_open.html#779106
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_miscpane.html#768266
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_recordspane.html#767113
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_callresultpane.html#734159
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_tzpane.html#757497
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_recallpane.html#734332
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_sortpane.html#758958
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_create.html#767471
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_save.html#767516
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_edit.html#767439
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_delete.html#755141
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_verify.html#721111
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_run.html#721239
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_copy.html#755214
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_list.html#754712


View selection reports●   

View record selection settings●   

Append record selection rows●   

Insert a row in a record selection●   

Delete a row in a record selection●   

Move a row up in a record selection●   

Move a row down in a record selection●   

Select all rows in a record selection●   

Unselect all rows in a record selection●   

 Volume I PDF

Legal Statement

Avaya Inc.

Overview 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/U...uide/vol1/10_Performance_RecordSelection_BB2.html (2 of 2) [4/5/2002 3:26:43 PM]

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_viewrpt.html#767650
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_view.html#767682
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_rowappend.html#761031
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_rowinsert.html#750459
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_rowdel.html#750481
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_rowmvup.html#750503
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_rowmvdn.html#750525
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_rowselectall.html#750547
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_rs_rowcancelsel.html#750550
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ch_ed_rs.html
http://www.avaya.com/


 Avaya PDS User Guide

Page 6 of 30

Understand the Selection Reports pane

Overview

When you click Selection Reports in the button bar, the Selection Reports pane appears and
shows a list of record selections that have previously been run. The Selection Reports pane
is an area that contains summary information, so you do not modify its contents. Modify
record selections in the pane that appears when you click Selections in the button bar.  

To view a selection report, double-click a selection. You can then right-click and select
Select All so that you can copy and paste the report into a different application.  

Understand the Selection Reports pane

The Selection Reports pane contains the following headings: Selection, List, Status,
Records, Records Remaining, Recalls, and Select Ran at.  

The following table describes these headings:

Heading Description

Selection  Record selection file name  

List  Calling list associated with this record selection  

Status  
Record selection status is In Use if being used for a currently
running job or Available if not.  

Records  
Number of customer records associated with this record selection
file  

Records Remaining  
Number of records that still need to be called (this number changes
if the job is running)  

Recalls  
Number of recalls (callbacks) that this record selection file has
flagged  

Selection Ran at  Time and date stamp  

 

Understand the Selection Reports pane 
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Minimum Hit rate determines  Latest stop time sets
 How many jobs an agent can log into

 How many lines a job can use

  How many calls an agent can make

  The smallest number of calls per job

  The last time calls are made on a job

 The last time agents can log on

 The first time an agent can log on

 The first time calls are made on a job

  
Initial hit rate determines  Which of the following is not a MANAGED tree

setting?
 When calls are attempted

 How quickly calls are made

 How many calls are made

 How many calls per agent are dialed

  Allow agents to cancel call

 Time limit for preview

 Allow dialing from deleted record

 Key field release code

  Copyright© 2002 Avaya Inc.
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Jobs 
To see topics for this section, click + in the contents list at left.
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Outbound job

Overview

During outbound jobs, the Avaya PDS automatically dials phone numbers and routes calls
to agents. The system screens for answering machines, phone operator intercepts, busy
signals, Interactive Voice Response systems (IVRs), and no answers.  

Special outbound jobs

An outbound job uses settings to target customers for calling. Agent Blending and
Intelligent Call Blending systems both use outbound jobs. Depending on your system
configuration, there are up to five special jobs. These settings are configured when you
create or modify a job.  

A Unit Work List job divides customer records into subsets. Agents work with
records only in their assigned work lists.

●   

A Managed Dialing job allows agents to preview or cancel a customer record before
the Avaya PDS calls the customer. As the supervisor, you can adjust the preview time
and allow agent to cancel calls depending on how the job settings are configured.

●   

A Sales Verification job creates a second campaign to verify a sale or commitment
that the customer made. Use the Sales Verification Record Selection when starting a
Sales Verification job.

●   

An Infinite job uses a special record selection to receive new records for calling while
the job is active. Use the Infinite record selection when starting an Infinite job.The
Avaya PDS uses this record selection to add new records (downloaded from your
host) to an existing calling list on an active infinite job. An infinite job runs until you
stop it manually.

●   

A Virtual Agent job allows the Avaya PDS to run a job without agents. When the
Avaya PDS detects a customer or an answering machine, the system plays a recorded
message.

●   

Define Sales Verification, Unit Work List, Virtual, and Managed on the second screen of the
Campaign Editor Job Wizard when you create a new job. These features are optional and
some features are mutually exclusive. For example, if you select Virtual, you cannot select
any other choices. If you select Managed, you can only select Sales Verification with it. If
you select Unit Work List, you can only select Sales Verification with it.  

Outbound job 
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Create a job 

Overview

You are not required to run a record selection before starting a job. Campaign Editor will
automatically execute the record selection if needed, and then verify the job. If the job
verification passes, you are offered a choice of starting the job or cancelling the action.  

Create a job

Use the following procedure to create a job.  

In the Campaign Editor button bar, select a dialer, and then click Jobs.1.  

Select File > New.2.  

Click Next when the Campaign Editor Job Wizard appears.3.  

Select the type of job to create, the appropriate outbound or inbound calling list, and
the check box next to the options you want to use: Sales Verification, Unit Work List,
Virtual, or Managed, and then click Next.

4.  

Type a job description, and then click Finish.
The default tree structure for your job type (inbound, outbound, blend, etc.) appears in
the right-hand pane. Use the Setting column to edit values.

5.  
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View job settings 

View job settings

Use the following procedure to view job settings.  

Double-click the job you want to view.
The job settings appear in the right-hand pane.

1.  
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Save a job 

Save a job

Use the following procedure to save a job.  

Select File > Save to save the job. (If needed, provide a file name.)1.  

Click OK.2.  
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Save a job as another name or on a different
dialer 

Save a job as another name or on a different dialer

Use the following procedure to save a job as another name or on a different dialer.  

Double-click the job you want to save.1.  

Select File > Save As.
If the multi-dialer option is enabled, select additional dialers to which you want to
save the job. (If the dialer check boxes are unavailable and you want to enable them,
select Settings > Options.)

2.  

Type a file name for your job, and then click OK.
The job is saved to the dialer you selected in the button bar and it to any additional
dialers you selected.

3.  
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Start a job on one or more dialers 

Start a job on one or more dialers

Use the following procedure to start a job on one or more dialers.  

Double-click the job you want to start.1.  

Select File > Run.
If the multi-dialer option is enabled, you are asked if you want to run the job on
additional dialers. Select additional dialers on which you want to start the job.

2.  

Click OK.3.  
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Start multiple jobs on currently selected
dialer 

Start multiple jobs on currently selected dialer

Use the following procedure to start multiple jobs on the currently selected dialer.  

Control-click the jobs you want to start.1.  

Select File > Run, and then click OK.2.  

 Volume I PDF

Legal Statement

Avaya Inc.

Start multiple jobs on currently selected dialer  

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ed_jobs_startmulti.html [4/5/2002 3:26:45 PM]

http://www.avaya.com/


 Avaya PDS User Guide

Page 12 of 18

Copy a job 

Copy a job

Use the following procedure to copy a job.  

Double-click the job you want to copy.1.  

Select File > Save As.
If the multi-dialer option is enabled, select the dialer where you want to copy a job.

2.  

Type a file name for the job, and then click OK.3.  
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Edit a job 

Edit a job

Use the following procedure to edit a job.  

Select File > Open.1.  

Double-click the job you want to edit, and then make the necessary edits in the
right-hand pane.

2.  

Select File > Save to save the job.
If the multi-dialer option in enabled, select the additional dialers to save the job to.

3.  

Type a file name for the job, and then click OK.4.  
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Verify a job on one or more dialers 

Verify a job on one or more dialers

Use the following procedure to verify a job on one or more dialers.  

Select the job you want to verify.1.  

Select File > Verify.
If the multi-dialer option is enabled, you are prompted to select whether or not to
verify the job on additional dialers. Specify your preferences, and then click OK.

2.  

In the This File is OK dialog box, click OK.3.  
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Verify multiple jobs on the currently selected
dialer 

Verify multiple jobs on the currently selected dialer

Use the following procedure to verify multiple jobs on the currently selected dialer.  

Control-click to select all the jobs you want to verify.1.  

Select File > Verify.2.  

Click OK in The File is OK dialog box.3.  
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Delete a job on one or more dialers 

Delete a job on one or more dialers

Use the following procedure to delete a job on one or more dialers.  

Select the job you want to delete.1.  

Select File > Delete.
If the multi-dialer option is enabled, you are prompted to specify whether or not to
delete the job from additional dialers. Make your selections, and then click OK.

2.  

When prompted, click Yes to delete the job.3.  
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Delete multiple jobs on the currently selected
dialer 

Delete multiple jobs on the currently selected dialer

Use the following procedure to delete multiple jobs on the currently selected dialer.  

Control-click to select the jobs you want to delete.1.  

Select File > Delete.
If the multi-dialer option is enabled, you are prompted to specify whether or not to
delete the job from additional dialers. Make your selections, and then click OK.

2.  

When prompted, click Yes to delete the jobs.3.  
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List all jobs on a selected dialer 

List all jobs on a selected dialer

Use the following procedure to list all jobs on a selected dialer.  

Select the dialer name on the button bar.1.  

Click Jobs. A list of jobs on the selected dialer appears.2.  
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Intro to Campaign Monitor
March 2002

The Main Menu in Campaign Monitor is the primary navigation point for:

opening views●   

opening and saving favorite views●   

completion codes●   

agent/supervisor relationships●   

setting and viewing alerts●   

Individual views operate within the main window which can be adjusted to fit your needs.

A view displays information on dialers, jobs, agents, and completion codes. In Campaign Monitor, you
are able to create your views and save them on exit and restore them on start up, which allows you to
display views in the same way without having to recreate specific views.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Campaign Monitor Overview Procedure

Campaign Monitor

Campaign Monitor User Intrface

View Control toolbar  

Campaign Monitor views

Agent Detail view  

Agent Completion Code view  

Agent History view  

Supervusor Agents view  

Dialer Status View  

Dialer Agents view  

Dialer Lines view  

Intro to Campaign Monitor
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Dialer History view  

Job Status View  

Job Agents view  

Job Detail view  

Job Call Handling view  

Job Completion Code view  

Job Wait Queue view  

Job History View  

Job Performance view  

Set Scope Selectors  

Find Agents view  

Create Custom view  
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Managing jobs
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This lesson shows you how to modify dialer, job, and agent settings from Campaign Monitor. In different
views, select a field and use the right-click menu to display the settings that can be changed:

Start or stop a job●   

Change expert calling ratio●   

Change hit rate●   

Change line usage●   

Change job linking●   

Add or change unit work lists●   

Modify phone strategy settings●   

Create and modify alert●   

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Campaign Monitor Overview Procedure

Campaign Monitor

Campaign Monitor User Intrface

View Control toolbar  

Campaign Monitor views

Agent Detail view  

Agent Completion Code view  

Agent History view  

Supervusor Agents view  

Dialer Status View  

Dialer Agents view  

Dialer Lines view  

Managing Jobs
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Dialer History view  

Job Status View  

Job Agents view  

Job Detail view  

Job Call Handling view  

Job Completion Code view  

Job Wait Queue view  

Job History View  

Job Performance view  

Set Scope Selectors  

Find Agents view  

Create Custom view  
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This lesson shows you how to review and monitor agent activities from Campaign Monitor. In different
views, select a field and use the right-click menu to display action options:

Remove an agent from a job●   

Transfer an agent to a job●   

Listen to an agent call●   

Monitor Agent screen●   

Send a message to an agent●   

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Campaign Monitor Overview Procedure

Campaign Monitor

Campaign Monitor User Intrface

View Control toolbar  

Campaign Monitor views

Agent Detail view  

Agent Completion Code view  

Agent History view  

Supervusor Agents view  

Dialer Status View  

Dialer Agents view  

Dialer Lines view  

Dialer History view  

Job Status View  

Job Agents view  

Managing Agents
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Job Detail view  

Job Call Handling view  

Job Completion Code view  

Job Wait Queue view  

Job History View  

Job Performance view  

Set Scope Selectors  

Find Agents view  

Create Custom view  
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Hierarchy Manager is a tool you can use to group data. Hierarchy Manager lets you create agent, job, or
dialer hierarchies that reflect the way your company or business is organized. For example, you can
create relationships between Avaya PDS agents and the management structure of a company. You can
use hierarchies in Campaign Monitor to adjust the scope of data to view and in Campaign Analyst to
group data in reports. This section describes Hierarchy Manager and how to use it.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Hierarchy Manager Overview Procedure

Overview of Hierarchy Manager  

Create a hierarchy

Open a hierarchy  

Managing Jobs
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Adding levels to Hierarchies

Adding data items to hierarchies

Moving levels within hierarchies
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Agent Blending integrates outbound calling activities on your Avaya PDS with inbound calling activities
on your ACD. In an Agent Blending system, ACD agents log on to the Avaya PDS and the ACD. Agent
Blending monitors the activity on the ACD and uses this information to determine when to acquire
agents for outbound calling and when to release ACD agents to handle inbound calls.

The Agent Blending tool allows you to manage domains (ACD call queues) and domain groups (every
domain is a member of a domain group). Start the Agent Blending tool from the Campaign Monitor or
Campaign Editor Tools menu.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Blend Manager Overview Procedure

Blend Manager  
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Your instructor will direct you in an activity with the Avaya PDS Campaign Monitor application that
builds upon the skills you learned in previous activities about the Operations phase of the Campaign Life
Cycle.
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Complete the exercise found in your Student Workbook.
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User interface

Overview

Campaign Monitor has a button bar on the left-hand side of the screen and an open space
where your various windows (or views) appear. A view is a window that displays when you
click a button in the button bar. In each view, you can filter information and customize your
monitoring.  

Campaign Monitor screen layout and usage

Campaign Monitor is highly customizable. The following is a sample list of Campaign
Monitor's customizable features. In addition to these features, you should experiment with
the toolbar options in each view to customize individual views. After you have a view set up
the way you want it, you can save it as a custom view so that it is available for you to select
from the Custom button group on the button bar. For more information on customizing
individual views using the toolbar, see "View Control Functions."  

Button bar

The button bar works like an accordion: it expands and contracts. In other words, when you
click a button group, the group expands to display its buttons.  

To learn more about the various Campaign Monitor views and how to customize each view,
see the "Views" section.  

Sort

You can sort the contents of a view by clicking a column heading. When you click a
heading, you see a small arrow appear alongside the heading; if the small arrow is pointing
up, you are sorting the data in ascending order. If the small arrow is pointing down, then you
are sorting in descending order.  

Resize columns

You can resize any column in a view by hovering your cursor between the heading titles
until a double-arrow appears. Hold down the left mouse button while you drag your cursor
to resize the columns.  

User interface 
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View control toolbar

Toolbar buttons within a View

Every view opens with a set of tools that help you manipulate the data in a View. The
available options vary depending the view. For example, the time selector option does not
appear if time scoping is not allowed for data in a view.

View tool Button Description

Table View    

If the view has two presentation modes
(graphical and table) this button displays
the data without icons (not available for
all views).  

Graphical View    

If the view has two presentation modes
(graphical and table) this button displays
the data by showing icons (not available
for all views).  

Filter Data    

Displays a dialog box that allows you to
filter the data in the view according to
one selected criteria.  

Performance Code    

Displays a dialog box that allows you to
select a completion code to use to
measure agent performance.  

Hide/Show Columns    

Displays a dialog box that allows you to
select which of the available data fields
will be displayed.  

Find    
Allows you to search for an item in a
view.  

Level 1 Scope Selector    
A drop-down list that allows you to limit
the amount of data in the display.  

Level 2 Scope Selector    

The choices in this list depend on the
choice made in the Level1 Scope
Selector.  

View control toolbar 
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Level 3 Scope Selector    

The choices offered in this list depend
on the choices made in the Level1 and
Level2 Scope Selectors.  

Hierarchy Manager    

A pull-down list that allows you to
select the types of data that will appear
in the Scope Selectors.  

Time Scope    

A pull-down list that lets you select the
time range for the data displayed in the
view.  

Refresh view    
Allows you to refresh a view.
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Views

Overview

A view displays information about dialers, jobs, agents, and completion codes. In Campaign
Monitor, you are able to create your views, save them on exit, and then restore them. This
allows you to display views in the same way without having to recreate specific views.  

The button bar provides a means of organizing the available views, as well as access to
those views. The button bar contains six view categories: View Set, Dialer, Job, Supervisor,
Agent, and Custom.  

View toolbar description

There are several view control options.  

Table view

Displays the data without icons (only available if the view has two presentation modes).  

Graphic view

Displays the data with icons (only available if the view has two presentation modes).  

Filter data

Allows you to filter the data in the view according to one selected criteria.  

Performance code

(For the Job Performance View only.) Allows you to select which completion code to use
when monitoring job performance.  

Hide/show columns

Allows you to select which of the available data fields appear.  

Find item

Allows you to search for a text string within a view. For example, search for a specific agent
or job.  

Views 
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Hierarchy Manager icon

Allows you to choose the types of data that appear in the scope selectors.  

You can choose to use no hierarchy, the default supervisor/agent hierarchy (if one has been
defined using Settings > Options), or another custom hierarchy (if one has been defined
using Settings > Options). You can define the default supervisor/agent hierarchy and the
custom hierarchy.

Hierarchy Scope selector 1 Scope selector 2 Scope selector 3

No hierarchy  Dialer (default)  Job (default)  empty  

Default agent/supervisor
hierarchy  

Dialer (default)  Job (default)  

supervisor (bottom
level of the
selected hierarchy)
 

Custom  
Top level of the
selected
hierarchy  

Middle level of
the selected
hierarchy  

Bottom level of
the selected
hierarchy  

 

Time Selector

Allows you to choose the time range for the data in the view.  

Refresh

Refreshes the data in the open views.  

View categories

The following view categories are available in Campaign Monitor:  

View set

You can create a view set that you can save and restore as a group. The first time you click
View Set, and no view set is active, the Save As dialog box appears so you can name the set
and choose its storage location. When the dialog box closes, a button for the new view set
appears in the View Sets group on the button bar. If you change a view, you will be asked
whether the view should be saved.  

Dialer views

Use the Dialer views to see Dialer Status, Dialer Agents, Dialer Lines, and Dialer History.  

Job views

Views 
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Use the Job views to see Job Status, Job Agents, Job Detail, Job Call Handling, Job
Completion Codes, Job Wait Queues, Job History, and Job Performance.  

Supervisor view

Use the Supervisor view to see the Supervisor Agents data.  

Agent view

Use the Agent views to display Agent data.  

Custom view

The custom views section will vary, depending on what you choose to include. Campaign
Monitor lets you save a customized view to the Custom group.  
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Complete the exercise found in your Student Workbook.
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What do you need to change to make the pace
of jobs go faster?

 How do you ensure that you are notified when a job
is complete?

 Change expert calling ratio

 Change job linking

  Change line usage

  Modify phone strategy

  Monitor the job

 Create a unit work list

 Use managed jobs

 Set an alert

  
When job1 is linked to job2, what happens
when job1 ends?

 An infinite job

 Agents must log into job2

 Agents are logged into job2

 The system supervisor is alerted

 The dialer enters runlevel 0

  Never ends

 There are no infinite jobs

 Ends when stopped

 Ends when complete
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Complete the exercise found in your Student Workbook.
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What parameter identifies under-utilized
agents?

 The customer information the agent sees comes from:

 idle time

 RPC rate

 call duration

 time off job

  nowhere

 the historical database

 the calling list

 a host

  
What notification does an agent receive when
monitored?

 Which of these is not an option in Campaign
Monitor?

 a small icon

 none

 a tone on the headset

 their computer slows down

  remove an agent from a job

 supervisor takes over call

 transfer call to next available agent

 trade calls between agents
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Complete the exercise found in your Student Workbook.
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A hierarchy is:  Which of the following is not a hierarchy parameter?
 a way of looking at data

 a way to segment data files

  a way to link data

  a way to hide data

  Type

 Top

 Bottom

 Median

  
If you name two like levels the same under one
parent level, Hierarchy Manager:

 Hierarchies are used for:

 combines them

 prompts with an error message

 creates both

 closes Hierarchy Manager

  Views

 Reports

 Agents, Jobs, and Dialers

 all of the above
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Module contents

Campaign Analyst

PC Analysis

System reports

Objectives
At the end of this module you will be able to:

Use Campaign Analyst to query and run standard reports●   

Understand how to access and run the standard reports provided with the product●   

Generate and evaluate System reports●   

Use PC Analyst to generate reports●   
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) allows you to customize the display of
Campaign Monitor windows and navigate among the various tool applications within
Campaign Monitor.  

Contents

This section contains the following topics:  

User interface●   

Navigate among the Tool menu applications●   

Use large icons or small icons in the button bar●   

Open a standard view●   

Open a view or view set from another location●   

Create a custom view●   

Save current view●   

Save as view set●   

Save view set with a new name●   

Delete a view set●   

Add a view to the Custom button group●   

Refresh a view●   
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Navigate among the Tool menu applications 

Navigate among the Tool menu applications

Campaign Monitor comes with tool applications that you access from the Tools menu. Use
the following procedure to start Tool menu applications.  

Select Start > Programs > Avaya > Campaign Director > Campaign Monitor.1.  

To start a tool, select it from the Tools menu.
While you use the tool, Campaign Monitor remains open in the background so that
you can navigate back to it when you are finished using the tool.

2.  
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Overview

Purpose

A view is the name given to the customizable window that appears in the main area of
Campaign Monitor after you click a button on the button bar. This section describes how to
use views in Campaign Monitor.  

Contents

This section contains the following topics:  

View control toolbar●   

Filter data in a view●   

Select a performance code●   

Set scope selectors●   

Scope selectors examples●   

Select a time range●   

Select a hierarchy●   

Hide or show columns●   

Select Table View or Graphical View●   

Save a view as HTML●   
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Filter data in a view 

Filter data in a view

Use the following procedure to filter data in a view.  

With a view open, click Filter Data. The Filter Data dialog box appears.1.  

Select a column from the list. The options in this list are the column headings for the
selected view.

2.  

From the Operator list, select an operator.3.  

In the Value box, type a value, and then click OK.4.  
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Overview

Purpose

Campaign Monitor uses the button bar (left-hand side of the window) as the primary
navigation point for opening views. You can open and save favorite views, display views
according to completion codes, display views according to agent and supervisor
relationships, and configure alerts so that you can receive notifications from the Avaya
Predictive Dialing System (PDS). Campaign Monitor displays views in the main window
(right-hand side of your screen).  

Contents

This section contains the following topics:  

Views●   

Dialer Status view●   

Dialer Agents view●   

Dialer Lines view●   

Dialer History view●   

Job Status view●   

Job Agents view●   

Job Detail view●   

Job Call Handling view●   

Job Completion Codes view●   

Job Wait Queues view●   

Job History view●   

Job Performance view●   

Supervisor Agents view●   

Find Agent view●   

Agent Detail view●   

Agent Completion Codes view●   

Agent History view●   

Overview 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/10_performance_Views_GUI_BB2.html (1 of 2) [4/5/2002 3:26:53 PM]

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ch_mon_views.html
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_dialer_agt.html#779937
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_dialer_lines.html#780228
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_dialer_hist.html#750182
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_status.html#760803
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_agt.html#761125
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_detail.html#761437
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_callhand.html#761944
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_ccode.html#762129
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_waitq.html#748985
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_hist.html#749496
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_job_perf.html#749791
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_sup_agt.html#753902
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_agt_find.html#755510
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_agt_detail.html#755622
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_agt_ccode.html#755496
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_view_agt_hist.html#755088


 Volume I PDF

Legal Statement

Avaya Inc.

Overview 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/10_performance_Views_GUI_BB2.html (2 of 2) [4/5/2002 3:26:53 PM]

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/ch_mon_views.html
http://www.avaya.com/


 Avaya PDS User Guide

Page 4 of 20

Dialer Status view 

Dialer Status view

The Dialer Status view displays the job, agent, and line resources used on a dialer. The view
shows the agents and lines assigned to all dialers in the selected scope, as well as the jobs
and the state of completion of each job.  

The following table describes the Dialer Status views.

Dialer Status Description

DialerID  
A unique identification number, automatically assigned to a dialer,
and is used to identify dialer data in the database.  

Dialer  The name of a dialer in the current scope.  

JobID  
A unique identification number, automatically assigned to a job (by
name), used to identify job data in the database.  

Job  The name of each job running in the current scope.  

Job Instance  

A unique identification number, automatically assigned to a single
instance of a job, used to identify data associated with that job
instance in the database. Each time a job runs, the system assigns it
a new job instance ID.  

Status  
The current status of the job (status types include stopped, running,
error, or shutting down).  

Start Time  The date and time the job instance started.  

Stop Time  
The time the job instance stopped or blank if the job is still running.
 

Estimated Job End  
The time that Campaign Monitor estimates the job will end. For an
inbound job, this field is empty.  

Inbound Agents  The total number of inbound agents logged in to each job.  

Outbound Agents  The total number of outbound agents logged in to each job.  

Blend Agents  The total number of blend agents logged in to each job.  

Managed Agents  The total number of managed agents logged in to each job.  

Dialer Status view  
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PTP Agents  The total number of person-to-person agents logged in to each job.  

ACD Agents  The total number of ACD Agents logged into each job.  

Total Agents  The total number of agents logged in to each job.  

Total Lines  The total number of lines in use by the job.  

% Complete  
The percentage of records called based upon the total number of
records selected for calling.  
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Campaign Analyst
March 2002

The final phase of the Campaign Life Cycle is Evaluation. This is when you run reports and analyze the
data from your campaigns. You evaluate how successfully you designed jobs and managed both jobs and
agents.

Campaign Analyst is an integrated part of Campaign Director and provides various reports that allow you
to track job and agent statistics. This business analysis tool can be used to measure call center
performance through generating reports with job, agent and system details.

One big advantage of this latest version of Campaign Director is that Hierarchy Manager and hierarchy
reporting share the same data, so hierarchy reporting is very dynamic.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Campaign Analyst Overview Procedure

Overview of Campaign Analyst  

Campaign Analyst reports  

Create a new report

Print a report

Preview a report

Schedule a report

  Copyright© 2002 Avaya Inc.
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PC Analysis
March 2002

The PC Analysis Telnet tool provides access to the character-based PC Analysis menus. PC Analysis is a
reporting and troubleshooting tool included with the Avaya PDS and lets you transfer extract output files
to a network location.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

PC Analysis (Telnet) Overview Procedure

Overview of PC Analysis Telnet  

PC Analysis toolbar  

Start PC Analysis Telnet

Transfer PC Analysis extract output files
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System reports
March 2002

The Avaya PDS system generates four system reports:

Agent Login Report shows the agent number, the login menu, and
the agent ID.

●   

Multiple Call Report sorts records by phone numbers. It lists the
number of times the Avaya PDS system called the record, the
date, the account number(s), call completion code, agent, and
calling list record number.

●   

Program Information File (PIF) Report shows a list of the
previous data processing programs run on the Avaya PDS system.
Use this report to help troubleshoot system problems.

●   

Hourly Inbound Activity Report shows the number of inbound
calls received as well as the number of inbound calls placed on
hold or abandoned.

●   

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

System reports Overview Procedure

System reports overview  

Agent history report fields  

Generate agent history reports  

Job history report fields  

Generate job history reports  

Calling list report fields  

Generating calling list reports  

System report fields  

Generate system reports  

System Reports
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Campaign Analyst activity
March 2002

Complete the exercise found in your Student Workbook.

  Copyright© 2002 Avaya Inc.
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Reports

Overview

Reports provide statistical information that you can use to evaluate your calling campaigns.
For example, reports can show you how agents spend their time, which completion codes
are most frequently used, the amount of time a particular job ran, and the hierarchy of
managers and agents.  

In Campaign Analyst, reports are grouped into four categories: Agent, Job, Time of Day,
and Administrative. For each category, Campaign Analyst provides several reports. For
example, the Agent category include reports about agent activity, performance summary,
and completion code summary. For each report, Campaign Analyst provides several
variations or configurations. The different configurations sort, group, and filter data
differently.  

In Campaign Analyst, report categories appear on the button bar. For each category, the
reports are listed. When you select a report, the report configurations appear in the main
pane.  

The main pane displays five columns (from left to right): record configuration title, Group 1,
Group 2, Group 3, and Criteria. The last four columns display the options that were selected
for the report configuration.  

There are many configurations for each report, so you should compare the configurations
and experiment with the New and Change reports features. These features allow you to
customize a report's configuration. After you create and save a configuration, it appears with
the other configurations for that report so you can access it any time you use Campaign
Analyst.  

In addition, you can use the Schedule feature to generate reports automatically (daily,
weekly, or monthly). When you set up a report schedule, you specify the exact time that
Avaya PDS sends the report to your printer.  
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Campaign Analyst quiz
March 2002

The schedule feature is used to  Time of day reports produce reports that
 Create reports automatically

 Prompt you to create reports

 Automatically update data

 Schedule job completions

  only include data from the primary dialer

 are weighted to a particular time of day

 are produced at set times every day

 contain data belonging to a time range

  
System time segment can be set to  Data grouping determines

 any interval

 every 5, 10, 15, 20, 30, or 60 minutes

 every 1,5,10 and 15 minutes

 only 6 minute intervals

  which pods are included in the report

 how the columns appear in preview

 which line groups are included

 how the data is formatted in the report

  Copyright© 2002 Avaya Inc.
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PC Analysis activity
March 2002

Complete the exercise found in your Student Workbook.
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Overview

The PC Analysis Telnet tool included in Campaign Analyst provides access to the
character-based PC Analysis menus, which you can use to define extract files and generate
extract output files. You can also use PC Analysis Telnet to move PC Analysis extract
output files from the Avaya PDS to a network location.  

After you transfer the extract output files, you can use spreadsheet, word processing, and
reporting packages available to you to create reports, charts, and spreadsheets.  

PC Analysis Telnet is available from the Campaign Analyst Tools menu only. If access to
Campaign Director is not available, you will need to use a third-party telnet tool to access
Avaya PDS menu system and PC Analysis.  

 Volume I PDF

Legal Statement

Avaya Inc.

PC Analysis Telnet 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/10_Performance_PCAnalTelnet_BB3.html [4/5/2002 3:26:56 PM]

http://www.avaya.com/


 Avaya PDS User Guide

Page 4 of 6

Toolbar icons

Toolbar icons

The PC Analysis Telnet window includes a set of tools that help you use and navigate the
character-based menus and PC Analysis screens. The PC Analysis Telnet toolset is similar
to that of System Telnet but also includes four additional tools designed specifically for use
with PC Analysis.

Toolbar Name Icon Description

Connect    

Use the Connect tool to select the dialer for which you want to
generate or transfer extract data files. This function is not
available while you are connected to a system. You must
disconnect from a dialer before you can connect to a different
dialer.  

Disconnect    

Use the Disconnect tool to end the telnet session for the
current dialer. If you exit the menu system, PC Analysis
Telnet automatically disconnects your session. After you
disconnect, you can connect to a different dialer or exit the PC
Analysis Telnet application.  

Exit out of entry    

Use the Exit out of entry tool to move back one screen in the
character-based screens. This provides the same functionality
as Ctrl-x.  

Done with entry    

Use the Done with entry tool to move to the next
character-based screen. This provides the same functionality
as the Done key (F1).  

Select    

Use the Select tool from the PC Analysis Extraction
Configuration Edit screen. Select moves your cursor to the
Select column. Press Enter after typing the Select value.  

Criteria    

Use the Criteria tool from the PC Analysis Extraction
Configuration Edit screen. Criteria moves your cursor to the
Criteria column. Press Enter after typing the Criteria
statement.  

Toolbar icons 
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Run extract    

Use Run extract from the PC Analysis Extraction
Configuration Edit screen to generate a PC Analysis extract
output file based on the configuration of the open extract file.  

Get file    
Use Get file to transfer one or more PC Analysis extract
output files from the dialer to a network location.  
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PC Analysis quiz
March 2002

PC Analysis Telnet is available from:  System Telnet and PC Analysis Telnet contain
 Campaign Analyst only

 Campaign Director

 Campaign Monitor

 Any Avaya PDS application

  different host connection settings

 different terminal emulation settings

 the same settings

 different toolbar icons

  
PC Analysis sends file via  Which of the following is NOT a toolbar icon?

 email

 ftp

 uucp

 the Internet

  Criteria

 Select

 Run extract

 Reconnect

  Copyright© 2002 Avaya Inc.
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System reports activity
March 2002

Complete the exercise found in your Student Workbook.
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Overview

Use the Reports commands to analyze and track the progress of your daily call activities.
Throughout the day, the Avaya PDS collects data about your calling lists, jobs, and agents.
The system uses this data to generate various reports. You can also use PC Analysis to
create reports. See the next section for details about PC Analysis.  

Choose Reports from the Supervisor Main Menu.  

 Volume II PDF

Legal Statement

Avaya Inc.

Avaya PDS reports overview 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol2/10_Supervisor_Reports_BA3.html [4/5/2002 3:26:57 PM]

http://www.avaya.com/


 Avaya PDS User Guide

Page 4 of 31

Agent history report fields

Overview

The following list describes agent history report fields.

Name Description

For the period...  
Specifies the date or period when the system
captured the report information.  

Report date  
Displays the date that the Avaya PDS created the
report.  

Time  
Displays the time that the Avaya PDS created the
report.  

Agent name  Displays the agent's logon ID.  

Job information  

Describes the job. The information includes job
name, system identification number, job type, and
the record selection file name. It displays the day
and time the job started and finished.  

Total Activity time on job (hh:mm)  

Displays the total time the agent spent on each job.
Active time is the time the agent worked with the
customer record, was on the phone, or waited
between calls.  

Total inbound connects  
Displays the total inbound calls passed to the
agent.  

Total outbound connects  
Displays the total dialing attempts passed to the
agent.  

Total connects per active hour  

Displays the average call connects made each
hour. The system calculates the total call connects
and divides by the  

total active time on the job. The Avaya PDS
calculates the  

average hours to one decimal place.  

Agent history report fields 
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Avg. Agent Related Time Intervals  
Provides a heading for the report field that shows
the average time the agent performed specific tasks
on each job.  

Time Agent Working with Record  

Calculates the average work time the agent talked
with a customer and worked on customer records.
Time begins with the call connection and ends
with record release. This is the total of Time Agent
on Phone and Time Agent on Record After Call.  

Time Agent on Phone  
Calculates the average talk time the agent was on
the phone with each job. Time begins with the call
connection and ends with the phone line release.  

Time Agent on Record After Call  
Calculates the average time to update records.
Time begins with the phone line release and ends
when the record release  

Time Waiting Between Calls  
Calculates the average time the agent waited
between calls. If this time is too long, you may
want to change the Expert Dialing setting.  
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Generate agent history reports

Overview

Agent history reports provide data on agent performance. The menu offers two types of
reports: Agent History Reports (based on job type) and the Agent Activity Report. The
following illustration shows the items on the Agent History Reports menu.  

You have a choice of outbound, inbound, or blend reports. Each report shows data on all the
jobs worked by the agent for a specified period. Information includes the total time an agent
was on a job and how the agent spent the time.  

Generate agent history reports

Use the following procedure to generate agent history reports.  

Choose Agent history reports from the Reports menu.1.  

Choose Outbound, Inbound, or Blend Agent History Report from the Agent History
Reports menu.

2.  

Type a Sort Field name. The sort name labels the columns in your report and
organizes the information in alphanumeric order. To generate an agent history report,
enter one or more of the following selection criteria:

3.  

Job Name(s)  Specify one job or a range of jobs.  

Job Description Label  not more than 30 characters  

Record Selection file
name(s)  

Separate multiple files with a comma.  

Phone Strategy file name(s).
 

Separate multiple files with a comma  

Job Start Date  

The system retrieves job information based on this date.
The start date can be one day or a range of days. Type
dates in the CCYY/MM/DD format. Separate a range with
a comma or a hyphen. For example, to include jobs that
started on June 14 and 15, 1999 type
1999/06/14-1999/06/15 or 1999/06/14, 1999/06/15. To
limit the report summary to one day, enter the date as a
range. For example, to enter June 14, 1999, type 1999/06/
14-1999/06/14.  

Generate agent history reports 
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Job Number(s)  
Separate a range with a dash and multiple job numbers
with a comma. For example, type 1-3 or 1,2,3.  

Agent Name  Include only one agent  

Report Description  not more than 30 characters  

 

Type the number of the Totalling Strategy. Here are what the numbers mean:4.  

0  Details by job  

1  Details by job and totals for a selected period  

2  Totals for a selected period  

3  Totals for a selected period  

4  Subtotals for each job type and totals for a selected period  

5  Details by job, subtotals by job type, and totals for a selected period  

 

Type Y at the prompt if the entries are correct or type N to edit your selections. The
cursor returns to the first field. Press Enter to move to the field you want to correct.
When all the fields are correct, type Y and the Agent History Reports menu appears.

5.  

Choose View or print reports from the Agent History Reports menu.6.  
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Job history report fields

Overview

The job history reports provide data on job performance. The menu offers two types of
reports: Job History Reports (based on job type) and the Previously Run Jobs Report. The
following illustration shows the items on the Job History Reports menu.

Name Description

For the period ...  
Specifies the date or period when the system
captured the report information.  

Report Date  
Displays the date that the Avaya PDS created
the report.  

Time  
Displays the time that the Avaya PDS created
the report.  

Job Information  

Describes the job. The information includes
job name, system identification number, job
type, and the record selection file name. It
displays the day and time the job started and
finished.  

Time System on Line (hh:mm)  

Displays the active time for an outbound job. It
does not include start up time and job
suspension  

time.  

Total Agent Hrs on Line  Displays the time agents were on the job.  

Average Agents On line  
Records the average number of agents logged  

into each job.  

Total Number of Inbound Calls  

Displays the total inbound calls received by the
 

system.  

Job history report fields 
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Inbound Calls per System Hour  
Displays the average number of inbound calls  

received per system hour.  

Inbound Calls per Agent Hour  
Displays the average number of inbound calls
received per agent hour. (Total calls divided by
total agent hours logged to the job)  

Total Connects  
Displays the total inbound calls passed to
agents.  

Total Number of Outbound Calls  
Displays the total dialing attempts made by the
Avaya PDS. It includes all attempts, including
those not passed to agents.  

Dials per System Hour  

Displays the average call connects made each
hour. The Avaya PDS calculates the total call
connects and divides by the total active time
on the job. The system calculates the average
hours to one decimal place.  

Dials per Agent Hour  

Displays the average number of dial attempts
per  

agent hour.  

Total Connects  
Displays the total outbound calls passed to
agents.  

Connects per System Hour  

Displays the average number of connects for
the  

time the job was active.  

Connects per Agent Hour  
Displays the average number of inbound calls  

received per agent hour.  

Rate of Connects to Calls (inbound)  

Displays a decimal amount based on the
number of inbound calls passed to agents
divided by the number of inbound calls
received by the system.  

Rate of Connects to Calls (outbound)  

Displays a decimal amount based on the total
number of connects divided by the total
number of dial attempts received by the
system.  

Average Agent Related Intervals  
Provides a heading for the report fields that
classify the average time agents spent
performing specific tasks on each job.  

Job history report fields 
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Time Agent on Record After Call  
Calculates the average time to update records.
Time begins with the line release and ends
with the record release.  

Time Agent Working with Record  

Calculates the average time agents spent
talking  

with a customer and working on the records.
Time begins with the call connection and ends
when the agent releases the record. This is the
total Time Agent on Record After Call and
Time  

Agent on Call.  

Time Agent on Call  

Calculates the average time agents spent on the
 

phone for each job.  

Time Waiting Between Calls  
Calculates the average time agents waited
between calls.  

Queue Statistics  
Displays the number of outbound and inbound
calls that were placed in wait queue.  

Connect Release Classification (Agent)  
Displays the different call completion codes
and the corresponding number of calls
released.  

System Release Classification  

Displays the number of calls released by the
system according to standard release
classifications or call completion codes such as
NOANSWER and BUSY.  
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Generate job history reports

Overview

The Job History Reports menu allows you to generate reports for outbound jobs, inbound
jobs, blend jobs, or combination reports. The reports provide information on the selected job
for a specific period. It includes the number of dials and connects, call completion codes,
agent work time, agent update time, and agent wait time between calls.  

Generate job history reports

Use the following procedure to generate job history reports.  

Choose Job history reports from the Reports menu.1.  

Choose Outbound, Inbound, or Blend Job Report from the Job History Reports menu.2.  

Type the name of the sort field.3.  

To generate the report, type one or more of the following report selection criteria:4.  

Job Name(s)  Specify one job or a range of jobs.  

Job Description Label  not more than 30 characters  

Record Selection file
name(s)  

Separate multiple files with a comma.  

Phone Strategy file name(s).
 

Separate multiple files with a comma  

Job Start Date  

The system retrieves job information based on this date.
The start date can be one day or a range of days. Type
dates in the CCYY/MM/DD format. Separate a range with
a comma or a hyphen. For example, to include jobs that
started on June 14 and 15, 1999 type
1999/06/14-1999/06/15 or 1999/06/14, 1999/06/15. To
limit the report summary to one day, enter the date as a
range. For example, to enter June 14, 1999, type 1999/06/
14-1999/06/14.  

Job Number(s)  
Separate a range with a dash and multiple job numbers
with a comma. For example, type 1-3 or 1,2,3.  

Agent Name  Include only one agent  

Generate job history reports 
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Report Description  not more than 30 characters  

 

Type the number of the Totalling Strategy.5.  

Type Y at the prompt if the entries are correct or type N to edit your selections. The
cursor returns to the first field. Press Enter to move to the field you want to correct.
When the entries are correct, type Y and the Job History Reports menu appears.

6.  

Choose View or print reports from the Job History Reports menu.7.  
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Calling list reports

Overview

During the download process, the Avaya PDS extracts the data for three calling list reports:  

Days on PDS Report shows the nonproductive contact records. Nonproductive
contact records are records for which no customer contact has occurred within a
certain time. The time is determined during the Avaya PDS configuration. The system
marks these records and includes them on a report after the specified number of days.
Depending on your system configuration, the system will either continue to call the
records or not call those records again.

●   

Reject Report shows the records the Avaya PDS rejected due to duplicate account
numbers, invalid telephone numbers, or time zone sorting failures.

●   

Release Code Report (call completion codes) shows all records with a specific call
completion code. For example, you can request a report of all calls that resulted in a
customer who has promised to make a payment.

●   
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Generate calling list reports

Overview

During the Avaya PDS configuration, the intervals at which the system generates reports
and the call completion codes for the reports were set. The system generates calling list
reports during the daily download process.  

Generate calling list reports

Use the following procedure to generate a calling list report.  

Choose Calling list reports from the Reports menu.1.  

Choose Days on PDS Report, Reject Report, or Release Code Report (Call
Completion Code Report) from the Calling List Reports menu.

2.  

Type a report description (not more than 30 characters).3.  

Type Y at the prompt to continue or N to cancel. The Avaya PDS generates the
report.

4.  

Choose View or print reports.5.  
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System reports

Overview

The Avaya PDS generates four system reports:  

Agent Login Report shows the agent number, the login menu, and the agent ID.●   

Multiple Call Report sorts records by phone numbers. It lists the number of times the
Avaya PDS called the record, the date, the account number(s), call completion code,
agent, and calling list record number.

●   

Program Information File (PIF) Report shows a list of the previous data processing
programs run on the Avaya PDS. Use this report to help troubleshoot system
problems.

●   

Hourly Inbound Activity Report shows the number of inbound calls received as well
as the number of inbound calls placed on hold or abandoned.

●   
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Generate system reports

Use the following procedure to generate a system report.  

Choose System reports from the Reports menu.1.  

Choose Agent Login Report, Multiple Call Report, Program Information File Report,
or Hourly Inbound Activity Report from the System Reports menu.

2.  

If you chose Multiple Call Report, type a phone number in the format
NNN-NNN-NNNN.

3.  

Type a report description (not more than 30 characters).4.  

Type Y at the prompt. The Avaya PDS generates the report.5.  

Choose View or print reports.6.  
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Overview

Purpose

Campaign Analyst generates call management reports with job, agent, and system details
based on Avaya Predictive Dialing System (PDS) activity.  

Contents

This section contains the following topics:  

Reports●   

Report categories●   

Preview a report●   

Export a report●   

Create a new report configuration●   

Schedule a report●   

Change a report●   

Print a report●   

Delete a report configuration●   
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Report categories

Campaign Analyst reports fall under the following categories: Agent, Job, Time of Day, and
Administrative.  

Agent reports

Agent reports present statistics on both an agent's work time (such as total work, update, and
idle time) and performance (such as total connects and connects per hour).

Job reports

Job reports present job statistics by job type: inbound, outbound, or blend. These reports
include statistics about how the system ran a job, system information on calling activity, and
statistics about combined agent activity during a job.

Several job report configurations also group statistics by system to accommodate a
multi-dialer environment.  

Time of Day reports

Time of day reports present job information grouped by time segments. Time of Day reports
let you evaluate job performance at intervals of 60, 30, 20, 15, 10, or 5 minutes. The interval
is set when your system is installed.

The data in any reported interval includes only calls that ended during that interval. For
example, if an agent started talking to a customer at 12:29 and ended the call with a Promise
to Pay at 12:32, the total talk time, update time, idle time, the PTP completion code count
and all other data associated with that transaction would be added to the 12:30-1:00 interval.
 

Several Time of Day report configurations also group statistics by system to accommodate a
multi-dialer environment.  

Administrative reports

Administrative reports present information about the hierarchies created using Hierarchy
Manager.

Report categories 
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Managed Dialing reports

Agent, Job, and Time of Day report groups include reports designed for Managed Dialing
jobs. Campaign Analyst handles connect and online time statistics for Managed Dialing jobs
differently than it does for regular (outbound, inbound, and blend) jobs.  

The following table summarizes the differences between regular and Managed Dialing
reports with regard to the connect and online time statistics.

Statistic Regular job Managed Dialing job

Connect  
An agent is connected to a call
placed by the Avaya PDS.  

An agent previewed a record and did
not cancel the call.  

Online time  
Amount of time an agent waited for
connects, talked to clients, and
updated records.  

Regular job online time plus the
time an agent previewed records.  

 

By default, reports for regular jobs do not contain statistics for Managed Dialing jobs.
Regular job reports contain criteria to include statistics where job type is outbound (OUT),
inbound (INB), or blend (BLND). If you want a report to include both Managed Dialing and
regular job statistics, use the Campaign Analyst report wizard to remove the criteria. On
page 4 of the wizard, remove the Job Type condition and its associated values.  

Note

If you generate a report that combines statistics from both regular and Managed Dialing
jobs, the numbers for online time and connects statistics might be skewed because of the
differences in how those statistics are calculated.  

Agent Completion Code Summary reports

The Completion Code Summary report in the Agent report group contains statistics about
completion codes the agents used during jobs. The report displays up to 14 completion
codes. You can control which codes appear on the report.  

Campaign Analyst selects the first 14 completion codes for which the first character of the
description is an asterisk (*). (Campaign Analyst selects codes in numerical order.) Use
Completion Code Manager to add an asterisk to the descriptions of the completion codes
that you want the Agent Completion Code Summary report to include. If you add an asterisk
to more than 14 completion code descriptions, Campaign Analyst selects the first 14 codes
and disregards the rest.  

In the report, the description appears in a narrow, three-line column (the asterisk does not
appear in the report). Consider modifying long descriptions so that they are more readable
when you view the report. For example, possible abbreviations for a Promise to Pay

Report categories 
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description include Prom to Pay or PTP.  

Note

If you are operating in a multi-dialer environment, Campaign Analyst uses the Completion
Code Manager settings from the primary dialer.  
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Overview

Purpose

The PC Analysis Telnet tool provides access to the character-based PC Analysis menus. PC
Analysis is a reporting and troubleshooting tool included with the AvayaTM Predictive
Dialing System (PDS). The PC Analysis Telnet tool also lets you transfer extract output files
to a network location.  

Contents

This section contains the following topics:  

PC Analysis Telnet●   

Toolbar icons●   

Start PC Analysis Telnet●   

Transfer PC Analysis extract output files●   
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Start PC Analysis Telnet

The PC Analysis Telnet tool provides access to the PC Analysis character-based menus. Use
the following procedure to start PC Analysis Telnet.  

Select Start > Programs > Avaya > Campaign Director > Campaign Analyst.1.  

Select Tools > PC Analysis Telnet.
The PC Analysis Telnet window appears.

2.  

Select File > Connect.
The Connect to PDS dialog box appears.

3.  

From the Name list, select the name of the dialer to which you want to connect, and
then click OK.
The dialer login: prompt appears in the Telnet window.

4.  

Use your system or PC Analysis login to access the PC Analysis menus.5.  

 Volume I PDF

Legal Statement

Avaya Inc.

Start PC Analysis Telnet  

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/telnet_pcanalysis_start.html [4/5/2002 3:27:01 PM]

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/telnet_pcanalysis_transfer.html
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/telnet_pcanalysis_transfer.html
http://www.avaya.com/


  

Sustaining activities
March 2002

Module contents

Administrative menus

Event Monitor

Objectives
At the end of this module you will be able to:

Add or change Area Codes or prefixes through the Administrator menu●   

Understand how the Event Monitoring option is used●   

Create a backup to the Avaya PDS and understand the different types of backups●   

Understand the Transfers and Process Records option●   
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Overview

Purpose

The purpose of this section is to explain AvayaTM Predictive Dialing System (PDS) reports.
 

Contents

This section contains the following topics:  

Avaya PDS reports overview●   

Agent history report fields●   

Generate agent history reports●   

View or print an agent history report●   

Job history report fields●   

Generate job history reports●   

Generate a previously run job history report●   

List distribution●   

Calling list data●   

List distribution report design●   

Generate list distribution reports●   

Select list distribution fields●   

Select list distribution field values●   

Select range in list distribution●   

Set list distribution filters●   

Change list distribution report titles●   

Move fields and values●   

Clear fields and values●   

Delete fields●   

Change or delete a value●   

Edit filters●   

Overview 
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Copy a list distribution report●   

Delete a list distribution report file●   

Execute and print list distribution reports●   

List distribution report analysis●   

Calling list reports●   

Generate calling list reports●   

System reports●   

Generate system reports●   
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View or print an agent history report

Use the following procedure to generate an agent history report.  

Choose Agent Activity Report from the Agent History Reports menu. The Avaya
PDS displays a prompt to tell you it's generating the report. The Agent History
Reports menu appears when the system completes the report.

1.  

Choose View or print reports from the Agent History Reports menu.2.  
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Generate a previously run job history report

Overview

This report provides a list of the last 200 to 500 jobs run by the Avaya PDS. (The actual
number of jobs depends on how your system was set up.) It includes the name, number, unit
work list, job date, job start time, job stop time, and the number of calls the system placed.
You can use it as a reference to help you to select appropriate categories for job or agent
history reports.  

Generate a previously run job history report

Use the following procedure to generate a previously run job history report.  

Choose Job History Reports from the Reports menu.1.  

Choose Previously Run Jobs Report from the Job History Reports menu. The system
displays a confirmation prompt.

2.  

Type Y to generate the report or N to quit without generating a report.3.  
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List distribution report analysis

Overview

The top portion of each report lists the Avaya PDS call completion codes. It helps determine
how many records you have left to call based on the last recorded calling result. These totals
are independent of the list distribution criteria you enter. The totals may change if you have
jobs running.  

The bottom portion of each report displays how many records match the criteria you set
when you defined your list distribution. The information will help you design your record
selections. Once you've looked at the results, you may want to go back and change the
criteria fields values you chose. For example, if you have a large number that appears
between the balance ranges of $1000 and $5000, you can edit the criteria to add a $2500
range.  
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PC Analysis
To see topics for this section, click + in the contents list at left.
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Administrator menus
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The Administrator menus allow you to perform a variety of administrative tasks on your Avaya PDS.
The menu will allow you to shutdown or restart the system, backup and restore the system, manage
inbound lists, and various other functions.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

System Telnet administrator menu Overview Procedure

Restart the Avaya PDS

Shut down the Avaya PDS  

Edit area codes and prefixes

Backup Avaya PDS

Create an empty inbound list

Download host records

Upload records to host  

Backup a calling list  

Restore a calling list  

Count calling list records  
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Use the Monitor security log command to monitor security-related system activity. The System Log
Monitor, at a specified time interval, continually checks the status of critical system and log files.

 Additional resources

For the final Using PDS class, the following links would take you to the relevant material in the online
Avaya PDS User's Guide.

Event Monitor Overview Procedure

Event Monitor  

Monitor security logs

Change monitor interval
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Administrative menus activity
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Complete the exercise found in your Student Workbook.
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Restart the Avaya PDS

This procedure must be completed from the Administrator's console. If you attempt to
restart the Avaya PDS from any other workstation, an error message will appear. Make sure
to shut down all jobs and tell all users to log off before restarting the Avaya PDS.  

Choose Restart system from the Administrative Tasks menu.1.  

Type Y at the prompt to continue or N to cancel. A series of messages appear. When
the restart is complete, the system displays the login prompt.

2.  
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Shut down the Avaya PDS

Overview

The Avaya PDS should always remain on except for the following situations:  

You plan to stop calling operations for several days.●   

There is the possibility of large power surges and electrical damage.●   

You plan to move your system.●   

Shut down the Avaya PDS

To avoid damaging the system components or losing data in active jobs, stop all jobs and
log all users off before shutting down the Avaya PDS.  

Choose Shut down system from the Administrative Tasks menu.1.  

Type Y at the prompt to continue or N to cancel. The following prompt appears: Are
you sure you want to shutdown HP-UX? Enter Y or N.

2.  

Type Y at the prompt to continue or N to cancel. The following message appears:
Halted, you may now cycle power.

3.  

Go to the Avaya PDS cabinet and turn off the power to all components. Most systems
have the components connected to a power strip. The easiest way to turn off the
equipment is to turn off the power strip.

4.  
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Edit area codes and prefixes

Use the following procedure to edit area codes and prefixes.  

From the Administrative Tasks menu, choose Edit area codes/prefixes. The Area
Code & Exchange Prefix Editor menu appears.

1.  

Type the option number or the first letter of the command name.2.  

The Avaya PDS saves changes you make using the Area Code and Exchange Prefix
Editor to a temporary file. When the Avaya PDS restarts, it activates the changes.

3.  
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Backup Avaya PDS

Overview

The standard backup medium is a 4mm, 90-meter, 2.2 GB digital data storage (DDS) tape.
However, you can also use a 9-track tape.  

Back up the following files on a regular basis:  

outbound calling lists●   

inbound calling results●   

call activity statistics●   

files containing user passwords●   

files containing host network (IP) addresses●   

Backup Avaya PDS

Use the following procedure to back up the Avaya PDS.  

Locate the tape drive in the Avaya PDS cabinet.1.  

Insert a new DDS tape in the drive.2.  

Choose a command from the Back Up and Restore Avaya PDS menu. For routine
daily system backups, choose option 3, Back up Avaya PDS & Calling Lists.

3.  

Select full or incremental backup.4.  

After the backup is complete, rewind and remove the tape.5.  

Store the tape in antistatic environment at the proper temperature and humidity.6.  
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Create an empty inbound calling list

Use the following procedure to create an empty inbound calling list.  

Choose Create empty inbound data list from the Inbound Lists menu.1.  

Type Y at the prompt. If the list already exists, the Avaya PDS does not create a new
one.

2.  

When the system completes the process, press any key to return to the Inbound Lists
menu.

3.  
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Back up a calling list

Overview

Making a backup of your calling list allows you to keep working if your host information
becomes damaged. You can back up all calling lists on the Avaya PDS or select specific
calling lists to back up.  

The records on a backup calling list remain in the Avaya PDS format, not in your host
computer format.  

Back up a calling list

Use the following procedure to backup a calling list.  

Locate the tape drive in the Avaya PDS cabinet.1.  

Insert a new DDS tape in the drive.2.  

Choose a backup command from the Back Up and Restore Avaya PDS Calling Lists
menu.

3.  

After the backup is complete, rewind and remove the tape.4.  

Store the tape in an antistatic environment at the proper temperature and humidity.5.  
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Restore a calling list

If a calling list becomes unusable, you can restore a previously backed up list. When you
restore calling list data, the Avaya PDS writes over all, same-named calling list data stored
on the system. Be sure to print reports, upload lists, or perform any other required
procedures before continuing.  

Locate the tape drive in the Avaya PDS cabinet.1.  

Insert a DDS tape with the backup calling list in the drive.2.  

Choose a restore command from the Back Up and Restore Avaya PDS Calling Lists
menu.

3.  

Type Y at the prompt to continue or N to cancel.4.  

After the restoration is complete, rewind the tape.5.  

Remove the tape from the tape drive.6.  
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Count calling list records

Use this command at any time to display the number of records in a calling list, its creation
date, and the amount of disk space it occupies.  

Choose Count calling list records from the Transfer and Process Records menu.1.  

Type Y at the prompt to process the changes or N to cancel.2.  
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Administrator menu quiz
March 2002

Which of these is NOT found on the
administrator menu?

 Where can you add/change an Area Code?

 Manage User Accounts

 Terminate a User Session

 Change Monitor Refresh Interval

 Backup PDS only

  System Monitor menu

 Administrative Tasks menu

 Backup and Restore menu

 Only Avaya Support can do this

  
The system restore commands  What is Operation #7 on the Administrator menu?

 can be used by anyone

 should only be used by Avaya support

 can be used by supervisors

 should never be used

  Copy

 Create

 Help

 Support

  Copyright© 2002 Avaya Inc.

Administrator Menu Quiz
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CUI campaigns
March 2002

Module contents

CUI strategies

CUI record selections

CUI jobs

CUI campaign activity

Objectives
At the end of this module you will be able to:

Create phone strategies, record selections, and set job parameters●   

Start and edit a job●   

Understand how to access Job Monitor through the CUI appellation and manage an active job and
agent activities

●   
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Monitor security logs

Overview

Use the Monitor security log command to monitor security-related system activity. The
System Log Monitor, at a specified time interval, continually checks the status of critical
system and log files. Specifically, the security monitor checks whether critical system files
have been modified since the last status check and whether the Avaya PDS recorded
particular events in the system audit and log files. Events include users logging into and out
of the Avaya PDS; changes to the permissions, ownership, and content of sensitive system
files; attempts to log into restricted user accounts, and changes to the system date and time.  

The System Log Monitor displays results including the date and time of the event, the event
type, whether the event succeeded or failed, and other event details such as the user name
associated with the event. The monitor also provides additional file information when the
file has been changed. For example, for the current and previous versions of a file, the
System Log Monitor lists the permissions, owner, group, file size, and date and ti me
stamps.  

Note  

The System Log Monitor tracks system events only when it is active. Events that occur
when the monitor is not running are not reported. However, if you have ESP access to your
Avaya PDS, it is possible to identify security events that occurred while the monitor was not
running.  
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Change the monitor interval

Overview

The System Log monitor checks system files and log files at regular intervals, for example,
every 60 seconds. The Change Monitor refresh interval command lets you change the
interval setting to increase or decrease the monitor's update frequency.  

You can set the interval to any positive whole number. Recommended settings are between
15 and 300 seconds.  

After you type and confirm a new refresh interval, the Avaya PDS automatically starts the
System Log Monitor.  

Change the monitor interval

Use the following procedure to change the monitor interval.  

From the System Log Monitor main menu, choose Change Monitor refresh interval.
The Additional Entry for Change Monitor refresh interval screen appears.

1.  

Type a new refresh interval, in seconds, then press Enter.2.  

At the Are above entries correct prompt, type Y for yes or N for no.3.  
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Change administrator passwords

The Administrator Main Menu includes sensitive features such as shutting down and
restarting the Avaya PDS. To protect your system, change the administrator's password
often.  

Choose Change administrator password from the Administrative Tasks menu.1.  

Type Y at the prompt to continue or N to cancel.2.  

Type the current password and press Enter.3.  

Type the new password and press Enter. It must contain at least 6 characters, 3 of
which need to be different from the old password. It also needs to contain at least 2
letters and 1 number. After you press Enter, the Avaya PDS prompts you to type the
new password again.

4.  

Type the new password again and press Enter.5.  
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Set the Avaya PDS date and time

Overview

This option is used to reset the Avaya PDS date and time. It is important to keep the system
time accurate due to time zone legalities. Make sure to log all other users off and shut down
all jobs before choosing this option.  

Warning

If you change the date or time during the Avaya PDS operations, you can critically affect
system operation and data.  

Note

If you have automatic file procedures such as an automatic download of data from the host,
setting the time forward can affect the timed event.  

Set the Avaya PDS date and time

Log off all other users and shut down all jobs before choosing this command. You can
critically affect system operation and data if you change the date or time during Avaya PDS
operations.  

Choose Set system date and time from the Administrative Tasks menu.1.  

Type Y at the prompt to continue or N to cancel.2.  

Type a new time in the format HH.MM. The Avaya PDS uses a 24 hour clock and
requires a period between the hours and minutes. For example, type 15.25 for 3:25
PM.

3.  

Type a new date in the format CCYY/MM/DD. For example, type 1999/06/01 for
June 1, 1999.

4.  

Press any key to return to the menu. The new time and date take effect immediately.5.  
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Area codes and prefixes

Overview

Telephone companies frequently add new area codes and prefixes to existing phone systems.
The Avaya PDS needs the up-to-date area code and prefix information to call phone
numbers that use the new codes. The Edit Area Codes and Prefixes option lets you update
the area code and prefix settings on your Avaya PDS.  

Telephone numbers generally consist of three parts: an area code, a prefix (also known as an
exchange), and a line number. For example, in the telephone number 206-555-1212, the area
code is 206, the prefix is 555, and the line number is 1212.  

The Avaya PDS associates prefixes with area codes based on system-defined time zones.
The Avaya PDS configuration includes the standard time zones, such as Eastern, Central,
Mountain, and Pacific. The Avaya PDS configuration also includes several additional time
zones designed to accommodate local and regional ordinances regarding legal calling hours.
For example, the Illinois time zone addresses laws specific to the state of Illinois. Several
other Avaya PDS time zones accommodate areas that do not follow daylight savings time.
See "Time Zones" beginning on page 267 for a list of Avaya PDS time zones.  

Avaya PDS time zones have associated zone codes. A zone code is a one-letter designation
that the Avaya PDS uses to reference a time zone. Zone codes are case-specific. For
example, zone code C (upper case) represents the Atlantic No Daylight time zone while
zone code c (lower case) represents the United Kingdom time zone. The Time Zone and
Exchange Prefix Editor prompts you to type the zone code to which you add (or remove)
area code and prefix settings. The list of Avaya PDS time zones on page 267 includes the
corresponding zone codes.  

Another important telephone system designation is country code. The Time Zone and
Exchange Prefix Editor default country code is 1, which represents the United States and
Canada. Usually, you'll make time zone and prefix setting changes to country code 1. The
editor, however, includes an option to select a different country code if necessary. See
"Country Codes" for a list of selected country codes.  

Note

Some states limit or prohibit placing certain types of telephone  

calls during specific times, usually before a certain time in the morning or after a certain
time at night. Area code fields in the System controls may be modified by the customer in
order to respond to regional area code changes. Such modifications may result in telephone

Area codes and prefixes 
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calls being made in violation of after-hours calling limitations. The customer is solely
responsible for any violations of applicable laws or regulations resulting from area code
modifications.  
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View current area codes and prefixes

Overview

The Query option displays the area codes and area code and prefix combinations that
currently exist on the Avaya PDS. It lists the settings according to time zones. Use the
Query option to determine if you need to change any existing settings. You can also use the
Query option to identify zone codes for which you need to change area code and prefix
settings. You need to know the zone code(s) when you add or delete area code and prefix
settings.  

Note

You can also view current area codes and prefixes from the Add and Delete options. See the
following sections, "Adding an Area Code or a Prefix to a Time Zone" and "Deleting an
Area Code or a Prefix," for more information.  

View current area codes and prefixes

Use the following procedure to view current area codes and prefixes.  

Choose Query from the Area Code & Exchange Prefix Editor menu. The Query Area
Codes and Prefixes screen appears.

1.  

Type an area code; area code and prefix combination; zone code; or zone code, area
code, and prefix combination. See the following section, "Query Options," for more
information.

2.  

The query results appear at the bottom of the query screen. If the query results fill more than
one screen, press Enter to view subsequent pages.  

Query Options

The Query Area Codes and Prefixes option accepts the following four types  

of queries:  

Area Code

The Avaya PDS lists all zone codes that contain the pecified area code. For each zone
code, it also lists the prefixes associated with the area code.

●   

Area Code and Prefix, separated by a colon●   

View current area codes and prefixes 
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The system identifies the zone code in which the specific area code and prefix
combination is listed.

Zone Code (for example, L, the zone code for Pacific Daylight time zone)

The system generates a list of all area codes and prefixes for the specified zone code.

●   

Zone Code followed by a space and an area code or an area code and prefix
combination

Use this option to query for a very specific item. If your criteria is too limited and the
system finds no matches, the system reports the area code or prefix as "not found."

●   

An asterisk (*) in query results represents all prefixes for this area code that aren't explicitly
listed under another zone code. There can be only one asterisk entry for any given area code.
Other entries must contain specific, unique exchange prefixes. For example, area code 709
exists under two zones, Newfoundland Daylight time zone (A) and Atlantic Daylight time
zone (B). The asterisk in the Newfoundland Daylight Prefix List represents all prefixes that
don't appear in the Atlantic Daylight prefix list.  
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Back up commands

From the Administrator Backup Menu you can access sub-menus to backup the Avaya PDS.
You can backup/restore the entire Avaya PDS, the calling lists only, or the host gateway
files.  

Full or Incremental Backup - If you choose any of the backup menu options you will be
asked if you want to perform a full or incremental backup A full backup will backup all the
files in a selected category. An incremental backup will backup only those files that have
been changed since the last backup.  

The following table describes the available backup commands.

Command Description

Back up complete system  

This is the most comprehensive backup option.
The backup includes the entire root file system,
the Avaya PDS, and all calling lists. Use this
option to prepare for events such as major
system upgrades and service pack installations.
 

Back up Avaya PDS & calling lists  
This command backs up the entire Avaya PDS
and all customer calling lists. Use this option
for routine daily system backups.  

Back up Avaya PDS only  
This command backs up the entire Avaya PDS
excluding the calling lists (specifically, all data
in the /usr/vl/xfer/clist directory).  

Back up Avaya PDS configuration files
 

This command backs up all the Avaya PDS
configuration files. These are the files needed
to customize a newly installed Avaya PDS to
the customer's applications.  

Back up Avaya PDS data/stat files  
This command backs up the data files needed
to run reports using the Avaya PDS PC
Analysis tools.  

 

Back up and restore commands 
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Restore Commands

The following table describes the available restore commands.

Command Description

Restore all from tape  This command restores all files from the backup tape.  

Restore a file from tape  
This command attempts to restore a single user-specified file
from the backup tape.  

List/verify a file on tape  
This command attempts a search for a single user-specified
file on the backup tape.  

List/verify tape contents  This command lists the entire contents of the backup tape.  

List tape volume info  
This command displays the creation information of the
backup tape.  
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Verify backup files

Use the following procedure to verify that you have a successful backup of your files.  

Choose a List/Verify command from the Back Up and Restore menu.1.  

Type Y at the prompt to continue or N to cancel.2.  

Follow the tape loading instructions on the screen.3.  

Type C to continue or press Ctrl+X to exit. Byte count, date, size, and file names
appear on the screen during the tape verification process.

4.  

After verifying the tape, follow the unloading instructions on the screen.5.  

Type C to return to the Back Up and Restore menu.6.  
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) uses inbound lists to capture information
from inbound calls.  

These commands are available if your Avaya PDS uses Intelligent Call Blending.  

An inbound calling list contains the fields that the agents use when handling inbound calls.
Once created, the inbound calling list file is a permanent part of the Avaya PDS.  

Contents

This section contains the following topics:  

Create an empty inbound calling list●   

Clear existing inbound calling lists●   

Count calling list records●   
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Clear existing inbound calling lists

Use this command to clear the data in the inbound calling list. Clear this list after
completing inbound calling and uploading all data to your host.  

Choose Clear an existing inbound data list from the Inbound Lists menu.1.  

Type Y at the prompt to continue or N to cancel.2.  

When the Avaya PDS completes the process, press any key to return to the Inbound
Lists menu.

3.  
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Monitor DAT drive status

Overview

You need to monitor the tape drive status during backup and restore procedures. There are
two LEDs on the tape drive. The LED on the left is the cassette LED. The LED on the right
is the drive LED. When the Avaya PDS uses the tape drive, both lights flash in different
color combinations.  

LED color

These combinations identify the tape drive's status.

Cassette LED Color Drive LED Color Status

Flashing green  Flashing green  
Write-enabled tape loading or unloading.
 

Green  Green  Write-enabled tape loaded and online.  

Flashing amber  Flashing green  
Write-protected tape loading or
unloading.  

Amber  Green  Write-protected tape loaded and online.  

Green  
Flashing green and
amber  

Media wear. Replace tape or clean tape
drive.  

Amber  Amber  
High room humidity. Tape cannot load or
unload.  

Flashing amber  Flashing amber  Successful power-on self-test.  

Flashing amber  Amber  
Unsuccessful power-on self-test. Contact
your Avaya PDS vendor.  

 

Monitor DAT drive status 
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System security event monitor
To see topics for this section, click + in the contents list at left.
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Recover calling list

Overview

If you do not receive a new calling list from your host computer, you can recover the old
calling list to use for your daily calling activities. Every evening the Avaya PDS saves your
calling list to a backup file named list.old. This list usually contains enough uncalled records
for you to use until you receive a new list from the host.  

Recover calling list

Restoring an old calling list writes over the existing calling list. Be sure to print your
reports, back up your list, or perform any other required procedures before proceeding.  

Choose Recover old calling list from the Transfer and Process Records menu.1.  

Type Y at the prompt to continue or N to cancel.2.  
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Download records for infinite jobs

Overview

This command is available if you have set up infinite jobs on the Avaya PDS. For more
information about infinite jobs, contact your Avaya PDS vendor.  

Use this command to manually download and process new records to add to a calling list
used by an infinite job. It downloads and processes a list segment while the job is active.  

This download command also performs a duplicate record check, if required. The Avaya
PDS then executes the infinity record selection only on the new list segment and makes the
new records available for calling on the infinite job. The new number of records will appear
in the Records Selected and Calls Left fields of the Job Monitor screen. These records have
the same priority as first attempt records.  

Before using this command, set up an infinity record selection and edit and start an infinite
job.  

Download records for an infinite job

Use the following procedure to download records for an infinite job.  

Choose Download records for Infinite Job from the Transfer and Process Records
menu.

1.  

Type Y at the prompt to continue or N to cancel. The host transmits the calling list
records to the Avaya PDS.

2.  
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Event Monitor activity
March 2002

Complete the exercise found in your Student Workbook.
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CUI phone strategies
March 2002

The character-based user interface (CUI) to the Avaya PDS is provided as a secondary means of
controlling and monitoring the dialer operations. In many contact centers a significant amount of
investment has been made in customization based on the CUI and therefore, although more limited than
the graphical user interface (GUI), these customers may continue to use the CUI for certain key
operations.

It is important to note that CUI applications control and manage a single dialer, whereas the Campaign
Director suite can manage multiple dialers.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Phone strategy (CUI) Overview Procedure

Create a phone strategy  

Add initial phone  

Add alternate initial phone  

Add ring count and call connect criteria  

Add retries  
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CUI record selections
March 2002

You can execute a record selection immediately after you define the selection criteria or save it and
execute the selection at a later time.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Record selection (CUI) Overview Procedure

Create a record selection

Selecting Time Zones  

Selecting Call Completion Codes  

Selecting field names and values  

Selecting phone strategies  

Sorthing field names and direction (optional)  

Selecting recall field names and values  
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CUI jobs
March 2002

Before creating a job for a campaign, load the calling list and prepare the phone strategy and record
selection files. Execute the record selection file, then copy the job definition and edit the copy.

 Additional resources

Use the following links to take you to the relevant material in the online Avaya PDS User's Guide.

Jobs (CUI) Overview Procedure

Create a job

Edit outbound job

Managed jobs  

Edit Managed Jobs  

Edit sales verification jobs

Edit infinite jobs

Edit virtual jobs

Edit inbound jobs

Edit blend jobs  

Copy a job  

Delete a job  
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CUI campaign activity
March 2002

Complete the exercise found in your Student Workbook.
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Overview

Purpose

The purpose of this section is to provide information about monitoring.  

Contents

This section contains the following topics:  

Monitor security logs●   

Use the system log monitor●   

Change the monitor interval●   

 Volume II PDF

Legal Statement

Avaya Inc.

Overview 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol2/10_Admin_SystemSecEventMon_BA2.html [4/5/2002 3:27:11 PM]

http://www.avaya.com/


 Avaya PDS User Guide

Page 4 of 5

Use the system log monitor

Use the system log monitor

Use the following procedure to use the system log monitor.  

To start the System Log Monitor, choose Monitor security log from the System Log
Monitor main menu. At a specified interval, the monitor updates the screen with
information about targeted events.

1.  

To close the System Log Monitor, type X, then press Enter.2.  
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Agent Blending
To see topics for this section, click + in the contents list at left.
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CUI phone strategy activity
March 2002

Complete the exercise found in your Student Workbook.
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Create phone strategy

Create a phone strategy

Use the following procedure to create a phone strategy.  

Choose Create a phone strategy from the Phone Strategies menu.1.  

If the system has more than one calling list, type the calling list number and press
Enter. (If you use only one calling list, the Avaya PDS skips this step.) The phone
strategy name prompt appears.

2.  

Type a strategy file name (not more than 8 characters). Do not use special characters
such as hyphens, slashes, or spaces.

3.  

Type Y at the prompt to process the changes or N to cancel. If you type Y, the Select
Initial Phone screen appears.

4.  
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Add initial phone

Add an initial phone

Use the following procedure to add an initial phone.  

In the Phone column, type the phone type number (1, 2, 3, ...) of the first phone
number you want to call.

1.  

Select a field by typing the field name (uppercase letters) in the Field column or press
F4 (View) to select the field from the calling list.

2.  

Type a value in the Value column. For help in setting values, see "To select field
names and value criteria".

3.  

To add a second field and value for this phone, type AND or OR in the And/Or
column; then repeat steps 2 and 3.

4.  

Repeat steps 1 through 4 for each selected phone. After you enter all the fields and
values for the initial phones, press F1 (Done). The Select Alternate Initial Phone
screen appears.

5.  
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Add alternate initial phone (optional)

Add an alternate initial phone

Use the following procedure to add an alternate initial phone (optional).  

In the Phone column, type the phone type number (1, 2, 3, ...) of the alternate phone
number you want to call.

1.  

In the Time Zones column, type the uppercase letter assigned to the time zone or type
an asterisk (*) for all time zones or press F4 (View) to select a time zone from a list.

2.  

In the Time column, type the time you want the Avaya PDS to start calling the
alternate phone (24-hour clock). Use a period to separate hours and minutes. For
example, type 17.10 to enter 5:10 PM.

3.  

Repeat steps 1 through 3 for each alternate initial phone. Press F1 (Done). The Select
System Set Recalls screen appears.

4.  
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Add ring count and call connect criteria

Add ring count and call connect criteria

Use the following procedure to add ring count and call connect criteria.  

In the Phone Field column, type the phone type number (1, 2, 3, ...).1.  

Type the number of rings to allow in the # of Rings column. (Low number
recommended, such as 3.)

2.  

Type the letter(s) to designate the call detection mode in the Connect.3.  

Repeat steps 1 through 3 for each initial phone type.4.  

Press F1 (Done). The Record Selections menu reappears. For help setting up record
selections, see "Overview of Record Selections".

5.  
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Add retries

Add retries

Use the following procedure to add retries.  

In the Phone Field column, type the phone type number (1, 2, 3, ...).1.  

Press F4 (View) to view the call completion codes list. Use the arrow keys to select a
code, then press Enter. You can also type the call code directly in the Call Result
column. It must match upper and lowercase characters.

2.  

Type the number of minutes between each calling attempts in the Min (Minutes)
column.

3.  

Type the number of retries in the Number column.4.  

In the Next Phone column, type the phone type number (1, 2, 3, ...). The Next Phone
is the phone the Avaya PDS calls after it makes the last attempt to call the initial
phone. If you leave this field blank, the system stops calling the record after the last
retry.

5.  

Repeat steps 1 through 5 for each call result for which you want to schedule retries.6.  

Press F1 (Done). The Select Ring Count and Call Connect Criteria screen appears.7.  
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CUI phone strategy quiz
March 2002

What is not allowed in a phone strategy name?  To specify all times zones in the alternative initial
phone setting, type

 numbers

 special characters

 upper case letters

 letters and numbers

  x

 all

 0

 *

  
To see the call completion code list, when
adding retires, type:

 How do you move to the next screen?

 F1

 F4

 F8

 ESC

  Control + N

 F4

 Control +X

 F1
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CUI record selection activity
March 2002

Complete the exercise found in your Student Workbook.

  Copyright© 2002 Avaya Inc.

CUI Record Selection Activity

http://pds.au.avaya.com/esp/mos12/Redtrain/UsingPDS/Cui/220.html [4/5/2002 3:27:13 PM]

http://www.avaya.com/


 Avaya PDS User Guide

Page 14 of 45

Create a Record Selection

Create a record selection

Use the following procedure to create a record selection.  

Choose Create a record selection from the Record Selections menu.1.  

If your system has more than one calling list, type the calling list number at the
prompt. (The system skips this step if your system has only one calling list.)

2.  

Type a name for this file (not more than 8 characters). Do not use special characters
such as hyphens, slashes, or spaces.

3.  

Type an optional report description (not more than 30 characters). The system names
the report if you leave the field blank.

4.  

Type Y at the prompt to confirm the name or N to cancel. The Select Time Zones for
Calling screen appears.

5.  
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Selecting Time Zones

Overview

Use the Select Time Zones for Calling screen to select the time zones the Avaya PDS uses
to call customers. The screen displays a list of all the time zones defined for the Avaya PDS.
The time designated for the various zones is your Avaya PDS time. The Avaya PDS time
zones are based on the local time zone where the Avaya PDS is located. An uppercase letter
code in the Zone column designates the time zone code.  

State laws differ about legal calling times. Therefore, your Avaya PDS may list numerous
time zones. If there are more zones than fit one page, press Ctrl+N (next page) to see the
additional screens. The screen also shows the recommended start and stop times for each of
these zones.  

Selecting Time Zone parameters

Use the following procedure to select time zone paramters.  

Type the Zone ID (uppercase letters only) in the Enter Time Zone Codes field. Press
Enter after each Zone ID. You need to enter at least one time zone. To select all time
zones, type an asterisk (*).

1.  

If you enter an incorrect letter or type a lowercase letter, an error message appears.
Press the arrow keys to move to the error. Make the correction and press Enter. To
clear an entry, press Spacebar.

2.  

Press F1 (Done). The Select Call Completion Codes screen appears.3.  
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Selecting Call Completion Codes

Overview

Call completion codes represent the result of the last completed call. Use the Select Call
Completion Codes screen to select records based on call completion codes. In most cases,
you select records that you have not contacted, such as BUSY, NOANSWER, or
NOTCALLED.  

When the screen appears, the Avaya PDS positions the cursor in the first field.  

Selecting Call Completion Codes

Use the following procedure to select call cmpletion codes  

Press F4 (View) to see the Call Completion Code List.1.  

To select additional codes, press Enter again. The cursor moves to the next blank
field.

2.  

Repeat steps 1 through 3 as necessary.3.  

Press F1 (Done). When the entries are correct, press F1 (Done). The Select Field
Names and Values screen appears

4.  
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Selecting Field Names and Value

Overview

Use the Select Field Names and Values screen to target a specific group of clients for
calling. Select records based on any field in the calling list and a value for that field.  

Enter values as they would appear in the calling list records. Use expressions, comparison
operator, and logical operators as needed.  

Selecting Field Names and Values

Use the following procedure to select field names and values.  

In the Name column, type the field name in uppercase letters or press F4 (View) to
select a field from the calling list.

1.  

Type a value in the Value column and press Enter.2.  

Note

You can have up to 40 fields on multiple screen pages. Press Ctrl+N next page) and Ctrl+P
(previous page) to move through screen pages. The Start Range column for the first row
contains an opening parenthesis. The End Range column of row 40 contains the closing
parenthesis.  
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Selecting Phone Strategies

Overview

Select a phone strategy file to tell the Avaya PDS how to call the selected records. This is
the last step in designing a record selection.  

Selecting a phone strategy

Use the following procedure to select a phone strategy to be used within the record
selection.  

Type the Strategy File Name or press F10 (Search) to scroll through the available
phone strategies. Each time you press F10 a new strategy appears. If you want to
confirm that you are choosing the correct strategy, press F4 (View) to review the
parameters for the selected strategy.

1.  

Press (F1) Done. If your system setup includes expanded Record Selection reporting,
the Select Fields for Report screen appears. Continue to "Selecting Fields for the
Record Selection Report" in the following section. Otherwise, the Selection List
Generation screen appears.

2.  

From the Selection List Generation screen, start the record selection or exit without
generating the record selection.

3.  
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Sorting field names and direction (optional)

Overview

Sorting records by field names is optional. If you choose to sort records, the Avaya PDS
calls the records in the order you set. Otherwise, the system calls them in the order they
appear in the calling list.  

Ascending is the default sort order. If you want to sort in descending order, move the cursor
to the Sort Direction column, type D and press Enter. To skip the Sort Field Names and
Direction screen, press F1 (Done).  

Selecting Fields Names and direction

Use the following procedure to select field names and direction.  

In the Sort Direction column, press Enter to leave the sort direction as Ascending or
type D and press Enter to change to descending.

1.  

In the Field Name column, press F4 (View) to see a list of fields. Choose the sort
field.

2.  

To add a subcategory to sort by, press Enter to move to the next line and repeat steps
1 and 2 for each subcategory. The Avaya PDS sorts first by the field in priority 1,
then priority 2, and so on.

3.  

Press F1 (Done). The Select Recall Field Names and Values screen appears.4.  
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Selecting recall field names and values

Overview

Use the Select Recall Field Names and Values screen to tell the Avaya PDS which agent set
recalls to include in the record selection. If left blank, the system includes all agent-set
recalls. To skip this screen, press F1 (Done). Set recall criteria the way you set field name
and value selection criteria.  

Selecting recall criteria

Use the following procedure to select recall criteria.  

In the Name column, type a field name or press F4 (View) to select a field name from
the calling list.

1.  

Type a value in the Value column and press Enter.2.  

Press Done (F1). The Select Call Strategy File screen appears.3.  
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CUI record selection quiz
March 2002

To clear an erroneous entry, type  What key(s) allow you to move to the next field?
 delete

 space

 F1

  start over

  Control +N

 F9

 F4

 F1

  
How do you start/run the record selection after
editing it?

 To use Unit Record Selections, you must use

 Control +N

 F4

 F9

 C + Enter

  multiple dialers

 blend agents

 agent call lists

 agent work lists
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CUI jobs activity
March 2002

Complete the exercise found in your Student Workbook.
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Create a job

Create a job

Before creating a job for a campaign, load the calling list and prepare the phone strategy and
record selection files. Execute the record selection file, then copy the job definition and edit
the copy.  

Choose Jobs from the Campaigns menu. The Jobs menu appears.1.  

Choose Copy a job from the Jobs menu and press Enter. Type the item number for the
job you want to copy and press Enter.

2.  

Type Y in response to the prompt.3.  

Type a new name for the job.4.  

On the Jobs menu, choose one of the following: Edit and start an outbound job, Edit
and start an inbound job, Edit and start a blend job, Edit and start a unit work list job,
or Edit and start an infinite job.

5.  

Type the item number of the job you want to edit. The Job Run Verification screen
appears. See the following sections for details on each screen.

6.  
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Edit an outbound job

Edit an outbound job

Use the Outbound Job Run Verification screen to set and verify outbound job settings.  

Choose Edit and start an outbound job from the Jobs menu.1.  

Type the item number for the job you want to edit. The Outbound Job Run
Verification screen appears. The cursor is in the first field.

2.  

If the value is correct, press Enter to go to the next field. If a value is incorrect, press
Ctrl+C (Change). Type the new information and press Enter to move to the next field.

3.  

If a field uses only a yes or no response, use Ctrl+C to switch between YES and NO.4.  
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Managed Jobs

Minimum hit rate

Type a number from 0 to 100 (without the percent sign) in increments of 5. Thirty (30) is the
recommended setting. Minimum hit rate determines the maximum number of calls the
system will make in attempting to make an agent connection. For example, a minimum hit
rate of 30% means the system will make no more than three dialing attempts for each agent.
 

Use minimum hit rate to limit the number of lines a job can use, even if the hit rate falls
below this rate. This prevents the system from allocating more pooled lines to a poorly
performing job at the expense of a more successful job.  

Initial hit rate

Type a number from 0 to 100 (without the percent sign) in increments of 5. Fifty (50) is the
recommended setting.  

Initial hit rate determines the average number of calls per agent the system makes during the
job's first five minutes. The initial hit rate is the number of call completions compared with
call attempts. For example, an initial hit rate of 50% means the system must make
approximately two dialing attempts for each agent to get one successful connection.  

When the system accumulates statistics from actual call attempts (after about five minutes),
it readjusts the hit rate automatically to meet the minimum hit rate setting.  

Use the following guidelines to set the initial hit rate.

If you want to make Set rate to Description

Daytime home calls  30  3 calls per agent for 1 connection  

Evening home calls  50  2 calls per agent for 1 connection  

Weekend home calls  50  2 calls per agent for 1 connection  

Daytime office calls  70  1 call per agent for 1 connection  

 

The initial hit rate controls dialing attempts for the first five minutes only. If you set the rate
too low (20 to 30), the system could make more connects than your agents can handle
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during the initial dialing period. If you set the rate too high (over 70), the system could fail
to make enough connections to keep your agents busy.  

Expert calling ratio

Type a Q, a W, or a U followed by a number from 0 to 100. For example, type Q30 to tell
the system to allow 30% of the calls into the wait queue. The major difference among
Expert Calling ratio settings is that the system bases W and U on agent productivity and Q
settings affect customer wait time. When you use W or U settings, the average agent idle
time can be short; but there may be a large percentage of customers in the wait queue at any
given time.  

See the following table for recommended settings.

Parameter Value Recommended setting

Q  0-100  Q4 through Q31  

W  0-100  W29 through W71  

U  0-100  U32 through U78  

 

The Expert Calling ratio tells the system how to predict when it should make the next call.
You can select one of the following:  

Q mode The system achieves a balance between agents waiting for a call and
customers placed in the wait queue. On average, when you use Q the agent idle time
is longer to make sure that customers spend less time in the wait queue.

●   

W mode The system monitors the time agents take to complete calls and update
records and adjusts the calling pace accordingly. When you use W, the average agent
idle time can be short, but there may be a large percentage of customers in the wait
queue at any given time.

●   

U mode The system monitors the time agents take to update records and adjusts the
calling pace accordingly. When you use W or U, the average agent idle time can be
short, but there may be a large percentage of customers in the wait queue at any given
time.

●   

Line types

Type the line type code(s). Separate multiple codes with commas. If your system has only
one outbound line pool, this feature is not available for outbound calls. Line type codes are
the same thing as line group (line pool) names. The ability to manage the phone lines
depends upon your system configuration. If your system has multiple line groupings, use
this parameter to select or clear the groups of lines the system uses for a job.  

Control the number of lines available for a particular job by assigning it additional groups or
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by moving a competing job to another line group. If you designate more than one line group,
separate them with a comma. For example, type REG1, REG2, REG3.  

Job description

Type a job description (not more than 30 characters). The job description appears on reports
and in job history files. You can sort job reports by the job description.  

Selection  

Type the name of the record selection file. The file contains the criteria the system uses to
select records from the calling list. It also includes the phone strategy.  

Note  

Always execute the record selection before you define or run a job.  

End job when quota is met

Type YES to tell the system to end a job when the agents reach the quota. You set this quota
with the Quota parameter.  

Type NO to tell the system to disregard the quota setting. Use NO when using unit work list
jobs, unless you are going to set a quota for the entire job. Once you start the job, you can
set quotas for individual unit work lists using Job Monitor.  

A job can end in one of the following ways:  

You can manually stop a job.●   

You can tell the system to continue making calls until it calls all initial phones at least
once.

●   

You can tell the system to continue calling until it has called all recalls at least once.●   

You can tell the system to call scheduled recalls but stop calling when it has called all
initial phones at least once.

●   

You can tell the system to stop calling when the agents meet the quota you set.●   

In any of the above cases, the system stops calling when the system time reaches the time
set in the Latest time to stop calling parameter.  

Order by time zone

Type YES to turn on time zone ordering or NO to call customers in mixed time zones.  

When you set this parameter to YES, the system calls all the records in the eastern most
time zone; then it calls the records in the next time zone to the west.  

When you set this parameter to NO, the system calls records round robin through the time
zones. This is useful when broad coverage is more important than completing calls in time
zone order.  
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Quota

Type the call completion code number, a comma, and the quota. For example, type 16,4.  

The system defines the quota as a specific number of successful calls assigned a call
completion code. This parameter is only effective when you set the End job when quota is
met parameter to YES. When a job reaches the quota, the system stops making calls.  

You have the following choices:  

Set no quota for the job. Leave the field blank or erase the existing entry by pressing
Ctrl+E.

●   

Set one quota for the entire job. When the job meets the quota, the job ends.●   

Set one quota to apply to all unit work lists. Each unit shuts down when the agent
reaches the quota for that list.

●   

Set different quotas for each unit work list. To do this, set the quota, then set
individual quotas in the Settings menu on the Job Monitor Screen. See "Editing Unit
Record Selections".

●   

Allocate all units to agents

Type YES to let agents work all available unit work lists or NO to assign theagents to
specific unit work lists. Use this parameter with unit work list jobs. If this is not a unit work
list job, leave this field blank or type NO.  

History reports by unit

Type YES to generate a report by unit work lists or NO to report by job. Use this parameter
with unit work list jobs. If this is not a unit work list job, leave this field blank or type NO.  

Managed dialing

Type YES to turn on Manage Dialing or NO to turn it off. Managed Dialing is an optional
feature that lets agents preview records before the system dials the number. See "Editing
Managed Jobs" for guidelines on other Managed Dialing settings.  

Note Use Managed Dialing with normal outbound jobs, not unit work list or Predictive
Blend jobs.  

The Preview limit and Allow agents to cancel calls parameters determine the Managed
Dialing settings.  

Preview limit (sec.)

Type a number between 0 and 999 to set the seconds to allow for preview time. It sets the
time that an agent can preview a record before the system dials the number.  
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Type 0 to specify unlimited preview time. This parameter is only effective if you set the
Managed Dialing parameter to YES.  

Allow agents to cancel calls

Type YES to allow agents to cancel calls before the system dials the number or NO to let
them preview records but not cancel calls. This parameter is only effective if you set the
Managed Dialing parameter to YES.  

Earliest start time

Leave the field blank to accept the system recommended time or type the time using the
24-hour clock. Use a period to separate hours and minutes. For example, type 17.10 to enter
5:10 PM and 8.30 to enter 8:30 AM.  

Change this setting to meet the objective of a particular job.  

The system is preset with recommended start and stop times for different time zones. If you
enter a time that is earlier than the recommended start time, the system does not begin
dialing until the system clock reaches the recommended time.  

Latest start time

Leave the field blank to accept the recommended time or type the time using the 24-hour
clock. For example, type 17.10 to enter 5:10 PM and 8.30 to enter 8:30 AM.  

The latest stop time tells the system when to stop making outbound calls. If you set a time
that is later than the recommended stop time, the system stops dialing at the recommended
time.  

Outbound list

Type the name of the calling list. Choose the outbound calling list for the job. The outbound
calling list needs to be the same for the job, the record selection, and the agent screen(s).  

Agent key definition file

Type the name of the agent keys file. Choose the keys file that was designed to run with the
job. These are the keys that agents use during an outbound job.  

Start script label

Type the message script name or press Ctrl+D to choose from a list. Choose the message the
customer hears in the wait queue.  
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Main data process label

Type the name of the data process label for an outbound job or press Ctrl+D to choose from
a list.  

Outbound screen(s)

Type the screen name. If agents use more than one screen, separate the screen names with a
comma. For example, type screen1, screen2, screen3. Choose the outbound screen(s) that
were designed to run with the job. These are the screens that agents see on their
workstations during an outbound job.  

Total Wait Delay

Type the maximum number of seconds (0-999) that a customer can wait in an outbound
queue before the system hangs up on the caller.  

Next linked job

Type the job name to run when the current job ends.  

Link jobs when you want the system to start a job as the current job ends. When you link a
job, the system transfers each agent to the next job after the agent completes the last call and
releases the record. The system displays a message telling the agents that they are changing
jobs. You can link an outbound job to any job that is not a unit work list job or a managed
job. You can link multiple managed jobs to each other. Remember to run the record
selection for the next job before it starts. If you do not, the job will not start.  

Transfer to job

Type the name of the inbound or blend job to which agents can transfer calls.  

Do not call group name

Type the Do Not Call group name if you want agents to mark records as Do Not Call. Do
Not Call groups contain one or more inbound or outbound calling lists. To use the
Supervisor menus to mark a record as Do Not Call, see "Marking Records as Do Not Call".  

Recall notify (mins)

Type the number of minutes before the recall that the system will notify the agent who owns
it. Use this parameter to set up the Agent Owned Recall feature. Leave it blank to disable
Agent Owned Recall.  
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Recall reschedule (min)

Type the number of minutes the system will wait before attempting to notify an agent again.
 

Use this parameter to set up the Agent Owned Recall feature. Leave it blank to disable
Agent Owned Recall.  

Recall tries (times)

Type the number of times the system will attempt to find the agent who set the recall before
it treats the call as a standard recall.  

Type 0 (zero) to tell the system to look for the original agent indefinitely. Use this parameter
to set up the Agent Owned Recall feature. Leave it blank to disable Agent Owned Recall.  

Infinite job resort field

Type the name of the field from the calling list record that is used to sort records for infinite
jobs.  
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Edit a managed job

A managed job is a job that uses Managed Dialing. It allows agents to preview a record
before the system dials the number. You can also give agents the option to cancel a call
before the system dials the number. To set up a managed job, choose Edit and start an
outbound job from the Jobs Menu. The Outbound Job Run Verification screen appears.  

Set managed job parameter

Follow the steps in "Editing Outbound Jobs" for all parameters that are not specifically for
managed jobs. Follow the directions below for managed job settings.  

Set Minimum hit rate to 100. Since the agents are previewing one record at a time, the
hit rate must be set to 100. This forces the system to dial only one number per agent.

1.  

Leave Expert Calling ratio blank. The system sets it to the appropriate level after the
first five minutes.

2.  

Type a Job description.3.  

In the Start script label field, select a Managed Dialing script. The managed script
tells the system to first pass the record to the agent for preview.

4.  

Set Managed Dialing to YES by pressing Ctrl+C to switch between NO and YES.5.  

Set a Preview limit. The range is 0 seconds to 999 seconds. If the setting is 0, the
agents have unlimited time to preview the record.

6.  

Set Allow agents to cancel calls to YES or NO. YES allows the agents to cancel the
call.

7.  
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Edit sales verification jobs

A sales verification job is an outbound (target) job used to verify a sale or commitment that
a customer made during a different (source) job. The system uses a different group of agents
for the target and source jobs. For more information about sales verification jobs, contact
your system vendor.  

When setting up a sales verification job, follow the steps in "Using Verify Record
Selections," "Creating Jobs," and "Editing Outbound Jobs". Use the following special
instructions.  

When executing a verify record selection file  

If prompted, choose the source job's calling list.●   

To set up the source job  

On the Outbound Job Run Verification screen, verify that the●   

Completion Code parameter is 93. If it isn't, press Ctrl+D and choose this code.●   

To create the sales verification job (target)  

Choose the outbound job named Verify as the job you want to copy.●   

Type a job name that identifies it as a verification job, such as verifyam.●   

On the Jobs menu, choose Edit and start an outbound job.●   

To set up Outbound Job Run Verification screen parameters  

Calling List: choose the source job's calling list.●   

Verification job: press Ctrl+C to change the setting to Yes.●   

Main data process label: confirm that the setting is Verify. If it isn't, press Ctrl+C and
choose Verify.

●   
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Edit infinite jobs

An infinite job is an optional outbound job that can receive new records for calling while the
job is active. An infinite job runs until you stop it manually. An infinite job uses a special
record selection called an infinite record selection. Using this record selection, the system
can add new records (downloaded from your host) to an existing calling list on an active
infinite job. The system adds the new records to a list segment. See "Using Infinite Record
Selections".  

For more information about infinite jobs, contact your system vendor.  

To edit an infinite job, choose Edit and start an outbound job from the Jobs Menu. Select the
predefined infinite job (usually called infinity). Follow the steps in "Editing Outbound Jobs"
for all parameters that are not specifically for infinite jobs.  

Follow the directions below for infinite job settings.  

Type infinity for the Job Description.1.  

Set the End job when quota is met parameter to No.2.  

To download and append a new list segment, use the Transfer and Process Records menu.
See "Downloading Records for Infinite Jobs".  

Type Y at the prompt to continue or N to cancel. The system receives the new calling list
records. An infinite job runs for long periods and must be shut down manually. If you need
to restart the job, run the infinity record selection again before restarting. This ensures that
the new list segments are properly incorporated into the calling list.  
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Edit virtual jobs

A virtual agent job is an optional outbound job during which the system manages calling
activities without agents. This type of job places a call, connects the customer or answering
machine to the system, and plays a recorded message. For more information about virtual
agent jobs, contact your system vendor.  

When setting up a virtual agent job, follow the steps in "Creating Jobs" on and "Editing
Outbound Jobs" using the following special instructions.  

When setting up a record selection file  

Select the phone strategy named virtual.●   

To create the virtual agent job  

Choose the outbound job named Virtual as the job to copy.●   

Type a job name that identifies it as a virtual job, such as virtpm.●   

On the Jobs menu, choose Edit and start an outbound job.●   

To set up Outbound Job Run Verification screen parameters  

Agents: press Ctrl+C to change the setting to No.●   

Selection: press Ctrl+D and select the record selection file to which you assigned the
virtual phone strategy.

●   

Start script label: press Ctrl+D and select the virtual job script label you want to use
with this job.

●   

Main data process label: confirm that the setting is Virtual. If it isn't, press Ctrl+D and
choose this setting.

●   
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Edit inbound jobs

(Intelligent Call Blending systems only) Use the Inbound Job Run Verification screen to set
and verify inbound job settings on Intelligent Call Blending systems. These settings do not
affect Predictive Blend systems.  

Choose Edit and start an inbound job from the Jobs menu.1.  

Type the item number for the job you want to edit or start. The Inbound Job Run
Verification screen appears. The cursor is in the first value field.

2.  

Set inbound job parameters

The following table describes each inbound job parameter listed on the Inbound Job Run
Verification screen. The settings and parameters on your system vary depending upon your
system configuration.

Parameter Value Recommended setting

Inbound list  Inbound list file name  inbnd1  

Inbound screen(s)  
Inbound screen name(s)
separated by commas  

inbnd1,inbnd2  

Wait queue limit
(secs)  

0-999 seconds  
0 to 5 seconds set an
unlimited wait queue time  

Job description  Up to 30 characters/spaces   

Agent key definition
file  

Agent keys file name  op_cmd  

Line type(s)  
REG INB  

OTHER  
INB1  

Start answer label  Answer script starting label  in_wait_1  

Main data process
label  

Data process label  generic  

Enable call forwarding
on ACD  

YES or NO  NO  
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Activate lines at logon
 

YES or NO  YES  

Max agent wait (secs)
 

0-999 seconds  60  

Max % of clients in
queue  

100 - 200  100  

Verification job   NO  

Next linked job  Job name   

Transfer wait queue
label  

  

Do Not Call group
name  

Do Not Call group file name   

 

Inbound List  

Type the name of the calling list. The inbound calling list is a template that contains the
information you need from the customer. Each time the system receives a call, it adds a
record to the inbound list. Some call centers upload this information to the system. In other
call centers, the agents connect directly to the host and interactively update records.  

Inbound Screen(s)  

Type the name of the screen. If the agents use more than one screen, separate the screen
names with a comma. For example, type screen1, screen2, screen3. Choose the inbound
screen(s) that were designed to run with the job. These are the screens that the agents use
during an inbound job.  

Wait Queue Limit (Secs)  

Type the maximum seconds (from 0-999) the system permits a call to remain in the inbound
wait queue before it hangs up on the caller.  

Job Description  

Type a job description (not more than 30 characters). The job description appears on reports
and in job history files. You can sort job reports by the job description.  

Agent Key Definition File  

Type the name of the agent keys file. Choose the keys file that was designed to run with the
job. These are the keys that agents use during an inbound job.  

Line Type(s)  
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Type the line type code(s). Separate multiple codes with commas.  

Note  

If your system uses line pooling, this feature is not available for inbound calls. Line type
codes are the same as line group names. The ability to manage the phone lines depends upon
your system configuration. If your system has multiple line groupings, use this parameter to
select or clear the groups of lines the system uses for a job. Control the number of lines
available for a particular job by assigning it additional groups or by moving a competing job
to another line group. If you designate more than one line group, separate them with a
comma. For example, type INB1,INB2,INB3 (no spaces).  

Start Answer Label  

Type the name of the message file. Press Ctrl+D to see a list of options. Choose the message
that customers hear when they are in the wait queue.  

Main Data Process Label  

Type the name of the data process label for an inbound job or press Ctrl+D to choose from a
list.  

Enable Call Forwarding on ACD  

Type YES to tell the system to pass an inbound call from the ACD to an available Avaya
PDS agent. If an agent isn't available the system passes the call back to the ACD. Type NO
to keep the call in the ACD wait queue. A confirmation prompt appears.  

To use this parameter, your ACD must be configured to allow call forwarding through the
system. For more information, consult your system vendor.  

Activate Inbound Lines at Logon  

Type YES to activate the lines as agents log on or NO to activate all lines at the start of the
job.  

You can activate an inbound line whenever a blend or inbound agent logs on. The system
continues activating lines until it has activated all the inbound lines assigned to the job.
Similarly, the system inactivates lines when agents log off. This keeps unused lines
available to other jobs.  

When this setting is on, the system keeps the number of ACD  

extensions equal to the number of agents available to service the calls. When the ACD sends
a call to the system and there is no agent available, the system returns a busy signal to the
ACD. This keeps a caller from being placed on hold by both the ACD and the system.  

Maximum Time Client Wait (Secs)  

Type the maximum seconds from 0-999. This setting determines the maximum time a call
can be in the wait queue before the system transfers a blend agent to take inbound calls.
Decrease agent wait time if you want to emphasize call center productivity. The Maximum
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% of clients in queue overrides the Maximum client wait.  

This parameter is used only for blend jobs. (This is the same parameter on the Blend Job
Run Verification screen.)  

Maximum % of Clients in Queue  

Type a number from 100-200 to represent the maximum percentage of calls to be in the wait
queue. This parameter is used only for blend jobs. (This is the same parameter on the Blend
Job Run Verification screen. We suggest that you leave it blank on the Inbound screen and
complete the setting on the Blend Job Run Verification screen.) It determines the percentage
of calls that can be in the wait queue before the system moves a blend agent to take calls.  

Verification Job  

This parameter appears only if your system has the Sales Verification feature. Type yes if
this job uses sales verification.  

Next Linked Job  

Type the name of the job to run when this job ends. Although it is unusual, you can link an
inbound job to any job that is not a managed job or a unit work list job. Link jobs when you
want the system to start a job as the current job ends. When you link a job, the system
transfers each agent to the next job after the agent completes the last call and releases the
record. The system displays a screen message telling the agents that they are changing jobs.
 

Transfer Wait Queue Label  

Type the name of the message file to be used with the Native Voice and Data Transfer
feature. Choose the message that your customers hear when they are in the wait queue on a
blind transfer to an inbound agent.  

Do Not Call Group Name  

Type the Do Not Call group name if you want agents to mark records as Do Not Call. Do
Not Call groups contain one or more inbound or outbound calling lists. To use the
Supervisor menus to mark a record as Do Not Call, see "Marking Records as Do Not Call".  
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Edit blend jobs

(Intelligent Call Blending systems only) A blend job is a combination of inbound and
outbound jobs. The system moves agents between inbound and outbound calls to achieve a
balance between customer service and agent activity. Before editing a job, create or edit the
phone strategy and record selection for the outbound job. Execute the record selection file;
then use the Blend Job Run Verification screen to set and verify the blend job settings.  

Choose Edit and start a blend job from the Jobs menu.1.  

Type the item number for the job you want to edit. The Blend Job Run Verification
screen appears. The cursor is in the first field.

2.  

If the value is correct, press Enter and go to the next field. If a value is incorrect, press
Ctrl+C (Change). Type the new information and press Enter to move to the next field.
If a field uses only a YES or NO response, use Ctrl+C to switch between YES and
NO.

3.  

Because a blend job is a combination of an inbound and outbound job, most of the blend job
parameters are the same as the inbound or outbound side of the job.  

The following section describes only the parameters that are unique to blend jobs. Refer to
the outbound and inbound parameter sections for all other settings.  

Maximum Time Client Wait (Secs)  

Type the maximum seconds from 0-999. Determines the maximum time a call can be in the
wait queue before the system transfers a blend agent to take inbound calls. Decrease agent
wait time if you want to emphasize call center productivity. The Maximum % of client in
queue overrides the Maximum client wait. This parameter is used only for blend jobs. (This
is the same parameter on the Blend Job Run Verification screen.)  

Maximum % of Clients in Queue  

Type a number from 100-200. Specifies the percentage of inbound calls that can be in the
wait queue before the system assigns a blend agent to inbound calling. The system bases this
on the ratio of the wait queue calls to the number of inbound and blend agents. The
minimum and recommended setting is 100. The Maximum % of clients in queue overrides
the Maximum client wait.  

In the following example, there are two blend agents and three inbound agents on a job. The
example illustrates how Maximum % of clients in queue affects the system.  
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If Maximum % of clients in queue is set to 100%, five calls must be in the wait queue
before the system moves a blend agent to take inbound calls.

●   

If Maximum % of clients in queue is set to 200%, ten calls must be in the wait queue
before the system moves a blend agent to take inbound calls.

●   

Blend Agent Return Time  

Type the maximum seconds from 5-995. This parameter sets the maximum time a blend
agent on inbound can be idle before the system transfers an agent to take outbound calls.
The minimum setting is 5; the recommended setting is 20.  
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Copy a job

To create a job, first copy an existing job. Assign the copy a new name and change the
settings to meet your job's goals. If the new job doesn't use the same calling list as the
original job, you need to select a new calling list and job screen(s).  

Choose Copy a job from the Jobs menu.1.  

In the Enter Item Number field, type the number of the job to copy.2.  

Type Y at the prompt.3.  

Type the new job name.4.  

Type Y at the prompt to continue or N to cancel.5.  
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Delete a job

Use the following procedure to delete a job:  

Choose Delete a job from the Jobs menu.1.  

Type the item number in the Enter Item Number field.2.  

Type Y at the prompt to delete the job or N to cancel.3.  
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Which of the following is not a job type?  How do you specify a change to a field?
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outbound

  Control + G
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How do you start a job?  Which initial hit rate results in 2 calls per agent for 1

connection?
 Control + C

 Control + N

 Control + X

 Control +G
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Start a campaign

Start a campaign

Use the following procedure to start a campaign.  

Set up or select phone strategies.1.  

Set up or review and run record selections.2.  

Set up and start jobs.3.  
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Edit a phone strategy

Edit a phone strategy

Use the following procedure to edit an existing phone strategy.  

Choose Edit a phone strategy from the Phone Strategies menu.1.  

Type the item number for the strategy file you want to edit. The Select Initial Phone
screen appears. Complete the following steps or, if the screen is correct, press F1
(Done) to move to the next screen.

2.  

Press down arrow to move to the field you want to change.3.  

Type the new value.4.  

Repeat steps 3 and 4 for each field you want to change.5.  

Press F1 (Done) to continue to the next screen.6.  

To edit the rest of the screens, follow the steps that begin with "Selecting Alternate
Initial Phones".

7.  
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Record Selection

Overview

A record selection tells the system which records to use to call customers. This feature gives
you the ability to target specific customers for calling. For example, you can select records
from specific time zones such as Eastern, Central, or Pacific, or you can select records with
specific call completion codes such as BUSY or NOANSWER. You can also select records
that help you satisfy specific goals such as accounts more than 30 days overdue, accounts
with a balance over $2,000, or accounts in a particular city.  

You can execute a record selection immediately after you define the selection criteria or
save it and execute the selection at a later time.  

Choose Record selections from the Campaigns menu. The Record Selections menu appears.
These commands are also available in Campaign Editor's Selection Editor.  

Use the following wildcard character in record selections.

Actions Keys

Done  F1  

Move a line  F2  

Group  F3  

View calling list  F4  

Previous page  F5  

Next page  F6  

View call detection modes or phone strategies  F10  

Clear the field  Ctrl+E  

 

Record Selection 
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Set ring count and call connect criteria

Overview

Use the Select Ring Count and Call Connect Criteria screen to specify two settings:  

The number of rings to allow before the system records a NOANSWER call
completion code.

●   

The call detection mode (Connect Criteria) to tell the system which calls to pass to
agents.

●   

Call detection modes are the type of response the system detects when it dials a number.
Detection modes include voice, answering machine, and special information tones.  

The type of connect criteria determines what type of connects the system will pass to an
agent. Remember, as you decide which ones to use, that you will increase your hit rate with
each additional criteria selected, as more calls will be handled by your agents instead of by
the system.  

The connect criteria abbreviations are as follows:  

V - Voice●   

AV - Autovoice●   

INT- Operator Intercept●   

NCN- Nonconnect●   

DIS- Disconnected Number●   

VAC- Vacant Number●   

ORD - Reorder●   

Set ring count and call connect criteria

Use the following procedure to set ring count and call connect criteria:  

In the Phone Field column, type the phone type number (1, 2, 3, ...).1.  

Type the number of rings to allow in the # of Rings column. (Low number
recommended, such as 3.)

2.  

Type the letter(s) to designate the call detection mode in the Connect Criteria column.3.  

Repeat steps 1 through 3 for each initial phone type.4.  

Press F1 (Done). The Record Selections menu reappears.5.  

Set ring count and call connect criteria 
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Delete a record selection

Delete a record selection

Use the following procedure to delete a record selection:  

Choose Delete a record selection from the Record Selections menu.1.  

Type the item number of the file.2.  

Type Y at the prompt to confirm the deletion or N to cancel.3.  
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Infinite Job Record Selection

Overview

Use an infinite record selection with an infinite, outbound job to enable the Avaya PDS to
call new records received from your host. The new records are called a list segment when
the system adds them to an existing calling list.  

When an infinite job receives new records from your host, the Avaya PDS processes the file
and generates an index. The system sorts the index by category code (also called behavioral
score) in descending order and recall time in ascending order. A behavioral score is a value
the Avaya PDS assigns to a record that typically identifies the fraud risk associated with a
given customer. If a record has no category code, the system treats it as if the code is zero.  

Create, copy, & edit Infinite record selection

Creating an Infinite record selection is the same as creating a general record selection, but
with one difference. To create an Infinite record selection, first copy and edit any existing
record selection. Follow the procedure below to create an Infinite record selection.  

Choose Execute infinite record selection from the Record Selections menu.1.  

Type the item number for the infinite record selection file you want to execute.2.  

Type a report description (not more than 30 characters).3.  

Type Y at the prompt to confirm your selection or N to cancel.4.  
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Complete the final project found in your Student Workbook.
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In order to take this test you must be:

Registered for this class.●   

Have access to the Avaya corporate network.●   

Have completed all of the modules in the course.●   

The test takes approximately 1 hour. Take your time. This test is automatically scored. Use the following
procedure to access the test for this course:

Go to http://www.avaya.com/learning and select one of the three options:

  

1.  

Log into the Learning Center site.2.  

Under My Learning, select current enrollments.3.  

Find the course in the enrollments and select this course title.4.  

Select Test on the components screen.5.  

Follow the instructions on the test to complete it.6.  

Warning: once you have submitted your answers, you cannot go back and change them, so take your
time and make the right choices carefully.
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The following additional resources are provided to assist you in reviewing the material included in this
course.

GUI/CUI activity Goals activity

Character based menus Procedural Rreference

Using the Avaya PDS 12.0 course
Student Workbook (Acrobat)

Student feedback form
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Fill in the blanks

GUI Applications Tasks

Create record selections, phone strategies, and jobs.

Manage and monitor jobs and agents.

Report on jobs, agents, and dialers.

Manage agent, job and dialer hierarchies.

Modify some completion code setting.

Modify blend settings.

Connect to the CUI.

What do they do?

CUI Menus

System 0. Exit

1. Help

2. Control  

5. Users

8. Screen

9. DoNotCall

 3. Campaigns

 

GUI vs. CUI Activity

http://pds.au.avaya.com/esp/mos12/Redtrain/UsingPDS/Qual/1000.html (1 of 2) [4/5/2002 3:27:21 PM]



Copyright© 2002 Avaya Inc.

GUI vs. CUI Activity

http://pds.au.avaya.com/esp/mos12/Redtrain/UsingPDS/Qual/1000.html (2 of 2) [4/5/2002 3:27:21 PM]

http://www.avaya.com/


Goals
March 2002

Now that you have a clear understanding of the Campaign Life Cycle, it is time to relate this process to
several call center scenarios.

This exercise explores the goals met by the Avaya PDS in the customer contact center. This exercise
should take approximately 15 minutes.

Instructions

Students should divide into three groups and each group should select a scenario from the three scenarios
presented. The purpose of this exercise is to allow students to answer the basic questions about how the
customer contact center is organized:

Where customers are contacted●   

What calls are made●   

When calls are made●   

Can you think of any other criteria that are important for efficiently processing calls through the call
center for the scenario?

How do you think the function of the system supervisor will be different for these different scenarios?

Scenario A - Credit Collections

This collections office has a territory covering 11 Northeastern and Midwestern states. Customers are
called when they are 30 days, 60 days, and 90 days delinquent. Most customers speak English, but some
only speak Spanish or Korean. There are three collections agents in the office who speak Spanish and
one who speaks Korean. Local ordinances restrict the time of day and frequency of collection calls and
these restrictions vary according to area code.

Scenario B - Insurance Sales

This insurance sales office covers the Western US. Past performance shows that the most effective sales
calls are made at specific times of day, though this varies from state to state. Due to this varying
outbound calling schedule, most agents are assigned to inbound calls for much of the day. There are five
agents in this office who are multi-lingual and one agent who has access to a TTY for calling deaf
customers.

Scenario C - Blood Bank

Goals
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This blood bank is located in Cologne, Germany and is responsible for scheduling blood donors for 114
blood donation sites in 7 EU countries. Because this is a public service driven calling center, there are
many fewer restrictions for calls than for collections or sales calls. However, one a party has been
contacted, it is necessary to transfer calls to a different agent, if available, who specializes in taking
patient information prior to scheduling the appointment.
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CUI Menus

Supervisor 0. Exit Closes the session.

1. Help Displays help for system menu

2. Control 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Count Counts calling list records

3. Create Create a new calling list

4. AppendList Create an empty calling list

5. Users Manage User Accounts

6. Purge Purge some records

7. Edit 0. Exit

1. Help

2. Edit

3. Delete

4. Edit with Quicksearch

5. Delete with Quicksearch

6. Outbound update

7. Mark records ineligible

8. Create outbound update

8. Screen Starts screenbuilder

9. DoNotCall Mark calling list records

10. Job Lists 0. Exit

1. Help

2. Create job list

3. Modify job List

4. Turn on agent list

5. Turn off agent list

3. Campaigns 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Phone Strategy 0. Exit

Character based menus
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1. Help

2. Create

3. Modify

4. Copy

5. Delete

3. Record Selection 0. Exit

1. Help

2. Create record selection

3. Edit record selection

4. Execute record selection

5. Create unit record selection

6. Edit unit record selection

7. Execute unit record selection

8. Copy record selection

9. Delete record selection

10. Execute infinite record selection

11. Execute verify record selection

13. Reports Various reports

4. Job 0. Exit

1. Help

2. Edit & start outbound job

3. Edit & start inbound job

4. Edit & start blend job

5. Copy a job6. Delete a job

4. Manage Job Monitor Application

5. Report 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Agent 0. Exit

1. Help

2. Outbound Agent History

3. Inbound Agent History

4. Blend Agent History

5. Agent Activity

3. Job 0. Exit

1. Help

2. Outbound Job

Character based menus
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3. Managed Job

4. Inbound Job

5. Blend Job

6. Previously Run Jobs

4. Dist 0. Exit

1. Help

2. Create list distribution

3. Edit list distribution

4. Execute list distribution

5. Cop list distribution

6. Delete list distribution

5. List 0. Exit

1. Help

2. Generate days on PDS

3. Generate reject

4. Generate release code

5. Rawfile or calling list dump

6. System 0. Exit

1. Help

2. Agent Login

3. Multiple Call

4. Program Info. File

5. Hourly inbound activity

7. Extract 0. Exit

1. Help

2. Create extract file

3. Edit extract file

4. Execute PC Analysis extract

5. Execute letter generation extract

6. Copy an extract

7. Delete an extract

8. Display release codes

9. Display available calling lists

8. Tools 0. Exit

1. Help

2. Copy an extract print file

Character based menus
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3. Delete an extract print file

9. Print Prints reports

6. Predict Configures predictive blend options.

7. Support Displays customer support message.

Administrator 0. Exit Closes the session.

 1. Help Displays help for system menu

 2. Admin 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Change Administrator Password

3. Restart System

4. Shut down system

5. Set system Date and Time

6. Monitor agent lines

7. Terminate a user session

8. Edit Area Codes / Prefixes

 3. Event Mon 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Monitor system security events

3. Change monitor refresh interval

 4. Backup 0. Exit  

  1. Help  

  2. Backup 0. Exit

1. Help

2. Backup complete system

3. Backup PDS and calling lists

4. Backup PDS only

5. Backup PDS configuration files

6. Backup data/stat files

7. Restore all from tape

8. Restore a file from tape

9. List/Verify a file on tape

10. ListVerify tape contents

11. List tape volume info

  3. Backup CL 0. Exit

1. Help

2. Backup all calling lists

Character based menus
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3. Backup specific calling list

4. Restore all calling lists

5. Restore specific calling list

 5. Inbound Sets Inbound calling options

 6. IVR 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Set up IVR Connections

3. Connect to IVR

4. Disconnect from IVR

5. Reset connection to IVR

6. Update list of IVR scripts

 7. Transfer 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Download Host records to PDS

3. Upload PDS Records to the Host

4. Recover old calling list

5. Count calling List records

6. Download records for infinite job

 8. Support Displays customer support message.
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Index
Alerts
Architecture
Avaya PDS Agent
Blend Manager
Campaign Analyst
Campaign Editor
Campaign Monitor
Completion Code
Manager

Event Monitor
Hierarchy Manager
Jobs
Jobs (CUI)
PC Analysis
(Telnet)
Phone strategy
Phone strategy
(CUI)

Record selection
Record selection (CUI)
System reports
System Telnet administrator menu
System Telnet supervisor menu

Alerts Overview Procedure

Alerts  

Alert settings

Create an alert

Check status of an alert  

Architecture Overview Procedure

Avaya PDS Overview   

Avaya PDS System Components   

Multiple-dialer operations   

Avaya PDS Agent Overview Procedure

Overview of Avaya PDS Agent  

Using the Avaya PDS Agent
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Blend Manager Overview Procedure

Blend Manager  

Campaign Analyst Overview Procedure

Overview of Campaign Analyst  

Campaign Analyst reports  

Create a new report

Print a report

Preview a report

Schedule a report

Campaign Editor Overview Procedure

Campaign Editor  

Enable/disable multi-dialer features  

Campaign Monitor Overview Procedure

Campaign Monitor

Campaign Monitor User Intrface

View Control toolbar  

Campaign Monitor views

Agent Detail view  

Agent Completion Code view  

Agent History view  

Supervusor Agents view  

Dialer Status View  

Dialer Agents view  

Dialer Lines view  

Dialer History view  

Job Status View  

Job Agents view  

Source Resources v2
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Job Detail view  

Job Call Handling view  

Job Completion Code view  

Job Wait Queue view  

Job History View  

Job Performance view  

Set Scope Selectors  

Find Agents view  

Create Custom view  

Completion Code Manager Overview Procedure

Overview of Completion Code Manager

Start Completion Code Manager  

Set a Completion Code as RPC

Set a Completion Code as Closure

Set a Completion Code as a Abandon

Change completion Code description  

Event Monitor Overview Procedure

Event Monitor  

Monitor security logs

Change monitor interval

Hierarchy Manager Overview Procedure

Overview of Hierarchy Manager  

Create a hierarchy

Open a hierarchy  

Adding levels to Hierarchies

Adding data items to hierarchies

Moving levels within hierarchies
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Jobs Overview Procedure

Jobs Overview

Job settings

Job Types

Create a job

Jobs (CUI) Overview Procedure

Create a job

Edit outbound job

Managed jobs  

Edit Managed Jobs  

Edit sales verification jobs

Edit infinite jobs

Edit virtual jobs

Edit inbound jobs

Edit blend jobs  

Copy a job  

Delete a job  

PC Analysis (Telnet) Overview Procedure

Overview of PC Analysis Telnet  

PC Analysis toolbar  

Start PC Analysis Telnet

Transfer PC Analysis extract output files

Phone strategy Overview Procedure

Phone strategy  

Phone strategy preparation

Phone strategy settings  
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Create a phone strategy

Phone strategy (CUI) Overview Procedure

Create a phone strategy

Add initial phone  

Add alternate initial phone  

Add ring count and call connect criteria  

Add retries  

Record selection Overview Procedure

Record selection

Record selection organization

Record selection wildcards

Create a record selection

Run a record selection

Record selection (CUI) Overview Procedure

Create a record selection

Selecting Time Zones  

Selecting Call Completion Codes  

Selecting field names and values  

Selecting phone strategies  

Sorthing field names and direction (optional)  

Selecting recall field names and values  

Software Overview Procedure

Campaign Editor  

Campaign Monitor  

Campaign Analyst  

Hierarchy Manager  
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Completion Code Manager  

Blend Manager  

System Telnet  

PC Analysis  

System reports Overview Procedure

System reports overview  

Agent history report fields  

Generate agent history reports  

Job history report fields  

Generate job history reports  

Calling list report fields  

Generating calling list reports  

System report fields  

Generate system reports  

System Telnet administrator menu Overview Procedure

Restart the Avaya PDS

Shut down the Avaya PDS  

Edit area codes and prefixes

Backup Avaya PDS

Create an empty inbound list

Download host records

Upload records to host  

Backup a calling list  

Restore a calling list  

Count calling list records  

System Telnet supervisor menu Overview Procedure

Overview System Telnet
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Logging in to the Avaya PDS

Counting Calling List Records

Download verification

Add user accounts

Record edit  

Job monitor

Campaign Update  

Mark Records Do Not Call  
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Feedback form
March 2002

Please use the following form to send the instructional design team your comments and suggestions. This
input is very important in changing the content of this course to better serve your needs.

Thank you.

Your name: 

Your e-mail:  Telephone: 

Comments:
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Resources
March 2002

The following additional resources are provided to assist you in reviewing the material included in this
course.

GUI/CUI activity Goals activity

Character based menus Procedural reference
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Resources
March 2002

The following additional resources are provided to assist you in reviewing the material included in this
course.

GUI/CUI activity Goals activity

Character based menus Procedural reference

Using the Avaya PDS 12.0 course
Student Workbook (Acrobat)

Student feedback form

   Copyright© 2002 Avaya Inc.
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Character based menus
March 2002

CUI menus

Supervisor 0. Exit Closes the session.

1. Help Displays help for system menu

2. Control 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Count Counts calling list records

3. Create Create a new calling list

4. AppendList Create an empty calling list

5. Users Manage User Accounts

6. Purge Purge some records

7. Edit 0. Exit

1. Help

2. Edit

3. Delete

4. Edit with Quicksearch

5. Delete with Quicksearch

6. Outbound update

7. Mark records ineligible

8. Create outbound update

8. Screen Starts screenbuilder

9. DoNotCall Mark calling list records

10. Job Lists 0. Exit

1. Help

2. Create job list

3. Modify job List

4. Turn on agent list

5. Turn off agent list

3. Campaigns 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Phone Strategy 0. Exit

Character based menus
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1. Help

2. Create

3. Modify

4. Copy

5. Delete

3. Record Selection 0. Exit

1. Help

2. Create record selection

3. Edit record selection

4. Execute record selection

5. Create unit record selection

6. Edit unit record selection

7. Execute unit record selection

8. Copy record selection

9. Delete record selection

10. Execute infinite record selection

11. Execute verify record selection

13. Reports Various reports

4. Job 0. Exit

1. Help

2. Edit & start outbound job

3. Edit & start inbound job

4. Edit & start blend job

5. Copy a job6. Delete a job

4. Manage Job Monitor Application

5. Report 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Agent 0. Exit

1. Help

2. Outbound Agent History

3. Inbound Agent History

4. Blend Agent History

5. Agent Activity

3. Job 0. Exit

1. Help

2. Outbound Job

Character based menus
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3. Managed Job

4. Inbound Job

5. Blend Job

6. Previously Run Jobs

4. Dist 0. Exit

1. Help

2. Create list distribution

3. Edit list distribution

4. Execute list distribution

5. Cop list distribution

6. Delete list distribution

5. List 0. Exit

1. Help

2. Generate days on PDS

3. Generate reject

4. Generate release code

5. Rawfile or calling list dump

6. System 0. Exit

1. Help

2. Agent Login

3. Multiple Call

4. Program Info. File

5. Hourly inbound activity

7. Extract 0. Exit

1. Help

2. Create extract file

3. Edit extract file

4. Execute PC Analysis extract

5. Execute letter generation extract

6. Copy an extract

7. Delete an extract

8. Display release codes

9. Display available calling lists

8. Tools 0. Exit

1. Help

2. Copy an extract print file

Character based menus
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3. Delete an extract print file

9. Print Prints reports

6. Predict Configures predictive blend options.

7. Support Displays customer support message.

Administrator 0. Exit Closes the session.

 1. Help Displays help for system menu

 2. Admin 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Change Administrator Password

3. Restart System

4. Shut down system

5. Set system Date and Time

6. Monitor agent lines

7. Terminate a user session

8. Edit Area Codes / Prefixes

 3. Event Mon 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Monitor system security events

3. Change monitor refresh interval

 4. Backup 0. Exit  

  1. Help  

  2. Backup 0. Exit

1. Help

2. Backup complete system

3. Backup PDS and calling lists

4. Backup PDS only

5. Backup PDS configuration files

6. Backup data/stat files

7. Restore all from tape

8. Restore a file from tape

9. List/Verify a file on tape

10. ListVerify tape contents

11. List tape volume info

  3. Backup CL 0. Exit

1. Help

2. Backup all calling lists
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3. Backup specific calling list

4. Restore all calling lists

5. Restore specific calling list

 5. Inbound Sets Inbound calling options

 6. IVR 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Set up IVR Connections

3. Connect to IVR

4. Disconnect from IVR

5. Reset connection to IVR

6. Update list of IVR scripts

 7. Transfer 0. Exit Returns to main menu

1. Help Displays help for system menu

2. Download Host records to PDS

3. Upload PDS Records to the Host

4. Recover old calling list

5. Count calling List records

6. Download records for infinite job

 8. Support Displays customer support message.

Copyright© 2002 Avaya Inc.
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Alerts

Overview

You can define up to 10 alerts that provide audio cues, visual cues, log files, e-mails, or
pager signals when job/agent performance, system or job status, or line usage varies beyond
predetermined levels. This capability allows you to identify and correct potential problems
before they escalate.  

For example, you might want to know when an agent takes more than five minutes on a call
or when the hit rate on a job is less than 30%. Alerts can also be set to tell you when the
system needs attention, for example, a job is approaching completion.  

To access alerts, start Campaign Monitor and select Settings > Alerts.  

Note

If you set an alert, you can close Campaign Monitor. When you restart Campaign Monitor,
your alert will be saved. However, if Campaign Monitor is closed when you should receive
your notification, you will not receive notification. In other words, Campaign Monitor must
be active in order for you to receive a notification. After you receive an alert notification,
the alert is not automatically enabled again. Open the Alert Viewer and select Enabled to
reactivate an alert.  

Alert examples

The Avaya PDS can alert you for many reasons. The following is a sample list.  

Average Idle Time - the average time that all agents or a specific agent are idle (not
talking or updating).

●   

Average Talk Time - the average time that all agents or a specific agent spend talking.●   

Average Update Time - the average update time that all agents or a specific agent
spend updating a customer record.

●   

Current Talk Time - the talk time for all agents or a specific agent, as shown talking
in real-time (rather than an average over multiple calls).

●   

Current Update Time - the update time for all agents or a specific agent, as shown
updating in real-time (rather than an average over multiple calls).

●   

Total Idle Time - the total idle time for all agents or a specific agent, as idle time
added over the course of a single job.

●   

Total Talk Time - the total talk time for all agents or a specific agent, as talk time●   

Alerts 

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/10_Performance_Alerts_BB3.html (1 of 2) [4/5/2002 3:27:26 PM]



added over the course of a single job.

Total Update Time - the total update time for all agents or a specific agent, as update
time added over the course of a single job.

●   

Line Utilization - the percentage of lines in use; for example, you might want to know
when 95% of your lines are utilized so that you can free up some lines (otherwise,
when 100% of the lines are utilized, customers will automatically be placed in a wait
queue when they call in).

●   

Current Hit Rate - a hit rate is the ratio or percentage of call connects to call attempts
(a 25% hit rate means that out of 100 attempts, 25 connects were made or it takes 4
calls to connect to one customer); a minimum hit rate keeps a job with a low hit rate
from using all the lines when it shares a line pool with other jobs.

●   

Time on Dialer - this feature is like an alarm clock: when the dialer hits a certain time
of the day/night, you are alerted.

●   

Agent Completion Code Total - the accumulated total of completion codes that agents
have entered.

●   

Agent Completion Code Average - the average number of completion codes that
agents have entered.

●   

Job Completion Code Average - the completion code average per hour; this is useful
if, for example, you would like an overall sense of job performance.

●   

Job Completion Code Total - the total of all job completion codes, as accumulated
over the entire life of a job; this is helpful if you want to shut down a job or reassign
agents to another job when the goal for a job has been met.

●   

Agents Assigned - the number of agents currently on a job.●   

Job End - the job has ended.●   

Records Left - the number of records still left in the job that need to be called.●   

Records Left as Percent of Total - the percent of records in the entire job still left to
be called.

●   

Time Remaining - the estimated time left on a job.●   

Note

There is also one alert that you may receive that you do not configure yourself. The Avaya
PDS automatically alerts you if new data has not appeared in the database for more than 12
minutes (12 is the current setting). This alert lets you know if the data you are viewing in
Campaign Monitor is not being updated.  
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Alert Settings

Alert settings

The following table shows possible combinations of alert settings:

Condition Dialer Job Agent Relation Value Modifier

Agent Comp Code
Totals  

Yes  Yes  Yes  >,<  
 

Total  

Agent Comp code
Avg  

Yes  Yes  Yes  >,<  
 

Average Per
Hour  

Agents Assigned  Yes  Yes  No  >,<  
 

 

Average Idle Time  Yes  Yes  Yes  >,<  0-1440  minutes  

Average Talk Time
 

Yes  Yes  Yes  >,<  0-1440  minutes  

Average Update
Time  

Yes  Yes  Yes  >,<  0-1440  minutes  

Current Hit Rate  Yes  Yes  No  >,<  1-100  %  

Current Talk Time  Yes  Yes  Yes  >,<  0-1440  
 

Current Update
Time  

Yes  Yes  Yes  >,<  0-1440  
 

Job Comp Code
Avg  

Yes  Yes  No  >,<  
  

Job Comp Code
Total  

Yes  Yes  No  >,<  
  

Job End  Yes  Yes  No  
   

Line Utilization  Yes  Yes  No  >,<  1-100  %  

Alert Settings 
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Records Left  Yes  Yes  No  >,<  
  

Records Left
Percent  

Yes  Yes  No  >,<  1-100  %  

Time on Dialer  Yes  No  No  >,<  1:00-12:59  AMPM  

Time Remaining  Yes  Yes  No  >,<  0-1440  minutes  

Total Idle Time  Yes  Yes  Yes  >,<  0-1440  minutes  

Total Talk Time  Yes  Yes  Yes  >,<  0-1440  minutes  

Total Update Time  Yes  Yes  Yes  >,<  0-1440  minutes  

 

The dialer, job, and agent columns indicate whether a data item is relevant to a particular
alert condition. For example, you can set a Job End alert for any job on any dialer, and you
can set a Total Talk Time alert on any agent on any job on any dialer.  
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Overview

Purpose

The AvayaTM Predictive Dialing System (PDS) uses alerts to signal to supervisors of the
end of a job, a goal being met, and other campaign events.  

Contents

This section contains the following topics:  

Alerts●   

Alert Settings●   

Create an alert●   

Edit an alert●   

Remove an alert●   

View a log●   

Enable and disable alerts●   

Check the status of each alert●   
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Create an alert 

Overview

You create alerts in Alerts Viewer, which is a available in Campaign Monitor.  

Create an alert

Use the following procedure to create an alert.  

Select Start > Programs > Avaya > Campaign Director > Campaign Monitor.1.  

Select Settings > Alerts.
(If an e-mail configuration wizard appears, either complete it or cancel out of it.)

2.  

In the Alerts Viewer dialog box, click Add.
The Alert Editor dialog box appears.

3.  

On the Alert Definition tab, select the condition you want to monitor and complete
the conditional statement.

4.  

On the Scope tab, narrow your alert condition.
You can skip this tab if you do not want to narrow your alert criteria.

5.  

On the Notifications tab, specify how Avaya PDS notifies you: a pop-up alert on your
screen, an audible sound, a log file, or an e-mail.
If you select Send to log, then you can view a log file that will contain all alert
conditions that have been met. This log file is accessible using the View Log button
on the Alert Viewer.
If Send e-mail is unavailable, configure your default e-mail client on your PC. If Send
e-mail is available and you want to receive an e-mail alert notification, type your
e-mail address in the To... box.

6.  

Click OK.
The alert name and summary information appear in the Alerts Viewer dialog box.

7.  

 Volume I PDF

Legal Statement

Avaya Inc.

Create an alert  

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_jobctrl_alert_create.html [4/5/2002 3:27:28 PM]

http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_jobctrl_alert_edit.html
http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/mon_jobctrl_alert_edit.html
http://www.avaya.com/


Search this site:

  

The search engine will find pages on this website only.
For best results enter just one or two words.
Searches on more than one word will be treated "as a phrase".
Use the asterisk (*) character for wildcard searches.

Search this site

http://pds.au.avaya.com/esp/mos12/Redtrain/searcht.html [4/5/2002 3:27:30 PM]


	avaya.com
	Using the Avaya PDS in the Customer Contact Center
	Campaign Life Cycle
	Using the Avaya PDS in the Customer Contact Center
	Agenda
	Course Materials
	Using Web Site
	Foundations Review
	Architecture
	Software
	Terminology Review
	Architecture Quiz
	Avaya PDS overview 
	System components 
	Overview 
	Architecture Quiz
	Campaign Editor 
	Campaign Monitor 
	Campaign Analyst 
	Overview 
	Overview 
	Overview 
	PC Analysis 
	Software Quiz
	Preparation
	Overview 
	AvayaPDSUserGuide.book
	Avaya PDS User's Guide Volume 1
	Table of Contents
	About this information product
	Reason for reissue
	Intended-Audience

	Part I:� Avaya Predictive Dialing System introduction
	1 Avaya Predictive Dialing System
	Avaya PDS overview
	System components
	Campaign Director
	Campaign Editor
	Campaign Monitor
	Campaign Analyst

	2 Campaign Life Cycle
	Campaign Life Cycle

	3 Multi-dialer
	Shared features
	Primary and secondary dialers
	Pod impacts

	4 Agent types
	Agent types
	Agent logons

	5 Calling list
	Calling list features
	Download calling lists

	6 Completion codes
	Completion codes
	Completion code table


	Part II:� Use the Avaya PDS
	7 Log in to Campaign Director
	Log in to Campaign Director

	8 Campaign Editor settings
	Enable or disable multi-dialer commands�
	Save options�
	Set refresh options�

	9 Phone strategy�
	Phone strategy overview
	Phone strategy preparation
	Phone strategy settings
	Create a phone strategy�
	Copy a phone strategy�
	View phone strategy settings�
	Edit a phone strategy�
	Delete a phone strategy�
	List all phone strategies on a selected dialer�
	Append a phone strategy row�
	Insert a row in a phone strategy�
	Delete a row in a phone strategy�
	Move a row up in a phone strategy�
	Move a row down in a phone strategy�
	Select all rows in a phone strategy�
	Unselect all rows in a phone strategy�

	10 Record selection�
	Record selection
	Record selection organization
	Record selection wildcard characters
	Understand the Selection Reports pane
	Open and view a record selection�
	Complete the Miscellaneous pane�
	Complete the Records pane�
	Complete the Time Zone pane�
	Complete the Calling Results pane�
	Complete the Recalls pane (optional)�
	Complete the Sort pane (optional)�
	Create a record selection�
	Save a record selection�
	Edit a record selection�
	Delete a record selection�
	Verify a record selection�
	Run a record selection�
	Copy a record selection�
	List all record selections on a selected dialer�
	View selection reports�
	View record selection settings�
	Append record selection rows�
	Insert a row in a record selection�
	Delete a row in a record selection�
	Move a row up in a record selection�
	Move a row down in a record selection�
	Select all rows in a record selection�
	Unselect all rows in a record selection�

	11 Jobs�
	Job types
	Outbound job
	Job settings
	Create a job�
	View job settings�
	Save a job�
	Save a job as another name or on a different dialer�
	Start a job on one or more dialers�
	Start multiple jobs on currently selected dialer�
	Copy a job�
	Edit a job�
	Verify a job on one or more dialers�
	Verify multiple jobs on the currently selected dialer�
	Delete a job on one or more dialers�
	Delete multiple jobs on the currently selected dialer�
	List all jobs on a selected dialer�

	12 Campaign Monitor settings�
	Set the default hierarchy�
	Set time range�
	Set job changes�
	Set agent states to display�
	Set view set�
	Set refresh rate�
	Set save on exit settings�

	13 Campaign Monitor navigation and personalization
	User interface
	Navigate among the Tool menu applications�
	Use large icons or small icons in the button bar�
	Open a standard view�
	Open a view or view set from another location�
	Create a custom view�
	Save current view�
	Save as view set�
	Save view set with a new name�
	Delete a view set�
	Add a view to the Custom button group�
	Refresh a view�

	14 Campaign Monitor views�
	Views
	Dialer Status view�
	Dialer Agents view�
	Dialer Lines view�
	Dialer History view�
	Job Status view�
	Job Agents view�
	Job Detail view�
	Job Call Handling view�
	Job Completion Codes view�
	Job Wait Queues view�
	Job History view�
	Job Performance view�
	Supervisor Agents view�
	Find Agent view�
	Agent Detail view�
	Agent Completion Codes view�
	Agent History view�

	15 View control functions�
	View control toolbar
	Filter data in a view�
	Select a performance code�
	Scope selectors examples
	Set scope selectors�
	Select a time range�
	Select a hierarchy�
	Hide or show columns�
	Select Table View or Graphical View�
	Save a view as HTML�

	16 Job control functions�
	Stop a job�
	Link to job�
	Minimum hit rate�
	Expert calling ratio�
	Inbound settings�
	Reassign lines�
	Managed Dialing�
	Time zones�
	Unit Work Lists�
	Detection modes�
	Alternate initial�
	Recalls�

	17 Quotas
	Job end and quotas
	Create or modify a quota�

	18 Alerts
	Alerts
	Alert Settings
	Create an alert�
	Edit an alert�
	Remove an alert�
	View a log�
	Enable and disable alerts�
	Check the status of each alert�

	19 Agent control functions�
	Agent control functions
	Find an agent�
	Transfer an agent to another job�
	Send message to an agent�
	Monitor agent line�
	Remove an agent from a job�
	Show an agent view�

	20 Campaign Analyst
	Reports
	Report categories
	Preview a report�
	Export a report�
	Create a new report configuration�
	Schedule a report�
	Change a report�
	Print a report�
	Delete a report configuration�


	Part III:� Tools
	21 Hierarchy Manager�
	Hierarchies
	Start Hierarchy Manager�
	Create a hierarchy�
	Open a hierarchy�
	Add a level to a hierarchy�
	Add a data item to a hierarchy�
	Move a level or item within a hierarchy�
	Rename a hierarchy level�
	Remove a level from a hierarchy�
	Remove a data item from a hierarchy�
	Rename a hierarchy�
	Delete a hierarchy�

	22 Completion Code Manager�
	Completion code categories
	Start Completion Code Manager�
	Set a completion code as RPC�
	Set a completion code as a Closure�
	Set a completion code as an Abandon�
	Remove a completion code�
	Change a completion code description�
	View Completion Code Manager for another dialer�

	23 PC Analysis Telnet
	PC Analysis Telnet
	Toolbar icons
	Start PC Analysis Telnet�
	Transfer PC Analysis extract output files�

	24 System Telnet
	System Telnet
	Toolbar icons
	Start System Telnet�

	25 Agent Blending�
	Agent Blending
	Supported ACDs
	Switch terminology
	Domains
	Domain Groups
	Start the Agent Blending tool�
	Create a domain group�
	Create a domain�
	Edit domain group settings�
	Edit domain settings�
	Delete a domain group�
	Delete a domain�
	Move a domain to a different group�
	Stop the blend engine�
	Start the blend engine�
	Reset the blend engine�
	Resynch the blend engine�
	View ACD statistics�
	View alerts�
	View transactions�




	http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol1/legal.html
	Campaign Director 
	3 Multi-dialer 
	Shared features 
	Primary and secondary dialers 
	Pod impacts 
	Architecture
	Architecture
	Architecture
	Tier Architecture
	Tier Architecture
	Tier Architecture
	2 Campaign Life Cycle 
	22 Completion Code Manager  
	Completion code categories 
	Start Completion Code Manager  
	Set a completion code as RPC  
	Set a completion code as a Closure  
	Set a completion code as an Abandon  
	Remove a completion code  
	Change a completion code description  
	View Completion Code Manager for another dialer  
	25 Agent Blending  
	Agent Blending 
	Supported ACDs 
	Switch terminology 
	Domains 
	Domain Groups 
	Start the Agent Blending tool  
	Create a domain group  
	Create a domain  
	Edit domain group settings  
	Edit domain settings  
	Delete a domain group  
	Delete a domain  
	Move a domain to a different group  
	Stop the blend engine  
	Start the blend engine  
	Reset the blend engine  
	Resynch the blend engine  
	View ACD statistics  
	View alerts  
	View transactions  
	24 System Telnet 
	System Telnet 
	Toolbar icons 
	Start System Telnet  
	Overview 
	Data sources 
	AvayaPDSUserGuide_VolumeII.book
	Avaya PDS User's Guide Volume 2
	Table of Contents
	About this information product
	Reason for reissue
	Intended-Audience

	Part I:� Supervisor menu
	1 Supervisor overview
	Supervisor main menu

	2 Campaign overview
	Start a campaign
	Create phone strategy
	Add initial phone
	Add alternate initial phone (optional)
	Add ring count and call connect criteria
	Add retries
	Edit a phone strategy
	Copy a phone strategy
	Delete a phone strategy
	Set Recall Times
	Record Selection
	Create a Record Selection
	Selecting Time Zones
	Selecting Call Completion Codes
	Selecting Field Names and Value
	Selecting Phone Strategies
	Sorting field names and direction (optional)
	Selecting recall field names and values
	Set ring count and call connect criteria
	Grouping expressions and statements
	Move fields and values
	Unit Record Selection
	Edit unit record selection
	Execute unit record selection
	Standard Record Edit
	Supervisor Menu Record Selection Preparation
	Edit a record selection
	Execute a record selection
	Copy a record selection
	Delete a record selection
	Create a job
	Edit an outbound job
	Managed Jobs
	Edit Managed Jobs
	Edit Sales Verification Jobs
	Edit Infinite Jobs
	Edit Virtual Jobs
	Edit Inbound Jobs
	Edit Blend Jobs
	Copy a Job
	Delete a Job
	Infinite Job Record Selection
	Manage Job Linking

	3 Calling lists and users
	Calling list
	Count calling list records
	User accounts and permission levels
	Add user accounts
	Delete user accounts
	Edit user accounts
	Record Edit
	Edit a record
	Delete a record
	Restore a deleted record
	Campaign Update
	Create an outbound Campaign Update report
	Mark records as Do Not Call

	4 Manage active jobs
	Overview of job monitor
	Open a job
	Close a job
	Remove agents
	View job statistics
	View completion codes
	View phone line usage
	View call types
	View agent screens
	Agents on active jobs
	Send a message to an agent
	Send a message to all agents
	Control jobs
	Shut down a job
	Stop a job immediately
	Link a job
	Monitor agents
	Transfer agents to another job
	Change phone line allocations
	Change maximum time a customer waits
	Change maximum % of client in queue
	Change blend agent return time
	Job settings
	Change Minimum Hit Rate
	Change Expert Calling Ratios
	Change Managed Dialing settings
	Change cancel mode
	Change time zone ordering
	Change time zone status
	Unit Work List settings
	Set different quotas for each Unit Work List
	Change Unit Work List controls
	Change phone strategy detection mode
	Change phone strategy recall parameters
	Change phone strategy alternate phone lines
	Analyze Job Activity Screens
	Agent Activity Fields
	Line Usage Fields
	Calling activities fields for outbound calls

	5 Screenbuilder
	Screenbuilder overview
	Screenbuilder menus
	Open Screenbuilder
	Create a screen
	Add text to screen
	Add fields to screen
	Copy a screen
	Find a screen
	Edit a screen
	Delete field and text in a screen
	Save screen changes
	Edit screens with Menu System
	Add screens to jobs
	Spell-check your screen
	Delete screens from a job
	Change screens and calling lists
	Field Attributes
	Change field appearance
	Set field edit capabilities
	Change field sequence order
	Field verification formats
	Set field verification formats
	Validate delimiters
	Acceptable field entries
	Set acceptable field entries
	Field reference information
	Set field reference information
	Build helpful screens
	Screenbuilder reports
	Create and view reports
	Print a report

	6 Reports
	Avaya PDS reports overview
	Agent history report fields
	Generate agent history reports
	View or print an agent history report
	Job history report fields
	Generate job history reports
	Generate a previously run job history report
	List distribution
	Calling list data
	List distribution report design
	Generate list distribution reports
	Select list distribution fields
	Select list distribution field values
	Select range in list distribution
	Set list distribution filters
	Change list distribution report titles
	Move fields and values
	Clear fields and values
	Delete fields
	Change or delete a value
	Edit filters
	Copy a list distribution report
	Delete a list distribution report file
	Execute and print list distribution reports
	List distribution report analysis
	Calling list reports
	Generate calling list reports
	System reports
	Generate system reports

	7 PC Analysis
	PC Analysis
	Data sources
	Job history
	Agent history
	Calling statistics
	Calling list
	Downloading an extract file
	PC Analysis extract
	Log in to PC Analysis using cdwanal password
	Log in to PC Analysis using supervisor password
	Create an extract file
	Extract selection information
	Set up the extract file
	Edit an extract file
	Copy an extract file
	Delete extract and output files
	Execute an extract configuration file
	Display completion codes
	Display available calling lists
	Copy an extract print file
	Delete an extract print file
	View and print an extract file


	Part II:� Administrative menu
	8 Administrator overview
	Log in to the Avaya PDS

	9 Avaya PDS administrative tasks
	Change administrator passwords
	Restart the Avaya PDS
	Shut down the Avaya PDS
	Set the Avaya PDS date and time
	Monitor agent lines
	Stop monitoring an agent
	Terminate user session
	Area codes and prefixes
	Edit area codes and prefixes
	View current area codes and prefixes
	View time zones
	Add an area code or a prefix to a time zone
	View current area code and prefix settings
	Delete an area code or prefix
	Change a country code
	Save area code and prefix changes
	Discard area code and prefix changes
	Restore a previous version of area code and prefix settings
	Start the Avaya PDS

	10 File transfers
	File transfer
	Record formats
	FTP
	Download host records to the Avaya PDS
	Downloads
	Upload the Avaya PDS records to a host computer
	Recover calling list
	Count calling list records
	Download records for infinite jobs

	11 Inbound lists
	Create an empty inbound calling list
	Clear existing inbound calling lists
	Count calling list records

	12 Backup and recovery
	Back up and restore commands
	Backup Avaya PDS
	Verify backup files
	Maintain backup tapes
	Restore Avaya PDS
	Monitor DAT drive status
	Back up a calling list
	Restore a calling list

	13 System security event monitor
	Monitor security logs
	Use the system log monitor
	Change the monitor interval


	Part III:� Agent Blending
	14 Agent Blending
	Agent Blending menus
	Exit a Menu
	Control Predictive Blend
	Modify domain groups
	Modify Service Level domain groups
	Modify Average Speed to Answer domain groups
	Modify Outbound only groups
	Modify domain group optional fields
	Modify control methods
	Delete domain groups
	Display groups
	Control and monitor domains
	Delete a domain
	Monitor a domain
	Display system alerts
	Change extensions
	Add extensions
	List extensions
	Delete extensions




	http://pds.au.avaya.com/esp/mos12/Redtrain/Docs/Userguide/vol2/legal.html
	GUI vs. CUI
	System Menus
	System Menus
	Avaya PDS Agent
	System Menus
	Supervisor main menu 
	Count calling list records 
	Downloads 
	Add user accounts 
	Record Edit 
	Overview of job monitor 
	Campaign Update 
	Mark records as Do Not Call 
	Planning
	Menus Quiz
	Overview 
	2 Campaign overview 
	Calling list 
	User accounts and permission levels 
	Download host records to the Avaya PDS 
	Upload the Avaya PDS records to a host computer 
	Delete user accounts 
	Edit user accounts 
	Edit a record 
	Overview 
	Open a job 
	Restore a deleted record 
	Create an outbound Campaign Update report 
	4 Manage active jobs 
	CLC Activity
	CLC Quiz
	Implementation
	Campaign Editor
	Phone Strategies
	Record Selections
	Jobs
	Completion Code Manager
	Campaign Editor Project
	Phone Strategy Exercise
	Phone strategy overview 
	Phone strategy preparation 
	Phone strategy settings 
	Phone Strategy Quiz
	Record Selection Exercise
	Record selection 
	Record selection organization 
	Record selection wildcard characters 
	Record Selection Quiz
	Jobs Exercise
	Overview 
	Job types 
	Job settings 
	Management
	Overview 
	Create a phone strategy  
	Overview 
	Understand the Selection Reports pane 
	Jobs Quiz
	11 Jobs  
	Outbound job 
	Create a job  
	View job settings  
	Save a job  
	Save a job as another name or on a different dialer  
	Start a job on one or more dialers  
	Start multiple jobs on currently selected dialer  
	Copy a job  
	Edit a job  
	Verify a job on one or more dialers  
	Verify multiple jobs on the currently selected dialer  
	Delete a job on one or more dialers  
	Delete multiple jobs on the currently selected dialer  
	List all jobs on a selected dialer  
	Intro to Campaign Monitor
	Managing Jobs
	Managing Agents
	Managing Jobs
	Agent Blending
	Managing Jobs
	Campaign Monitor Activity
	User interface 
	View control toolbar 
	Views 
	Campaign Monitor Activity
	Managing Jobs Quiz
	Managing agents activity
	Managing Agents Quiz
	Hierarchy Manager activity
	Managing Hierarchies Quiz
	Evaluation
	Overview 
	Navigate among the Tool menu applications  
	Overview 
	Filter data in a view  
	Overview 
	Dialer Status view  
	Campaign Analyst
	Campaign Analyst
	System Reports
	Tools Exercise
	Reports 
	Campaign Analyst Quiz
	PC Analysis Activity
	PC Analysis Telnet 
	Toolbar icons 
	PC Analysis Quiz
	Tools Exercise
	Avaya PDS reports overview 
	Agent history report fields 
	Generate agent history reports 
	Job history report fields 
	Generate job history reports 
	Calling list reports 
	Generate calling list reports 
	System reports 
	Generate system reports 
	Overview 
	Report categories 
	Overview 
	Start PC Analysis Telnet  
	Sustaining Tasks
	Overview 
	View or print an agent history report 
	Generate a previously run job history report 
	List distribution report analysis 
	7 PC Analysis 
	Administrator Menus
	Event Monitor
	Tools Exercise
	Restart the Avaya PDS 
	Shut down the Avaya PDS 
	Edit area codes and prefixes 
	Backup Avaya PDS 
	Create an empty inbound calling list 
	Back up a calling list 
	Restore a calling list 
	Count calling list records 
	Administrator Menu Quiz
	CUI Campaigns
	Monitor security logs 
	Change the monitor interval 
	Change administrator passwords 
	Set the Avaya PDS date and time 
	Area codes and prefixes 
	View current area codes and prefixes 
	Back up and restore commands 
	Verify backup files 
	Overview 
	Clear existing inbound calling lists 
	Monitor DAT drive status 
	13 System security event monitor 
	Recover calling list 
	Download records for infinite jobs 
	Event Monitor Activity
	CUI Phone Strategies
	CUI Record Selections
	CUI Jobs
	CUI Campaign Activity
	Overview 
	Use the system log monitor 
	Part III: Agent Blending 
	CUI Phone Strategy Activity
	Create phone strategy 
	Add initial phone 
	Add alternate initial phone (optional) 
	Add ring count and call connect criteria 
	Add retries 
	CUI Phone Strategy Quiz
	CUI Record Selection Activity
	Create a Record Selection 
	Selecting Time Zones 
	Selecting Call Completion Codes 
	Selecting Field Names and Value 
	Selecting Phone Strategies 
	Sorting field names and direction (optional) 
	Selecting recall field names and values 
	CUI Record Selection Quiz
	CUI Phone Strategy Activity
	Create a job 
	Edit an outbound job 
	Managed Jobs 
	Edit Managed Jobs 
	Edit Sales Verification Jobs 
	Edit Infinite Jobs 
	Edit Virtual Jobs 
	Edit Inbound Jobs 
	Edit Blend Jobs 
	Copy a Job 
	Delete a Job 
	CUI Phone Strategy Quiz
	Qualifying
	Start a campaign 
	Edit a phone strategy 
	Record Selection 
	Set ring count and call connect criteria 
	Delete a record selection 
	Infinite Job Record Selection 
	Preparing for the Test
	Preparing for the Test
	Character based menus
	GUI vs. CUI Activity
	Goals
	Character based menus
	Source Resources v2
	Feedback Form
	Character based menus
	Character based menus
	Character based menus
	Alerts 
	Alert Settings 
	Overview 
	Create an alert  
	Search this site


	PAFPMIFBMPNIPMOAKDHIICNBKKKONENA: 
	form1: 
	x: 
	f1: [Select an Application]
	f2: [Select an Application]
	f3: [Select an Application]
	f4: [Select an Application]
	f5: [Select an Application]
	f6: [Select an Application]
	f7: [Select an Application]
	f8: 
	f9: 
	f10: 
	f11: 
	f12: 



	IALAOEGJNELHNJICJMNDDLLPKJMBBFIL: 
	form1: 
	x: 
	f1: 
	f2: 
	f3: 
	f4: 
	f5: Submit

	f6: 
	f7: 


	PGBPOKOMFLMPAEOKJFINKNJGBJAEJIDG: 
	form1: 
	x: 
	f1: 
	f2: Search

	f3: 




